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1 Foreword
With its modular interface concept and compact design, the stand-alone SB6 drive controller enables extremely versatile
system designs. SB6 is available as a single-axis controller in three sizes with a nominal output current of up to 32 A. If you
are looking for a universal and flexible solution, the SB6 drive controller is the right choice.

Features

§ Control of rotary synchronous servo motors and asynchronous motors

§ Control of linear and torque motors

§ Sensorless position control of STOBER Lean motors

§ One Cable Solution EnDat 3

§ Electronic motor nameplate via EnDat encoder interfaces

§ Integrated EtherCAT or PROFINET communication

§ STO safety technology using terminals or STO and SS1 using FSoE or PROFIsafe: SIL 3, PL e (Cat. 4)

§ Optional operating unit consisting of text display and keys

§ Modular interface concept

§ Integrated brake control

§ Energy supply through direct power feed-in
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2 User information
This documentation covers the SB6 drive controller. You will receive support for the assembly of the individual modules
along with the associated components that you will need to operate the drive controllers in the control cabinet.

You will also find information on wiring the modules correctly and checking their functionality in the group with an initial
test.

Combinations with other 6th generation STOBER drive controllers are possible under certain boundary conditions.

More detailed information on project configuration, diagnostics and service are additional topics covered in this manual.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is binding for:

SB6 series drive controllers in conjunction with the 
DriveControlSuite software (DS6) in V 6.7-A or higher and associated firmware in V 6.7-A or higher.

Type ID No.

Drive controller SB6A06 5050162

SB6A16 5050164

SB6A26 5050166

Tab. 1: Described product types, SB6 drive controllers

2.3 Directives and standards
The following European directives and standards are relevant to the drive controllers:

§ Directive 2006/42/EC – Machinery Directive

§ Directive 2014/30/EU – EMC Directive

§ Directive 2011/65/EU – RoHS Directive

§ Directive 2009/125/EC – Ecodesign Directive

§ EN IEC 61800-3:2018

§ EN 61800-5-1:2007 + A1:2017

§ EN 61800-5-2:2017

§ EN IEC 63000:2018

§ EN ISO 13849-1:2015

Subsequent references to the standards do not specify the respective year in order to improve readability.
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2.4 UL file number
cULus-certified devices with corresponding test symbols meet the requirements of the standards UL 61800-5-1 and 
CSA C22.2 No. 274.

Under the file number specified in the following table, you can find the product in the online database of Underwriter
Laboratories (UL):
https://iq2.ulprospector.com

Type File number UL Category Control Number Certification

America Canada

Drive controller SB6A06 E189114 NMMS NMMS7 cULus

SB6A16

SB6A26

Braking resistors FZMU, FZZMU E212934 NMTR2 NMTR8 cURus

GVADU, GBADU

Output chokes TEP3720-0ES41 E333628 NMMS2 NMMS8 cURus

TEP3820-0CS41

TEP4020-0RS41

Motors EZ or LM series
synchronous servo
motors

E488992 PRHZ2 PRHZ8 cURus

Asynchronous motors E216143 PRGY2 PRGY8 cURus

Encoder and power
cables

All types E172204
E170315
E356538

AVLV2 AVLV8 cURus

One Cable Solution
Basic

All types E356538 AVLV2 AVLV8 cURus

One Cable Solution
Advanced

All types E170315 AVLV2 AVLV8 cURus

Tab. 2: File number-certified products

2.5 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.6 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

2.7 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

https://iq2.ulprospector.com
http://www.stoeber.de/en/downloads/
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2.8 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.8.1 Display of warning messages and information
Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.8.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

Operating buttons

The buttons of the drive controller are depicted as follows in the continuous text.

[OK] Button on the operating unit of the drive controller

2.8.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

– Subtraction

+ Addition

× Multiplication

÷ Division

| | Absolute value

http://www.stoeber.de
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2.8.4 Conventions for cables
In the cable connection descriptions, core colors are shortened and used as follows.

Cable colors

BK: BLACK PK: PINK

BN: BROWN RD: RED

BU: BLUE VT: VIOLET

GN: GREEN WH: WHITE

GY: GRAY YE: YELLOW

OG: ORANGE

Formatting conventions

Two-colored core: WHYE WHITEYELLOW (white-yellow core)

Single-colored core: BK/BN BLACK/BROWN (black or brown core)

Core pair: BU-BK BLUE-BLACK (blue and black core)

2.9 Marks and test symbols
The following marks and test symbols are mentioned in the technical data.

RoHS lead-free mark 
Marking in accordance with RoHS directive 2011-65-EU.

CE mark 
Manufacturer's self declaration: The product meets the requirements of EU
directives.

UKCA test symbol
Manufacturer's self declaration: The product meets the requirements of UK
directives.

UL test symbol (cULus)
This product is listed by UL for the United States and Canada.
Representative samples of this product have been evaluated by UL and meet the
requirements of applicable standards.

UL recognized component mark (cURus)
This component or material is recognized by UL for the US and Canada.
Representative samples of this product have been evaluated by UL and meet
applicable requirements.
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2.10 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

CANopen®, 
CiA®

CANopen® and CiA® are registered trademarks of CAN in AUTOMATION e.V.,
Germany, the international user and manufacturer association.

CODESYS® CODESYS® is a registered trademark of CODESYS GmbH, Germany.

EnDat® EnDat® and the EnDat® logo are registered trademarks of Dr. Johannes Heidenhain
GmbH, Germany.

EPLAN® EPLAN® and the EPLAN® logo are registered trademarks of EPLAN Software & Service
GmbH & Co. KG, Germany.

EtherCAT®,
Safety over EtherCAT®

EtherCAT® and TwinCAT® are registered trademarks and patented technologies,
licensed by Beckhoff Automation GmbH, Germany.

HIPERFACE® HIPERFACE® and the HIPERFACE DSL® logo are registered trademarks of SICK AG,
Germany.

Hyper-V® Hyper-V® is a registered trademark of the Microsoft Corporation in the United States
and/or other countries.

PLCopen® PLCopen® is a registered trademark of the PLCopen Organisation, Netherlands.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS
Nutzerorganisation e.V., Germany.

PROFIdrive®,
PROFIsafe®

PROFIdrive® and PROFIsafe® are registered trademarks of Siemens AG, Germany.

SIMATIC®, 
TIA Portal®

SIMATIC® and TIA Portal® are registered trademarks of Siemens AG, Germany.

speedtec® speedtec® is a registered trademark of TE Connectivity Industrial GmbH, Germany.

TORX® TORX® and the TORX® logo are registered trademarks of Acument Intellectual
Properties in the USA and/or other countries.

TwinCAT® TwinCAT® is a registered and licensed trademark of Beckhoff Automation GmbH,
Germany.

VirtualBox® VirtualBox® is a registered trademark of Oracle America, Inc., USA.

VMware® VMware® is a registered trademark of VMware, Inc., USA.

Windows®,
Windows® 7,
Windows® 10,
Windows® 11

Windows®, the Windows® logo, Windows® XP, Windows® 7, Windows® 10, and
Windows® 11 are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.
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3 Safety notes
There are risks associated with the product described in this documentation that can be prevented by complying with the
following basic safety notes as well as the included technical rules and regulations.

3.1 Qualified personnel
In order to be able to perform the tasks described in this documentation, the persons instructed to perform them must
have the appropriate professional qualification and be able to assess the risks and residual hazards when handling the
products. For this reason, all work on the products as well as their operation and disposal may be performed only by
professionally qualified personnel.

Qualified personnel are persons who have acquired the authorization to perform these activities either through training to
become a specialist and/or instruction by specialists.

Furthermore, valid regulations, legal requirements, applicable basic rules, this documentation and the safety notes included
in it must be carefully read, understood and observed.

3.2 Intended use
As defined by EN 50178, drive controllers are electrical devices operating as power electronics to control the flow of energy
in high-voltage systems.

The drive controllers are intended solely for the operation of motors that meet the requirements of EN 60034-1:

§ Lean motors of the LM series

§ Synchronous servo motors (e.g. of the EZ series)

§ Asynchronous motors

§ Linear motors

§ Torque motors

The connection of other electronic loads or operation outside applicable technical specifications constitutes improper use.

When installing drive controllers in machines, commissioning (i.e. commencing intended operation) may not be performed
until it has been determined that the machine is in compliance with local laws and directives.

EMC-compliant installation

The SB6 drive controller and accessories must be installed and wired compliant for EMC.

Modification

As the user, you may not make any physical, technical or electrical modifications to the SB6 drive controller and the
accessories.

Maintenance

The SB6 drive controller and accessories are maintenance-free. However, take appropriate measures to detect or prevent
possible errors in the connecting wiring.
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3.3 Transport and storage
Inspect the delivery for any transport damage immediately after you receive it. Notify the transport company of any
damage immediately. Do not put a damaged product into operation.

Store the products in a dry and dust-free room if you do not install them immediately.

Transport and store the products in the original packaging and protect the products from mechanical impacts and
vibrations. Observe the transport and storage conditions recommended in the technical data.

3.4 Operational environment and operation
The products are subject to sales restrictions in accordance with EN IEC 61800-3.

The products are not designed for use in a public low-voltage network that supplies residential areas. Radio-frequency
interference can be expected if the products are used in this type of network.

The products are intended exclusively for installation in control cabinets with at least protection class IP54.

To ensure the faultless and safe operation of the products, they must be professionally configured, installed, operated and
maintained.

Always operate the products within the limits specified by the technical data.

The following applications are prohibited:

§ Use in potentially explosive atmospheres

§ Use in environments with harmful substances as specified by EN 60721, such as oils, acids, gases, vapors, dust and
radiation

Implementation of the following applications is permitted only after approval from STOBER:

§ Use in non-stationary applications

§ The connection of active and passive components (drive controllers, supply modules, regenerative feedback modules
or discharge units) from third-party manufacturers

All device types are intended exclusively for operation on TN networks or wye sources that supply a maximum differential
short-circuit current in accordance with the following table.

For UL-compliant operation:
All device types supplied with 480 VAC are intended solely for operation with grounded wye sources at 480/277 VAC.
For all device types – with 240 VAC or 480 VAC supply – the supply grid must not deliver a differential short-circuit current
above the specification in the following table.

Size of the drive controller Max. differential short-circuit current

Size 0 – size 2 5000 A

Tab. 3: Short-circuit current rating (SCCR)

The drive controller has a configurable restart. If the drive controller is designed for an automatic restart after energy
shutdown, this must be clearly specified on the system in accordance with EN 61800-5-1.

The drive controller has the option of a Safe Torque Off safety function (STO) in accordance with EN 61800-5-2 for safely
disconnecting the energy supply to the motor. Measures based on this for protection against unexpected startup are
described in EN ISO 12100 and EN ISO 14118, for example.
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3.5 Working on the machine
Before all work on machines and systems, apply the 5 safety rules in accordance with DIN VDE 0105-100 (Operation of
electrical installations – Part 100: General requirements) in the order listed:

§ Disconnect (also ensure that the auxiliary circuits are disconnected).

§ Ensure power cannot be switched on again.

§ Ensure that everything is de-energized.

§ Ground and short-circuit.

§ Cover adjacent live parts.

Information

Note the discharge time of the DC link capacitors in the general technical data for the devices. You can only determine the
absence of voltage after this time period.

3.6 Installation
Installation work is permitted only when no voltage is present. Obey the 5 safety rules 
(see Working on the machine [} 19]).

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Handle the devices with care:

§ Do not damage any components or change any insulation distances when transporting or handling the devices.

§ Avoid mechanical overloads.

§ Do not touch any electronic components or contacts.

To protect the devices from overheating, obey the operating conditions described in the technical data and comply with the
required minimum clearances for installation.

Protect the devices against falling parts (bits or strands of wire, pieces of metal, etc.) during installation or other work in the
control cabinet. Parts with conductive properties may result in a short-circuit inside the devices and device failure as a
result.
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3.7 Electrical connection
Connection work is permitted only when no voltage is present. Observe the 5 safety rules 
(see Working on the machine [} 19]).

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

The device and the cables connected to it are not necessarily de-energized when the supply voltage is switched off and all
displays have gone out!

Opening the housing, plugging in or unplugging connection terminals, connecting or removing a connecting wiring, and
installing or removing accessories are prohibited while the voltage supply is switched on.

The device housing must be closed before you turn on the supply voltage.

Protect the devices against falling parts (bits or strands of wire, pieces of metal, etc.) during installation or other work in the
control cabinet. Parts with conductive properties may result in a short-circuit inside the devices and device failure as a
result.

Use only copper conductors. For the corresponding conductor cross-sections, consult the standards DIN VDE 0298-4 or 
EN 60204-1 (Annexes D, G) as well as the relevant terminal specifications in this documentation.

The protection class of the devices is protective grounding (protection class I in accordance with EN 61140). This means that
operation is permitted only if the grounding conductor is connected according to requirements.

All protective ground connections are identified by "PE" or the international grounding symbol (IEC 60417, symbol 5019).

The products are not designed for use in a public low-voltage network that supplies residential areas. Radio-frequency
interference can be expected if the products are used in this type of network.

3.8 Ensuring traceability
The orderer must ensure traceability of the products using the serial number.

3.9 Decommissioning
In safety-oriented applications, note the mission time TM = 20 years in the safety-relevant key performance indicators. A
drive controller with integrated safety module must be taken out of operation 20 years after the production date. The
production date of the drive controller is found on the accompanying nameplate.

For detailed information about using the safety technology, refer to the corresponding manual (see Further information
[} 399]).
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3.10 Disposal
Observe the current national and regional regulations when disposing of the packaging and product! Dispose of the
packaging and individual product parts depending on their properties, e.g. as:

§ Cardboard

§ Electronic waste (printed boards)

§ Plastic

§ Sheet metal

§ Copper

§ Aluminum

§ Battery

3.11 Firefighting

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

There is a risk of fatal injury due to electric shock when using conductive firefighting equipment.

▪ Use ABC powder or carbon dioxide (CO2) for firefighting.
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4 Security
Security refers to the protection and safety of your components and systems with regard to confidentiality, integrity and
availability.

While functional safety technology focuses on the avoidance of systematic or random faults, security technology is based
on targeted influences. These influences may be intentional or unintentional with direct or indirect access to equipment.

Security risks

§ Incorrect operation, e.g. connection to an incorrect device

§ Hardware:

• Changing the wiring

• Changing the device configuration, e.g. the FSoE address

• Disassembly of accessories, e.g. the SD card

§ Software:

• Changing the firmware

• Changing the device configuration, e.g. via DriveControlSuite, via the SD card or using script mode

• Changing parameters

§ Network structure

Recognizing and avoiding risks

For example, the following tools are available to help you identify risks and avoid tampering.

§ Make sure that the device identification is unique:

• Reference code

• Communication address(es)

§ After establishing the connection, make sure that communication with the desired device has been established.

§ Test and log the (re)commissioning.

§ Check the security log of the drive controller regularly (see Security log [} 397]).

§ Limit access:

• Physically (close off the control cabinet and electrical operating room)

• Logically (restrict communication, e.g. by means of a firewall)

§ Use sealing tape to detect tampering at the following interfaces:

• Ethernet service interface X9

• Fieldbus interfaces X200 and X201

• SD slot X700

§ Make sure that the controller runs a plausibility check:

• Device status

• Application-specific configuration ID

Planning measures

The requirements from the locally applicable safety and application standards regarding protection against tampering must
be observed. The authorization of personnel and the implementation of the necessary protective measures are the
responsibility of the operator.

All systems to be protected must be considered individually. Organizational protective measures are supported by technical
measures. Technical measures alone are not sufficient.
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In the course of planning, you should name and document the measures to be taken.

Such measures include:

§ Sensible division of user groups

§ Use of appropriate passwords

§ Updated network plans

Network plans can be used to ensure that secure networks are permanently separated from public networks and, if
necessary, that there is only defined access (e.g. via a firewall or a DMZ).

A regular, e.g. annual, review of the security measures is advisable.

Defense in depth concept

Counter risks with layered security solutions.

In accordance with EN IEC 62443-4-1, the defense-in-depth concept is an approach to defend the system against any kind of
attack by applying multiple independent methods.

Features:

§ The approach is based on the fundamental idea that any protective measure can be, and probably will be, overcome.

§ Attackers have to overcome or bypass each layer without being detected.

§ A weakness in one layer can be mitigated by the capabilities of another layer.

§ The system's IT security becomes a set of layers within the overall IT network security.

§ Each layer should stand alone, should not be based on the same functionality as the other layers and should not have
the same failure modes as them.

Operator
- System security

System integrator
- Network security

- System integrity

Security
process

· Drive controllers
· Commissioning software
· Motors
· Gear units

· Physical access protection
· Processes and policies
· Security services

System

Fig. 1: Defense in depth concept
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5 UL-compliant use
This chapter contains relevant information for use under UL conditions (UL – Underwriters Laboratories).

Surrounding air temperature and pollution degree

The maximum surrounding air temperature for UL-compliant operation is 45°C. Use in an environment up to pollution
degree 2 is permitted.

Supply grid

All device types supplied with 480 VAC are intended solely for operation with grounded wye sources at 480/277 VAC.

For all device types – with 240 VAC or 480 VAC supply – the supply grid must not deliver a symmetrical short-circuit current
above the specification in the following table.

Size of the drive controller Max. differential short-circuit current

Size 0 – size 2 5000 A

Tab. 4: Short-circuit current rating (SCCR)

Line fuse

Obey the information on the UL-compliant line fuse of the supplied drive controllers [} 91].

Branch circuit protection

Integral solid state short-circuit protection does not provide branch circuit protection (line fuse) upstream of the drive
controller. Branch circuit protection must be provided in accordance with the manufacturer instructions, the National
Electrical Code, the Canadian Electrical Code, part I, and any additional local codes.

Protective grounding

The protective grounding of motors connected to the drive controller must not be connected using terminal X20. The
grounding conductor connection of the motor must be ensured for the respective application in accordance with the valid
electrical standards.

The grounding at terminal X10 of the SB6 drive controller must not be used for protective grounding. The housing for the
drive controllers must be connected to the protective grounding using the M6 ground bolt (4.0 Nm, 35 Lb.inch).

The connection for the protective grounding on the housing is identified by the grounding symbol in accordance with 
IEC 60417 (symbol 5019).

For correct installation, obey the instructions for UL-compliant connection of the grounding conductor [} 95].

Functional grounding

In addition to the protective grounding, a functional grounding is required for proper operation of the SB6 drive controller
and the motor. The functional grounding of the drive controller is connected using terminal X10, while that of the motor is
connected using terminal X20. The connections for the functional grounding to terminals X10 and X20 are marked with PE.
For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.
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Motor overload protection/motor temperature protection

Use motor overload protection/motor temperature protection. The SB6 drive controller features connections for PTC
thermistors (NAT 145 °C, sensor voltage = 3.3 VDC, sensor current = max. 0.6 mA) at X2, pins 7 and 8. The devices are only
intended for use with motors with integrated temperature protection. In accordance with UL certification, operation
without motor overload protection/motor temperature protection in or on the motor (X2 jumpers) is not permitted!

For a proper connection, follow the terminal description for X2 [} 101].

For EnDat 3 or HIPERFACE DSL encoders, the motor temperature is transmitted together with the encoder data over
connector X4. Additional cabling at terminal X2 is not needed.

Brake

Obey the technical data for the brake.

Digital inputs

Observe the technical data of the digital inputs of terminal X1 [} 43] and the technical data of the 
digital inputs of terminal X101 [} 62] (XB6 option).

Terminals

Note that the basic device is delivered without terminals. Suitable terminal sets are available separately for each size. An
order overview of the available terminal sets can be found in the appendix.

The terminals are labeled accordingly for correct connection. Observe the connection overviews and terminal descriptions
for the connection.

Power terminals

Use only copper conductors for a surrounding temperature of 60/75 °C.

24 V supply and fuses

Low-voltage circuits must be supplied by an isolated source with a maximum output voltage that does not exceed 30 VDC.

Fuses for 24 VDC supplies must be approved for DC voltage in accordance with UL 248.

§ Protect the 24 VDC supply of the control unit with a 10 A fuse (time delay). 
Follow the terminal description for X11 [} 109], pin 1 or 2 (+).

§ Protect the 24 VDC supply for the brake with a 10 A fuse (time delay). Follow the terminal description for X7 [} 106],
pin 1 (+).

§ The following applies to the STO safety function via terminal X12 (option SR6): Protect the supply voltage of the status
signal with a 3.15 A fuse (time delay). Follow the terminal description for X12 [} 110], pin 8 (U1status).

§ Protect the 24 VDC supply for the digital outputs with a 1 A fuse (time delay). Follow the terminal description for X1
[} 99], pin 4 (+24 VDC) and, for the optional interface extension with the XB6 terminal module, the terminal description
for X101 [} 122], pin 6 (+24 VDC).

UL test

Only the risks of electric shock and the risk of fire have been examined during UL acceptance. Functional safety aspects
have not been assessed during the UL approval process. These are assessed for STOBER by bodies such as the TÜV SÜD
certification service.
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6 System design
For connecting to a controller, we recommend the PROFINET fieldbus in combination with the Drive Based or PROFIdrive
application. As an alternative, you can use the EtherCAT fieldbus and an application with a CiA 402 interface. You
commission the drive controller using the DriveControlSuite software.

The drive controllers offer the STO safety function in accordance with EN 61800-5-2 as an option. For connection to a
higher-level safety circuit, different interfaces are available.

The following graphic explains the principle system design.

SB6

Controller

Fieldbus

Drive controller

Lean motors,
synchronous servo motors or
asynchronous motors

Ac
tu

at
or

/s
en

so
r l

ev
el

,
el

ec
tr

om
ec

ha
ni

cs
Fi

el
d 

le
ve

l

Commissioning

Safety

Co
nt

ro
lle

r l
ev

el
Co

m
m

an
d 

le
ve

l

Fig. 2: System overview
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6.1 Hardware components
Below you will find an overview of the available hardware components.

6.1.1 Drive controllers
The SB6 drive controller is available in multiple sizes. Various interface options can also be selected.

6.1.1.1 Nameplate

The nameplate is placed on the side of the drive controller.

Fig. 3: SB6A06 nameplate
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Designation Value in example Meaning

Type SB6A06 Production information

ID No. 5050162

HW 002 CC

Date 2403 (year/calendar week)

S/N 7008316

Input voltage 3 × 400 VAC

50 Hz
UL: 3 × 480 VAC

50 – 60 Hz

Input voltage

Input current 4.0 A Input current

Output data 0 to 460 VAC

0 to 700 Hz

@8 kHz: 3.4 A

Output voltage

Output frequency

Output current for 8 kHz clock frequency

Protection class IP20 Protection class

Efficiency IE2 Energy efficiency class

ηN = 95.9% Nominal efficiency

Tab. 5: Meaning of the specifications on the nameplate

Information

UL and cUL-certified devices with corresponding test symbols meet the requirements of the standards UL 61800-5-1 and
CSA C22.2 No. 274.

6.1.1.2 Type designation

SB 6  A 0 6 Z X O

Tab. 6: Example code for type designation

Code Designation Design

SB Series

6 Generation Generation 6

A Version

0 – 2 Size

6 Power output stage Power output stage within the size

Z
R
U
Y

Safety technology SZ6: Without safety technology
SR6: STO using terminals
SU6: STO and SS1 using PROFIsafe
SY6: STO and SS1 using FSoE

N
X

Terminal module Without terminal module
XB6: With extended terminal option

N
O

Operating unit Without operating unit
OP6: With operating unit

Tab. 7: Meaning of the example code
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6.1.1.3 Material variant

On the side of the drive controller above the nameplate, there is another sticker with the material variant (MV) and serial
number (SN).

Fig. 4: Sticker with MV and serial number

Designation Value in example Meaning

MV MV0000012345 MV number

SN 6001192064 Serial number

— SB6A06ZXO Device type in accordance with type designation

— 1000914812/001100 Order number/order item

Tab. 8: Meaning of the specifications on the sticker

6.1.1.4 Sizes

Type ID No. Size Axis controller

SB6A06 5050162 Size 0 Single-axis controller

SB6A16 5050164 Size 1 Single-axis controller

SB6A26 5050166 Size 2 Single-axis controller

Tab. 9: Available SB6 types and sizes

SB6 in sizes 2, 1 and 0

Note that the basic device is delivered without terminals. Suitable terminal sets are available separately for each size.
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Terminal set for drive controllers (standard version)

(Fig. similar)

The following designs are available:

ID No. 138711
Terminal set for SB6A06.

ID No. 138712
Terminal set for SB6A16.

ID No. 138713
Terminal set for SB6A26.

Contents: 10 terminals.

Terminal set for drive controllers with SR6 safety module (STO using terminals)

(Fig. similar)

The following designs are available:

ID No. 138717
Terminal set for SB6A06 with SR6.

ID No. 138718
Terminal set for SB6A16 with SR6.

ID No. 138719
Terminal set for SB6A26 with SR6.

Contents: 11 terminals.

Terminal set for drive controllers with XB6 terminal module

(Fig. similar)

The following designs are available:

ID No. 138720
Terminal set for SB6A06 with XB6.

ID No. 138721
Terminal set for SB6A16 with XB6.

ID No. 138722
Terminal set for SB6A26 with XB6.

Contents: 12 terminals.

Terminal set for drive controllers with SR6 safety module (STO using terminals) and XB6 terminal module

(Fig. similar)

The following designs are available:

ID No. 138723
Terminal set for SB6A06 with SR6 and XB6.

ID No. 138724
Terminal set for SB6A16 with SR6 and XB6.

ID No. 138725
Terminal set for SB6A26 with SR6 and XB6.

Contents: 13 terminals.
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6.1.2 Operating motors, encoders and brakes
You can use the SB6 drive controller to operate Lean motors of the LM series, synchronous servo motors (such as those of
the EZ series), asynchronous motors, linear motors or torque motors.

Evaluation options for feedback are available on the X4 connection for the following encoders:

§ EnDat 2.1/2.2 digital encoders

§ SSI encoders

§ Differential TTL and differential HTL incremental encoders

§ EnDat 3 or HIPERFACE DSL encoders (with One Cable Solution design)

In addition, evaluation options for the following encoders are available on the X1 connection:

§ Single-ended HTL incremental encoders

§ Single-ended HTL pulse/direction interface

The following additional encoder types can be connected via the optional available XB6 terminal module:

§ Resolvers

§ EnDat 2.1 sin/cos encoders

§ Sin/cos encoders

§ EnDat 2.1/2.2 digital encoders

§ SSI encoders (SSI motion bus)

§ Differential TTL incremental encoders

§ Differential TTL pulse/direction interface

§ Differential TTL Hall sensor

All device types of the SB6 drive controller have connections for PTC thermistors and can control a 24 VDC brake as standard.

6.1.3 Accessories
You can find information about the available accessories in the following chapters.

6.1.3.1 Operating unit

OP6 operating unit

Information

You must order the optional operating unit together with the basic device.

ID No. 5050180
Operating unit for the drive controller, consisting of a text display and 9 keys.
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6.1.3.2 Safety technology

The safety modules are used to realize the STO safety function. They prevent the generation of a rotating magnetic field in
the power unit of the drive controller. For an external requirement or in the event of error, the safety module switches the
drive controller to the STO state. Different human-machine interfaces and additional safety functions are available
depending on the selected design of the accessories.

Information

The drive controller is delivered in the standard design without safety technology (option SZ6). If you want a drive
controller with integrated safety technology, you must order it together with the drive controller. The safety modules are
an integrated part of the drive controllers and must not be modified.

SZ6 option – Without safety technology

ID No. 56660
Design without safety technology.

SR6 safety module – STO using terminals

ID No. 56661
Optional accessory for the use of the Safe Torque Off safety function (STO) in safety-
relevant applications (PL e, SIL 3) in accordance with EN ISO 13849-1 and 
EN 61800-5-2. Connection to a higher-level safety circuit via terminal X12.

SY6 safety module – STO and SS1 using FSoE

ID No. 56662
Optional accessory for the use of the Safe Torque Off (STO) and Safe Stop 1 (SS1)
safety functions in safety-relevant applications (PL e, SIL 3) in accordance with 
EN ISO 13849-1 and EN 61800-5-2. Connection to the higher-level safety circuit using
Fail Safe over EtherCAT (FSoE).

SU6 safety module – STO and SS1 using PROFIsafe

ID No. 56696
Optional accessory for the use of the Safe Torque Off (STO) and Safe Stop 1 (SS1)
safety functions in safety-relevant applications (PL e, SIL 3) in accordance with 
EN ISO 13849-1 and EN 61800-5-2. Connection to a higher-level safety circuit via
PROFINET (PROFIsafe).

For detailed information about using the safety technology, refer to the corresponding manual (see Further information
[} 399]).
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6.1.3.3 Terminal module

XB6 terminal module

ID No. 5050181
Optional terminal module for connecting analog and digital signals as well as
encoders.

Inputs and outputs:

§ 8 digital inputs (24 VDC)

§ 8 digital outputs (24 VDC)

§ 2 analog inputs (±10 VDC, 1 × 0 – 20 mA, 16 bits)

§ 2 analog outputs (±10 VDC, ±20 mA, 12 bits)

Supported encoders and interfaces:

§ Resolver (evaluation)

§ EnDat 2.1 sin/cos encoder (evaluation)

§ Sin/cos encoder (evaluation)

§ EnDat 2.1/2.2 digital encoder (evaluation)

§ SSI encoder (SSI motion bus, evaluation and simulation)

§ Differential TTL incremental encoder (evaluation and simulation)

§ Differential TTL pulse/direction interface (evaluation and simulation)

§ Differential TTL Hall sensor

X120 TTL connecting cable

ID No. 49482
Cable for coupling the X120 TTL interface to the XB6 terminal module for the
transmission of SSI or incremental signals, length: 0.3 m.

Information

For connecting con.23 resolver cables with a 9-pin D-sub connector, such as the standard design for ED/EK synchronous
servo motors, you must use interface adapter AP6A00 (ID No. 56498) or AP6A01 (ID No. 56522, with motor temperature
sensor leads), available separately.

Information

For connecting EnDat 2.1 sin/cos cables with a 15-pin D-sub connector to an integrated motor temperature sensor, you
must use the AP6A02 interface adapter (ID No. 56523), available separately, to lead out the temperature sensor cores.
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AP6 interface adapters

The following variants are available:

AP6A00
ID No. 56498
Adapter X140 resolver, 9/15-pin.
Adapters for connecting resolver cables with a 9-pin D-sub connector to the X140
encoder interface of the XB6 terminal module.

AP6A01
ID No. 56522
Adapter X140 resolver, 9/15-pin with cores of the motor temperature sensor led out
at the side (core length: approx. 11 cm).
Adapters for connecting resolver cables with a 9-pin D-sub connector to the X140
encoder interface of the XB6 terminal module.

AP6A02
ID No. 56523
Adapter X140 EnDat 2.1 sin/cos, 15/15-pin with cores of the motor temperature
sensor led out at the side (core length: approx. 11 cm).
Adapters for connecting EnDat 2.1 sin/cos cables with a 15-pin D-sub connector to
the X140 encoder interface of the XB6 terminal module.
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6.1.3.4 Communication

The drive controller has two interfaces for the EtherCAT or PROFINET connection on the top of the device as well as an
Ethernet service interface on the front of the device. Cables for the connection are available separately.

EtherCAT or PROFINET

Specify the desired fieldbus system when placing your order for the base device,
since fieldbus communication is defined by the firmware.

EtherCAT cables

Ethernet patch cable, CAT5e, yellow.

The following designs are available:

ID No. 49313: Length approx. 0.25 m. 
ID No. 49314: Length approx. 0.5 m.

PC connecting cable

ID No. 49857
Cable for connecting the X9 service interface to the PC, CAT5e, blue, length: 5 m.

USB 2.0 Ethernet adapter

ID No. 49940
Adapter for connecting Ethernet to a USB port.

For detailed information about the fieldbus connection, refer to the corresponding manual (see Further information
[} 399]).
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6.1.3.5 Braking resistor

STOBER offers braking resistors in different sizes and performance classes.

For more detailed information on this, refer to the technical data (see Braking resistor [} 64]).

6.1.3.6 Choke

STOBER offers various chokes corresponding to your application.

For more detailed information, refer to the technical data (see Choke [} 69]).

6.1.3.7 EMC shield plate

As an alternative to shield contact at terminal X20 of the drive controller, you can use the following shield plate to connect
the cable shield of the power cable.

EM6A0 EMC shield plate

ID No. 56459
EMC shield plate for SB6 and SD6 series drive controllers up to size 2.
Accessory part for shield connection of the power cable.
Can be attached to the drive controller housing.
Including shield connection terminal.

Information

Alternatively, the EM 5000 shield plate can be used. Please note the deviating installation dimensions in the technical data
of the drive controller.
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6.2 Software components
Various software components are available for commissioning your drive system and implementing your application.

6.2.1 Project configuration and parameterization
For project configuration and parameterization, the drive controller can be addressed using the DriveControlSuite
commissioning software (DS6). The program guides you step by step through the complete project configuration and
parameterization process using wizards.

6.2.2 Applications
A drive-based application is recommended for the decentralized motion control of sophisticated machines.

The drive-based application package from STOBER is the right choice wherever universal and flexible solutions are needed.
The Drive Based application provides drive-based motion control for positioning, velocity and torque/force with the
PLCopen Motion Control command set. These standard commands have been combined into operating modes for different
applications and supplemented with additional functions such as motion block linking, cams and much more. For the
command operating mode, all properties of the movements are specified directly by the controller. The properties of the
movements in the drive are predefined in the motion block operating mode so that only a start signal is necessary to
perform the movement. Linking can be used to define complete motion sequences. There is a separate operating mode
available for applications controlled by velocity or torque/force such as pumps, fans or conveyor belts. This also allows for
operation without a controller.

In addition, the CiA 402 and PROFIdrive applications are also available, which include both the controller-based and drive-
based operating modes and application classes. For example, standard telegrams 1, 2 and 3 as well as telegrams 102 and
111 are available for standard drives according to PROFIdrive in application class 1 and for decentralized positioning control
according to application class 3. Based on these telegrams, the drive controllers can be used with the SpeedAxis and
BasicPos (EPos) technology objects.

Furthermore, programming based on IEC 61131-3 with CFC can be used to create new applications or expand existing ones.
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7 Technical data
Technical data for the drive controllers and accessories can be found in the following chapters.

7.1 Drive controllers
The following chapters contain specifications for the electrical data, dimensions and weight of the drive controller.

7.1.1 General technical data
The following information applies to all device types.

Device features

Protection class of the device IP20

Protection class of the installation space At least IP54

Protection class Protection class I in accordance with EN 61140

Radio interference suppression Integrated line filter in accordance with EN 61800-3, interference emission
class C3

Overvoltage category III in accordance with EN 61800-5-1

Marks and test symbols CE, cULus, RoHS

Tab. 10: Device features

Transport and storage conditions

Storage/
transport temperature

−20 °C to +70 °C
Maximum change: 20 K/h

Relative humidity Maximum relative humidity 85%, non-condensing

Vibration (transport) in accordance with
EN 60068-2-6

5 Hz ≤ f ≤ 9 Hz: 3.5 mm 
9 Hz ≤ f ≤ 200 Hz: 10 m/s²
200 Hz ≤ f ≤ 500 Hz: 15 m/s²

Fall height for free fall1

Weight < 100 kg
in accordance with EN 61800-2
(or IEC 60721-3-2, class 2M4)

0.25 m

Shock testing in accordance with 
EN 60068-2-27

Pulse shape: Half-sine
Acceleration: 5 g
Shock duration: 30 ms
Number of shocks: 3 per axis

Tab. 11: Transport and storage conditions

1 Only valid for components in their original packaging.
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Operating conditions

Surrounding temperature during
operation

0 °C to 45 °C with nominal data
45 °C to 55 °C with derating −2.5% / K

Relative humidity Maximum relative humidity 85%, non-condensing

Installation altitude 0 m to 1000 m above sea level without restrictions
1000 m to 2000 m above sea level with −1.5%/100 m derating

Pollution degree Pollution degree 2 in accordance with EN 50178

Ventilation Installed fan

Vibration (operation) in accordance with
EN 60068-2-6

5 Hz ≤ f ≤ 9 Hz: 0.35 mm 
9 Hz ≤ f ≤ 200 Hz: 1 m/s²

Tab. 12: Operating conditions

Discharge times

Self-discharge of DC link 15 min

Tab. 13: Discharge times of the DC link circuit

7.1.2 Electrical data
The electrical data of the available sizes as well as the properties of the brake chopper can be found in the following
chapters.

Information

For the time span between energizing two devices, note that:

▪ Direct, repeat activation of the supply voltage is possible for cyclical power-on/power-off operation.

Information

The STO safety function is available for safe stopping as an alternative to continuous, cyclical power-on/power-off
operation.

For an explanation of the formula symbols used, see Symbols in formulas.

7.1.2.1 Control unit

Electrical data All types

U1CU 24 VDC, +20%/−15%

I1maxCU 1.5 A

Tab. 14: Control unit electrical data
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7.1.2.2 Power unit: Size 0

Electrical data SB6A06

U1PU 3 × 400 VAC, +32% / −50%, 50/60 Hz;
3 × 480 VAC, +10% / −58%, 50/60 Hz

f2PU 0 – 700 Hz

U2PU 0 – max. U1PU

U2PU,ZK √2 × U1PU

CPU 135 µF

CN,PU 540 µF

Tab. 15: SB6 electrical data, size 0

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SB6A06

fPWM,PU 4 kHz

I1N,PU 5.4 A

I2N,PU 4.5 A

I2maxPU 180% for 5 s; 150% for 30 s

Tab. 16: SB6 electrical data, size 0, for 4 kHz clock frequency

Electrical data SB6A06

fPWM,PU 8 kHz

I1N,PU 4 A

I2N,PU 3.8 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 17: SB6 electrical data, size 0, for 8 kHz clock frequency

Electrical data SB6A06

UonCH 780 – 800 VDC

UoffCH 740 – 760 VDC

R2minRB 100 Ω

PmaxRB 6.4 kW

PeffRB 2.9 kW

Tab. 18: Brake chopper electrical data, size 0
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7.1.2.3 Power unit: Size 1

Electrical data SB6A16

U1PU 3 × 400 VAC, +32% / −50%, 50/60 Hz;
3 × 480 VAC, +10% / −58%, 50/60 Hz

f2PU 0 – 700 Hz

U2PU 0 – max. U1PU

U2PU,ZK √2 × U1PU

CPU 560 µF

CN,PU 1400 µF

Tab. 19: SB6 electrical data, size 1

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SB6A16

fPWM,PU 4 kHz

I1N,PU 19.2 A

I2N,PU 16 A

I2maxPU 180% for 5 s; 150% for 30 s

Tab. 20: SB6 electrical data, size 1, for 4 kHz clock frequency

Electrical data SB6A16

fPWM,PU 8 kHz

I1N,PU 15.8 A

I2N,PU 12 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 21: SB6 electrical data, size 1, for 8 kHz clock frequency

Electrical data SB6A16

UonCH 780 – 800 VDC

UoffCH 740 – 760 VDC

R2minRB 47 Ω

PmaxRB 13.6 kW

PeffRB 6.2 kW

Tab. 22: Brake chopper electrical data, size 1
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7.1.2.4 Power unit: Size 2

Electrical data SB6A26

U1PU 3 × 400 VAC, +32% / −50%, 50/60 Hz;
3 × 480 VAC, +10% / −58%, 50/60 Hz

f2PU 0 – 700 Hz

U2PU 0 – max. U1PU

U2PU,ZK √2 × U1PU

CPU 1000 µF

CN,PU 1400 µF

Tab. 23: SB6 electrical data, size 2

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SB6A26

fPWM,PU 4 kHz

I1N,PU 38.4 A

I2N,PU 32 A

I2maxPU 180% for 5 s; 150% for 30 s

Tab. 24: SB6 electrical data, size 2, for 4 kHz clock frequency

Electrical data SB6A26

fPWM,PU 8 kHz

I1N,PU 32.6 A

I2N,PU 20 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 25: SB6 electrical data, size 2, for 8 kHz clock frequency

Electrical data SB6A26

UonCH 780 – 800 VDC

UoffCH 740 – 760 VDC

R2minRB 22 Ω

PmaxRB 29.1 kW

PeffRB 13.2 kW

Tab. 26: Brake chopper electrical data, size 2
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7.1.2.5 X1: Inputs and outputs

Feature Value

Internal device update rate Cycle time for the application parameterized in A150; tmin = 250 µs; also applicable to
digital inputs DI3 and DI4: with timestamp correction in an accuracy range of 1 µs

Max. cable length 30 m

Tab. 27: Technical data – Inputs and outputs

X1 – Analog input

Electrical data Analog input Value

Measuring range AI3 ±10 VDC

Resolution 12 bits

Internal resistance > 40 kΩ

Tab. 28: X1 electrical data – Analog input

X1 – Digital inputs and outputs

The inputs are suitable for the connection of PELV voltage in accordance with EN 60204-1.

Electrical data Digital inputs/
outputs

Value

Low level DI1 – DI4 0 – 8 VDC

High level 12 – 30 VDC

U1max 30 VDC

I1max 16 mA

f1max DI1 – DI2 10 kHz

f1max DI3 – DI4 250 kHz

I2max DO1 – DO2 100 mA

Typical voltage drop < 2 VDC

U1 24 VDC supply 18 – 28.8 VDC

Tab. 29: X1 electrical data – Digital inputs and outputs
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7.1.2.6 X22: DC link connection

X22 – DC link connection

Electrical data Device fuse SB6A06 SB6A16 SB6A26

Cmax — 405 µF 840 µF 400 µF

IN 6 A 4.8 A — —

10 A 8 A — —

20 A — 16 A —

40 A — — 32 A

50 A — — 40 A

Imax — 180% for 5 s; 150% for 30 s

UN — √2 × U1PU

Umax — 800 VDC

Tab. 30: X22 electrical data – DC link connection

Feature All sizes

Max. core/cable length 3 m, > 30 cm shielded

Tab. 31: Maximum core/cable length [m]
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7.1.2.7 Power loss data in accordance with EN 61800-9-2

Type Nominal
current

I2N,PU

Apparent
power

Absolute
losses 
PV,CU

2

Operating points3 IE class4 Comparison5

(0/25) (0/50) (0/100) (50/25) (50/50) (50/100) (90/50) (90/100)

Relative losses

[A] [kVA] [W] [%]

SB6A06 4.5 3.1 Max. 12 1.71 1.86 2.24 1.75 1.97 2.51 2.16 3.04 IE2

SB6A16 16 11.1 Max. 12 0.95 1.12 1.66 0.99 1.23 1.98 1.41 2.52 IE2

SB6A26 32 22.2 15 0.70 0.87 1.40 0.74 0.97 1.67 1.11 2.10 IE2

Absolute losses 
PV

[A] [kVA] [W] [W] [%]

SB6A06 4.5 3.1 Max. 12 52.9 57.6 69.3 54.4 61.0 77.9 67.1 94.1 IE2 39.6

SB6A16 16 11.1 Max. 12 104.9 124.0 184.6 110.3 136.6 219.8 156.0 279.8 IE2 35.8

SB6A26 32 22.2 Max. 15 154.7 192.8 311.3 164.7 214.9 370.5 246.9 465.9 IE2 38.6

Tab. 32: Power loss data of the SB6 drive controller in accordance with EN 61800-9-2

General conditions

The power loss data applies to drive controllers without accessories.

The power loss calculation is based on a 3-phase supply voltage with 400 VAC/50 Hz.

The calculated data includes a supplement of 10% in accordance with EN 61800-9-2.

The power loss specifications refer to a clock frequency of 4 kHz.

The absolute losses for a power unit that is switched off refer to the 24 VDC power supply of the control electronics.

2 Absolute losses for a power unit that is switched off
3 Operating points for relative motor stator frequency in % and relative torque current in %
4 IE class in accordance with EN 61800-9-2
5 Comparison of the losses for the reference related to IE2 in the nominal point (90, 100)
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7.1.2.8 Power loss data of accessories

If you intend to order the drive controller with accessory parts, losses increase as follows.

Type Absolute losses
PV [W]

SR6 safety module 1

SY6 or SU6 safety module 2

XB6 terminal module < 5

OP6 operating unit 1

Tab. 33: Absolute losses of the accessories

Information

Note the absolute power loss of the encoder (usually < 3 W) and of the brake when designing as well.

Loss specifications for other optional accessories can be found in the technical data of the respective accessory part.

7.1.3 Cycle times
Possible cycle times can be found in the following table.

Type Cycle times Relevant parameters

Application 250 µs, 500 µs, 1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

EtherCAT fieldbus, cyclical
communication

250 µs, 500 µs, 1 ms, 2 ms, 4 ms, 8 ms Adjustable in TwinCAT 3 or
CODESYS

PROFINET RT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms, 8 ms Adjustable in the TIA Portal

PROFINET IRT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms Adjustable in the TIA Portal

Motion core (movement calculation) 250 µs —

Control cascade 62.5 µs B24 ≥ 8 kHz and B20 = 48, 64 or 70

125 µs B24 = 4 kHz

Tab. 34: Cycle times

Information

For Lean motors (control mode B20 = 32: LM - sensorless vector control), only operation at 4 kHz is permitted.



STOBER 7 | Technical data
11

/2
02

4 
| 

ID
 4

43
34

0.
01

47

7.1.4 Derating
When dimensioning the drive controller, observe the derating of the nominal output current as a function of the clock
frequency, surrounding temperature and installation altitude. There is no restriction for a surrounding temperature from
0 °C to 45 °C and an installation altitude of 0 m to 1000 m. The details given below apply to values outside these ranges.

7.1.4.1 Effect of the clock frequency

Changing the clock frequency fPWM affects the amount of noise produced by the drive, among other things. However,
increasing the clock frequency results in increased losses. During project configuration, define the highest clock frequency
and use it to determine the nominal output current I2N,PU for dimensioning the drive controller.

Type I2N,PU

4 kHz [A]
I2N,PU

8 kHz [A]
I2N,PU

16 kHz [A]

SB6A06 4.5 3.8 2.3

SB6A16 16 12 5.7

SB6A26 32 20 12

Tab. 35: Nominal output current I2N,PU dependent on the clock frequency

Information

Select the defined clock frequency using parameter B24.

7.1.4.2 Effect of the surrounding temperature

Derating as a function of the surrounding temperature is determined as follows:

§ 0 °C to 45 °C: No restrictions (DT = 100%)

§ 45 °C to 55 °C: Derating −2.5%/K

Example

The drive controller needs to be operated at 50 °C.

The derating factor DT is calculated as follows
DT= 100% − 5 × 2.5% = 87.5%

7.1.4.3 Effect of the installation altitude

Derating as a function of the installation altitude is determined as follows:

§ 0 m to 1000 m: No restriction (DIA = 100%)

§ 1000 m to 2000 m: Derating −1.5%/100 m

Example

The drive controller needs to be installed at an altitude of 1500 m above sea level.

The derating factor DIA is calculated as follows:
DIA = 100% − 5 × 1.5% = 92.5%
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7.1.4.4 Calculating the derating

Follow these steps for the calculation:

1. Determine the highest clock frequency (fPWM) that will be used during operation and use it to determine the nominal
current I2N,PU.

2. Determine the derating factors for installation altitude and surrounding temperature.

3. Calculate the reduced nominal current I2N,PU(red) in accordance with the following formula:
I2N,PU(red) = I2N,PU × DT × DIA

Example

A drive controller of type SB6A06 needs to be operated at a clock frequency of 8 kHz at an altitude of 1500 m above sea
level and a surrounding temperature of 50 °C.

The nominal current of the SB6A06 at 8 kHz is 3.8 A. The derating factor DT is calculated as follows: 
DT = 100% − 5 × 2.5% = 87.5%

The derating factor DIA is calculated as follows: 
DIA = 100% − 5 × 1.5% = 92.5%

The output current of importance for the project configuration is: 
I2N,PU(red) = 3.8 A × 0.875 × 0.925 = 2.75 A
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7.1.5 Dimensions

B
A

W D

H4 H3 H1
H2

 

H5

Fig. 5: SB6 dimensional drawing

Dimension SB6A06 SB6A16 SB6A26

Drive controller Width W 70 105

Depth D 188 276

Body height H1 260

Fastening clip height H2 20

Height incl.
fastening clips

H3 300

Total height incl.
shield contact (terminal X20)

H4 344 362

Height incl. AES H5 360

Fastening bores (M5) Vertical distance  A 284+2

Vertical distance to the upper edge B 6

Tab. 36: SB6 dimensions [mm]

If you are using shield plate EM6 or EM 5000 instead of shield contact at terminal X20, please note the following deviating
total height H4:

Dimension SB6A06 SB6A16 SB6A26

Drive controller Total height incl.
shield plate EM6

H4 360

Total height incl.
shield plate EM 5000

H4 365

Tab. 37: Total height including shield plate EM6 or EM 5000 [mm]

Take the additional installation depth of the rear section modules into account when calculating the overall dimensions.
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7.1.6 Weight

Type Weight without packaging [g] Weight with packaging [g]

SB6A06 2500 3500

SB6A16 3700 5400

SB6A26 5000 6500

Tab. 38: SB6 weight [g]

7.2 SR6 safety module
The SR6 option adds the STO safety function to the SB6 drive controller via terminal X12.

Information

If you would like to use the STO safety function via terminals, be sure to read the manual for the SR6 safety module.

If you do not want to use the safety function, connect STOa and STOb to 24 VDC and connect GND to the reference potential,
e.g., using a connection with terminal X11.

Digital input Electrical data

STOa U1max = 30 VDC (PELV)
High level = 15 – 30 VDC

Low level = 0 – 8 VDC

I1max = 100 mA
I1N = 10 – 15 mA per channel
C1max = 10 nF

STOb

STOstatus U2 = U1 − (1.5 Ω * I1)
I2min = 1 mA

STOstatus supply U1 = +24 VDC, +20%/25% 
I1max = 100 mA

GND —

Tab. 39: X12 electrical data – Digital inputs
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7.3 Operating motors
The drive controller supports rotational motors with a number of motor poles from 2 to 120 poles (1 through 60 pole pairs),
as well as linear motors with pole pitches from 1 to 500 mm.

When selecting the motor, consider the technical data of the drive controller (output voltage range and clock frequency).

You can operate the following motors with the specified control modes.

Motor type B20 Control mode Encoders Other settings Characteristics

Lean motor 32: LM - sensorless
vector control

No encoder
required

— Dynamics, high speed
accuracy, constant speed,
overcurrent protection

Synchronous
servo motor,
torque motor

64: SSM - vector control Absolute encoder
required: EnDat
2.1/2.2 digital, SSI,
resolver, EnDat 3
or HIPERFACE DSL
encoders

Without field weakening
(B91 Field weakening =
0: Inactive)

High dynamics, high speed
accuracy, very constant
speed, high overcurrent
protection

With field weakening
(B91 Field weakening = 
1: Active)

High dynamics, high speed
accuracy, very constant
speed, high overcurrent
protection, greater speed
range, but also higher
current requirement

48: SSM-vector control
incremental encoder

Incremental
encoder required

Without field weakening
(B91 Field weakening =
0: Inactive)

High dynamics, high speed
accuracy, very constant
speed, high overcurrent
protection

With field weakening
(B91 Field weakening = 
1: Active)

High dynamics, high speed
accuracy, very constant
speed, high overcurrent
protection, greater speed
range, but also higher
current requirement

Synchronous
linear motor

70: SLM - vector control Linear encoder and
commutation
information
required

— High dynamics, high
overcurrent protection
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Motor type B20 Control mode Encoders Other settings Characteristics

Asynchronous
motor

2: ASM - vector control Encoder required — High dynamics, high speed
accuracy, very constant
speed, high overcurrent
protection

3: ASM - sensorless
vector control

No encoder
required

— Dynamics, speed accuracy,
constant speed,
overcurrent protection

1: ASM - V/f-slip
compensated

Linear characteristic
curve (B21 V/f-
characteristic = 0: Linear)

Very constant speed

Quadratic characteristic
curve (B21 V/f-
characteristic = 
1: Square)

Very constant speed,
especially suitable for fan
applications

0: ASM - V/f-control Linear characteristic
curve (B21 V/f-
characteristic = 0: Linear)

Very constant speed

Quadratic characteristic
curve (B21 V/f-
characteristic = 
1: Square)

Very constant speed,
especially suitable for fan
applications

Tab. 40: Motor types and control modes

Unsuitable drive controller/motor combinations

Lean motors of size 5 and 7 cannot be operated on drive controllers of size 0 (type SB6A06). The LM706 Lean motor also
cannot be operated on drive controllers of size 1 (type SB6A16).
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7.4 Evaluable encoders
The technical data of the evaluable encoder can be found in the following chapters.

7.4.1 Overview
The overview table explains which connections are available for the various encoders.

Encoder Connection Connection location Note

EnDat 2.1 digital X4 Base unit Not suitable for linear encoders

X140 XB6 terminal module

EnDat 2.2 digital X4 Base unit The drive controller evaluates the
information reported by the encoder and
automatically detects whether the encoder
of a rotational or linear motor is connected

X140 XB6 terminal module

SSI X4 Base unit —

X120 XB6 terminal module Evaluation and simulation, SSI motion bus

Incremental HTL X4 Base unit HTL signals, differential

X1 Base unit HTL signals, single-ended;
evaluation and simulation

Incremental TTL X4 Base unit TTL signals, differential

X120 XB6 terminal module TTL signals, differential;
evaluation and simulation

HTL pulse and direction X1 Base unit HTL signals, single-ended;
evaluation and simulation

TTL pulse and direction X120 XB6 terminal module TTL signals, differential;
evaluation and simulation

Resolvers X140 XB6 terminal module —

EnDat 2.1 sin/cos X140 XB6 terminal module —

Sin/cos X140 XB6 terminal module Sin/cos encoders with W&S are connected
to X140 directly; XB6 evaluates the analog
sin/cos signals

Hall sensor X120 XB6 terminal module For the direct connection of differential TTL
Hall sensors

EnDat 3 X4 Base unit In One Cable Solution (OCS) design

HIPERFACE DSL X4 Base unit In One Cable Solution (OCS) design

Tab. 41: Encoder connections
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7.4.2 Signal transmission
The signal levels of the encoder inputs and outputs apply to signal transmission.

7.4.2.1 Encoder inputs

The following signal levels apply to the encoder inputs for single-ended signal transmission:

Signal level HTL, single-ended

Low level 0 to 8 VDC

High level 15 to 30 VDC

Tab. 42: Signal level encoder inputs, single-ended

The following signal levels apply to the encoder inputs for differential signal transmission:

Signal level Differential HTL TTL, differential
(ANSI TIA/EIA-422)

Low level −30 to −4.2 VDC −6 to −0.2 VDC

High level 4.2 to 30 VDC 0.2 to 6 VDC

Tab. 43: Signal levels of encoder inputs, differential

7.4.2.2 Encoder outputs (simulation)

The following signal levels apply to single-ended signal transmission at encoder outputs:

Signal level HTL, single-ended

Low level 0 VDC

High level U1−2 VDC

Tab. 44: Signal level of encoder outputs, single-ended

The following signal levels apply to differential signal transmission at encoder outputs:

Signal level TTL, differential

Low level −3 VDC

High level 3 VDC

Tab. 45: Signal levels of encoder outputs, differential
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7.4.3 Drive controllers
The X4 connection is provided on the bottom of the drive controller as an encoder interface. The technical data for the
connection and other encoder terminations are described below.

7.4.3.1 X1: Encoder

Feature All sizes

Max. core/cable length 30 m

Tab. 46: Maximum core/cable length [m]

Electrical data Digital inputs/
outputs

Value

Low level DI1 – DI4 0 – 8 VDC

High level 15 – 30 VDC

U1max 30 VDC

I1max 16 mA

f1max DI1 – DI2 10 kHz

f1max DI3 – DI4 250 kHz

I2max DO1 – DO2 100 mA

Typical voltage drop < 2 VDC

U1 24 VDC supply 18 – 28.8 VDC

Tab. 47: X1 electrical data – Single-ended HTL incremental signals and single-ended HTL pulse/direction signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2048 increments per revolution: 3000 revolutions per minute (equivalent to 50 revolutions per second)
x 2048 increments per revolution = 102400 increments per second = 102.4 kHz < 250 kHz
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7.4.3.2 X4: Encoder

ATTENTION!

Risk of encoder destruction!

The drive controller provides 12 VDC for the encoder supply. Take this into account when selecting the encoder. Only
connect an encoder that is made for operation with a supply voltage of 12 VDC.

Unsuitable encoder models

The following encoder models must not be connected due to their supply voltage:

Encoder model Code according to type designation

ECI 1118 C0, C2

EQI 1130 Q0, Q2

ECI 1319 CR

EQI 1329 QP

EQI 1331 QR

Tab. 48: Encoder models with unsuitable supply voltage range

X4 – EnDat 2.1 digital encoders

Technical data EnDat 2.1 digital signals

U2 12 VDC +/−5%

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

I2min —

Encoder type Single-turn and multi-turn; not suitable for linear encoders

Clock frequency 2 MHz

Max. cable length 100 m, shielded

Tab. 49: X4 technical data – EnDat 2.1 digital signals

X4 – EnDat 2.2 digital encoders

Technical data EnDat 2.2 digital signals

U2 12 VDC +/−5%

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

Encoder type Single-turn and multi-turn

Clock frequency 4 MHz

Max. cable length 100 m, shielded

Tab. 50: X4 technical data – EnDat 2.2 digital signals
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X4 – SSI encoders with free setting

Obey the instructions on the free setting of SSI encoders (see SSI: Evaluation at X4 with free setting (H00 = 78) [} 357]).

Technical data SSI signals

U2 12 VDC +/−5%

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

Encoder type Single-turn and multi-turn

Data length Various resolutions possible

Clock frequency 150 – 1000 kHz

Sampling rate 250 µs

Monoflop time 10 – 100 µs

Code Binary or gray

Transfer Double or single

Max. cable length 100 m, shielded

Tab. 51: X4 technical data – SSI signals with free setting

X4 – Incremental encoders

Technical data Incremental signals

U2 12 VDC +/−5%

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

fmax 1 MHz

Signal level Differential HTL and differential TTL

Max. cable length 100 m, shielded

Tab. 52: X4 technical data – Incremental signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2048 increments per revolution: 3000 revolutions per minute (equivalent to 50 revolutions per second)
x 2048 increments per revolution = 102400 increments per second = 102.4 kHz << 1 MHz

X4 – EnDat 3 encoders (One Cable Solution)

Technical data EnDat 3 signals

U2 12 VDC +/−5%

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

Encoder type Single-turn and multi-turn

Max. cable length 100 m, shielded

Tab. 53: X4 technical data – EnDat 3 signals
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X4 – HIPERFACE DSL encoders (One Cable Solution)

Technical data HIPERFACE DSL signals

U2 12 VDC +/−5%

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

Encoder type Single-turn and multi-turn

Max. cable length 100 m, shielded

Tab. 54: X4 technical data – HIPERFACE DSL signals

7.4.4 Terminal module
The optional XB6 terminal module provides the following additional encoder interfaces.

7.4.4.1 X120 (XB6 option): Encoder

SSI encoder signals can be made available to several drive controllers via the dual interface of X120A and X120B without
extra wiring needed (SSI motion bus). The technical data and pin assignments of the two encoder connections are identical.
Alternatively, you can use X120A or X120B as a connection for an incremental encoder or Hall sensor.

X120 – SSI encoder with free setting (evaluation and simulation, SSI motion bus)

Obey the instructions on the free setting of SSI encoders (see SSI: Evaluation, simulation and motion bus at X120 with free
setting (H120 = 76 or 83) [} 358]).

Technical data SSI signals

U2 15 VDC +/− 10% (see encoder supply)

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

Encoder type Single-turn and multi-turn

Data length Various resolutions possible

Clock frequency 150 – 1000 kHz

Sampling rate 250 µs

Monoflop time Evaluation: 10 – 100 µs, simulation: 15 µs

Code Binary or gray

Transfer Double or single

Max. cable length 50 m, shielded

Max. number of nodes 8

Tab. 55: X120 technical data – SSI signals (free setting, evaluation and simulation, SSI motion bus)
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X120 – Incremental encoder (evaluation and simulation), pulse/direction interface (evaluation and
simulation) or Hall sensor

Technical data Incremental, pulse/direction or hall sensors

U2 15 VDC +/− 10% (see encoder supply)

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

fmax Evaluation: 1 MHz;
simulation: 500 kHz

Signal level TTL, differential

Max. cable length 50 m, shielded

Tab. 56: X120 technical data – Differential TTL incremental, pulse/direction or hall sensor signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2048 increments per revolution: 3000 revolutions per minute (equivalent to 50 revolutions per second)
x 2048 increments per revolution = 102,400 increments per second = 102.4 kHz

Encoder supply

Depending on the power consumption of the encoder, an external supply may be required, which can cause differences in
the GND connection.

U2 Bridge

Internal: Pin 8 (U2) Pin 1 (GND Enc) to pin 9 (0 V GND)

External Pin 1 (GND Enc) to 0 V GND of the external supply

Tab. 57: X120 encoder supply

7.4.4.2 X140 (XB6 option): Encoder

The X140 encoder connection is a part of the optional XB6 terminal module.

X140 – EnDat 2.1 digital encoders

Technical data EnDat 2.1 digital signals

U2 5 – 12 VDC (see encoder supply)

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

I2min 13 mA

Encoder type Single-turn and multi-turn; not suitable for linear encoders

Clock frequency 2 MHz

Max. cable length 100 m, shielded

Tab. 58: X140 technical data – EnDat 2.1 digital signals
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X140 – EnDat 2.2 digital encoders

Technical data EnDat 2.2 digital signals

U2 5 – 12 VDC (see encoder supply)

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

I2min 13 mA

Encoder type Single-turn and multi-turn

Clock frequency 4 MHz

Max. cable length 100 m, shielded

Tab. 59: X140 technical data – EnDat 2.2 digital encoder signals

X140 – Resolvers

Technical data Resolver signals

Measuring range ± 2.5 V

Resolution 16 bits

U2 ± 10 V

I2max 80 mA

f2 7 – 9 kHz

Pmax 0.8 W

Transfer ratio 0.5 ± 5%

Number of poles 2, 4, 6 and 8

Signal shape Sine

Max. cable length 100 m, shielded

Tab. 60: X140 technical data – Resolver signals

X140 – EnDat 2.1 sin/cos encoders and sin/cos encoders

Technical data EnDat 2.1 sin/cos, sin/cos signals

Measuring range ± 2.5 VDC

Resolution 14 bits

U2 5 – 12 VDC (see encoder supply)

I2max 250 mA
(sum of X4, X120, X140: 500 mA)

I2min 13 mA

Encoder type Single-turn and multi-turn

fmax analog 225 kHz

fmax digital 2 MHz

Max. cable length 100 m, shielded

Tab. 61: X140 technical data – EnDat 2.1 sin/cos, sin/cos signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2048 increments per revolution: 3000 revolutions per minute (equivalent to 50 revolutions per second)
x 2048 increments per revolution = 102,400 increments per second = 102.4 kHz
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Encoder supply

U2 Through Note

5 VDC +/− 10% at encoder Sense line of the encoder connected
at pin 12 (U2 Sense)

STOBER synchronous servo motors;
EnDat 2.1/2.2 (standard)

5 VDC +/− 10% Pin 12 (U2 Sense) bridged with pin 4
(U2)

STOBER asynchronous motors;
TTL incremental encoders (for
customer-specific solutions), without
cable compensation

11 VDC +/− 10% Pin 12 (U2 Sense) not assigned

12 VDC +/− 10% Pin 12 (U2 Sense) bridged with pin 2
(0 V GND)

Tab. 62: Encoder supply X140
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7.5 Terminal module
The XB6 option adds connections for analog and digital signals as well as additional encoder connections to the drive
controller.

Feature Value

Internal device update rate Cycle time parameterized in A150 of the application: tmin = 250 µs

Max. cable length 30 m

Tab. 63: Technical data – Inputs and outputs

X100 – Analog inputs and outputs

Electrical data Analog input/
output

Value

Measuring range AI1 – AI2 ±10 VDC

Resolution 16 bits

Internal resistance > 40 kΩ

Level AE1 as current input
(AI1+ and AI1 shunt
bridged)

±20 mA

Resolution 16 bits

Internal resistance 492 Ω

Wire break monitoring Can be parameterized in F15

Level AO1 – AO2 (short-
circuit proof)

±10 VDC, ±20 mA

Resolution 12 bits

I2max ±20 mA

Tab. 64: X100 electrical data – Analog inputs and outputs

X101 – Digital inputs and outputs

The inputs are suitable for the connection of PELV voltage in accordance with EN 60204-1.

Electrical data Digital inputs/
outputs

Value

Low level DI5 – DI12 0 – 8 VDC

High level 12 – 30 VDC

U1max 30 VDC

I1max 16 mA

I2max DO3 – DO10 50 mA

Typical voltage drop < 2 VDC

Inductive load DO3 – DO4 Max. 1.2 VA

Tab. 65: X101 electrical data – Digital inputs and outputs

X120 for encoders

X120 is available as an encoder connection. Note the technical data of the evaluable encoders at X120 
(see X120 (XB6 option): Encoder [} 58]).

X140 for encoders

X140 is available as an encoder connection. Note the technical data of the evaluable encoders at X140 
(see X140 (XB6 option): Encoder [} 59]).
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7.6 Controllable brakes
You can control the following brakes:

§ Directly connected 24 VDC brakes

§ Brakes connected indirectly over contactor

The brakes are supplied over X300.

Electrical data Brake connection

U2 24 VDC, +20%

I2max 2.5 A

f2max 1 Hz at IN ≤ 2.1 A;
0.25 Hz at IN > 2.1 A

E2max 1.83 J

Tab. 66: X5 and X8 electrical data – Brake connection

Information

In the case of a nominal brake current > 2.1 A, the controller must ensure compliance with the maximum switching
frequency of 0.25 Hz.

Information

Control modes 48: SSM-vector control incremental encoder and 70: SLM - vector control with commutation finding using
Wake and Shake may only be used in combination with a brake for axes without gravity load.

For more information, see B20 = 32, 48, 64, or 70 [} 210].

7.7 Evaluable motor temperature sensors
You can connect a PTC triplet at terminal X2 or a Pt1000 motor temperature sensor using the One Cable Solution to the SB6
drive controller.

Information

Evaluation of the temperature sensors is always active. If operation without a temperature sensor is permitted, the
connections must be bridged to X2. Otherwise a fault is triggered when the device is switched on.

Type Triggering limit

PTC thermistor 4000 Ω

Pt1000 temperature sensor Can be parameterized in °C in parameter B39

Tab. 67: Triggering limit of temperature sensor
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7.8 Braking resistor
In addition to drive controllers, STOBER offers the following braking resistors described below in various sizes and
performance classes. For the selection, note the minimum permitted braking resistors specified in the technical data of the
individual drive controller types.

7.8.1 Tubular fixed resistor FZMU, FZZMU

Type FZMU 400×65 FZZMU 400×65

ID No. 49010 55445 53895 55447

SB6A06 X — — —

SB6A16 (X) — X —

SB6A26 (—) X (X) X

Tab. 68: Assignment of FZMU, FZZMU braking resistor – SB6 drive controller

X Recommended

(X) Possible

(—) Useful under certain conditions

— Not possible

Properties

Technical data FZMU 400×65 FZZMU 400×65

ID No. 49010 55445 53895 55447

Type Tubular fixed resistor Tubular fixed resistor

Resistance [Ω] 100 ±10% 22 ±10% 47 ±10% 22 ±10%

Thermal drift ±10% ±10%

Power [W] 600 1200

Therm. time const. τth

[s]
40 40

Pulse power for < 1 s
[kW]

18 36

Umax [V] 848 848

Weight without
packaging [g]

2200 4170

Protection class IP20 IP20

Marks and test
symbols

cURus, CE, UKCA cURus, CE, UKCA

Tab. 69: FZMU, FZZMU technical data
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Dimensions

RL

1 2

U

K

O

M X

øD H

R

K

U

Fig. 6: FZMU (1), FZZMU (2) dimensional drawing

Dimension FZMU 400×65 FZZMU 400×65

ID No. 49010 55445 53895 55447

L x D 400 × 65 400 × 65

H 120 120

K 6.5 × 12 6.5 × 12

M 430 426

O 485 485

R 92 185

U 64 150

X 10 10

Tab. 70: FZMU, FZZMU dimensions [mm]
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7.8.2 GVADU, GBADU flat resistor

Type GVADU 210×20 GBADU 265×30 GBADU 335×30 GBADU 265×30

ID No. 55441 55442 55443 55444

SB6A06 X X — —

SB6A16 (X) (X) X —

SB6A26 (—) (—) (X) X

Tab. 71: Assignment of GVADU, GBADU braking resistor – SB6 drive controller

X Recommended

(X) Possible

(—) Useful under certain conditions

— Not possible

Properties

Technical data GVADU 210×20 GBADU 265×30 GBADU 335×30 GBADU 265×30

ID No. 55441 55442 55443 55444

Type 22 ±10%

Resistance [Ω] 100 ±10% 100 ±10% 47 ±10% 22 ±10%

Thermal drift ±10% ±10% ±10% ±10%

Power [W] 150 300 400 300

Therm. time const. τth [s] 60 60 60 60

Pulse power for < 1 s [kW] 3.3 6.6 8.8 6.6

Umax [V] 848 848 848 848

Cable design Radox FEP FEP FEP

Cable length [mm] 500 1500 1500 1500

Conductor cross-section [AWG] 18/19
(0.82 mm²)

14/19
(1.9 mm²)

14/19
(1.9 mm²)

14/19
(1.9 mm²)

Weight without packaging [g] 300 930 1200 930

Protection class IP54 IP54 IP54 IP54

Marks and test symbols cURus, CE, UKCA

Tab. 72: GVADU, GBADU technical data
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Dimensions

A

D
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G C

J K

H
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Fig. 7: GVADU, GBADU dimensional drawing

Dimension GVADU 210×20 GBADU 265×30 GBADU 335×30 GBADU 265×30

ID No. 55441 55442 55443 55444

 A 210 265 335 265

H 192 246 316 246

C 20 30 30 30

D 40 60 60 60

E 18.2 28.8 28.8 28.8

F 6.2 10.8 10.8 10.8

G 2 3 3 3

K 2.5 4 4 4

J 4.3 5.3 5.3 5.3

β 65° 73° 73° 73°

Tab. 73: GVADU, GBADU dimensions [mm]
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7.8.3 RB 5000 rear section braking resistor

Type RB 5022 RB 5047 RB 5100

ID No. 45618 44966 44965

SB6A06 — — X

SB6A16 — X (X)

SB6A26 X — —

Tab. 74: Assignment of RB 5000 braking resistor – SB6 drive controller

X Recommended

(X) Possible

— Not possible

Properties

Technical data RB 5022 RB 5047 RB 5100

ID No. 45618 44966 44965

Resistance [Ω] 22 ±10% 47 ±10% 100 ±10%

Thermal drift ±10% ±10% ±10%

Power [W] 100 60 60

Therm. time const. τth [s] 8 8 8

Pulse power for < 1 s [kW] 1.5 1.0 1.0

Umax [V] 800 800 800

Weight without packaging [g] 640 460 440

Cable design Radox Radox Radox

Cable length [mm] 250 250 250

Conductor cross-section [AWG] 18/19
(0.82 mm²)

18/19
(0.82 mm²)

18/19
(0.82 mm²)

Maximum torque of M5 threaded bolts [Nm] 5 5 5

Protection class IP40 IP40 IP40

Marks and test symbols cURus, CE, UKCA cURus, CE, UKCA cURus, CE, UKCA

Tab. 75: RB 5000 technical data

Dimensions

Dimension RB 5022 RB 5047 RB 5100

ID No. 45618 44966 44965

Height 300 300 300

Width 94 62 62

Depth 18 18 18

Drilling diagram corresponds to size Size 2 Size 1 Size 0 and Size 1

Tab. 76: RB 5000 dimensions [mm]
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7.9 Choke
Technical specifications for suitable chokes can be found in the following chapters.

7.9.1 TEP output choke
Output chokes are required for connecting size 0 to 2 drive controllers to synchronous servo motors or asynchronous
motors from a cable length > 50 m in order to reduce interference pulses and protect the drive system. If Lean motors are
connected, output chokes must not be used.

Information

The following technical data only applies to a rotating magnetic field frequency of 200 Hz. For example, this rotating
magnetic field frequency is achieved with a motor with 4 pole pairs and a nominal speed of 3000 rpm. Always observe the
specified derating for higher rotating magnetic field frequencies. Also observe the relationship with the clock frequency.

Properties

Technical data TEP3720-0ES41 TEP3820-0CS41 TEP4020-0RS41

ID No. 53188 53189 53190

Voltage range 3 × 0 to 480 VAC

Frequency range 0 – 200 Hz

Nominal current IN,MF at 4 kHz 4 A 17.5 A 38 A

Nominal current IN,MF at 8 kHz 3.3 A 15.2 A 30.4 A

Max. permitted motor
cable length with
output choke

100 m

Max. surrounding
temperature ϑamb,max

40 °C

Protection class IP00

Winding losses 11 W 29 W 61 W

Iron losses 25 W 16 W 33 W

Connection Screw terminal

Max. conductor cross-section 10 mm²

UL Recognized
Component (CAN; USA)

Yes

Marks and test symbols cURus, CE

Tab. 77: TEP technical data
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Dimensions

E

F

H

B1

B2

A
M1:2

A

W D

A2A1

Fig. 8: TEP dimensional drawing

Dimension TEP3720-0ES41 TEP3820-0CS41 TEP4020-0RS41

Height H [mm] Max. 150 Max. 152 Max. 172

Width W [mm] 178 178 219

Depth D [mm] 73 88 119

Vertical distance – 
A1 fastening bores [mm]

166 166 201

Vertical distance – 
A2 fastening bores [mm]

113 113 136

Horizontal distance – 
B1 fastening bores [mm]

53 68 89

Horizontal distance – 
B2 fastening bores [mm]

49 64 76

Drill holes – Depth E [mm] 5.8 5.8 7

Drill holes – Width F [mm] 11 11 13

Screw connection – M M5 M5 M6

Weight without packaging [g] 2900 5900 8800

Tab. 78: TEP dimensions and weight
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8 Project configuration
Relevant information on the project configuration and design of your drive system can be found in the following chapters.

EPLAN macros for all 6th generation drive controllers and their accessories are available in the EPLAN Data Portal for
efficient planning and support of your project configuration.

8.1 Drive controller

Minimum time between 2 energizing processes

The drive controllers have temperature-dependent resistors in the charging circuit that prevent the devices from being
damaged when being connected to the grid after a fault, such as a short-circuited DC link, incorrect wiring, etc. These
resistors are heated when charging the DC link. In order to prevent overloading, a specified, minimum time period must be
maintained between energizing two devices.

Information

For the time span between energizing two devices, note that:

▪ Direct, repeat activation of the supply voltage is possible for cyclical power-on/power-off operation.

Information

The STO safety function is available for safe stopping as an alternative to continuous, cyclical power-on/power-off
operation.

8.2 DC link connection
To optimize energy efficiency, the drive controllers can be coupled in the DC link.

Comply with the following points:

§ Only one drive controller may be fed in.

§ The line input must be protected against overload and short-circuit.

§ The DC link connections must be twisted and either routed as short as possible or shielded.

§ The technical data for terminal X22 must be observed:

• Maximum capacitance Cmax

• Nominal current IN

• Overload capacity Imax
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8.3 Motor
During the project configuration for motors, note the framework conditions described below.

Rotational motors (Lean motors, synchronous servo motors, asynchronous motors, torque motors)

The maximum possible motor speed is limited to 36000 rpm.

The following relationship applies: 
Rotating magnetic field frequency = Motor speed × Number of pole pairs ÷ 60

Since the output frequency f2PU can be a maximum of 700 Hz, the motor speed can only be reached if the calculated rotating
magnetic field frequency is less than f2PU.

Translational motors (linear motors)

The maximum possible motor velocity is limited to 20,000 m/min.

The following relationship applies: 
Field frequency = Velocity in m/min × 1000 ÷ (60 ÷ pole distance in mm)

Since the output frequency f2PU can be a maximum of 700 Hz, the motor velocity can only be reached if the calculated field
frequency is less than f2PU.

8.4 Choke
For project configuration of the chokes, note the general conditions described below.

8.4.1 TEP output choke
Select the output chokes in accordance with the nominal currents of the output chokes, motor and drive controller. In
particular, observe the derating of the output choke for rotating magnetic field frequencies higher than 200 Hz. You can
calculate the rotating magnetic field frequency for your drive with the following formula:

N N
pf n
60

´=

Derating – Effect of the clock frequency

0 100 300200 500 600 700400

1
2

f [Hz]

IN [A]
4,5

4

3,5

3

2,5

2

1,5

1

0,5

0

Fig. 9: Derating the nominal current depending on the clock frequency, TEP3720-0ES41

1 4 kHz clock frequency

2 8 kHz clock frequency
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Fig. 10: Derating the nominal current depending on the clock frequency, TEP3820-0CS41

1 4 kHz clock frequency

2 8 kHz clock frequency
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Fig. 11: Derating the nominal current depending on the clock frequency, TEP4020-0RS41

1 4 kHz clock frequency

2 8 kHz clock frequency
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Derating – Effect of surrounding temperature
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Fig. 12: Derating the nominal current based on surrounding temperature

Derating – Effect of the installation elevation
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Fig. 13: Derating the nominal current depending on installation elevation
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Fig. 14: Derating the voltage depending on installation elevation
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9 Storage
Store the products in a dry and dust-free room if you do not install them immediately.

9.1 Drive controllers
The DC link capacitors can lose their electrical strength due to long storage times and must be reformed before
commissioning.

ATTENTION!

Material damage due to reduced electrical strength!

Reduced electrical strength can cause considerable material damage when switching on the drive controller.

▪ Reform drive controllers in storage annually or before commissioning.

9.1.1 Annual reforming
To prevent damage to stored drive controllers, STOBER recommends connecting stored devices to the supply voltage once
per year for one hour.

The following graphics show the basic line connection for 3-phase devices.

X10

L1 PET1

F1

L3L2

L1 L3 PEL2

L1 – L3 Lines 1 to 3

N Neutral conductor

PE Grounding conductor

F1 Fuse

T1 Drive controller

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.
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9.1.2 Reforming before commissioning
If annual reforming is not possible, implement reforming on stored devices before commissioning. Note that the voltage
levels depend on the storage time.

The following graphic shows the predominant supply connection.

T1

T2

F1

X10

L1 PEL3L2

PEL1 L3L2

L1 – L3 Lines 1 to 3

N Neutral conductor

PE Grounding conductor

F1 Fuse

T1 Variable transformer

T2 Drive controller

0
0

25

50

75

100

U
[%]

0,5 1

1 2 3

4 86 2
t [h]

Fig. 15: Voltage levels dependent on storage time

1 Storage time of 1 – 2 years: Apply voltage for 1 hour before switching on.

2 Storage time of 2 – 3 years: Implement reforming according to the graph before switching on.

3 Storage time ≥ 3 years: Implement reforming according to the graph before switching on.

Storage time < 1 year: No actions required.

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.
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10 Installation
The following chapters describe the installation of a drive controller and the available accessories.

For information on replacing a drive controller, see Replacement [} 336].

10.1 Basic assembly instructions
Note the points described below for installation.

10.1.1 Drive controllers
Note the following points for installation:

§ Prevent condensation, e.g. with anti-condensation heating elements.

§ For reasons related to EMC, use installation plates with a conductive surface (unpainted, etc.).

§ Avoid installation above or in the immediate vicinity of heat-generating devices, e.g. output chokes or braking resistors.

§ To ensure there is sufficient air circulation in the control cabinet, observe the minimum clearances.

§ Install the devices vertically.

Reference code

Attach a sticker to the front on the device with the unique reference code of the drive controller to prevent mix-ups during
installation or replacement.
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10.1.2 Braking resistor
Note the permitted mounting positions for the braking resistor.

FZMU, FZZMU tubular fixed resistor

Permitted installation:

§ On vertical surfaces with terminals downwards

§ On horizontal surfaces

§ In control cabinets

Impermissible installation:

§ On vertical surfaces with terminals upwards, left or right

§ Outside of control cabinets

GVADU, GBADU flat resistor

Permitted installation:

§ On vertical surfaces with cables downwards

§ On horizontal surfaces

§ Installation outside of the control cabinet possible for mechanical protection of
the conductors

Impermissible installation:

§ On vertical surfaces with cables upwards

10.1.3 Choke
In relation to the flow of cooling air, the following mounting positions are permitted for the TEP output choke:

CA B
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10.2 Minimum clearances
Note the minimum clearances for installation below.

Drive controller

CC

  

A
B

D18

Fig. 16: Minimum clearances

Take into account the additional installation depth of 18 mm for the optional RB 5000 rear section braking resistor.

The dimensions specified in the table relate to the outer edges of the drive controller.

Minimum clearance A (above) B (below) C (on the side) D (in front)

All sizes 100 200 5 506

Tab. 79: Minimum clearances [mm]

Chokes and filters

Avoid installation below drive controllers or supply modules. For installation in a control cabinet, a distance of
approximately 100 mm to other neighboring components is recommended. This distance ensures proper heat dissipation
for chokes and filters.

Braking resistors

Avoid installation below drive controllers or supply modules. In order for heated air to flow out unimpeded, a minimum
clearance of approximately 200 mm must be maintained in relation to neighboring components or walls and approximately
300 mm must be maintained to components above or ceilings.

6 Minimum clearance to be taken into account for permanent connection of the X9 service interface
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10.3 Drilling diagrams and bore dimensions
Drilling diagrams and dimensions can be found in the following chapters.

10.3.1 Drive controller

A/2

C

B

A/2

Fig. 17: SB6 drilling diagram

Dimension SB6A06, SB6A16 SB6A26

Horizontal fastening bores
∅ 4.2 (M5)

 A 70 105

B Size 0,
size 1

70±1 87.5±1

B Size 2 87.5±1 105±1

Vertical fastening bores
∅ 4.2 (M5)

C 285+2 285+2

Tab. 80: Drilling dimensions for SB6 drive controller [mm]
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10.3.2 Braking resistor

10.3.2.1 FZMU, FZZMU tubular fixed resistor

U

M

K

Fig. 18: FZMU, FZZMU drilling diagram

Dimension FZMU 400×65 FZZMU 400×65

K 6.5 × 12 6.5 × 12

M 430 426

U 64 150

Tab. 81: FZMU, FZZMU drilling dimensions [mm]

10.3.2.2 GVADU, GBADU flat resistor

H

K

J K

Fig. 19: GVADU, GBADU drilling diagram

Dimension GVADU 210×20 GBADU 265×30 GBADU 335×30

H 192 246 316

K 2.5 4 4

J 4.3 5.3 5.3

Tab. 82: GVADU, GBADU drilling dimensions [mm]

10.3.2.3 RB 5000 rear section braking resistor

Information

Note the dimensional data in the drilling diagram of the drive controller (see Drive controller [} 80]) for the installation of a
drive controller with rear section braking resistor.
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10.3.3 Choke

10.3.3.1 TEP output choke

A1A2

B1

B2

M

Fig. 20: TEP drilling diagram

Dimension TEP3720-0ES41 TEP3820-0CS41 TEP4020-0RS41

Vertical distance – 
A1 fastening bores [mm]

166 166 201

Vertical distance – 
A2 fastening bores [mm]

113 113 136

Horizontal distance – 
B1 fastening bores [mm]

53 68 89

Horizontal distance – 
B2 fastening bores [mm]

49 64 76

Drill holes – Depth E [mm] 5.8 5.8 7

Drill holes – Width F [mm] 11 11 13

Screw connection – M M5 M5 M6

Tab. 83: TEP drilling dimensions
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10.4 Installing the drive controller without a rear section
module

This chapter describes the installation of the SB6 drive controller without a rear section module.

If you use rear section braking resistors, you must first install them and then build the appropriate drive controllers over
them.

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Information

Note that drive controllers in storage require reforming each year or before commissioning at the latest.

Tools and material

You will need:

§ Fastening screws

§ Tool for tightening the fastening screws

Requirements and installation

Perform the following steps for each drive controller within the group and in the specified order.

ü In accordance with the drilling diagram, taking into consideration the various device dimensions, you have made
threaded holes for the threaded bolts on the mounting plate at the mounting position.

ü The mounting plate has been cleaned (free of oil, grease and swarf).

1. Fasten the top of the drive controller on the mounting plate.

2. Fasten the bottom of the drive controller on the mounting plate.

3. Connect the grounding conductor to the ground bolt. Obey the instructions and requirements for Protective
grounding [} 93].

ð The installation is completed. In the next step, connect the drive controller.
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10.5 Installing a rear section braking resistor
If you employ the RB 5000 rear section braking resistor provided for drive controllers of sizes 0 to 2, you must mount it first
and then build over with the appropriate drive controller.

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Tools and material

You will need:

§ The M5 threaded bolts included with the rear section braking resistor and the accompanying screw and washer
assemblies (screws with flat and spring washers)

§ An 8 mm hexagonal socket wrench

Requirements and installation

ü In accordance with the drilling diagram, taking into consideration the various device dimensions, you have made
threaded holes for the threaded bolts on the mounting plate at the mounting position.

ü The mounting plate has been cleaned (free of oil, grease and swarf).

1. Fasten the rear section braking resistor to the mounting plate using the threaded bolts.

ð You have installed the rear section braking resistor. In the next step, build over it with the appropriate drive controller.
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10.6 Mounting the drive controller on the rear section module

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Information

Note that drive controllers in storage require reforming each year or before commissioning at the latest.

Tools and material

You will need:

§ A suitable terminal set for each drive controller

§ A PH2 Phillips screwdriver

Requirements and installation

Perform the following steps for each drive controller within the group.

ü There is a circuit diagram of the system that describes the connection of the drive controllers.

ü For each drive controller, the RB 5000 rear section modules have already been installed in the installation position.

1. Remove terminal X21 from the appropriate terminal set. Connect the two cores of the braking resistor to pin 1 and pin
2 of terminal X21. Ensure that the cores of the braking resistor are twisted pairs.
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2. Position the drive controller on the guides of the rear section module.

3. Press the drive controller downward onto the guides.

4. Optional: Mount the EMC shield plate.

5. Attach the drive controller to the threaded bolts using the screw and washer assemblies.
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6. Connect the grounding conductor to the ground bolt. Obey the instructions and requirements for Protective
grounding [} 93].

7. Attach terminal X21 on the underside of the drive controller.

ð The installation is completed. In the next step, connect the drive controller.
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11 Connection
The following chapter describes the connection of the drive controller and the available accessories.

11.1 Line routing
Observe the valid provisions for your machine or system, e.g. IEC 60364 or EN 50110, during the installation of electrical
equipment.

11.2 Protective measures
Take the following protective measures into account.

11.2.1 Power supply with DC link connection

ATTENTION!

Device damage due to the emission of electromagnetic interference!

If the EMC threshold limits are exceeded, devices in the immediate area can be interrupted or damaged.

▪ Take suitable measures to comply with the electromagnetic compatibility.

▪ Twist intermediate circuit connections and connections to braking resistors and always route the shortest possible
connections. If they are longer than 30 cm, they must be shielded.

ATTENTION!

Device damage in the event of failure of a device in the DC link group!

The failure of a drive controller or supply module in the DC link group can result in damage to additional devices.

▪ A failure must trigger the isolation of the entire DC link group from the grid.

▪ For the most comprehensive equipment protection possible, follow the recommendations for device protection.
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11.2.2 Line fuse
All device types are intended exclusively for operation on TN networks or wye sources that supply a maximum differential
short-circuit current in accordance with the following table.

For UL-compliant operation:
All device types supplied with 480 VAC are intended solely for operation with grounded wye sources at 480/277 VAC.
For all device types – with 240 VAC or 480 VAC supply – the supply grid must not deliver a differential short-circuit current
above the specification in the following table.

Size of the drive controller Max. differential short-circuit current

Size 0 – size 2 5000 A

Tab. 84: Short-circuit current rating (SCCR)

The line fuse ensures the line and overload protection in the drive controller. To that end, observe the requirements
described below, which vary based on the configuration.

11.2.2.1 Line fuses in stand-alone operation

You can use the following protective devices when operating a single drive controller:

§ Full-range safety fuses for cable and line protection with operating class gG in accordance with IEC 60269-2-1 or time
delay triggering characteristics in accordance with DIN VDE 0636

§ Miniature circuit breakers with triggering characteristic C in accordance with EN 60898

§ Circuit breakers

Information on the recommended maximum line fuse can be found in the following table:

Size Type I1N,PU (4 kHz) [A] Recommended max. line fuse [A]

0 SB6A06 5.4 10

1 SB6A16 19.2 20

2 SB6A26 38.4 50

Tab. 85: Line fuses in stand-alone operation

Information

To ensure problem-free operation, always comply with the recommended trigger limits and trigger characteristics of the
fuse elements.
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11.2.2.2 Line fuses for DC link connection

Every drive controller connected to the grid in the DC link group must be protected at the line input against overload and
short-circuit. To do this, a fuse combination consisting of overload protection and semiconductor short-circuit protection is
connected in series. A miniature circuit breaker protects against overload and a safety fuse with gR triggering characteristics
protects against short-circuit.

You can use the following fuse combinations:

Size Type I1N,PU

(4 kHz)
[A]

Fuse selection

Miniature circuit breakers Safety fuse

0 SB6A06 5.4 EATON
Type: FAZ-B6/3,

Manufacturer No. 278841
Triggering characteristics:

B 6 A

SIBA
Type: URZ,

Item No. 50 140 06.20
Triggering characteristics:

gR 20 A

1 SB6A16 19.2 EATON
Type: FAZ-Z20/3,

Manufacturer No. 278928
Triggering characteristics:

Z 20 A

SIBA
Type: URZ,

Item No. 50 140 06.32
Triggering characteristics:

gR 32 A

2 SB6A26 38.4 EATON
Type: FAZ-Z40/3,

Manufacturer No. 278931
Triggering characteristics:

Z 40 A

SIBA
Type: URZ,

Item No. 50 140 06.80
Triggering characteristics:

gR 80 A

Tab. 86: Line fuses for DC link connection

Information

To ensure problem-free operation, always comply with the recommended trigger limits and trigger characteristics of the
fuse elements.
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11.2.2.3 UL-compliant line fuses

For UL compliance, use one of the following protection measures:

§ Class CC, CF, J, T, G or RK1 safety fuses

§ Circuit breakers

More detailed specifications about the appropriate fuses can be found in the following table:

Size Type Safety fuse Circuit breakers

IN [A] UN [VAC]

0 SB6A06 15 600 EATON
FAZ-B15/3-NA

Manufacturer No. 132721

1 SB6A16 25 600 EATON
FAZ-B25/3-NA

Manufacturer No. 132726

2 SB6A26 50 600 EATON
FAZ-B50/3-NA

Manufacturer No. 190787

Tab. 87: UL-compliant line fuses

Information

To ensure problem-free operation, always comply with the recommended trigger limits and trigger characteristics of the
fuse elements.
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11.2.3 Residual current protective device
Depending on the function, leakage currents may occur when operating drive controllers. Leakage currents are interpreted
as residual currents by residual current protective devices (RCDs) and may therefore lead to false triggering. Depending on
the relevant power supply connections, residual currents may occur with or without a DC current component. Because of
this, you should take into consideration both the magnitude as well as the profile of the possible leakage or residual current
when selecting a suitable residual current protective device.

Leakage and residual currents with a DC current component can restrict the functionality of type A and AC residual current
protective devices.

Protect 1-phase installations using type B universal current-sensitive residual current protective devices or type F mixed
frequency-sensitive devices.

Protect 3-phase installations with type B universal current-sensitive residual current protective devices.

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

In 3-phase installations, this product can cause a direct current in the protective grounding conductor.

▪ If a residual current protective device (RCD) or residual current monitoring device (RCM) is used for protection in case
of direct or indirect contact, only one RCD or RCM of type B is permitted on the power supply side of this product.

False triggering – Causes

Depending on stray capacitances and imbalances, leakage currents above 30 mA may occur during operation.

Undesirable false triggering occurs under the following conditions:

§ Connecting the installation to the supply voltage:
This false triggering can be remedied by using short-time delayed (super-resistant), delayed switch-off (selective)
residual current protective devices or those with increased tripping current (e.g. 300 or 500 mA).

§ Higher frequency leakage currents for long power cables under normal operating conditions:
For example, use low-capacitance cables or use an output choke.

§ High imbalances in the supply grid.
This false triggering can be rectified, e.g. using an isolating transformer.

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

Residual current protective devices with increased tripping current as well as with short-time delayed or delayed switch-off
trigger characteristics may not meet the requirements for personal protection.

▪ Check whether the use of the selected residual current protective device is permitted in your application.
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11.2.4 Protective grounding
In order to dimension the grounding, it must be ensured that the upstream fuse is triggered in the event of a short-circuit.
Observe the requirements described below for the correct connection of the protective grounding.

11.2.4.1 Minimum cross-section of the grounding conductor

Leakage currents > 10 mA can arise in normal operation. The minimum cross-section of the protective grounding conductor
must comply with the local safety regulations for protective grounding conductors with high leakage current. To fulfill
regulations such as EN 60204-1, connect a copper conductor according to the following table:

Cross-section A
Power grid line

Minimum cross-section Amin

Grounding conductor

A ≤ 2.5 mm² 2.5 mm²

2.5 mm² < A ≤ 16 mm² A

16 mm² < A ≤ 35 mm² ≥ 16 mm²

> 35 mm² A/2

Tab. 88: Minimum cross-section of the grounding conductor

11.2.4.2 Cable shields and sheaths

In accordance with EN 60204-1, the following parts of a machine and its electrical equipment must be connected to the
grounding conductor system, but must not be used as grounding conductors:

§ Metal cable shields

§ Sheath
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11.2.4.3 Connection of the grounding conductor

You connect the grounding conductor to the drive controller over terminal X10.

Additional requirements for protective equipotential bonding apply in the event of ground leakage currents > 10 mA. At
least one of the following conditions must be fulfilled:

§ The grounding conductor must have a minimum cross-section of 10 mm² Cu over its overall length

§ If the grounding conductor has a cross-section of less than 10 mm², a 2nd grounding conductor must be provided with
a cross-section of at least the same size, as at terminal X10, up to the point at which the grounding conductor exhibits
the minimum cross-section of 10 mm²

A ground bolt is mounted to the devices for connecting the 2nd grounding conductor. The ground bolt is marked with the
grounding symbol according to IEC 60417 (symbol 5019).

You will need an open-ended wrench or external hex key with a width across flats of 10 mm.

Obey a tightening torque of 4.0 Nm (35 Lb.inch).

Observe the order for assembly:

1

4

5

2
3

Fig. 21: Connection of the grounding conductor

1 M6 ground bolt

2 Contact disk

3 Cable lug

4 Washer

5 Nut

The contact disk, washer and nut are supplied with the drive controller.
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11.2.4.4 UL-compliant connection of the grounding conductor

Note that UL-compliant operation requires just a single grounding conductor.

The grounding at terminal X10 of the SB6 drive controller must not be used for protective grounding. The housing for the
drive controllers must be connected to the protective grounding using the M6 ground bolt (4.0 Nm, 35 Lb.inch).

The connection for the protective grounding on the housing is identified by the grounding symbol in accordance with 
IEC 60417 (symbol 5019).

You will need an open-ended wrench or external hex key with a width across flats of 10 mm.

Observe the order for assembly:

1

4

5

2
3

Fig. 22: Connection of the grounding conductor

1 M6 ground bolt

2 Contact disk

3 Cable lug

4 Washer

5 Nut

The contact disk, washer and nut are supplied with the drive controller.
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11.2.5 EMC recommendations

Information

The following information on EMC-compliant installation is only a recommendation. Depending on the application, the
ambient conditions as well as the legal requirements, measures beyond these recommendations may be required.

Lay the power line, power cable and signal lines separately from each other, e.g. in separate cable ducts.

Only use shielded, low-capacitance cables as power cables.

If the brake line is carried in the power cable, it must be shielded separately.

Ground and insulate free line ends if they cannot be connected to the terminals provided for this purpose on the drive
controller, e.g. using a connecting terminal.

Connect the shield of the power cable to the grounding conductor system over a wide area and in the immediate vicinity of
the drive controller. For this purpose, use the shield contact provided for the drive controllers or suitable accessories.

The connection lines for braking resistors as well as the cores of the Quick DC-Link modules must be implemented as
twisted pairs. At line lengths of 30 cm or more, the lines also must be implemented with shielding and the shield must be
applied over a wide area in the immediate vicinity of the drive controller.

For motors with terminal boxes, connect the shield to the terminal box over large contact areas. For example, use EMC
cable glands.

Connect the shield of the control lines on one side to the reference potential of the source, e.g. the PLC or CNC.

You may use chokes to improve the EMC and protect the drive system. Output chokes reduce current peaks caused by line
capacity at the power output of the drive controller.

ATTENTION!

Material damage due to incorrect or uncontrolled movement!

When connecting Lean motors in combination with an output choke, a successful position and speed determination is not
ensured. This can lead to an incorrect or uncontrolled movement right from the start.

▪ If Lean motors are connected, output chokes must not be used.
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11.3 Drive controllers
The following section contains detailed information about the terminals and the correct connection of the drive controller.

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.

11.3.1 Overview

4 X101

20

13
14
15
16
17
18
19

11
12

10

3
4
5
6
7
8
9

1
2

8 X1007
8

5
6

3
4

1
2

3
4

+
-X7

5
6X5

X21 RB
RB

PE
W
V
U

14

19

20

13

X22

X20

7

9

X201

X200

5X1

1
2
3
4
5
6
7
8
9

10

-
+

-
+ 3X11

PE
L3
L2
L1

2X10

1

X8 11

7
8X2

12 X4

16

D+
D+
D-
D-

21 

17 X120A

8
7
6
5
4
3
2
1

6 X12

15 X140

B A

18 X120B

S1 10

Fig. 23: SB6 connection overview, top and bottom of device

Top of the device Bottom of the device

1 Ground bolt 10 S1 operating button

2 X10: 400 VAC supply 11 X8: Brake (in preparation) or DO

3 X11: 24 VDC supply 12 X4: Encoder

4 X101: DI5 – DI12, DO3 – DO10 (only with XB6
option)

13 X7: 24 VDC supply for brakes

5 X1: AI3, DI1 – DI4, DO1 – DO2 14 X5: Brake or DO

6 X12: STO via terminals (only for SR6 option) 15 X140: Encoder (only with XB6 option)

7 X201: EtherCAT Out / PROFINET 16 X2: Temperature sensor

8 X100: AI1 – AI2, AO1 – AO2 (only with XB6
option)

17 X120A: Encoder (only with XB6 option)

9 X200: EtherCAT In / PROFINET 18 X120B: Encoder (only with XB6 option)

19 X20: Motor

20 X22: DC link connection

21 X21: Braking resistor
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25X9

24

23

22

X700 26

1

Fig. 24: SB6 connection overview, front of device

Front of the device

1 Ground bolt

22 Display (only with OP6 option)

23 Keys (only with OP6 option)

24 5 diagnostic LEDs

25 X9: Ethernet service interface

26 X700: SD slot
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11.3.2 X1: Inputs and outputs

X1 for analog or digital signals

For the evaluation of analog or digital signals at X1, obey the technical data of the drive controller 
(see X1: Inputs and outputs [} 43]).

Connection

Terminal Pin Designation Role

10 | 9 | 8 | ... | 3 | 2 | 1

1 AI3 + AI3+ input

2 AI3 − AI3− input

3 0 V DGND Reference potential for digital inputs and outputs as
well as 24 VDC supply

4 +24 VDC External 24 VDC supply; recommended fuse
protection: max. 1 AT7

5 DI1 Digital inputs

6 DI2

7 DI3

8 DI4

9 DO1 Digital outputs

10 DO2

Tab. 89: X1 connection description for analog and digital signals

For the connecting wiring, obey the terminal specification FMC 1,5 -ST-3,5 [} 351].

Feature All sizes

Max. core/cable length 30 m

Tab. 90: Maximum core/cable length [m]

7 For the fuse protection, use a 1 A fuse (time delay). For UL-compliant use, be sure that the fuse meets certification require-
ments for DC voltage in accordance with UL 248.
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X1 for encoders

If you would like to use X1 as an encoder connection, obey the technical data of the evaluable encoders at X1 
(see X1: Encoder [} 55]).

Single-ended HTL incremental encoders

Terminal Pin Designation Role

1 | 2 | 3 | ... | 8 | 9 | 10

1 AI3 + —

2 AI3 − —

3 0 V DGND Reference potential for digital outputs

4 +24 VDC External 24 VDC supply; recommended fuse
protection: max. 1 AT8

5 DI1 —

6 DI2 Evaluation: N track

7 DI3 Evaluation: A track

8 DI4 Evaluation: B track

9 DO1 Simulation: A track

10 DO2 Simulation: B track

Tab. 91: X1 connection description for single-ended HTL incremental signals

Single-ended HTL pulse/direction interface

Terminal Pin Designation Role

1 | 2 | 3 | ... | 8 | 9 | 10

1 AI3 + —

2 AI3 − —

3 0 V DGND Reference potential for digital outputs

4 +24 VDC External 24 VDC supply; recommended fuse
protection: max. 1 AT9

5 DI1 —

6 DI2 —

7 DI3 Evaluation: Pulse

8 DI4 Evaluation: Direction

9 DO1 Simulation: Pulse

10 DO2 Simulation: Direction

Tab. 92: X1 connection description for single-ended HTL pulse/direction signals

8 For the fuse protection, use a 1 A fuse (time delay). For UL-compliant use, be sure that the fuse meets certification require-
ments for DC voltage in accordance with UL 248.
9 For the fuse protection, use a 1 A fuse (time delay). For UL-compliant use, be sure that the fuse meets certification require-
ments for DC voltage in accordance with UL 248.
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11.3.3 X2: Motor temperature sensor
The motor temperature sensor is connected to terminal X2. All device types of the SB6 drive controller have connections for
PTC thermistors.

Information

Evaluation of the temperature sensor is always active. If operation without a temperature sensor is permitted, the
connections must be bridged to X2. Otherwise a fault is triggered when the device is switched on.

Information

Note that a temperature sensor does not have to be connected to terminal X2 for EnDat 3 or HIPERFACE DSL encoders. In
this case, the temperature sensor signal is transferred together with the encoder signal over connector X4.

Connection

Pin Designation Role

 
7 | 8

7 1TP1 PTC connection

8 1TP2

Tab. 93: X2 connection description, motor temperature sensor

For the connecting wiring, obey the terminal specification BLF 5.08HC 180 SN [} 349].

Feature All sizes

Max. cable length 100 m, shielded

Tab. 94: Maximum cable length [m]
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11.3.4 X4: Encoder
The encoders described below can be connected to X4.

ATTENTION!

Risk of encoder destruction!

Only encoders with a suitable input voltage range (minimum 12 VDC) may be connected to X4.

Unsuitable encoder models

The following encoder models must not be connected due to their supply voltage:

Encoder model Code according to type designation

ECI 1118 C0, C2

EQI 1130 Q0, Q2

ECI 1319 CR

EQI 1329 QP

EQI 1331 QR

Tab. 95: Encoder models with unsuitable supply voltage range

ATTENTION!

Risk of encoder destruction!

X4 may not be plugged in or unplugged when the device is switched on!

Technical data

Note the technical data of the evaluable encoders at X4 (see Evaluable encoders [} 53]).
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Connection

EnDat 2.1/2.2 digital encoders and SSI encoders

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 0 V GND Reference potential for encoder supply to pin 4

3 — —

4 U2 Encoder supply

5 Data + Differential input for DATA

6 — —

7 — —

8 Clock + Differential input for CLOCK

9 — —

10 — —

11 — —

12 — —

13 Data − Inverse differential input for DATA

14 — —

15 Clock − Inverse differential input for CLOCK

Tab. 96: X4 connection description for EnDat 2.1/2.2 digital encoders and SSI encoders

Differential HTL incremental encoders

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 B + Differential input for B track

2 0 V GND Reference potential for encoder supply to pin 4

3 N + Differential input for N track

4 U2 Encoder supply

5 — —

6 A + Differential input for A track

7 — —

8 — —

9 B − Inverse differential input for B track

10 N − Inverse differential input for N track

11 A − Inverse differential input for A track

12 — —

13 — —

14 — —

15 — —

Tab. 97: X4 connection description for differential HTL incremental encoders
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Differential TTL incremental encoders

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 0 V GND Reference potential for encoder supply to pin 4

3 — —

4 U2 Encoder supply

5 B + Differential input for B track

6 — —

7 N + Differential input for N track

8 A + Differential input for A track

9 — —

10 — —

11 — —

12 — —

13 B − Inverse differential input for B track

14 N − Inverse differential input for N track

15 A − Inverse differential input for A track

Tab. 98: X4 connection description for differential TTL incremental encoders

EnDat 3 and HIPERFACE DSL encoders

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 P_D − Inverse EnDat 3 or HIPERFACE DSL signal (motor
temperature sensor evaluation over EnDat or DSL
communication)

3 — —

4 P_D + EnDat 3 or HIPERFACE DSL signal (motor temperature
sensor evaluation over EnDat or DSL communication)

5 — —

6 — —

7 — —

8 — —

9 — —

10 — —

11 — —

12 — —

13 — —

14 — —

15 — —

Tab. 99: X4 connection description for EnDat 3 and HIPERFACE DSL encoders
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Cable requirements

Feature All sizes

Max. cable length 100 m, shielded

Tab. 100: Maximum cable length [m]

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

11.3.5 X5: Brake or digital output
All device types of the SB6 drive controller can control 24 VDC brakes as standard.

Alternatively, you can use X5 as a digital output (see Brake connection as digital output [} 219]).

Information

You can deactivate brake monitoring for cable breaks and undervoltage in parameter F105.

Technical data

Note the technical data of the brakes controllable at X5 (see Controllable brakes).

Connection

Pin Designation Role

5 | 6

5 1BD1 Brake control or use as digital output

6 1BD2 Reference potential

Tab. 101: X5 connection description, brake or digital output

For the connecting wiring, obey the terminal specification BLF 5.08HC 180 SN [} 349].

Feature Use All sizes

Max. core/cable length Direct brake control 100 m, shielded

Indirect brake control or digital output 3 m

Tab. 102: Maximum core/cable length [m]
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11.3.6 X7: Brake(s) – Supply
X7 is used to supply the brake(s).

Technical data

Electrical data All types

U1 24 VDC, +20%

I1max 5 A

Tab. 103: X7 electrical data – Brake supply

Connection

Pin Designation Role

 
1 | 2

1 + 24 VDC supply for brakes at X5 and X8; recommended
fuse protection: max. 10 AT10

2 − Reference potential for supply voltage of the brakes

Tab. 104: X7 connection description

For the connecting wiring, obey the terminal specification BLF 5.08HC 180 SN [} 349].

Feature All sizes

Max. core/cable length 30 m

Tab. 105: Maximum core/cable length [m]

11.3.7 X8: Brake (in preparation) or digital output
You can use X8 as a digital output (see Brake connection as digital output [} 219]).

Connection

Pin Designation Role

 
3 | 4

3 DO Digital output

4 GND Reference potential

Tab. 106: X8 connection description, digital output

For the connecting wiring, obey the terminal specification BLF 5.08HC 180 SN [} 349].

Feature Use All sizes

Max. cable length Digital output 3 m

Tab. 107: Maximum cable length [m]

10 For UL-compliance, use a 10 A fuse (time delay). Note that the fuse meets certification requirements for the relevant DC
voltage in accordance with UL 248.
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11.3.8 X9: Ethernet service interface
X9 is used to connect the drive controller to a PC with DriveControlSuite commissioning software installed.

Connection

Socket Pin Designation Function

1|2|3|4|5|6|7|8 1 TxData+ Ethernet communication

2 TxData−

3 RecvData+

4 ─ ─

5 ─ ─

6 RecvData− Ethernet communication

7 ─ ─

8 ─ ─

Tab. 108: X9 connection description

Cable requirements

Feature All sizes

Max. cable length 100 m, shielded

Tab. 109: Maximum cable length [m]

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

It is also possible to use cables with the following specification:

Feature Design

Connector wiring Patch or crossover

Quality CAT 5e

Shielding SF/FTP, S/FTP or SF/UTP

Tab. 110: Cable requirements

Device addressing

For information on device addressing, see Device addressing [} 361].
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11.3.9 X10: 400 V supply
Terminal X10 serves to connect the drive controller to the supply grid.

Conductor cross-sections for the power connection

When selecting the conductor cross-section, note the line fuse, the maximum permitted conductor cross-section of
terminal X10, the routing method and the surrounding temperature.

UL-compliant operation

The grounding at terminal X10 of the SB6 drive controller must not be used for protective grounding. The housing for the
drive controllers must be connected to the protective grounding using the M6 ground bolt (4.0 Nm, 35 Lb.inch).

Connection

Size 0

Terminal Pin Designation Role

 
1 | 2 | 3 | 4

1 L1 Power supply

2 L2

3 L3

4 PE Grounding conductor

Tab. 111: X10 connection description, size 0

For the connecting wiring, obey the terminal specification GFKC 2,5 -ST-7,62 [} 352].

Size 1

Terminal Pin Designation Role

 
1 | 2 | 3 | 4

1 L1 Power supply

2 L2

3 L3

4 PE Grounding conductor

Tab. 112: X10 connection description, size 1

For the connecting wiring, obey the terminal specification SPC 5 -ST-7,62 [} 354].

Size 2

Terminal Pin Designation Role

 
1 | 2 | 3 | 4

1 L1 Power supply

2 L2

3 L3

4 PE Grounding conductor

Tab. 113: X10 connection description, size 2

For the connecting wiring, obey the terminal specification SPC 16 -ST-10,16 [} 354].
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11.3.10 X11: 24 V supply – Control unit
The connection of 24 VDC to X11 is required for the power supply of the control unit.

ATTENTION!

Device damage due to overload!

If the 24 VDC power supply is looped to multiple devices over the terminal, the terminal may be damaged by a current that is
too high.

▪ Make sure that the current over the terminal does not exceed the value 15 A (UL: 10 A).

Technical data

Electrical data All types

U1CU 24 VDC, +20%/−15%

I1maxCU 1.5 A

Tab. 114: Control unit electrical data

Connection

Information

The device may not be connected to a DC supply grid. Instead, supply it over a local 24 VDC power supply unit.

Pin Designation Role

1 | 3

2 | 4

1 + 24 VDC supply for the control unit; bridged in the
terminal; design in accordance with EN 60204: PELV,
secondary grounded, recommended fuse protection:
max. 15 AT11

2

3 − Reference potential for +24 VDC, bridged in the
terminal4

Tab. 115: X11 connection description

For the connecting wiring, obey the terminal specification BLDF 5.08 180 SN [} 350].

Feature All sizes

Max. core/cable length 30 m

Tab. 116: Maximum core/cable length [m]

11 For UL-compliance, use a 10 A fuse (time delay). Make sure that the fuse meets certification requirements for DC voltage
in accordance with UL 248.
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11.3.11 X12 (SR6 option): Safety technology
The SR6 option adds the STO safety function to the SB6 drive controller via terminal X12.

Information

If you would like to use the STO safety function via terminals, be sure to read the manual for the SR6 safety module.

If you do not want to use the safety function, connect STOa and STOb to 24 VDC and connect GND to the reference potential,
e.g., using a connection with terminal X11.

Technical data

Obey the technical data of the safety options at X12 (see SR6 safety module [} 50]).

Connection

Terminal Pin Designation Role

 
1|2|3|4|5|6|7|8

1 STOa Input of safety channel 1

2

3 STOb Input of safety channel 2

4

5 0 V GND Reference potential for STOa and
STOb, internally bridged with pin 7

6 STOstatus Feedback signal of safety channels
1 and 2 for diagnostic purposes

7 0 V GND Reference potential for STOa and
STOb, internally bridged with pin 5

8 U1status STOstatus supply; recommended fuse
protection: max. 3.15 AT12

Tab. 117: X12 connection description

For the connecting wiring, obey the terminal specification BCF 3,81 180 SN [} 349].

Feature All sizes

Max. core/cable length 30 m

Tab. 118: Maximum core/cable length [m]

12 For UL-compliance, use a 3.15 A fuse (time delay). The fuse must be certified for DC voltage in accordance with UL 248.
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11.3.12 X20: Motor
The motor is connected to X20.

Connection

Size 0

Terminal Pin Designation Role

1 | 2 | 3 | 4

1 U Motor phase U connection

2 V Motor phase V connection

3 W Motor phase W connection

4 PE Grounding conductor

Tab. 119: X20 connection description, size 0

For the connecting wiring, obey the terminal specification GFKC 2,5 -ST-7,62 [} 352].

Size 1

Terminal Pin Designation Role

1 | 2 | 3 | 4

1 U Motor phase U connection

2 V Motor phase V connection

3 W Motor phase W connection

4 PE Grounding conductor

Tab. 120: X20 connection description, size 1

For the connecting wiring, obey the terminal specification SPC 5 -ST-7,62 [} 354].

Size 2

Terminal Pin Designation Role

1 | 2 | 3 | 4

1 U Motor phase U connection

2 V Motor phase V connection

3 W Motor phase W connection

4 PE Grounding conductor

Tab. 121: X20 connection description, size 2

For the connecting wiring, obey the terminal specification SPC 16 -ST-10,16 [} 354].

Cable requirements

Motor type Connection Size 0 to 2

Synchronous servo motor,
asynchronous motor

Without output choke 50 m, shielded

Synchronous servo motor,
asynchronous motor

With output choke 100 m, shielded

Lean motor Without output choke 50 m, shieldeda)

Tab. 122: Maximum cable length of the power cable [m]



11 | Connection STOBER

112

11
/2

02
4 

| 
ID

 4
43

34
0.

01

The use of cables with a length greater than 50 m and up to maximum 100 m must be checked by STOBER for the
application.

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

Shielded connection of the power cable

Note the following points for the connection of the power cable:

§ Ground the shield of the power cable on the shield contact on the drive controller intended for this.

§ Keep the exposed conductors as short as possible. All devices and circuits that are sensitive to EMC must be kept at a
distance of at least 0.3 m.
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11.3.13 X21: Braking resistor
Terminal X21 is available for the connection of a braking resistor.

Connection

Size 0

Terminal Pin Designation Role

 
1 | 2

1 RB Braking resistor connection

2 RB

Tab. 123: X21 connection description, size 0

For the connecting wiring, obey the terminal specification GFKIC 2.5 -ST-7.62 [} 352].

Size 1

Terminal Pin Designation Role

 
1 | 2

1 RB Braking resistor connection

2 RB

Tab. 124: X21 connection description, size 1

For the connecting wiring, obey the terminal specification ISPC 5 -STGCL-7,62 [} 353].

Size 2

Terminal Pin Designation Role

 
1 | 2

1 RB Braking resistor connection

2 RB

Tab. 125: X21 connection description, size 2

For the connecting wiring, obey the terminal specification ISPC 16 -ST-10,16 [} 353].

Feature All sizes

Max. core/cable length 3 m, > 30 cm shielded

Tab. 126: Maximum core/cable length [m]



11 | Connection STOBER

114

11
/2

02
4 

| 
ID

 4
43

34
0.

01

11.3.14 X22: DC link connection
Terminal X22 is available for the DC link connection of the drive controller.

Technical data

Note the technical data for X22 (see X22: DC link connection [} 44]).

Connection

Size 0

Terminal Pin Designation Role

 
1 | 2 | 3 | 4

1 D− DC link connection

2 D−

3 D+

4 D+

Tab. 127: X22 connection description, size 0

For the connecting wiring, obey the terminal specification GFKIC 2.5 -ST-7.62 [} 352].

Size 1

Terminal Pin Designation Role

 
1 | 2 | 3 | 4

1 D− DC link connection

2 D−

3 D+

4 D+

Tab. 128: X22 connection description, size 1

For the connecting wiring, obey the terminal specification ISPC 5 -STGCL-7,62 [} 353].

Size 2

Terminal Pin Designation Role

 
1 | 2 | 3 | 4

1 D− DC link connection

2 D−

3 D+

4 D+

Tab. 129: X22 connection description, size 2

For the connecting wiring, obey the terminal specification ISPC 16 -ST-10,16 [} 353].

Feature All sizes

Max. core/cable length 3 m, > 30 cm shielded

Tab. 130: Maximum core/cable length [m]



STOBER 11 | Connection
11

/2
02

4 
| 

ID
 4

43
34

0.
01

115

11.3.15 X200, X201: EtherCAT
The drive controllers have both RJ-45 sockets X200 and X201. The sockets are located on top of the device. The associated
pin assignment and color coding correspond to the EIA/TIA-T568B standard.

Connection

Connect X200 as an input to the cable coming from the EtherCAT MainDevice. Connect X201 as an output to any
subsequent EtherCAT nodes.

Socket Pin Designation Function

1|2| ... |7|8 1 Tx+ Communication

2 Tx−

3 Rx+

4 — —

5 — —

6 Rx− Communication

7 — —

8 — —

Tab. 131: X200 and X201 connection description

Cable requirements

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

STOBER provides ready-made cables for EtherCAT connection. It is also possible to use cables with the following
specification:

Ethernet patch cables or crossover cables meeting the CAT 5e quality level are the ideal cables. The Fast Ethernet
technology allows a maximum cable length of 100 m between two nodes.

Information

Ensure that you only use shielded cables with an SF/FTP, S/FTP or SF/UTP design.

Device addressing and fieldbus connection

For information on device addressing, see Device addressing [} 361].

You will find detailed information about the fieldbus connection in the corresponding manual for communication with
EtherCAT.
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11.3.16 X200, X201: PROFINET
In order to be able to connect the drive controllers to other PROFINET nodes, an integrated switch with both X200 and X201
RJ-45 sockets is provided. The sockets are located on top of the device. The associated pin assignment and color coding
correspond to the EIA/TIA-T568B standard.

Connection

Connect X200 or X201 with the IO controller and the remaining connection with the next drive controller.

Socket Pin Designation Function

1|2| ... |7|8 1 Tx+ Communication

2 Tx−

3 Rx+

4 — —

5 — —

6 Rx− Communication

7 — —

8 — —

Tab. 132: X200 and X201 connection description

Cable requirements

The connections between the nodes of a PROFINET network generally consist of symmetrical, shielded copper cables
twisted in pairs (shielded twisted pair, CAT 5e quality level). Fiber-optic cables are also a possible means of transmission.

Signals are transmitted according to the 100BASE TX method, i.e. with a transfer rate of 100 Mbps at a frequency of
125 MHz. A maximum of 1440 bytes can be transferred per frame. The maximum cable length is 100 m.

PROFINET cables exist in different versions that are tailored to different application scenarios and ambient conditions.

We recommend using the cables and plug connectors specified in the PROFINET installation guidelines. They are adjusted
for use in automation technology with regard to usage, resistance, EMC properties and color coding.

There are type A, B and C cables, differentiated by installation type:

§ Type A
4-wire shielded copper cable for fixed installation

§ Type B
4-wire shielded copper cable for flexible installation

§ Type C
4-wire shielded copper cable for constant movements

Device addressing and fieldbus connection

For information on device addressing, see Device addressing [} 361].

Detailed information about the fieldbus connection can be found in the corresponding manual for communication with
PROFINET.
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11.3.17 X700: SD slot
The SD slot is used for data backup in case of service. SD and SDHC cards with storage capacity from 128 MB to 32 GB are
supported. SDHC cards with a storage capacity of 64 GB can be used only if they have been first reformatted to max. 32 GB
(FAT32). Since higher capacities extend the controller start-up time, STOBER recommends the use of cards with a storage
capacity of 2 to 4 GB.

Information

The drive controller has internal configuration memory and can therefore be operated without an inserted SD card. In the
DriveControlSuite commissioning software, the action Save values always saves to both the internal configuration memory
and the inserted SD card. Back up your configuration to an SD card after completing commissioning in order to allow
transfer of the configuration to the replacement drive controller in case of service. When the replacement drive controller
is switched on, the data is loaded with priority given to the inserted SD card. To make a non-volatile back-up in the internal
configuration memory, you must perform the Save values action in parameter A00 or press and hold the S1 operating
button on the drive controller for 3 s.
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11.3.18 Connecting a drive controller

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Tools and material

You will need:

§ A suitable terminal set for the drive controller

§ Tool for tightening the fastening screws

Requirements and connection

Bottom of the device:

ü You have a system circuit diagram describing the connection of the drive controller.

1. Optional: Connect the braking resistor to terminal X21 and attach the terminal. Make sure that the conductors are
twisted pairs.

2. In order to connect the motor temperature sensor, the brake and the motor itself to the drive controller, wire the
cores of the power cables with terminals X2, X5 and X20.

3. Attach the power cable with the shield clamp to the shield contact of terminal X20.
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4. Attach terminal X20 and tighten the screws of X20. After tightening the screws, make sure that there is sufficient
distance between the cores and terminal X20.

X2
X20

5. Attach terminals X2 and X5.

6. Optional: Connect the supply voltage for the brake to terminal X7 and attach it.

7. Optional: Connect an encoder to terminal X4.

Top of the device:

ü You have a system circuit diagram describing the connection of the drive controller.

1. Connect the power supply to terminal X10 and attach the terminal.

2. Connect the 24 VDC power supply for the control electronics to terminal X11 and attach the terminal.

3. If you use the STO safety function, connect it as follows:

3.1. SR6 option: Connect terminal X12 according to your safety configuration and attach the terminal.

3.2. SY6 option: In order to be able to identify the safety module in the FSoE network, you must transfer its unique
address in the FSoE network to the drive controller using the DIP switches.

3.3. SU6 option: In order to be able to identify the safety module in the PROFIsafe network, you must transfer its
unique address in the PROFIsafe network to the drive controller using the DIP switches.

4. Connect the fieldbus to the sockets X200 and X201.

5. Optional: Connect the inputs and outputs to terminals X1 and attach it.

Examples can be found in the appendix (see Wiring examples [} 355]).
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11.4 Terminal module
The connection descriptions for the XB6 terminal module can be found in the following chapters.

11.4.1 X100 (XB6 option): AI1 – AI2, AO1 – AO2
The terminal module adds 2 analog inputs and 2 analog outputs to the drive controller via terminal X100.

Technical data

For the connection, observe the technical data of the terminal module (see Terminal module [} 62]).

Connection

Terminal Pin Designation Role

4 | 3 | 2 | 1

8 | 7 | 6 | 5

1 AE1+ AI1+ input

2 AE1− AI1− input

3 AI1 shunt Current input; shunt connection pin 3 is to be bridged
to pin 2

4 AO1 AO1 output

5 AE2+ AI2+ input

6 AE2− AI2− input

7 0 V AGND Reference potential for AO1 and AO2

8 AO2 AO2 output

Tab. 133: X100 connection description

For the connecting wiring, note the DFMC 1.5 -ST-3.5 [} 350] terminal specification.

Feature All sizes

Max. core/cable length 30 m

Tab. 134: Maximum core/cable length [m]

Connection examples

AI1 Shunt

AI1+
AI1-

AO2

AO1

AGND

XB6X100
1
2
3
4

7
8

R10K

Potentiometer
Drive controller

Fig. 25: X100: Potentiometer connection example
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x

0 (4) -
20 mA AI1 Shunt

AI1+
AI1-

AO2

AO1

AGND

X100 XB6
1
2
3
4

7
8

Sensor (0 – 20 mA, 4 – 20 mA)
Drive controller

Fig. 26: X100: Sensor connection example 1

1
2
3
4

7
8

AI1 Shunt

AI1+
AI1-

AO2

AO1

AGND

X100 XB6x

± 10 V

Sensor (± 10 V)
Drive controller

Fig. 27: X100: Sensor connection example 2

4

7
8

AGND

X100

x

± 10 V

x

0 - 20 mA

1
2
3
4

7
8

AI1 Shunt

AI1+
AI1-

AO2

AO1

AGND
V

XB6

XB6

AO2

AO1A

Actuator (± 10 V, 0 - 20 mA)
Drive controller

Fig. 28: X100: Actuator connection example
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11.4.2 X101 (XB6 option): DI5 – DI12, DO3 – DO10
8 digital inputs and 8 digital outputs are available via terminal X101 of the terminal module.

X101 for digital signals

For the evaluation of digital signals at X101, observe the technical data of the terminal module (see XI6).

Connection

Terminal Pin Designation Role

10|9|8| ... |3|2|1

20|19|18| ... |13|12|11

1 DI5 Digital inputs

2 DI6

3 DI7

4 DI8

5 0 V DGND Reference potential

6 +24 VDC External 24 VDC supply; recommended fuse
protection: max. 1 AT13

7 DO3 Digital outputs

8 DO4

9 DO5

10 DO6

11 DI9 Digital inputs

12 DI10

13 DI11

14 DI12

15 0 V DGND Reference potential

16 0 V DGND Reference potential

17 DO7 Digital outputs

18 DO8

19 DO9

20 DO10

Tab. 135: X101 connection description for digital signals

For the connecting wiring, note the DFMC 1.5 -ST-3.5 [} 350] terminal specification.

Feature All sizes

Max. core/cable length 30 m

Tab. 136: Maximum core/cable length [m]

13 For the fuse protection, use a 1 A fuse (time delay). For UL-compliant use, be sure that the fuse meets certification re-
quirements for DC voltage in accordance with UL 248.
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11.4.3 X120 (XB6 option): Encoder
SSI encoder signals can be made available to several drive controllers via the dual interface of X120A and X120B without
extra wiring needed (SSI motion bus). The technical data and pin assignments of the two encoder connections are identical.
Alternatively, you can use X120A or X120B as a connection for an incremental encoder or Hall sensor.

Information

When using the dual interface of X120A and X120B as an SSI motion bus, all nodes must be switched on or off
simultaneously (24 V supply at terminal X11 and at terminal X101, pin 6). Switching individual nodes during operation leads
to faults in other nodes.

Technical data

Note the technical data of the evaluable encoders at X120 (see X120).

Connection

SSI encoders

Connector Pin Designation Role

1 | 2 | 3 | 4 | 5 

6 | 7 | 8 | 9

1 GND Enc Reference potential for pin 2 to pin 7

2 — —

3 — —

4 Clock − Inverse differential input/output for CLOCK

5 Clock + Differential input/output for CLOCK

6 Data + Differential input/output for DATA

7 Data − Inverse differential input/output for DATA

8 U2 Encoder supply

9 0 V GND Reference potential for pin 8

Tab. 137: X120 connection description for SSI encoders

Differential TTL incremental encoders

Connector Pin Designation Role

1 | 2 | 3 | 4 | 5 

6 | 7 | 8 | 9

1 GND Enc Reference potential for pin 2 to pin 7

2 N + Differential input/output for N track

3 N − Inverse differential input/output for N track

4 A − Inverse differential input/output for A track

5 A + Differential input/output for A track

6 B + Differential input/output for B track

7 B − Inverse differential input/output for B track

8 U2 Encoder supply

9 0 V GND Reference potential for pin 8

Tab. 138: X120 connection description for differential TTL incremental encoders
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Differential TTL Hall sensor

Connector Pin Designation Role

1 | 2 | 3 | 4 | 5 

6 | 7 | 8 | 9

1 GND Enc Reference potential for pin 2 to pin 7

2 HALL C + Differential input for HALL C

3 HALL C − Inverse differential input for HALL C

4 HALL A − Inverse differential input for HALL A

5 HALL A + Differential input for HALL A

6 HALL B + Differential input for HALL B

7 HALL B− Inverse differential input for HALL B

8 U2 Encoder supply

9 0 V GND Reference potential for pin 8

Tab. 139: X120 connection description for differential TTL hall sensors

Differential TTL pulse/direction interface

Connector Pin Designation Role

1 | 2 | 3 | 4 | 5 

6 | 7 | 8 | 9

1 GND Enc Reference potential for pin 2 to pin 7

2 — —

3 — —

4 Pulse − Inverse differential input for pulses

5 Pulse + Differential input for pulses

6 Direction + Differential input for direction

7 Direction − Inverse differential input for direction

8 U2 Encoder supply

9 0 V GND Reference potential for pin 8

Tab. 140: X120 connection description for differential TTL pulse/direction signals

Cable requirements

Feature All sizes

Max. cable length 50 m, shielded

Tab. 141: Cable length [m]
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11.4.4 X140 (XB6 option): Encoder

Technical data

Note the technical data of the evaluable encoders at X140 (see X140 (XB6 option): Encoder [} 59]).

Connection

EnDat 2.1/2.2 digital encoders

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 0 V GND Reference potential for encoder supply to pin 4

3 — —

4 U2 Encoder supply

5 Data + Differential input for DATA

6 — —

7 — —

8 Clock + Differential input for CLOCK

9 — —

10 0 V Sense Optional reference potential of the Sense connection
for regulating the encoder supply

11 — —

12 U2 Sense Sense signals for voltage regulation

13 Data − Inverse differential input for DATA

14 — —

15 Clock − Inverse differential input for CLOCK

Tab. 142: X140 connection description for EnDat 2.1/2.2 digital encoders



11 | Connection STOBER

126

11
/2

02
4 

| 
ID

 4
43

34
0.

01

Resolvers

Information

For connecting con.23 resolver cables with a 9-pin D-sub connector, such as the standard design for ED/EK synchronous
servo motors, you must use interface adapter AP6A00 (ID No. 56498) or AP6A01 (ID No. 56522, with motor temperature
sensor leads), available separately.

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 S4 Sin + Sin input

2 R1 Ref − Reference potential for pin 6

3 S3 Cos + Cos input

4 — —

5 — —

6 R2 Ref + Resolver excitation signal

7 1TP1 Reserve

8 — —

9 S2 Sin − Reference potential for pin 1

10 — —

11 S1 Cos − Reference potential for pin 3

12 — —

13 — —

14 1TP2 Reserve

15 — —

Tab. 143: X140 connection description for resolvers
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EnDat 2.1 sin/cos encoders

Information

For connecting EnDat 2.1 sin/cos cables with a 15-pin D-sub connector to an integrated motor temperature sensor, you
must use the AP6A02 interface adapter (ID No. 56523), available separately, to lead out the temperature sensor cores.

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 B − (Sin −) Reference potential for sin input

2 0 V GND Reference potential for encoder supply to pin 4

3 A − (Cos −) Reference potential for cos input

4 U2 Encoder supply

5 Data + Differential input for DATA

6 — —

7 1TP1 Reserve

8 Clock + Differential input for CLOCK

9 B + (Sin +) Sin input

10 0 V Sense Optional reference potential of the Sense connection
for regulating the encoder supply

11 A + (Cos +) Cos input

12 U2 Sense Sense signals for voltage regulation

13 Data − Inverse differential input for DATA

14 1TP2 Reserve

15 Clock − Inverse differential input for CLOCK

Tab. 144: X140 connection description for EnDat 2.1 sin/cos encoders
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Sin/cos encoders

Bush Pin Designation Role

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 B − (Sin −) Reference potential for sin input

2 0 V GND Reference potential for encoder supply to pin 4

3 A − (Cos −) Reference potential for cos input

4 U2 Encoder supply

5 — —

6 — —

7 — —

8 — —

9 B + (Sin +) Sin input

10 0 V Sense Optional Sense connection for regulating the encoder
supply

11 A + (Cos +) Cos input

12 U2 Sense Sense signals for voltage regulation

13 — —

14 — —

15 — —

Tab. 145: X140 connection description for sin/cos encoders

Cable requirements

Feature All sizes

Max. cable length 100 m, shielded

Tab. 146: Maximum cable length [m]
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11.5 Braking resistor

WARNING!

Risk of burns! Fire hazard! Material damage!

Chokes and braking resistors can heat up to over 100 °C under permitted operating conditions.

▪ Take protective measures against accidental and intentional contact with the choke or braking resistor.

▪ Make sure that no flammable material is in the vicinity of the choke or braking resistor.

▪ Note the specified minimum clearances for installation.

WARNING!

Fire hazard due to overheating!

Using chokes or braking resistors outside of the nominal data (cable length, current, frequency, etc.) can cause them to
overheat.

▪ Always comply with the maximum nominal data when operating the chokes and braking resistors.

Housing grounding of the braking resistor

When grounding the housing of the braking resistor, obey the information on how to connect the grounding conductor
correctly (see Connection of the grounding conductor [} 94]).
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11.5.1 FZMU, FZZMU connection description
The internal connections of the tubular fixed resistor are wired to terminals with heat-resistant, silicone-insulated strands
of wire. Also ensure a heat-resistant and sufficiently surge-proof design for the connection!

1

32

Fig. 29: FZMU connection overview

32

1

Fig. 30: FZZMU connection overview

No. Function

1 Grounding conductor

2 RB drive controller braking resistor connection: X21, pin 1

3 RB drive controller braking resistor connection: X21, pin 2

Tab. 147: FZMU, FZZMU connection description

For the connecting wiring of the braking resistor, obey the terminal specification G 10/2 [} 351].

11.5.2 GVADU, GBADU connection description
GVADU flat resistors have two red cores for connecting to the drive controller, while GBADU flat resistors have one gray
and one white core.

No. Function

RD/GY RB drive controller braking resistor connection: X21, pin 1

RD/WH RB drive controller braking resistor connection: X21, pin 2

Tab. 148: GVADU, GBADU connection description

11.5.3 RB 5000 connection description
The rear section braking resistor has two red cores for connecting to the drive controller.

Sizes 0 to 2

Core color Role

RD RB drive controller braking resistor connection: X21, pin 1

RD RB drive controller braking resistor connection: X21, pin 2

Tab. 149: RB 5000 connection description
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11.6 Output choke

WARNING!

Risk of burns! Fire hazard! Material damage!

Chokes and braking resistors can heat up to over 100 °C under permitted operating conditions.

▪ Take protective measures against accidental and intentional contact with the choke or braking resistor.

▪ Make sure that no flammable material is in the vicinity of the choke or braking resistor.

▪ Note the specified minimum clearances for installation.

WARNING!

Fire hazard due to overheating!

Using chokes or braking resistors outside of the nominal data (cable length, current, frequency, etc.) can cause them to
overheat.

▪ Always comply with the maximum nominal data when operating the chokes and braking resistors.

11.6.1 Connection description

Designation Function

1U1 Phase U drive controller connection: X20, pin 1

1U2 Motor phase U connection

1V1 Phase V drive controller connection: X20, pin 2

1V2 Motor phase V connection

1W1 Phase W drive controller connection: X20, pin 3

1W2 Motor phase W connection

7 Drive controller grounding conductor: X20, Pin 4

8 Power cable grounding conductor

Tab. 150: TEP output choke connection description

M

1 32 PE 1 32 PE 1 32 PE

X20

U V W PE 1U
1

1V
1

1W
1

7 1U
2

1V
2

1W
2

8

Fig. 31: TEP output choke connection example
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Shielded connection of the power cable

Note the following points for the connection of the power cable for a motor with output choke:

§ Ground the shield of the power cable over large contact areas in the immediate vicinity of the output choke, for
example with electrically conductive metal cable clips on a grounded busbar.

§ Keep the exposed conductors as short as possible. All devices and circuits that are sensitive to EMC must be kept at a
distance of at least 0.3 m.

The following graphic shows an example of the shielded connection of the power cable.

Fig. 32: Shielded connection of the power cable

Choke housing grounding

When connecting the grounding conductor, obey the requirements described 
(see Connection of the grounding conductor [} 94]).

11.7 Cables
Note that the motor, cables and drive controller each have electrical properties which influence one another. Unfavorable
combinations could possibly result in impermissible voltage peaks on the motor and drive controller and increased wear as
a result.

Take into consideration the following instructions when selecting suitable cables:

§ Cable cross-sections for connection to the motor:
Note the permitted stall current I0 for the motor when making your selection.

§ Conductor cross-sections for the power connection:
Note the line fuse, the maximum permitted conductor cross-section for terminal X10, the routing method and the
surrounding temperature when making your selection.

§ Also pay attention to the trailing and torsional strength of the lines.

§ When using a motor brake, pay attention to the voltage drop in the supply voltage on the line.

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

Information

When connecting the cables, refer to the motor connection diagram that is delivered with every STOBER motor.
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11.7.1 Power cables
The synchronous servo motors and Lean motors are equipped with plug connectors as standard, while asynchronous
motors are equipped with terminal boxes.

STOBER provides suitable cables in various lengths, conductor cross-sections and connector sizes.

11.7.1.1 Connection description

Depending on the size of the motor plug connector, power cables are available in the following designs:

§ Quick lock for con.15

§ speedtec quick lock for con.23 and con.40

Information

Observe the designations on the identification clips for the correct connection of the cores.

Motor-side connection

x

y op
en

con.23

con.40

con.15 E

1

A
B

C

5 1
2

4
35

1 2
3

4

7 68
9

10

11
12

EA B

C

1 Plug connectors
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Drive controller-side connection

53

58

100

1

2

3

5
6

7
8

3 4 52

50

1

2

3 1W1

1V1

1U1

4 PE
5
6

1BD1
1BD2

7
8

1TP1
1TP2

2 Power cable with cable shield

3 Connection to terminal X20, motor

4 Connection of terminal X5, brake

5 Connection to terminal X2, temperature sensor
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Maximum cable length

Motor type Connection Size 0 to 2

Synchronous servo motor,
asynchronous motor

Without output choke 50 m, shielded

Synchronous servo motor,
asynchronous motor

With output choke 100 m, shielded

Lean motor Without output choke 50 m, shieldeda)

Tab. 151: Maximum cable length of the power cable [m]

The use of cables with a length greater than 50 m and up to maximum 100 m must be checked by STOBER for the
application.

Power cables – con.15 plug connector

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Motor connection
diagram

Pin Designation Identification/
Core color

Pin
X20

Pin
X5

Pin
X2

 A 1U1 1 1 — —

B 1V1 2 2 — —

C 1W1 3 3 — —

1 1TP1 7 — — 7

2 1TP2 8 — — 8

3 1BD1 5 — 5 —

4 1BD2 6 — 6 —

5 — — — — —

PE GNYE 4 — —

Housing Shield — Shield contact — —

Tab. 152: con.15 power cable pin assignment

Length x [mm] Diameter y [mm]

42 18.7

Tab. 153: con.15 connector dimensions
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Power cables – con.23 plug connector

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Motor connection
diagram

Pin Designation Identification/
Core color

Pin
X20

Pin
X5

Pin
X2

1 1U1 1 1 — —

3 1V1 2 2 — —

4 1W1 3 3 — —

 A 1BD1 5 — 5 —

B 1BD2 6 — 6 —

C 1TP1 7 — — 7

D 1TP2 8 — — 8

PE GNYE 4 — —

Housing Shield — Shield contact — —

Tab. 154: con.23 power cable pin assignment

Length x [mm] Diameter y [mm]

78 26

Tab. 155: con.23 connector dimensions
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Power cables – con.40 plug connector

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Motor connection
diagram

Pin Designation Identification/
Core color

Pin
X20

Pin
X5

Pin
X2

U 1U1 1 1 — —

V 1V1 2 2 — —

W 1W1 3 3 — —

+ 1BD1 5 — 5 —

− 1BD2 6 — 6 —

1 1TP1 7 — — 7

2 1TP2 8 — — 8

PE GNYE 4 — —

Housing Shield — Shield contact — —

Tab. 156: con.40 power cable pin assignment

Length x [mm] Diameter y [mm]

99 46

Tab. 157: con.40 connector dimensions
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11.7.2 Encoder cables
The motors are equipped with encoder systems and plug connectors as standard.

STOBER provides suitable cables in various lengths, conductor cross-sections and connector sizes.

Depending on the respective motor types, different encoder systems can be used.

11.7.2.1 EnDat 2.1/2.2 digital encoders

Suitable encoder cables are described below.

11.7.2.1.1 Connection description

Depending on the size of the motor plug connector, encoder cables are available in the following designs:

§ Quick lock for con.15

§ speedtec quick lock for con.17 and con.23

con.23

1 3

con.17

con.15

2

op
en

x

y

E

P

1

15

E
2

1

3
456

7
8

9
10

1112

2

1

3
4 5

6

7

89

10

11

12

5

1 2
3

4

7 68
9

10

11
12

A
B

C

E 5 1
2

4
3

1 Plug connectors

2 Encoder cables

3 D-sub X4/X140
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Encoder cables – con.15 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X4/X140

1 Clock + YE 8

2 — — —

3 — — —

4 — — —

5 Data − BN 13

6 Data + WH 5

7 — — —

8 Clock − GN 15

9 — — —

10 0 V GND BU 2

11 — — —

12 U2 RD 4

Housing Shield — Housing

Tab. 158: con.15 encoder cable pin assignment, EnDat 2.1/2.2 digital

Length x [mm] Diameter y [mm]

42 18.7

Tab. 159: con.15 connector dimensions
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Encoder cables – con.17 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X4/X140

1 Clock + YE 8

2 — — —

3 — — —

4 — — —

5 Data − BN 13

6 Data + WH 5

7 — — —

8 Clock − GN 15

9 — — —

10 0 V GND BU 2

11 — — —

12 U2 RD 4

Housing Shield — Housing

Tab. 160: con.17 encoder cable pin assignment, EnDat 2.1/2.2 digital

Length x [mm] Diameter y [mm]

56 22

Tab. 161: con.17 connector dimensions
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Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X4/X140

1 Clock + YE 8

2 — — —

3 — — —

4 — — —

5 Data − BN 13

6 Data + WH 5

7 — — —

8 Clock − GN 15

9 — — —

10 0 V GND BU 2

11 — — —

12 U2 RD 4

Housing Shield — Housing

Tab. 162: con.23 encoder cable pin assignment, EnDat 2.1/2.2 digital

Length x [mm] Diameter y [mm]

58 26

Tab. 163: con.23 plug dimensions
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11.7.2.2 SSI encoders

Suitable encoder cables are described below.

11.7.2.2.1 Connection description

The encoder cable is available in plug connector size con.23 with a speedtec quick lock.

1 32
x

ycon.23

1

15

P2

1

3
4 5

6

7

89

10

11

12

1 Plug connectors

2 Encoder cables

3 D-sub X4

Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X4

1 Clock + YE 8

2 U2 Sense PK 12

3 — — —

4 — — —

5 Data − BN 13

6 Data + WH 5

7 — — —

8 Clock − GN 15

9 — — —

10 0 V GND BU 2

11 — — —

12 U2 RD 4

Housing Shield — Housing

Tab. 164: con.23 encoder cable pin assignment, SSI

Length x [mm] Diameter y [mm]

58 26

Tab. 165: con.23 plug dimensions
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11.7.2.3 Differential HTL incremental encoders

Suitable encoder cables are described below.

11.7.2.3.1 Connection description

The encoder cable is available in plug connector size con.23 with a speedtec quick lock.

1 32
x

ycon.23

1

15

P2

1

3
4 5

6

7

89

10

11

12

1 Plug connectors

2 Encoder cables

3 D-sub X4

Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X4

1 B − YE 9

2 — — —

3 N + PK 3

4 N − GY 10

5 A + BN 6

6 A − WH 11

7 — — —

8 B + GN 1

9 — — —

10 0 V GND BU 214

11 — — —

12 U2 RD 4

Housing Shield — Housing

Tab. 166: con.23 encoder cable pin assignment, incremental HTL

Length x [mm] Diameter y [mm]

58 26

Tab. 167: con.23 plug dimensions

14 Pin 12 (U2 Sense) with pin 2 (0 V GND) bridged: The bridge is constructed in the cable connector that is connected to X4.
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11.7.2.4 Resolver

Suitable encoder cables are described below.

11.7.2.4.1 Connection description

Depending on the size of the motor plug connector, encoder cables are available in the following designs:

§ Quick lock for con.15

§ speedtec quick lock for con.17 and con.23

con.23

1 2

con.17

con.15

3

1

15

E

E

op
en

x

y

P2

1

3
4 5

6

7

89

10

11

12

2
1

3
456

7
8

9
10

1112

5

1 2
3

4

7 68
9

10

11
12

A
B

C

E 5 1
2

4
3

1 Plug connectors

2 Encoder cables

3 D-sub X140/adapter

Information

Note that the cores for the temperature sensor are routed in the power cable as standard. For motors that provide the
temperature sensor at the encoder connection, you need an interface adapter to lead out the temperature sensor cores for
connecting the cable to the drive controller.

Information

For connecting con.23 resolver cables with a 9-pin D-sub connector, such as the standard design for ED/EK synchronous
servo motors, you must use interface adapter AP6A00 (ID No. 56498) or AP6A01 (ID No. 56522, with motor temperature
sensor leads), available separately.
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11.7.2.4.1.1 Resolver cable with "Motion Resolver" imprint

Encoder cables – con.15 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pair Pin
X140

1 S3 Cos + GN GN-BK 3

2 S1 Cos − BK GN-BK 11

3 S4 Sin + WH WH-BK 1

4 S2 Sin − BK WH-BK 9

5 1TP1 RD RD-BK 7

6 1TP2 BK RD-BK 14

7 R2 Ref + BU BU-BK 6

8 R1 Ref − BK BU-BK 2

9 — — — —

10 — — — —

11 — — — —

12 — — — —

Housing Shield — — Housing

Tab. 168: Encoder cable pin assignment con.15, resolver, "Motion Resolver" cable label

Length x [mm] Diameter y [mm]

42 18.7

Tab. 169: con.15 connector dimensions
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Encoder cables – con.17 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pair Pin
X140

1 S3 Cos + GN GN-BK 3

2 S1 Cos − BK GN-BK 11

3 S4 Sin + WH WH-BK 1

4 S2 Sin − BK WH-BK 9

5 1TP1 RD RD-BK 7

6 1TP2 BK RD-BK 14

7 R2 Ref + BU BU-BK 6

8 R1 Ref − BK BU-BK 2

9 — — — —

10 — — — —

11 — — — —

12 — — — —

Housing Shield — — Housing

Tab. 170: Encoder cable pin assignment con.17, resolver, "Motion Resolver" cable label

Length x [mm] Diameter y [mm]

56 22

Tab. 171: con.17 connector dimensions
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Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Adapter
(3)

Connection diagram Pin Designation Core color Pair Pin
9-pin connector

1 S3 Cos + GN GN-BK 8

2 S1 Cos − BK GN-BK 4

3 S4 Sin + WH WH-BK 7

4 S2 Sin − BK WH-BK 3

5 1TP1 RD RD-BK 2

6 1TP2 BK RD-BK 6

7 R2 Ref + BU BU-BK 9

8 R1 Ref − BK BU-BK 5

9 — — — —

10 — — — —

11 — — — —

12 — — — —

Housing Shield — — Housing

Tab. 172: Encoder cable pin assignment con.23, resolver, "Motion Resolver" cable label

Length x [mm] Diameter y [mm]

58 26

Tab. 173: con.23 plug dimensions
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11.7.2.4.1.2 Resolver cable with "No. 44206" imprint

Encoder cables – con.15 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X140

1 S3 Cos + YE 3

2 S1 Cos − GN 11

3 S4 Sin + WH 1

4 S2 Sin − BN 9

5 1TP1 RD 7

6 1TP2 BU 14

7 R2 Ref + GY 6

8 R1 Ref − PK 2

9 — — —

10 — — —

11 — — —

12 — — —

Housing Shield — Housing

Tab. 174: Encoder cable pin assignment con.15, resolver, "No. 44206" cable label

Length x [mm] Diameter y [mm]

42 18.7

Tab. 175: con.15 connector dimensions
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Encoder cables – con.17 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Pin
X140

1 S3 Cos + YE 3

2 S1 Cos − GN 11

3 S4 Sin + WH 1

4 S2 Sin − BN 9

5 1TP1 RD 7

6 1TP2 BU 14

7 R2 Ref + GY 6

8 R1 Ref − PK 2

9 — — —

10 — — —

11 — — —

12 — — —

Housing Shield — Housing

Tab. 176: Encoder cable pin assignment con.17, resolver, "No. 44206" cable label

Length x [mm] Diameter y [mm]

56 22

Tab. 177: con.17 connector dimensions
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Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Adapter
(3)

Connection diagram Pin Designation Core color Pin
9-pin connector

1 S3 Cos + YE 8

2 S1 Cos − GN 4

3 S4 Sin + WH 7

4 S2 Sin − BN 3

5 1TP1 RD 2

6 1TP2 BU 6

7 R2 Ref + GY 9

8 R1 Ref − PK 5

9 — — —

10 — — —

11 — — —

12 — — —

Housing Shield — Housing

Tab. 178: Encoder cable pin assignment con.23, resolver, "No. 44206" cable label

Length x [mm] Diameter y [mm]

58 26

Tab. 179: con.23 plug dimensions
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11.7.3 One Cable Solution
The synchronous servo motors are equipped with plug connectors as standard.

A motor connection as a One Cable Solution (OCS) combined with an EnDat 3 or HIPERFACE DSL encoder requires hybrid
cables which feature encoder communication and power transmission in a shared cable.

STOBER provides suitable cables in various lengths, conductor cross-sections and connector sizes.

For applications with a cable length of up to 12.5 m, conductor cross-sections of 1.0 or 1.5 mm² and a non-moving
installation, STOBER recommends the OCS-Basic hybrid cables. For longer lengths or installation in moving cable runs (such
as a drag chain), use the OCS-Advanced hybrid cables.

Information

For connecting as a One Cable Solution, use exclusively hybrid cables from STOBER. The use of unsuitable cables or poorly
made connections can cause subsequent damage. For this reason, we reserve the right to reject claims under the warranty
in this case.

11.7.3.1 Connection description

The hybrid cables are available in plug connector size con.23 with a speedtec quick lock.

con.23

2 3 4 5

5
6 1BD2

1

PE

4 P_D+

1/L1

WH

1U1

y

x

1

2/L2
3/L3 3

2
1W1
1V1

6
5 1BD1

BU 2 P_D-

1

15

53

58

100

50

290

4

1 Plug connectors

2 Hybrid cables

3 Connection to terminal X20, motor

4 Connection of terminal X2, brake

5 D-sub X4
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Hybrid cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Connection diagram Pin Designation Core No./
Core color

Pin
X20

Pin
X2

Pin
X4

 A 1U1 1/L1 1 — —

B 1V1 2/L2 2 — —

C 1W1 3/L3 3 — —

E P_D− BU — — 2

F P_D shield — — — Housing

G 1BD1 5 — 5 —

H P_D+ WH — — 4

L 1BD2 6 — 6 —

PE GNYE 4 —

Housing Shield — Shield contact — —

Tab. 180: con.23 hybrid cable pin assignment

Length x [mm] Diameter y [mm]

78 26

Tab. 181: con.23 connector dimensions
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12 Operation
The S1 operating button is located on the bottom of the device and can be used to save the configuration to the drive
controller in non-volatile memory, for example. The OP6 operating unit is available as an option. It consists of a text display
and 9 keys.

12.1 S1 operating button of the drive controller
The S1 operating button is located on the bottom of the drive controller.

Overriding a fixed IP address upon device start-up

If the drive controller has a fixed IP address that does not match the subnet of the PC, press and hold the operating button
when switching on the 24 V supply until all 3 LEDs go out (approx. 3 s after switching on). The IP address is then assigned
either automatically by DriveControlSuite or via DHCP, regardless of the setting in A166. In this case, the operating button
acts as an override.

Non-volatile storage in operation

To save the configuration to the drive controller in non-volatile memory, press and hold the operating button for 3 s.

Activating and executing a function in operation

The following additional functions are available to you:

§ 1: Temporarily deactivate the fan (A15 = 0: Inactive)

§ 2: Acknowledge faults in both axes

Information

Function 1 is used exclusively for project configuration and commissioning purposes; using it in normal or automatic mode
is not permitted.

At a power unit temperature E25[0] greater than 45 °C or a control unit temperature E25[1] greater than 60 °C, an inactive
fan is switched on automatically (A15 = 1: Active). The fan can be deactivated once. As soon as the fan is activated again
afterwards, the drive controller must be restarted to deactivate the fan. It is not possible to deactivate it again using the
S1 operating button.

To activate and execute one of these functions, proceed as follows:

1. To activate function selection, press the operating button briefly (< 3 s).

ð Both LEDs light up for approx. 1 s.

ð Then only the green LED lights up.

ð Function 1 is selected (default).

2. Then press the operating button again to change the function.

ð The LEDs on the front of the drive controller light up depending on the selected function.

3. To confirm the selected function, press and hold the operating button for 3 s.

ð Both LEDs flash twice.

ð The selected function is executed.

ð The LEDs then switch back to the normal operating display.
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SB6

1
2

Fig. 33: LEDs for the functions of the S1 operating button

1 Green

2 Red

LEDs:
(Green/Red)

Conduct Role

On 1: Temporarily deactivate the fan (A15 = 0: Inactive)

Off

Off 2: Acknowledge faults in both axes

On

Tab. 182: Status of the LEDs when selecting functions via the S1 operating button

Acknowledging the function selection

If the operating button is not pressed again within 10 s of activating the function selection, the function selection is exited
and the LEDs switch back to the normal operating display.
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12.2 Operating unit

123567°
0.000 rpm

0.0 A

Status display

Fig. 34: Optional OP6 operating unit

Select levels, parameter groups and parameters or
apply modified parameter values

Display parameters of the start display,
navigate to a previous level,
reject modified parameter values or
acknowledge fault

Select parameters within a parameter group or
change parameter values

Select a parameter group or
select a character position of a parameter

Activate or deactivate local operation; a deactivation causes the enable signal to be cleared

Enable drive in local operation, if parameterized

Store in non-volatile memory: press button for 3 s
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12.2.1 Menu structure and navigation

Parameters – Quick access

Status display
I80 Current position
E08 n-motor filtered
E00 I-motor

Source

Status display
123.567°
0.000 rpm

0.0 A

Status display     1
E49 SwOnInhibReason 

E47 SwOnInhibReason
01000011

Status display     2
E19 Digital inputs 

E27 Digital outputs
0000000000000000

Status display     3
E52 InfoDriveControl
[0] SD6A06
[1] 999

Parameter groups

Parameter

A:Drive controller B:Motor Z:Fault counter

A:Drive controller
A21 Brake resistor R

A11 Edited axe
A12 Language

Current language Changing the language

Start display

A12
Language
0:Deutsch

Language

0:Deutsch

A12

1:English

A:Drive controller
A167 Sourc.rem.maint

A165 Man IPSubMsk
A166[0] IPadr.del

A:Drive controller
A167 Sourc.rem.maint

A165 Man IPSubMsk
A166[1] IPadr.del.

Values

Changing an array parameters

Fig. 35: Menu structure and navigation using the optional OP6 operating unit

Parameters – Quick access

Using quick access, you get direct access to the status of the most important (diagnostic) parameters. This level consists of
the STATUS DISPLAY start display and three additional topic-specific overviews: STATUS DISPLAY 1, for example, provides
information about the causes of a possible switch-on lockout, STATUS DISPLAY 2 provides information about analog and
digital inputs and outputs, STATUS DISPLAY 3 provides information about the general data of the drive controller, such as
type, firmware, integrated option modules, etc. You can navigate within this level using the left and right arrow buttons.
You can use the up and down arrow buttons to navigate within the current overview to see more information.

You can access parameters hidden behind the four values on the STATUS DISPLAY start display by using [Esc]. These four
parameters can be configured individually using parameter A144.

Parameter groups

Parameters are combined into groups by their functional properties, such as "Drive controller", "Motor", "Machine",
"Terminal", etc. You can navigate within this level using the right and left arrow buttons; you can select one of the possible
groups with [OK].
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Parameters

Within a parameter group, you can navigate using the up and down arrow buttons; you can select one of the possible
parameters with [OK]. If you would like to change a parameter value, select the corresponding character position using the
right and left arrow buttons and select the new value using the up and down arrow buttons. You can apply changes with
[OK] or reject them with [Esc].

Information

Note that modified values can be stored in non-volatile memory via an operating unit using the save button or parameter
A00.
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13 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

13.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.

1 2

3

4

5

6 7 8
9

Fig. 36: DS6: Program interface
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No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.

13.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series
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13.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.

Group Topic

 A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gear unit and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 183: Parameter groups
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13.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2 147 483 648 – 2 147 483 647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or
parameter address

4 bytes (1 double word,
unsigned)

0 – 4 294 967 295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 – 3.40282 × 1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 184: Parameters: Data types, parameter types, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

§ Text
Outputs or messages



13 | What you should know before commissioning STOBER

162

11
/2

02
4 

| 
ID

 4
43

34
0.

01

13.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 185: Parameter types

13.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

§ Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters 
(value range: 1 – 4).

§ Group
The thematic group to which a parameter belongs (value range: A – Z).

§ Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

§ Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

§ Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 – 31).
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13.2.5 Parameter visibility
The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the properties you project
for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or hidden
depending on other parameters or settings. For example, the parameters of an additional function are only shown as soon
as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

§ Over the drive controller display (A10[0])

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

For example, a drive controller can evaluate an encoder using terminal X120, provided that a corresponding terminal
module has been installed. The accompanying evaluation is activated using parameter H120. However, this parameter is
visible only if the terminal module was initially selected during the drive project configuration.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.
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13.3 Signal sources and process data mapping
The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources

Drive controllers are controlled either over a fieldbus, using mixed operation consisting of a fieldbus system and terminals
or exclusively using terminals. 
You can use the corresponding selection parameters, referred to as signal sources, to configure whether the control signals
and set values of the application are obtained over a fieldbus or using terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals or set values must be
part of the subsequent process data mapping. In the case of activation using terminals, the respective analog or digital
inputs are specified directly.

Process data mapping

If you are working with a fieldbus system and have selected the source parameters for control signals and set values,
configure the fieldbus-specific settings, e.g. the assignment of the process data channels for transmitting receive and
transmit process data, as the last step. The respective procedure can be found in the accompanying fieldbus manuals.

13.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller

To save the configuration in non-volatile memory on a drive controller, you have the following options:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values: Set the parameter
A00[0] to the value 1: Active

§ Saving the configuration using the S1 operating button:
Drive controller with S1 operating button: Press and hold the operating button for 3 s

§ Saving the configuration using the operating unit:
Drive controller with operating unit: Press the save button for 3 s

Saving to all drive controllers within a project

To save the configuration in non-volatile memory on several drive controllers, you have the following options:

§ Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

§ Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start with fault 40: Invalid data the next time it is switched on. To successfully complete the saving
procedure, the configuration must be stored again in non-volatile memory.
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14 Commissioning
The following chapters describe how to commission your drive system using the DriveControlSuite commissioning software.

Information on system requirements and software installation can be found in the appendix (see DriveControlSuite [} 362]).

For the components of your axis model, we require one of the following two combinations as an example:

Synchronous servo motor with EnDat 2.2 digital or EnDat 3 encoder (and optional brake)

These motors are saved along with all relevant data for the project configuration in the DriveControlSuite motor database
and in the electronic nameplate. 
Upon selecting the motor from the database, such as when reading out the nameplate, all data is transferred to the
corresponding parameters. There is no need for complex parameterization of the motor, encoder and brake.

LM Lean motor without encoder (with optional brake)

These motors are stored in the motor database of the DriveControlSuite, along with all the data relevant for project
configuration. Furthermore, the motor data and the release and engaging times of the brake are part of the firmware. 
Upon selecting the desired motor from the database, all data is transmitted to the corresponding parameters. The release
and engaging times of the brake are also stored. If a brake is present, you must only activate this manually. However,
complex parameterization of the motor and brake is not necessary.

For asynchronous motors, the motor data relevant for project configuration is also taken from the motor database. All
other motor types, as well as motors from third-party manufacturers, need to have their parameters configured manually.

Make sure that the system nodes are wired and supplied with control voltage before commissioning.

Information

The commissioning process described below is particularly suitable for quick initial commissioning of your drive system with
subsequent testing of your projected axis model. Since steps or their sequence may vary depending on the application,
refer to the corresponding application manual for detailed information.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.
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14.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

14.1.1 Projecting the drive controller and axis
Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:
Define the reference code (equipment code) of the drive controller.

1.2. Designation:
Give the drive controller a unique name.

1.3. Version:
Version your project configuration.

1.4. Description:
If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:
Select the series, device type and firmware version of the drive controller.

3. Option modules tab:
Project the option modules of the drive controller.

3.1. Terminal module:
If you are controlling the drive controller via analog and digital inputs, select the corresponding terminal
module.

3.2. Safety module:
If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Project the basic control of the drive controller.

4.1. Device control:
Select the device control that defines the underlying activation signals of the drive controller.

4.2. Rx process data, Tx process data:
If you use a fieldbus to control the drive controller, select the corresponding receive and transmit process data.
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Projecting the axis

1. Click Axis A.

2. Properties tab: 
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the axis.

2.2. Designation:
Give the axis a unique name.

2.3. Version:
Version your project configuration.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Application tab:
Select the desired controller-based or drive-based application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter
the accompanying motor data later.

5. Confirm with OK.

14.1.2 Configuring safety technology
If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step (see Further information [} 399]).

14.1.3 Creating other modules and drive controllers
We recommend sorting all drive controllers of your project in DriveControlSuite either functionally by groups and
combining a group under a module, or organizing several drive controllers in corresponding modules based on their
distribution to different control cabinets.

1. Select your P1 project in the project tree > Context menu Create new module.

ð Your M2 module is created in the project tree.

2. Select your M2 module in the project tree > Context menu Create new drive controller.

ð Your T2 drive controller is created in the project tree.

3. Mark your T2 drive controller in the project tree.

4. Change to the project menu and click Project configuration.

5. Project the drive controller and specify the newly created module.

6. Repeat the steps for all other drive controllers and modules of your project.
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14.1.4 Projecting the module
Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the module opens.

2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the module.

2.2. Designation:
Give the module a unique name.

2.3. Version:
Version the module.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.

14.1.5 Projecting the project
Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the project opens.

2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the project.

2.2. Designation:
Give the project a unique name.

2.3. Version:
Version the project.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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14.2 Mapping the mechanical axis model
To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

14.2.1 Parameterizing the motor
You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. All additional data on the brake and
encoder is transferred at the same time.

Lean motor without encoder (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. You only have to parameterize the cable
length in use. Even the brake purging and engaging times are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:
Select the cable length of the power cable in use.

Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active.

Motor protection

The drive controller has an i²t model of the motor, a computational model for thermal monitoring of the motor. To activate
it and set up the protective function, configure the following settings (deviating from the presets): U10 = 2: Warning and
U11 = 1.00 s. This model can be used instead of or in addition to motor temperature monitoring.

14.2.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:

§ Define the axis model

§ Scale the axis

§ Parameterize the position and velocity window

§ Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force
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14.2.2.1 Define the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying positions, velocities, accelerations and jerk, select 0: User defined, rotational or 1: User defined,
translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying positions, velocities,
accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:
Define the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Define the interface to which the position encoder is connected.

6. I00 Position range:
Define whether the travel range of the axis is limited or endless (modulo).

7. If you select I00 = 1: Endless, parameterize a revolution length when you scale the axis.

Information

When you parameterize I05 Type of axis, you can either use selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (I09)
and the decimal places (I06) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s2, jerk in rad/s3.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s2, jerk in m/s3.

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder is used for position control as
standard.
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14.2.2.2 Scale the axis

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,
accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless for I00 Position range, enter the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
unit of measure.

7. Application-dependent parameter:
Use the polarity to specify the direction of interpretation between the axis movement and motor movement.

Information

A change to parameter I06 moves the decimal separator for all axis-specific position values! Ideally, define I06 before
parameterizing other position values and then check them.

If the axis receives set value specifications from a controller or follows the master values of a master, the resolution of
position values directly impacts the smooth operation of the axis. Therefore, you should define a sufficient number of
decimal places appropriate for your application.

Information

Parameter I297 Maximum speed position encoder must be parameterized according to your application case. If I297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places position, I09 Measure unit as well as
I07 Distance factor numerator position and I08 Distance factor denominator position or A585 Feed constant for CiA 402. If
you have made changes to one of the parameters listed, select I297 accordingly as well.
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14.2.2.3 Parameterize the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:
Parameterize a tolerance window for velocity tests.

3. I22 Target window:
Parameterize a tolerance window for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.

5. Application-dependent parameter:
Parameterize a tolerance window for lag tests.

14.2.2.4 Limiting the axis

As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration, jerk and torque/
force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling provides you with the Conversion of
position, velocities, accelerations, torque/force scaling calculator, which calculates the effects of changed motion variables
on the entire system. You can use the scaling calculator to enter values for motion variables of the motor, gear unit output
and axis in order to convert the values to all other locations in the axis model.

Limiting the position

To secure the travel range of the axis, you have the option to limit the permitted positions using a software or hardware
limit switch.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. I101 Source positive /limit switch, I102 Source negative /limit switch:
To limit the travel range of the axis via hardware limit switches, select the source of the digital signal that is used to
evaluate a limit switch at the positive or negative end of the travel range.

3.1. If a fieldbus is the source, select 2: Parameter.

3.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

4. I50 Software stop positive, I51 Software stop negative:
To limit the travel range of the axis via software limit switches, define the largest or smallest permitted position for
software position limiting.
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Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration
according to your application. The default values are designed for slow velocities without gear units.

1. Select the Motor wizard.

2. B83 v-max motor:
Determine the maximum permitted velocity of the motor.

3. Select the Axis model wizard > Axis: Scaling.

4. Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the output using the maximum permitted
velocity of the motor.

5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. I10 Maximal speed:
Define the maximum permitted velocity for the output.

7. I11 Maximal acceleration:
Define the maximum permitted acceleration for the output.

8. I16 Maximal jerk:
Define the maximum permitted jerk for the output.

9. I17 Quickstop deceleration: 
Define the desired quick stop deceleration for the output.

Limiting torque/force

As an option, you can limit the torque/force according to your application. The default values take into account the rated
operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. C03 Maximum positive torque/force, C05 Maximum negative torque/force:
Define the maximum permitted set torque/maximum permitted set force.

3. C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop and in case of drive-
controlled emergency stop SS1, SS1 and SS2.
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14.3 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection
of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configurations are transferred to the drive controllers.
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Saving a configuration

ü You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Select on which drive controllers you want to save the configuration.

3. Click Start action.

ð The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart is required: for example, after the configuration is
saved on the drive controller for the first time or when changes are made to the firmware or process data mapping.

Restarting a drive controller

ü You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety note with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð The selected drive controllers restart.

14.4 Testing the configuration
After you have transferred the configuration to the drive controller, first check your projected axis model and the
parameterized electrical and mechanical data for plausibility before continuing with the parameterization.
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14.4.1 Testing the configuration via DriveControlSuite
Jog control panel provides various commands for jog mode which you can use to test the configuration of your projected
axis model for plausibility.

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the jog control panel

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have successfully stored the configuration on the drive controller.

ü No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis gradually using
the Jog+, Jog-, Jog step+ and Jog step- buttons.

6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.
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14.4.2 Testing the configuration via the operating unit
You have connected the drive controller along with its accessories as described and would like to test the components in
the group for correct wiring and functionality. The standard parameterization enables an initial function test if you are
operating the drive controller together with a STOBER synchronous servo motor and an EnDat encoder. In this case, the
electronic nameplate of the motor is read out when the device starts and the accompanying data is transferred into the
drive controller.

14.4.2.1 Schematic test sequence

Schematic test sequence
The following illustration shows the schematic sequence of the wiring and function test.

Remedy
causes

Activate
local operation

Ready to switch on

Enable
drive controller

Move axis

Test end

Determine
causes

(E47, E49)

Single cause:
no enable signal
for application?

(E47, E49.x)

Switch on
power grid supply

Switch on
24 V supply

for drive controller

Switch on
24 V supply

for brake

Test start

Yes
Switch-on disabled?

(E48)

No

YesNo

Fig. 37: Schematic test sequence for wiring and function test
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14.4.2.2 Practical test sequence

DANGER!

Risk of fatal injury due to moving parts!

Motor shaft rotates during the wiring and function test described below!

▪ Clear the danger area before the test.

▪ Do not connect any downstream mechanical parts to the motor or gear unit until the test has finished.

▪ Make sure that components attached to the motor, such as feather keys or coupling elements, are sufficiently
secured against centrifugal forces.

Perform the individual steps in the specified order.

Preparing for the test

1. Switch on the 24 VDC supply of the brake.

2. Switch on the 24 VDC supply of the drive controller.

3. Switch on the power supply.

4. Optional: If you use the SR6 safety module, deactivate the STO safety function, such as by connecting STOa and STOb to
24 VDC and GND to the reference potential (terminal X12).

5. Optional: If you are using the SU6 or SY6 safety module, deactivate the STO safety function by deactivating the STO
safety function in the safe control word.

ð The drive controller either switches to the "ready to switch on" or "locked" state.

Performing the test

ü Drive controller is ready to switch on:

1. Activate local operation using the [Hand] button.

2. Enable the drive controller using the [I/O] button.

3. Rotate the motor axis using the left and right arrow buttons at the velocity and acceleration configured in parameter
I12.

ð You have correctly wired all components; the function test completed successfully.

ü Drive controller is locked (display = 1: Switch-on disable, parameter E48):

1. Determine the causes for the switch-on lockout and remedy them:
Parameter E49 outputs possible causes in code and parameter E47 shows them in plain text.

2. Then, carry out the test (see the section "Drive controller is ready to switch on").

Information

If the lack of enable signal for the CiA 402 application is the sole cause for the switch-on lockout, switch to local operation
directly and carry out the test (see the section "Drive controller is ready to switch on").

Finishing the test

1. Lock the drive controller using the [I/O] button.

2. Switch to normal operation using the [Hand] button.
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14.5 Preparing for a case of service
Back up your configuration to an SD card after completing commissioning in order to allow transfer of the configuration to
the replacement drive controller in case of service. For information on the SD cards that can be used, see X700: SD slot
[} 117].

For plain text messages and easy operation, we also recommend the optional display (option OP6).

14.6 Testing the safety configuration
Check the interfaces, limit values and reaction times of the safety functions. Document the test results using the scope
functions of DriveControlSuite, for example. Detailed information on the safety functions can be found in the manual for
the safety module.
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15 Communication
The following options are available for communicating with the SB6 drive controller:

§ Communication between drive controller and controller

• Fieldbus

• Terminals

§ Communication between drive controllers for synchronous operation

• SSI motion bus

§ Communication between drive controller and PC for commissioning, optimization and diagnostics

• Direct connection

• Fieldbus

The DriveControlSuite project configuration and commissioning software installed on the PC is able to handle multiple
direct connections simultaneously.

15.1 Direct connection
A direct connection is a network connection in which all nodes are in the same network.

In its simplest form, a direct connection is a point-to-point cable connection between the network interface of the PC
where DriveControlSuite is installed and the network interface of the drive controller. Switches or routers can also be used
in place of a simple network cable.

The IP address required for direct connection is either assigned automatically by DriveControlSuite or using DHCP, or it is
specified manually.

Requirements

Type of direct connection Requirements

Automatic The A166 parameter in DriveControlSuite must be set to 2: DHCP + DS6
for the direct connection to be established automatically. In addition,
the network adapter used on the PC side should be set to "Obtain IP
address automatically".

Manual If the IP address of the drive controller was specified manually, the
socket of the gateway device and the network connection of the PC
must have IP addresses from the same subnet.

Tab. 186: Requirements for a direct connection

Observe the requirements for communication (see Communication requirements [} 364]) and the information on
establishing a connection (see Establishing a connection [} 365]).

Virtual machines

If you want to connect STOBER drive controllers to DriveControlSuite from a virtual machine, pay attention to the
configuration information (see Configuring virtual machines [} 371]).
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15.1.1 Starting a drive controller in emergency operation
If you cannot establish a network connection to the drive controller via DriveControlSuite, DriveControlSuite cannot assign
a network address to the drive controller or the drive controller is not displayed in DriveControlSuite, you can use the S1
operating button or an empty SD card to start the drive controller in emergency operation.

Starting with S1 operating button

If the drive controller has a fixed IP address that does not match the subnet of the PC, press and hold the operating button
when switching on the 24 V supply until all 3 LEDs go out (approx. 3 s after switching on). The IP address is then assigned
either automatically by DriveControlSuite or via DHCP, regardless of the setting in A166. In this case, the operating button
acts as an override.

The S1 operating button is located on the bottom of the drive controller.

Starting with an SD card

If an SD card is inserted when the drive controller is started, it is started from this card. Any existing configuration in the
internal memory of the drive controller is ignored. If there is no configuration on the SD card or if it is invalid, the drive
controller starts in emergency operation. For drive controllers with firmware V 6.5-A or higher, the fixed IP address
192.168.3.2 and fixed subnet mask 255.255.255.0 are used for service interface X9 in emergency operation.

Reading out the internal configuration

If you want to read out the internal configuration, save a file with the information on the desired IP address, subnet mask
and address assignment to the SD card. The drive controller adopts these settings after reading the internal configuration
for interface X9. You can then establish a manual direct connection to the drive controller.

1. Create a text file with the file name ParaWr.cmd and the following content:
A164 = "192.168.3.2"

A165 = "255.255.255.0"

A166 = "0"

Make sure that each line, including the last, ends with a line break (CR LF).

2. Create the \command directory on the SD card.

3. Save the text file to the newly created directory on the SD card.

4. Adjust the IP address and subnet mask of your PC.

5. Establish a manual direct connection to the drive controller in DriveControlSuite.

15.2 SSI motion bus
Setting instructions for SSI encoders can be found in the attachment (see SSI encoders [} 357]).

For more detailed information on communication over SSI motion bus, refer to the Drive Based Synchronous application
manual (see Further information [} 399]).

15.3 Fieldbus
For detailed information about the fieldbus connection, refer to the corresponding manual (see Further information
[} 399]).
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16 Optimizing the control cascade
The following chapters describe the structure of the control cascade first as a basis, as well as the general procedure for
optimizing it. Then, you learn how you can check your control cascade based on a few parameters for nearly 80% of all
applications and, if necessary, optimize the pre-set values for your specific application case. Special cases are addressed at
the end of the chapter.

16.1 Structure of the control cascade
The control cascade triggers the appropriate electrical actuation of the motor for a requested movement. The structure of
the control cascade depends on the control mode set in B20.

The following graphic shows the control cascade using a motor with encoder in vector-controlled operation as an example.
The representation of the control cascade follows the signal course: Position controller > Velocity controller > Current
controller.

M
xset vset M/FsetPosition

controller
Velocity

controller
Current

controller

Current
measure-

ment

Load-independentLoad-dependent Load-dependent

Load-independent

Fig. 38: Structure of the control cascade

Position controller

The position controller is a P controller (proportional controller) with feedforward control. The settings for the position
controller are load-dependent.

The following applications use position control:

§ Drive Based applications for the following commands:

• MC_MoveAbsolute

• MC_MoveRelative

• MC_MoveAdditive

• MC_MoveVelocity

§ CiA 402 application in the following operating modes:

• Cyclic synchronous position mode

• Profile position mode

§ PROFIdrive application in the following application classes:

• Application class 3 (AC3)

§ Application-independent with position control in jog mode



STOBER 16 | Optimizing the control cascade
11

/2
02

4 
| 

ID
 4

43
34

0.
01

183

Velocity controller

The velocity controller is a PI controller (proportional-integral controller). The settings for the velocity controller are load-
dependent. Velocity control is always required for vector control.

Current controller

The current controller is a PID controller (proportional-integral-differential controller). The settings for the current
controller are load-independent. The current controller is always required for vector control.

16.2 General procedure
Before making changes to your control cascade, observe the following information on the general procedure for
optimization.

Defining the optimization goal

First, define the goal that you want to reach through optimization:

§ High dynamics

§ High energy efficiency

§ Positioning accuracy

§ Smooth operation

§ Minimum control difference

§ High velocity

Some goals can only be combined under certain conditions or are mutually exclusive.

Hardware components as possible limits of optimization

An optimal drive train always consists of a coordinated system of all hardware components (gear unit, motor, encoder,
drive controller and cable). Consequently, optimization depends not only on your parameter settings, but also on the
hardware components used.

Drive controller presets

If you use components from STOBER, all data is transmitted to the corresponding parameters when reading out the
electronic nameplate or upon selection of the motor from the motor database ─ eliminating the need for complex
parameterization of the motor, encoder and brake. These default values are carefully selected and checked, and generally
deliver good results. Only change the default values when necessary, taking the following points into consideration:

1. First, record the current behavior of your drive train with a scope image.

2. Carry out the optimization of your control cascade in the opposite order of the signal path: Current controller >
velocity controller > position controller, i.e. from the motor back to the set value specification. However, do not make
adjustments to the current controller if you are using components from STOBER.

3. If adjustments are necessary, only ever change one setting and then check every change with a scope image.
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16.3 Example project
The optimization described in the following chapters is based on the following general conditions and settings.

Specified goal

High dynamics with the highest possible velocity, but without the system overshooting.

System components

§ 6th generation drive controller

§ Synchronous servo motor with absolute encoder and electronic nameplate

§ DriveControlSuite commissioning software

§ Load supplied to the motor

Application and device control

§ Drive Based application

§ Drive Based device control

16.3.1 Scope settings
For the scope image at the beginning and after each adjustment, we recommend the settings described below to be able to
compare the different results with each other.

General settings

§ Sampling time: 250 µs

§ Pre-trigger: 5%

Channels

Using the Parameter selection and the associated picklists, define the relevant parameters for the scope image.

Trigger condition

§ Simple trigger

§ Source: Parameter E15 v-motor-encoder

§ Absolute value: Yes

§ Condition: Greater

§ Edge: Yes

§ Comparison value: 5.0 rpm
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16.3.2 Jog settings
During optimization, test each change using the Jog control panel with the following settings:

§ I26 Jog control mode:

• Optimization of the velocity controller: Select 0: Velocity control to receive pure velocity control without a higher-
level position controller with the Jog+ and Jog− bit.

• Optimization of the position controller: Select 1: Position control with the Jog step+ und Jog step− bit.

§ I14 Jog step:
Define the increment.

§ I12 Jog velocity:
Define the jog velocity.

§ I13 Jog acceleration:
For the jog acceleration, select a value that is higher than the velocity by a factor of 10.

§ I45 Jog deceleration:
For the jog deceleration, select a value that is higher than the velocity by a factor of 10.

§ I18 Jog jerk:
For the jog jerk, select a value that is higher than the acceleration by a factor of 10.
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16.4 Schematic sequence
The following graphic shows the schematic sequence for optimizing the control cascade. The specific steps that are required
depend on the control mode. The information on optimization assumes the following control modes:

§ B20 = 64: SSM - vector control for synchronous servo motors

§ B20 = 2: ASM - vector control for asynchronous motors

§ B20 = 32: LM - sensorless vector control for Lean motors

I25

I20

C32

C31

C34

C30
I26 = 0!

I26 = 1!

Drive train

Synchronous servo motor,
asynchronous motor Lean motor

Fig. 39: Schematic sequence of optimization based on relevant parameters

0 Default Lean motors settings ─ Estimating the speed

1 Velocity controller ─ Defining filters for the actual velocity

2 Velocity controller ─ Defining the proportional coefficient

3 Velocity controller ─ Defining the integral coefficient

4 Position controller ─ Defining the proportional coefficient

5 Position controller ─ Defining the feedforward control of the velocity controller
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16.5 Current controller ─ Notes
The current controller settings depend exclusively on the motor type, not on the load or application.

Do not make any changes to the current controller if you are using components from STOBER!

The data of a STOBER motor is part of the DriveControlSuite motor database as well as the electronic nameplate. This data
is transferred to the respective parameters during project configuration or when reading out the nameplate. All additional
data on the brake and encoder is transferred at the same time. These settings were calibrated in the STOBER test bay and
no longer need to be adjusted.

16.6 0: Default Lean motor settings ─ Speed estimation
When using a Lean motor of the LM series, two methods are available in DriveControlSuite for determining the speed. An
observer-based process is set by default in parameter B104 that is suitable for most applications. However, the specification
of the mass inertia ratio of load to motor in parameter C30 is crucial for this process.

Effects

By specifying the mass inertia ratio, the speed determination of the model adjusts to the real conditions of the machine.

Procedure

1. Work with the default value of B104 = 0: Robust.

2. In C30, enter the mass inertia ratio of load to motor based on the estimated mass inertia at the motor shaft.

Information

Only change the setting of B104 if either the mass inertia cannot be determined or the load occurring is changing rapidly.

Information

For C30, note that a deviation up to factor 2 only has a slight influence on the dynamics. If more is still needed, you can
optimize the value through a comparison with the actual velocity I88 during acceleration and braking.
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16.7 1: Velocity controller ─ Actual velocity filters
The following graphic shows the influence of the lowpass filter time constant on the velocity controller.

vset

vact

M/Fset

 

KP

Time

Reference

Time

Lowpass filter

PI controller

Fig. 40: Velocity controller ─ Filters for the actual velocity

The lowpass filter time constant for the actual velocity of the motor encoder is defined in C34.

Effects

C34 affects the smooth operation of the motor and the dynamics that can be achieved with the drive; as C34 increases,
smooth operation rises and the dynamics drop.

Furthermore, C34 also has a direct influence on the maximum possible coefficient, since a large filter time also requires a
large downtime.

Procedure

Select a value for C34 that is large enough to minimize the measurement and quantization noise, but is as small as possible
to avoid unnecessary downtime, since this makes the system unstable and reduces dynamics.

Guide values for C34 can be found in the following table.

Encoder model Encoder interface Guide value C34 [ms]

EBI 135 EnDat 2.2 digital 0.4 – 0.6

EBI 1135 EnDat 2.2 digital 0.4 – 0.6

ECI 119 EnDat 2.2 digital 0.4 – 0.6

ECI 1118-G1 EnDat 2.1 digital 1.4 – 1.8

ECI 1118-G2 EnDat 2.2 digital 0.4 – 0.6

ECI 1119 EnDat 2.2 digital 0.4 – 0.6

ECI 1319 EnDat 2.1 digital 1.2 – 1.8

ECN 1113 EnDat 2.1 digital 0.8 – 1.2

ECN 1123 EnDat 2.2 digital 0.2 – 0.4

ECN 1313 EnDat 2.1 digital 0.8 – 1.2

ECN 1313 EnDat 2.1 sin/cos 0.2 – 0.8

ECN 1325 EnDat 2.2 digital 0.0 – 0.2

EDM 35 HIPERFACE DSL 0.4 – 0.6

EDS 35 HIPERFACE DSL 0.4 – 0.6

EKM 36 HIPERFACE DSL 0.4 – 0.6

EKS 36 HIPERFACE DSL 0.4 – 0.6
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Encoder model Encoder interface Guide value C34 [ms]

EQI 1130 EnDat 2.1 digital 1.4 – 1.8

EQI 1131 EnDat 2.2 digital, EnDat 3 0.4 – 0.6

EQI 1329 EnDat 2.1 digital 1.2 – 1.8

EQI 1331 EnDat 2.1 digital 1.2 – 1.8

EQN 425 EnDat 2.1 0.8 – 1.2

EQN 425 SSI 0.8 – 1.2

EQN 1125 EnDat 2.1 digital 0.8 – 1.2

EQN 1125 EnDat 2.1 sin/cos 0.4 – 0.8

EQN 1135 EnDat 2.2 digital 0.2 – 0.4

EQN 1325 EnDat 2.1 digital 0.8 – 1.2

EQN 1325 EnDat 2.1 sin/cos 0.2 – 0.8

EQN 1337 EnDat 2.2 digital 0.0 – 0.2

Incremental; 1024 increments/revolution HTL/TTL 2.0

Incremental; 2048 increments/revolution HTL/TTL 1.4

Incremental; 4096 increments/revolution HTL/TTL 0.8

Resolver; 2 poles Analog 1.4 – 2.0

Resolver; 4 poles Analog 1.2 – 1.8

Resolver; 6 poles Analog 1.0 – 1.6

Resolver; 8 poles Analog 0.8 – 1.4

Tab. 187: Guide values for C34

In Lean motors, the value is automatically taken from the drive controller firmware during the initial coupling of the motor
and drive controller (prerequisite: B100 ≠ 0: User defined).

Scope image

Requirements:

§ I26 = 0: Velocity control

§ C34 = Guide value or value taken from firmware

Parameter for the scope image:

§ E06 V-reference motor

§ E15 v-motor-encoder
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16.8 2: Velocity controller ─ Proportional coefficient
The following graphic shows the influence of the proportional coefficient on the velocity controller.

:

K I

vact

vset

M/Fset

KP

KP

Reference

Lowpass filter

Time

Time

Integral

PI controller

Fig. 41: Velocity controller ─ Proportional coefficient

The proportional coefficient KP of the velocity controller can be defined in C31.

Effects

An adjustment of the P-share always has an effect on the I-share as well. The reason for this is the following dependency:

The integral coefficient KI of the velocity controller results from the proportional coefficient KP and reset time Ti 
(KI = KP ÷ Ti = C31 × C35 ÷ C32).

Procedure

1. Start with the default value for C31.

2. First, enter the value 0 ms for the reset time in C32 to deactivate the I-share initially.

3. Increase the value of C31 up to the stability limit.

4. Define the value of C31 approximately 10% below the stability limit.

Scope image

Requirements:

§ I26 = 0: Velocity control

§ C34 = Guide value or value taken from firmware

§ C32 = 0 ms

§ C31 = e.g. 10, 20, 50, 150 and 200%

Parameter for the scope image:

§ E06 V-reference motor

§ E15 v-motor-encoder
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Fig. 42: Scope ─ Proportional coefficient of the velocity controller (C31), default value

Green Set value

Brown Actual value with default value

Fig. 43: Scope ─ Proportional coefficient of the velocity controller (C31), continuous oscillations

Green Set value

Red Actual value that exhibits continuous oscillation upon reaching the stability limit
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Fig. 44: Scope ─ Proportional coefficient of the velocity controller (C31), optimized value

Green Set value

Yellow Actual value with optimized coefficient
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The zoom factor was increased for the following scope image to show overshooting based on additional values, which
devolves into continuous oscillations upon reaching the stability limit.

Fig. 45: Scope ─ Proportional coefficient of the velocity controller (C31), overshooting

Green Set value

Turquoise Actual value that shows brief overshooting

Yellow Actual value with optimized coefficient

Brown Actual value with default value

Pink Actual value that shows long overshooting with phase-out
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16.9 3: Velocity controller ─ Integral coefficient
The following graphic shows the influence of the integral coefficient on the velocity controller.

:

vset
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M/Fset

KP

KP

K I

PI controller

Lowpass filter

Reference
Integral

Time

Time

Fig. 46: Velocity controller ─ Integral coefficient

The integral coefficient KI of the velocity controller results from the proportional coefficient KP and reset time Ti 
(KI = KP ÷ Ti = C31 × C35 ÷ C32).

Effects

Since the value of C31 was already optimized in the previous step, the integral coefficient is optimized in this step by
adjusting the reset time in C32.

Procedure

1. Start with the default value for C32.

2. Reduce the value of C32 in order to recover more quickly. In this process, note that if C32 ≤ 1 ms, the I-share is
deactivated.

3. Increase the value of C32 up to the stability limit.

4. Define the value of C32 approximately 10% above the stability limit.

Scope image

Requirements:

§ I26 = 0: Velocity control

§ C34 = Guide value or value taken from firmware

§ C31 = Already optimized value

§ C32 = e.g. 0, 5, 10 and 50 ms

Parameter for the scope image:

§ E06 V-reference motor

§ E15 v-motor-encoder
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Fig. 47: Scope ─ Integral coefficient of the velocity controller (C32)

Green Set value

Red Actual value that exhibits overshooting

Yellow Actual value with optimized coefficient

Brown Actual value with default value

Turquoise Actual value with deactivated coefficient (≤ 1)

16.10 Velocity controller ─ Summary
In summary, the following conclusions can be drawn for the optimization of the velocity controller:

§ Simple encoders must be filtered more heavily.

§ The maximum possible coefficient is lower with heavier filtering.

§ The default coefficient is sufficient in simpler applications.

§ You only require a higher coefficient in case of higher dynamics.

§ Without the integral coefficient, you do not maintain any stationary accuracy, since the set velocity is not reached.
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16.11 4: Position controller ─ Proportional coefficient
The following graphic shows the influence of the proportional coefficient on the position controller.

vset    

∆x

xset

vset

xset

xact

KP

Feedforward control

P controller

Fig. 48: Position controller ─ Proportional coefficient

The proportional coefficient KP of the position controller can be defined in I20.

Effects

A higher coefficient produces a lower following error, but the system becomes more sensitive.

Procedure

1. Start with the default value for I20.

2. Increase the value of I20 up to the stability limit.

3. Define the value of I20 approximately 10% below the stability limit.

Scope image

Prerequisites:

§ I26 = 1: Position control

§ C34 = Guide value or value taken from firmware

§ C31 = Already optimized value

§ C32 = Already optimized value

§ I20 = e.g. 10, 20, and 50

Parameter for the scope image:

§ I96 Reference position

§ I80 Current position

§ I84 Following error

§ E06 V-reference motor

§ E15 v-motor-encoder
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16.12 5: Position controller ─ Velocity controller feedforward
control

The following graphic shows the influence of the feedforward control on the position controller.

xact

xset

∆x

xset

vset

vset    

KP

P controller

Feedforward control

Fig. 49: Position controller ─ Feedforward control of the velocity controller

In case of external controller-generated or internal drive-generated feedforward control, the set velocity is also calculated
in addition to the set position. In I25, you can define how much of that is directly communicated to the velocity controller.

Effects

Feedforward control reduces the load of the position controller and reduces the following error; however, stronger
feedforward control makes the system more sensitive.

Procedure

1. Start with the default value of 95% for I25.

2. Reduce the value of I25 if the system is oscillating.

Scope image

Requirements:

§ I26 = 1: Position control

§ C34 = Guide value or value taken from firmware

§ C31 = Already optimized value

§ C32 = Already optimized value

§ I20 = Already optimized value

§ I25 = e.g. 50 and 95%

Parameter for the scope image:

§ I96 Reference position

§ I80 Current position

§ I84 Following error

§ E06 V-reference motor

§ E15 v-motor-encoder
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16.13 Position controller ─ Summary
In summary, the following conclusions can be drawn for the optimization of the position controller:

§ If the velocity controller is optimized, only small adjustments are required for the position controller.

16.14 Special cases
In the cases described below, additional parameters are relevant for optimization.

16.14.1 Current controller ─ Motor reaches saturation
Synchronous servo motors show a saturation effect at high currents.

Effects

Upon reaching the saturation limits, a higher motor current no longer generates higher field strength and it begins to
fluctuate if the current continues to increase.

Procedure

1. Carry out the action B41 Calibrate motor.

ð The electrical data of the motor is calibrated and the coefficients of the saturation characteristic are defined (B60).

2. Activate current control tracking in B59.

ð The controller coefficients are tracked according to the saturation characteristic of the motor.

Scope image

Parameter for the scope image:

§ E166 Iq-ref

§ E93 Iq

Fig. 50: Scope ─ Motor reaches saturation without tracking (B59)

Green Set current

Red Actual current
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Fig. 51: Scope ─ Motor reaches saturation with tracking (B59)

Green Set current

Red Actual current

16.14.2 Velocity controller ─ High set torque
C36 Reference torque/force low pass:

If the set torque becomes very high, such as in case of maximum utilization of the drive controller, the set torque can be
filtered using this parameter. The filter prevents the overshooting of the torque and thus the occurrence of overcurrents.
The effect of C36 is defined using C37.

16.14.3 Position controller ─ Friction or play
I23 Position controller deadband:

To prevent control oscillations due to friction or play in the mechanics, the position control can be deactivated in a narrow
range using this parameter.

16.14.4 Position controller ─ Poor resolution
C33 Lowpass reference speed:

Using this parameter, the set velocity can be smoothed if the calculation of the set or actual position is too rough due to
one of the following conditions:

§ In case of controller-based applications with poor or low quantization of the set value

§ In case of drive-based applications with poor resolution of the master encoder
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17 Brake
The following chapter describes the basic brake settings using the DriveControlSuite commissioning software.

Gravity-loaded axis with brake

Information

If you use a gravity-loaded axis with a brake, always switch off the drive using a controlled stop, e.g. quick stop. This
prevents the load from dropping until the brake is fully engaged.

For more detailed information on the application, refer to the corresponding manual (see Further information [} 399]).

17.1 Activating the brake
You activate the brakes in parameter F00.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active if you are operating the motor in a regulated control mode and if the torque is to be saved at the time
that the brake engages. In this case, the saved torque is restored before releasing the brakes. Select this option for
gravity-loaded axes, for example.
However, select 2: Do not save torque/force if only motor magnetization is to be restored when the brakes are
released.

4. If necessary, store the release and engaging times of the brakes (see Brake release time and brake engaging time
[} 212]).
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17.2 Calibrate brake
You can calibrate the release and engaging times for brakes with unknown release and engaging times.

For more detailed information on the requirements as well as the exact procedure, see Calibrating the brake [} 213].

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

ü There is an online connection between DriveControlSuite and drive controllers.

ü The drive controller is ready to switch on (E48 = 2: Ready for switch-on).

ü The brake is activated.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard > Test brake.

3. B306 Permitted direction for actions of the brake:
Define the permitted travel direction. Calibration only takes place in one travel direction. If both directions of rotation
are permitted, travel proceeds in the positive direction.

4. B307 Standstill window brake test:
Enter the angle of rotation that the drive evaluates as a standstill.

5. Select the Brake wizard > Calibrate brake.

6. Click Calibrate release/engaging time for brake.

ð Calibration of the brake is executed.

ð The determined times are stored in F04 and F05.

ð F96[1] indicates the progress.

ð F96[2] outputs the result of the action.

7. Afterwards, save the determined values in non-volatile memory (A00).



17 | Brake STOBER

202

11
/2

02
4 

| 
ID

 4
43

34
0.

01

17.3 Testing a functional brake
Using the brake test, check whether the brake can still apply the required holding torque or holding force.

For more information on the test and calculation of test torques, see Brake test [} 215] and Torque calculation [} 216].

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the closed brake is loaded with a specified test torque or a specified test force. If the test torque or test
force exceeds the holding torque or holding force of the brake, this results in movement of the axis. This can cause a
gravity-loaded vertical axis to drop.

▪ Make sure that safe movement is possible.

ü There is an online connection between DriveControlSuite and drive controllers.

ü The drive controller is ready to switch on (E48 = 2: Ready for switch-on).

ü The brake is activated.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard > Test brake.

3. B304 Positive torque/force limit for brake test:
Enter the test torque or test force that that brake must hold in case of a positive direction of rotation.

4. B305 Negative torque/force limit for brake test:
Enter the test torque or test force that that brake must hold in case of a negative direction of rotation.

5. E65 Current maximum positive torque/force:
Make sure that the limit in the drive controller permits the value stored in B304.

6. E66 Current maximum negative torque/force:
Make sure that the limit in the drive controller permits the value stored in B305.

7. B306 Permitted direction for actions of the brake:
Define the permitted travel direction. If both directions of rotation are permitted, travel first proceeds in the positive
direction.

8. B307 Standstill window brake test:
Enter the permitted standstill window.

9. Click on Test brake.

ð The brake test is executed.

ð B300[1] indicates the progress.

ð B300[2] outputs the result of the action.
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17.4 Bedding in the brake
By bedding in the brake, any deposits on the friction surface are removed that can negatively influence the holding function
of the brake. For more information, see Bedding in the brake [} 218].

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

ü There is an online connection between DriveControlSuite and drive controllers.

ü The drive controller is ready to switch on (E48 = 2: Ready for switch-on).

ü The brake is activated.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard > Bend in brake.

3. B306 Permitted direction for actions of the brake:
Define the permitted travel direction. If both directions of rotation are permitted, travel first proceeds in the positive
direction.

4. B308 Number of intervals for grind:
Enter how often the brake is to engage when rotating in one direction.

5. B309 Number of cycles for grind:
Enter how often the drive is to bed in in any direction.

6. Click on Bed in brake.

ð The bedding in of the brake is executed.

ð B301[1] indicates the progress.

ð B301[2] outputs the result of the action.
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17.5 More about the brake?
The following chapters summarize the important terms and settings.

17.5.1 Direct and indirect brake connection
The SB6 drive controller provides the option of directly connecting 24 VDC brakes with a current draw of up to 2.5 A. Brakes
with a different supply voltage or higher current draw can be connected indirectly, e.g. through a contactor.

You have the following options for connection:

§ Directly to X5 (with or without monitoring)

§ Indirectly to X5 (with or without monitoring)

You can monitor the brake using parameter F105.

17.5.2 Release override
You have the option of releasing the brakes using an override function when the power unit is deactivated. The release
override is only available with internal brake control. You define the release override in parameter F06 (signal: F07).

Please note that the drive cannot be enabled when the release override is active.

When the drive is enabled, the release override cannot be executed; this is to avoid disturbing the automatic brake control
and the associated processes.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

If you use the release override, the brake is released when the power unit is deactivated. This can cause a gravity-loaded
axis to fall in an uncontrolled manner.

▪ Only use the release override for gravity-free axes or secure them externally.
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17.5.3 Internal and external brake control
With internal brake control, the drive controller controls the brakes and the release and engaging times are taken into
account. For controller-based applications, you have the option of switching from internal (automatic) brake control
through the drive controller to external brake control through a controller.

Overview

The following diagrams show the brake control, including relevant parameters from an application perspective.

0

F108F06

A180.6

Drive Based

0: Low
1: High
2: Parameter
3: DI1
4: DI1 inverted
...

0: Internal
1: External F07[0]

OpenBrakeOverride

F07[1]
F07[2]

Brake control external

F101[1]
F101[2]

F101[0]

Fig. 52: Brake control in Drive Based applications

0

F108F06

A515.14

A515.14

F108

0

CiA 402

0: Low
1: High
2: Parameter
3: DI1
4: DI1 inverted
...

0: Internal
1: External F07[0]

OpenBrakeOverride

F07[1]
F07[2]

Brake control external

F101[1]
F101[2]

F101[0]1: External
0: Internal

Fig. 53: Brake control in CiA 402 applications

0

F108F06

M515.12

M515.12

F108

0

PROFIdrive

0: Low
1: High
2: Parameter
3: DI1
4: DI1 inverted
...

0: Internal
1: External F07[0]

OpenBrakeOverride

F07[1]
F07[2]

Brake control external

F101[1]
F101[2]

F101[0]1: External
0: Internal

Fig. 54: Brake control in PROFIdrive applications
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17.5.3.1 Internal brake control

With internal brake control, the drive controller controls the brakes and the release and engaging times are taken into
account. You activate the internal brake control in parameter F00.

Information

To protect the holding brake, avoid engaging a brake when an axis is moving:

▪ Avoid uncontrolled stopping of a moving axis.

▪ If you would like to deactivate the enable signal for a moving axis, select A44 = 1: Active (default) so that a quick stop
is carried out with Enable-off.

▪ As a fault reaction, always select a quick stop (A29 = 1: Active, default) or emergency braking (U30 = 1: Active).

17.5.3.1.1 Operation with 1 brake

After Enable-on, the brake releases along with the first command and remains released until one of the following events
occurs:

§ Event with fault reaction:

• Power unit is locked

• Quick stop (brake only engages at the end of the quick stop)

• Emergency braking

§ Enable-off

§ Quick stop signal (brake only engages at the end of the quick stop)

§ Brake is engaged at the end of the motion command (Drive Based applications: J27/J53; parameter depends on
selected operating mode):

• 1: MC_MoveAbsolute

• 2: MC_MoveRelative

• 3: MC_MoveAdditive

• 5: MC_Stop

• 6: MC_Home (requirement: I30 ≠ 5: Define home)

• 11: MC_Halt

The brake can be released by means of a release override. This must be defined in parameter F06 (signal: F07).

The brake can be monitored for short-circuits and cable breaks. Monitoring can be set or deactivated in F105.



STOBER 17 | Brake
11

/2
02

4 
| 

ID
 4

43
34

0.
01

207

17.5.3.1.2 Internal brake control based on control mode

The following chapters show the brake control depending on the control mode (B20) for 1 brake with internal brake control
through the drive controller.

17.5.3.1.2.1 B20 = 0 or 1

Terminal = 0

Engaged

F04

Terminal = 1

Released

F05

Terminal = 0

Engaged

t

t

StandstillF0
3

Motion

F0
2

Standstill

v

Fig. 55: Brake control for control mode B20 = 0: ASM - V/f-control or 1: ASM - V/f-slip compensated

In these control modes for asynchronous motors without a motor encoder, the axis is controlled to move within the release
time F04.

Here, F02 is the velocity of the asynchronous motor that is built up during the release time F04. F03 is the velocity starting
from which the brakes are controlled to engage.

During the release process, a set acceleration calculated from the velocity and release time takes effect (F02, F04). During
the engaging process, a set deceleration calculated from the velocity and engaging time takes effect (F03, F05).
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17.5.3.1.2.2 B20 = 2

Terminal = 0

Engaged Engaged

Terminal = 0

F05F04

Released

Terminal = 1

Standstill

Motion

Standstill

M/F

F00 = 1
F102 + F103

F00 = 2
F102

E170

Magnetization current100%

0%

I42

B27

B2
5

t

t

t

t

I

v

Fig. 56: Brake control for control mode B20 = 2: ASM - vector control

In this control mode for asynchronous motors with a motor encoder, the axis is controlled to move after the release time
F04 has expired.

In the motion block and command operating modes, you can define a wait time for the brake to engage at the end of the
motion command in parameter I42 (J27, J53). When this is done, multiple motion commands can be executed in succession
without interruption from the brake engaging.

For specification of torque/force, E170 is the currently required set torque or the currently required set force M/Fset of the
motor control (limit: E65, E66).

In F102, define a static feedforward control for torque/force for the velocity controller if you would like to set a base load
for gravity-loaded axes. Depending on the boundary conditions of the machine, it may make sense to use different settings.
For commissioning recommendations for gravity-loaded axes, see Special case of load changes when the power unit is
switched off [} 219].

With the setting F00 = 1: Active, the torque or force for the next brake release process (F103) is determined automatically
and stored in non-volatile memory. The torque or force is not saved if F00 = 2: Do not save torque/force.

F103 is determined only for steady-state control and a completely released brake (F09). F103 is determined if the actual
velocity of the motor encoder is less than the velocity window (|E15| < |C40|).

The hold magnetization B25 ensures that the motor is still supplied with current when the brake is engaged. The
magnetization is reduced as soon as the motor has come to a standstill and the wait time B27 has expired.

B25 influences the thermal machine utilization. The thermal machine utilization is reduced as B25 decreases, but the
reaction time simultaneously increases as the brakes are released.
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17.5.3.1.2.3 B20 = 3

Terminal = 0

Engaged

Terminal = 1

Released

F04 F05

Terminal = 0

Engaged

t

t

Standstill

Motion

I

100%

0%

Magnetization current

B27

B2
5

t

StandstillF0
2

F0
3

v

Fig. 57: Brake control for control mode B20 = 3: ASM - sensorless vector control

In this control mode for asynchronous motors without a motor encoder, the axis is controlled to move within the release
time F04.

Here, F02 is the velocity of the asynchronous motor that is built up during the release time F04. F03 is the velocity starting
from which the brakes are controlled to engage.

During the release process, a set acceleration calculated from the velocity and release time takes effect (F02, F04). During
the engaging process, a set deceleration calculated from the velocity and engaging time takes effect (F03, F05).

The hold magnetization B25 ensures that the motor is still supplied with current when the brake is engaged. The
magnetization is reduced as soon as the motor velocity has undershot the brake-engaging velocity F03 and the wait time
B27 has expired.

B25 influences the thermal machine utilization. The thermal machine utilization is reduced as B25 decreases, but the
reaction time simultaneously increases as the brakes are released.
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17.5.3.1.2.4 B20 = 32, 48, 64, or 70

Terminal = 0

Engaged Engaged

Terminal = 0

F05F04

Released

Terminal = 1

Standstill

Motion

Standstill

M/F

F00 = 1
F102 + F103

F00 = 2
F102

E170

I42
t

t

t

t

v

Fig. 58: Brake control for control mode B20 = 32: LM - sensorless vector control, 48: SSM-vector control incremental
encoder, 64: SSM - vector control or 70: SLM - vector control

In these control modes for synchronous servo motors or synchronous linear motors with a motor encoder or Lean motors
with sensorless vector control, the axis is controlled to move after the release time F04 has expired.

In the motion block and command operating modes, you can define a wait time for the brake to engage at the end of the
motion command in parameter I42 (J27, J53). When this is done, multiple motion commands can be executed in succession
without interruption from the brake engaging.

For specification of torque/force, E170 is the currently required set torque or the currently required set force M/Fset of the
motor control (limit: E65, E66).

In F102, define a static feedforward control for torque/force for the velocity controller if you would like to set a base load
for gravity-loaded axes. Depending on the boundary conditions of the machine, it may make sense to use different settings.
For commissioning recommendations for gravity-loaded axes, see Special case of load changes when the power unit is
switched off [} 219].

With the setting F00 = 1: Active, the torque or force for the next brake release process (F103) is determined automatically
and stored in non-volatile memory. The torque or force is not saved if F00 = 2: Do not save torque/force.

F103 is determined only for steady-state control and a completely released brake (F09). F103 is determined if the actual
velocity of the motor encoder is less than the velocity window (|E15| < |C40|).

Commutation finding process using Wake and Shake in combination with a brake

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

Gravity-loaded axes can sink during a commutation finding process using Wake and Shake because the brake for the
commutation finding process has to be released.

▪ Use the 48: SSM-vector control incremental encoder and 70: SLM - vector control control modes in combination with
a commutation finding process using Wake and Shake only for axes without a gravity load.

▪ For gravity-loaded axes, use motors with an absolute encoder.

For more information on commutation finding via Wake and Shake, see Commutation finding [} 360].
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17.5.3.2 External brake control in V 6.5-L or later

For the CiA 402 or PROFIdrive application, parameter F108 offers the option of switching from internal (automatic) brake
control through the drive controller to external brake control through a controller.

WARNING!

Injury to persons and material damage due to axis movement!

For external brake control, the brake does not engage automatically in the event of faults or Enable-off. For Enable-on or
the start of a motion, the brake is not automatically released. The external brake control is independent of the device state
and motion core through the controller.

▪ Guarantee a suitable process in the controller and take suitable measures to ensure safety.

▪ When releasing the brake, also take into account the motor-side requirements (e.g. required time for building up
magnetization in the case of asynchronous motors or for position determination in the case of Lean motors).

The controller can check whether the brakes are engaged or released (E201, bits 3 and 4) before set values for position and
velocity are specified.

For external brake control, bit 14 of parameter A515 is the source of F101[0] in the CiA 402 application and bit 12 of M515
in the PROFIdrive application (prerequisite: F108 = 1: External (plc)).
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17.5.4 Brake release time and brake engaging time
The release time of the connected brake is defined in parameter F04 and the engaging time in parameter F05:

§ F04[0]: Release time of the brake

§ F05[0]: Engaging time of the brake

When a movement is started, the movement and status signals are delayed by the time F04 to prevent movement against a
brake that is not yet fully open.

When the brake engages, the control still remains active for the time F05 to prevent a gravity-loaded axis from sinking. For
STO, the brake engages immediately. The behavior for deactivation of the enable signal can be defined with A44 (brake
engages immediately or after a quick stop).

Motors with an electronic nameplate

In motors with an electronic nameplate, the values during initial coupling of the motor and drive controller or when the
action B06 is started are taken over from the electronic nameplate (prerequisite: B04 = 64: Active).

Sources for the values from the electronic nameplate:

§ R50: nameplate release time of the motor brake

§ R51: nameplate engaging time of the motor brake

Motors without an electronic nameplate

Depending on the connection type, you have to calculate the release time and engaging time of the brake differently.

For a direct connection of the brake, take into account a safety factor of 1.3 for the release and engaging times when
transferring the values to the drive controller.

Guide values:

§ F04 = 1.3 × t2B

§ F05 = 1.3 × t1B

For an indirect connection of the brake, e.g. through a contactor, take into account 1.2 × the switching time of the
contactor in addition to the guide value for direct connection for both the release time and engaging time.

If you do not know the release time and engaging time of the brake, you can calibrate these using the action F96.
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17.5.5 Time between 2 release processes

Information

The time between two brake release processes must be at least 1 s. If this is not observed, the 2nd release process will be
delayed.

1 s

Release time (F04) Engaging time (F05)

Brake engaged (F08)

Deceleration

Release
brake

Engage
brake

Brake released (F09)

Release
brake

t

Fig. 59: Minimum time between 2 release processes for the brake

17.5.6 Calibrating the brake
The release and engaging times of the brake can be calibrated using the action F96. This action is not required for motors
with an electronic nameplate because these values are taken over from the electronic nameplate during initial coupling of
the motor for the drive controller.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

Prerequisites

The action F96 is only available in the following control modes (B20):

§ 2: ASM - vector control

§ 3: ASM - sensorless vector control

§ 32: LM - sensorless vector control

§ 48: SSM-vector control incremental encoder

§ 64: SSM - vector control

§ 70: SLM - vector control
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F96 can be carried out also for loaded axes. In this case, the velocity controller should be optimized and the load must not
be more than 2/3 of the maximum torque or force currently permitted (E65, E66).

Required parameters

Define the permitted direction of motion for calibrating the brake in parameter B306, the standstill window in parameter
B307.

The travel range with unloaded axis is approx. 2 motor revolutions (synchronous linear motors: approx. 2 m). To determine
the travel path exactly, please include the gear unit and feed in the calculation.

Sequence of the action

During the action, the axis rotates at a fixed set speed of 20 rpm (set velocity for synchronous linear motors: 2 m/min).
Initially, for a released brake, a measurement run is carried out for the duration of 1 s. Then the axis moves against the
engaging brake. After detection of the brake engaging (timeout 2 s), the axis stops. This is followed by a standstill of 2 s
(recovery phase). Then the axis moves against the releasing brake. After detection of the brake release (timeout 2 s), the
axis continues moving for 0.5 s and then stops.

The determined times are stored in F04 and F05:

§ F04[0]: Release time of the brake

§ F05[0]: Engaging time of the brake

Saving values

For the measured values to be saved in non-volatile memory, the action A00 has to be carried out after this.

Alternatively, the action B06 can be used to retrieve the values from the electronic nameplate, provided that it contains the
brake data.

Results

After the action F96 is started, the progress can be observed in parameter F96[1], and after the action is completed, F96[2]
can be used to call up the results of calibrating.

The action F96 evaluates the measured time with the safety factor of 1.2. This means that the values entered in F04 and
F05 are 1.2 times greater than the actually measured values.
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17.5.7 Brake test
The action B300 Test brake checks whether the brake can still apply the required holding torque or holding force.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the closed brake is loaded with a specified test torque or a specified test force. If the test torque or test
force exceeds the holding torque or holding force of the brake, this results in movement of the axis. This can cause a
gravity-loaded vertical axis to drop.

▪ Make sure that safe movement is possible.

Requirements

The action B300 requires a position encoder and is permitted only in the following control modes (B20):

§ 2: ASM - vector control

§ 32: LM - sensorless vector control

§ 48: SSM-vector control incremental encoder

§ 64: SSM - vector control

§ 70: SLM - vector control

Required parameters

Enter the test torque or test force in the parameters B304 and B305:

§ B304[0]: Positive set torque/positive set force for the brake

§ B305[0]: Negative set torque/negative set force for the brake

Define the permitted travel direction in B306. If both directions of rotation are permitted, travel first proceeds in the
positive direction. Enter the angle of rotation of the motor that the drive evaluates as a standstill in B307.

To define the test torques or test forces, note that the motor is limited to the values in C03 and C05. If larger values are
entered in B304 and B305, they cannot be achieved. In addition, make sure that no device-specific limitations take effect.
To do so, check the parameters E65 and E66 during the brake test.

Travel path for brake test

§ Synchronous servo motors, Lean motors and asynchronous motors: If the brake can hold the test torque, then the
maximum travel path is 0.125 motor revolutions.

§ Synchronous linear motors: If the brake can hold the test force, then the maximum travel path is 0.8 mm.

Sequence of the action

If the brake is released, then the encoder is tested first. For the encoder test, the motor rotates at approximately 60 rpm at
a maximum of 45° in both directions of rotation. Then the brake engages and a parameterizable test torque or test force is
applied to the drive in each permitted direction of rotation. If the drive detects motion, then the brake was unable to apply
the required holding torque or holding force and the test has failed.

Results

After the action B300 is started, the progress can be observed in parameter B300[1], and after the action is completed,
B300[2] can be used to call up the test results.
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17.5.8 Torque calculation
In the following chapters, you will find information for calculating the torques that you have to enter in B304 and B305 for
the brake test.

17.5.8.1 Torques for synchronous servo motors

To calculate the torques, you need the following values:

§ MB: Select the braking torque that you have designed and that is required for your application. M1Bstat

§ M0: Stall torque

§ I0: Stall current

§ I2N,PU: Nominal output current of the drive controller

In the first step, calculate the ratio of torques as a percentage:

= ´B
 

0

M
K 100 %

M

In the next step, determine the current for MB:

I = I0 × K

Compare I to I2N,PU of the drive controller:

If I ≤ 2 × I2N,PU, then:
B304 = K and B305 = −K

If I > 2 × I2N,PU, then the drive controller cannot generate the test torque that you have designed.

Example

§ MB = 10 Nm

§ M0 = 6.6 Nm

§ I0 = 4.43 A

§ I2N,PU = 6 A

= ´ =  
10 Nm

K 100 % 151%
6,6 Nm

I = 4.43 A × 151% = 6.69 A

I2N,PU × 2 = 12 A

6.69 A < 12 A

Results: B304 = 151% and B305 = −151%
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17.5.8.2 Torques for asynchronous motors

To calculate the torques, you need the following values:

§ MB: Select the braking torque that you have designed and that is required for your application. Alternatively, perform a
calculation with the nominal braking torque of the motor brake MN,B

§ MN: Nominal torque of the motor

§ Mk: Breakdown torque of the motor

§ I2N,PU: Nominal output current of the drive controller

§ Id,ref (E171): Magnetization-generating reference current in the d/q coordinate system

§ Iq,ref (E172): Torque/force-generating reference current in the d/q coordinate system

To obtain the correct values from E171 and E172, complete the project configuration of the motor, transfer the project to
the drive controller and save it. Then read out the values in online operation.

In the first step, calculate the ratio of torques as a percentage:

= ´B
 

N

M
K 100 %

M

In the next step, determine the current for MB:

= + ´d,ref q,ref
² ²I I (K I )

Compare I to I2N,PU of the drive controller:

If I ≤ 1.8 × I2N,PU, then:
B304 = K and B305 = −K

If I > 1.8 × I2N,PU, then the drive controller cannot generate the test torque that you have designed.

Check whether the motor can apply the required test torque:

Mk/MB > 1

Example

§ MB = 10 Nm

§ MN = 5.12 Nm

§ Mk = 11.8 Nm

§ I2N,PU = 2.3 A

§ Id,ref = 1.383 A

§ Iq,ref = 1.581 A

= ´ =  
10 Nm

K 100 % 195 %
5,12 Nm

    
² ²I (1,383 A) (195 % 1,581A) 3,38 A= + ´ =

I2N,PU × 1.8 = 4.14 A

3.38 A < 4.14 A

Mk/MB = 1.18

1.18 > 1

Results: B304 = 195% and B305 = −195%
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17.5.9 Bedding in the brake
For the actions B301 Grind brake and B302 Brake 2 grind, the brake repeatedly engages for approximately 0.7 s and then is
released for approximately 0.7 s while the motor rotates at approximately 20 rpm. This grinds off any deposits on the
friction surface that can negatively influence the holding function of the brake.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

Required parameters

You can define the following parameters:

§ How often the brake engages while rotating in one direction (B308)

§ How often the drive should rotate in each direction (B309)

§ Whether a direction of rotation is blocked (B306)

Set speed/velocity and travel range

§ Synchronous servo motors, Lean motors and asynchronous motors:

• Fixed set speed: 20 rpm

• Travel range: B308 × 0.5 motor revolutions

§ Synchronous linear motors:

• Fixed set velocity: 20 m/min

• Travel range: B308 × 0.5 m

Results

After the action is started, the progress can be observed in parameter B301[1]. After the action is completed, the result can
be called up using B301[2].
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17.5.10 Brake connection as digital output
Terminal X5 is used for the brake connection. Alternatively, terminals X5 and X8 can be used as digital outputs.

The 24 VDC supply must be guaranteed via terminal X300. Furthermore, the setting for brake control must be deactivated
(F00 = 0: Inactive).

In DriveControlSuite, you can define the source of the digital signals via the parameters F59 and F60 (Terminals wizard >
Brake connection as digital output). The status is displayed in parameter E27, bit 14 and bit 15.

Information

By default, parameter A900 is stored as the source so that the output is switched on when Enable-on is activated. This
serves to protect any connected brake.

When using a brake connection as a digital output, it is not monitored and the switch limit at 1 Hz is not active.

17.5.11 Special case of load changes when the power unit is switched off
Depending on the boundary conditions of the machine, it may make sense to use different settings.

Recommendation for commissioning with gravity-loaded axes

If load changes occur only when the power unit is switched on, leave the presets.

On the other hand, if load changes also occur when the power unit is switched off, reduce the correcting process when the
brakes are released:

1. F00 Brake:
Select 2: Do not save torque/force to save F103 only in volatile memory.

2. F102 Torque/force feed forward:
Enter the determined value for the base load so that only the load difference needs to be adjusted when the load
changes.

3. Reduce the correcting process when releasing the brakes by optimizing the velocity controller.

Determining the base load

1. F102 Torque/force feed forward:
Set the value to 0.0%.

2. Load the axis with the base load.

3. Select the Jog control panel wizard.

4. Enable the axis and let it stand in one position with released brakes in active position control.

5. Determine a stable value for E02 using a scope image; this value corresponds to the base load.

6. Select the Jog control panel wizard.

7. Deactivate the enable signal of the axis.

8. F102 Torque/force feed forward:
Enter the determined base load.

9. A00 Save values:
Save the value in non-volatile memory.
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18 Predictive Maintenance
Predictive Maintenance (PMR) in the context of Industry 4.0 enables a machine to predict and signal the optimal time when
components should be serviced or replaced.

Especially in industrial automation technology, geared motors are system-relevant components and therefore very
important for predictive analysis. One way to infer the service life of a geared motor is based on the loads to which the gear
unit is subjected during its lifetime.

The Predictive Maintenance function in the drive controller monitors your connected geared motor. Its life performance is
calculated using a model-based analysis procedure and mapped in parameters. These parameters can be displayed via the
higher-level controller or in the DriveControlSuite commissioning software. This allows you to plan maintenance optimally
and proactively. The solution includes 3 essential components. The load matrix is a solid data base for recording the real-
world load situations of your machine and improving quality and economic efficiency. The life performance indicator is the
value for the calculated life performance of the geared motor. The recommendation to replace the geared motor can be
displayed in DriveControlSuite and is also provided to the controller as a parameter that can be read out.

Predictive Maintenance is automatically active for geared motors with an electronic nameplate as of production date
04/2022. For geared motors without an electronic nameplate or for older geared motors, monitoring can be activated
manually in the DriveControlSuite commissioning software by using a wizard (V 6.5-G and later and associated firmware in
V 6.5-G and later).

Your advantages at a glance

§ Prognosis of the optimal time for maintenance

§ Extension of the maintenance intervals

§ Reduction of spare part inventories through controlled procurement

§ Service concepts

Predictive Maintenance requires no additional external sensors, no additional wiring and no additional components.

18.1 Legal disclaimer
As of 2022 in DriveControlSuite in V 6.5-G or later, functions that estimate the aging and wear of the components used have
been implemented in our drive systems.

The estimates are used to make various kinds of predictions to provide support for decisions about preventative
replacement. This computer-based support is usually called Predictive Maintenance or something similar.

As development matures, this support is expected to become increasingly precise. On the one hand, this is partly due to our
growing statistical knowledge. On the other hand, the algorithms are also refined over time and the number of sensors
used increases.

Nevertheless, statistical errors are to be expected. In principle, there are two types of errors:

§ False positive: The algorithm predicts failure in the future, although damage has already occurred in the system.

§ False negative: The algorithm recommends replacement although the service life is evidently still long.

By using this function, it is acknowledged that the occurrence of statistical errors is typical of the system and is not cause
for any liability on the part of the manufacturer. There is no entitlement to compensation for damages due to a
miscalculation by the algorithm.
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18.2 Displaying the state
Open the corresponding wizard in DriveControlSuite if you want to check the state of Predictive Maintenance and the
relevant parameters.

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the respective drive controller in the project tree and click on the configured axis whose monitoring you would
like to check in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard.

ð The state is displayed directly as an icon with a corresponding note.

ð R100 PRM state:
Displays the state of Predictive Maintenance. If R100 = 0: Inactive, you must configure Predictive Maintenance
manually.

ð R101 PRM life performance indicator:
Displays the calculated life performance of the geared motor; from a value ≥ 90%, replacement of the geared motor is
recommended.

ð R112 PRM gear unit designation:
Displays the type designation of the geared motor being monitored in Predictive Maintenance.



18 | Predictive Maintenance STOBER

222

11
/2

02
4 

| 
ID

 4
43

34
0.

01

18.3 Configuring Predictive Maintenance
Predictive Maintenance is automatically active for geared motors with an electronic nameplate as of production date
04/2022. Configure monitoring in DriveControlSuite only in the following cases:

§ Geared motors with a manufacturing date prior to 04/2022

§ Geared motors without an electronic nameplate

In the cases mentioned above, Predictive Maintenance is inactive. First check the status of Predictive Maintenance with an
existing online connection (see Displaying the state [} 221]). If R100 = 0: Inactive, you can then carry out the manual
configuration in offline mode.

Configuring Predictive Maintenance via the serial number

ü You have the serial number of the gear unit.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Predictive Maintenance wizard.

3. Click Configure Predictive Maintenance (Internet).

ð The Configure Predictive Maintenance (Internet) dialog box opens.

4. Click Proxy settings.

ð The Proxy settings dialog box opens.

5. Select the desired option for the proxy setting.
For manual proxy configuration:

5.1. If you are using a proxy server, specify the name of the proxy server or the IP address in the address field and
the port of the proxy server in the Port field.

5.2. If you are using a proxy server with a login, also specify the username and password for login.

5.3. Use Test connection to make sure that a connection to the proxy server is possible.

6. Confirm with OK.

ð The Proxy settings dialog box closes.

7. Enter the serial number of your gear unit in the Configure Predictive Maintenance (Internet) dialog box.

8. Click Start download.

ð The data is downloaded and automatically written to the associated parameters.

9. After a successful download, confirm with OK

ð You have activated Predictive Maintenance.

Then transfer the configuration to the drive controller, save it and restart the drive controller 
(see Transmitting and saving the configuration [} 174]).
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Configuring Predictive Maintenance manually

If automatic configuration via the serial number fails, you can alternatively configure Predictive Maintenance manually.

Information

The required information can be found in the order confirmation for your gear unit, for example. Alternatively, you can scan
the QR code on the nameplate or retrieve it online using the serial, delivery note or invoice number at: https://
id.stober.com.

ü The order confirmation is available to you or you have access to the electronic product ID of your gear unit.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Predictive Maintenance wizard.

3. Click Configure Predictive Maintenance (local).

ð The Configure Predictive Maintenance (local) dialog box opens.

4. Select the series of your gear unit.

5. Select the size of your gear unit.

6. Then select your gear unit from the list.

7. Confirm with OK.

ð You have activated Predictive Maintenance.

Then transfer the configuration to the drive controller, save it and restart the drive controller 
(see Transmitting and saving the configuration [} 174]).

https://id.stober.com
https://id.stober.com
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Configuring Predictive Maintenance using the database file

If STOBER has provided you with a database containing your specific gear unit data, you can load it into DriveControlSuite
and then configure your gear unit manually.

Information

The required information can be found in the order confirmation for your gear unit, for example. Alternatively, you can scan
the QR code on the nameplate or retrieve it online using the serial, delivery note or invoice number at: https://
id.stober.com.

ü You have saved the database containing your gear unit data locally.

ü The order confirmation is available to you or you have access to the electronic product ID of your gear unit.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Predictive Maintenance wizard.

3. Click the  button.

ð The Open PRM database dialog box opens.

4. Navigate to the directory, select the database and open it.

ð The Configure Predictive Maintenance (local) dialog box opens.

5. Select the series of your gear unit.

6. Select the size of your gear unit.

7. Then select your gear unit from the list.

8. Confirm with OK.

ð You have activated Predictive Maintenance.

Then transfer the configuration to the drive controller, save it and restart the drive controller (see Transmitting and saving
the configuration [} 174]).

https://id.stober.com
https://id.stober.com
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18.4 Sending the load matrix
Open the associated wizard in DriveControlSuite and send the load matrix to STOBER if you need assistance with data
analysis, for example. With an existing online connection, the load matrix is read from the drive controller and sent as a
JSON file. In offline mode, you can send a load matrix already exported in JSON format.

Information

It is not possible to infer specific machine cycles based on the load matrix. The load matrix contains only highly condensed,
statistical features.

Sending the load matrix (drive controller)

ü Predictive Maintenance is active (R100 = 1: Active).

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the relevant drive controller in the project tree and click on the projected axis whose load matrix you want to
send in the project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Load matrix.

3. Fill in the required fields.

4. Click Send load matrix (drive controller).

ð The Send load matrix (drive controller) dialog box opens.

ð The source, destination and amount of data of the current load matrix are displayed.

5. Click Proxy settings.

ð The Proxy settings dialog box opens.

6. Select the desired option for the proxy setting.
For manual proxy configuration:

6.1. If you are using a proxy server, specify the name of the proxy server or the IP address in the address field and
the port of the proxy server in the Port field.

6.2. If you are using a proxy server with a login, also specify the username and password for login.

6.3. Use Test connection to make sure that a connection to the proxy server is possible.

7. Confirm with OK.

ð The Proxy settings dialog box closes.

8. In the Send load matrix (drive controller) dialog box, click Send.

ð The sending process starts and the data is transmitted to STOBER.

9. Close the dialog box after sending has been completed successfully.
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Sending the load matrix (directory)

ü You have exported the load matrix in JSON format.

1. Select the relevant drive controller in the project tree and click on the projected axis whose exported load matrix you
want to send to STOBER in the project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Load matrix.

3. Click Send load matrix (directory).

ð The dialog box for selecting the file opens.

4. Navigate to the load matrix previously exported in JSON format and select it.

5. Click Open.

ð The Send load matrix (directory) dialog box opens.

ð The source, destination and data volume of the current load matrix are displayed in the dialog box.

6. Click Proxy settings.

ð The Proxy settings dialog box opens.

7. Select the desired option for the proxy setting.
For manual proxy configuration:

7.1. If you are using a proxy server, specify the name of the proxy server or the IP address in the address field and
the port of the proxy server in the Port field.

7.2. If you are using a proxy server with a login, also specify the username and password for login.

7.3. Use Test connection to make sure that a connection to the proxy server is possible.

8. Confirm with OK.

ð The Proxy settings dialog box closes.

9. In the Send load matrix (directory) dialog box, click Send.

ð The sending process starts and the data is transmitted to STOBER.

10. Close the dialog box after sending has been completed successfully.
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18.5 Exporting the load matrix
If you want to check or analyze the data, use the associated DriveControlSuite wizard to export the load matrix. With an
existing online connection, the load matrix is read directly from the drive controller for export. If the data in your project is
already available in DriveControlSuite, you can also export the data in offline mode.

ü Predictive Maintenance is active (R100 = 1: Active).

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the relevant drive controller in the project tree and in the Project menu > Wizard area click on the projected
axis whose load matrix you want to export.

2. Select the Predictive Maintenance wizard > Load matrix.

3. Fill in the required fields.

4. Click Export load matrix (directory).

ð The Export load matrix (directory) dialog box opens.

5. Select the directory to which you want to export the load matrix.

6. Select the desired file type (JSON or CSV).

7. Assign a file name and select .json or .csv as the file extension.

8. Confirm with Save.

ð The load matrix is saved as a JSON or CSV file (*.json, *.csv).

18.6 Resetting the load matrix
The load matrix is stored in non-volatile memory on the SD card along with the life performance indicator every 30 minutes.

You can manually reset the load matrix as necessary.

If an SD card is inserted, the existing load matrix is moved to a backup folder before resetting. When resetting, both the
load matrix on the SD card and the load matrix stored in volatile memory in the drive controller are reset.

ü Predictive Maintenance is active (R100 = 1: Active).

1. Select the relevant drive controller in the project tree and click on the projected axis whose load matrix you want to
reset in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Load matrix > Reset load matrix.

3. Click Reset load matrix.

ð The load matrix is reset.

ð R105[1] indicates the progress.

ð R105[2] outputs the result of the action.
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18.7 Displaying a 3D load matrix
The load matrix represents the frequency distribution of speeds and torques that occurred at the output of the monitored
geared motor. If you want to check the speeds and torques that have occurred, open the associated wizard in
DriveControlSuite for a three-dimensional, rotatable display of the load matrix. With an existing online connection, the load
matrix is read directly from the drive controller for the display. If the data in your project is already available in
DriveControlSuite, the load matrix can also be displayed in offline mode.

ü Predictive Maintenance is active (R100 = 1: Active).

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the relevant drive controller in the project tree and click on the projected axis whose load matrix you want to
display in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Load matrix > Load matrix 3D.

ð The load matrix is displayed as a 3D column diagram.

3. Customize the display by changing the default settings for time and scaling according to your needs.

For more information on operation, see 3D load matrix.

18.8 Resetting the life performance indicator
The life performance indicator is stored in non-volatile memory in the drive controller every 10 minutes, and on the SD card
together with the load matrix every 30 minutes.

In certain cases, you may need to manually reset the life performance indicator:

§ After replacing a geared motor without an electronic nameplate with an identical geared motor

§ After servicing a geared motor (with or without electronic nameplate)

In both cases, monitoring remains active for the entire period. However, since the life performance indicator of the
replaced or serviced geared motor has the value 0%, you must also reset the life performance indicator in the drive
controller.

Information

Resetting the life performance indicator also resets the operating time of the gear unit and the counter for instances of
exceeding the torque for Predictive Maintenance (R123, R124).

ü Predictive Maintenance is active (R100 = 1: Active).

1. Select the relevant drive controller in the project tree and click on the first projected axis whose life performance
indicator must be reset in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Reset life performance indicator.

3. Click Reset life performance indicator.

ð The life performance indicator is reset.

ð R104[1] indicates the progress.

ð R104[2] outputs the result of the action.

ð R101 displays the life performance indicator.
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18.9 Information on activation, operation and replacement
Pay attention to the following information on activating Predictive Maintenance and for operating and replacing
components.

Activation

The following requirements apply for successful activation of Predictive Maintenance:

§ STOBER system (consisting of drive controllers and geared motors from STOBER)

§ Automatic activation for geared motors with a manufacturing date as of 04/2022

§ Manual configuration required for geared motors with an older manufacturing date or geared motors without an
electronic nameplate

§ Plugged-in SD card for non-volatile storage of the load matrix

§ No linear motor (control mode B20 ≠ 70: SLM - vector control)

§ Gear units not connected in series, as this is not supported by the life performance indicator

Operation

Predictive Maintenance is continued without interruption after restarting the drive controller if the following requirements
are met:

§ SD card permanently inserted in the drive controller

§ Uninterrupted connection of drive controller and geared motor

§ Constant gear ratio of the gear unit (Drive Based or PROFIdrive: C15, C16; CiA 402: A584)

Replacement

After the drive controller has been replaced, monitoring can be continued without interruption by transferring the data
from the SD card.

After replacing a geared motor with an electronic nameplate, the existing data is not overwritten if it is replaced with a new
motor, but a new data record is created. With the original data, the drive controller is able to continue monitoring the
geared motor after the geared motor has been replaced.

In certain cases, you may need to manually reset the life performance indicator:

§ After replacing a geared motor without an electronic nameplate with an identical geared motor

§ After servicing a geared motor (with or without electronic nameplate)

In both cases, monitoring remains active for the entire period. However, since the life performance indicator of the
replaced or serviced geared motor has the value 0%, you must also reset the life performance indicator in the drive
controller.
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18.10 More about Predictive Maintenance?
The following chapters summarize the essential terms of Predictive Maintenance and provide you with further relevant
information on the subject.

18.10.1 Load matrix
The load matrix represents the data base for recording the real-world load situations of machines and improving the quality
and economic efficiency. It represents the frequency distribution of speeds and torques that occurred at the output of the
geared motor. The load matrix and other information are stored in DriveControlSuite in parameter R118. The information
relevant for Predictive Maintenance is also made available to the controller via this parameter.

Information

For performance reasons, parameter R118 is not displayed in the parameter list of DriveControlSuite. The parameter data
can be accessed indirectly via the load matrix wizard or via acyclic fieldbus communication.

Information

The load matrix is only recorded if the axis is enabled (A900 = 1).

Structure and scope

The load matrix divides speed and torque into equidistant classes. For the speed, 21 classes are available for both directions
of rotation. The speed range covers -150% to +150% of the nominal speed. For the torque, 31 classes are available for the
torque range from -250% to +250% of the nominal torque.

The nominal speed and nominal torque of the load matrix refer to the gear unit output of the geared motor.

The speed range includes:

-1.5 × n2N to +1.5 × n2N

The speed is stored in rpm.

The torque range includes:

-2.5 × M2N to +2.5 × M2N

The torque is stored in %. The reference value for the percentage torque value is C09.

Torques and speeds outside the respective specified range are assigned to the outermost class:
Values that fall below the lower limit are sorted into the lowest class. Values that exceed the upper limit are sorted into the
highest class.
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Scaling

The recorded speed classes are scaled as follows, with the label representing the average of the two class limits in each
case:
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Fig. 60: Scaling of the recorded speed classes

The recorded torque classes are scaled as follows, with the label representing the average of the two class limits in each
case:
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Fig. 61: Scaling of the recorded torque classes

Data export or data transmission

From the DriveControlSuite commissioning software, the load matrix can be exported in JSON data format (*.json) or in CSV
data format (*.csv).

Alternatively, you can send the load matrix to STOBER for analysis (see Reading out and transmitting the load matrix
[} 240]).
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18.10.1.1 Information on the load matrix

The load matrix is stored in DriveControlSuite in parameter R118 along with the life performance indicator in JSON data
format. The parameter contains all the information necessary to understand the load matrix.

Information

For performance reasons, parameter R118 is not displayed in the parameter list of DriveControlSuite. The parameter data
can be accessed indirectly via the load matrix wizard or via acyclic fieldbus communication.

Key Value Description

"version" String Version name of the JSON format

"id" String ID for the type of JSON document

"ds6-username" String User name that is entered by DriveControlSuite when
exporting or sending

"ds6-email" String Email address that is entered by DriveControlSuite when
exporting or sending

"ds6-company" String Company name that is entered by DriveControlSuite when
exporting or sending

"ds6-comment" String Comment that is entered by DriveControlSuite when
exporting or sending

"ds6-date" String Date on which the file was exported or sent

"database-id" Number Database ID of the parameterized geared motor

"paramodul-sn" String Number on the SD card (generated upon first use and acts
as identification)

"encoder-type" Number Type of the connected encoder (0: none, 1: incremental,
2: SSI, 3: EnDat 2.x, 4: HIPERFACE, 5: Resolver, 6: EnDat 3.x)

"gearmotor-type" String Geared motor type

"drive-controller-type" String Drive controller type

"reference" String Reference of the drive controller

"motor-type" String Motor type

"axis-number" Number Axis number (0/1)

"gear-ratio" Number Gear ratio of the geared motor

"operating-time-h" Number Hour value of the operating time

"operating-time-m" Number Minute value of the operating time

"operating-time-s" Number Seconds value of the operating time

"motor-serial-number" Number Serial number of the motor

"gearbox-serial-number" Number Serial number of the gear unit

"encoder-serial-number" Number Encoder serial number

"drive-production-number" Number Production number of the drive controller according to
nameplate (S/N)

"t-reference" Number Reference torque for "t-average" and "t-limits"

"t-reference-unit" String Unit of reference torque for "t-average" and "t-limits"

"t-limits" Array of numbers Load matrix: upper limits of the torque classes

"t-limit-unit" String Load matrix: unit of the upper limits of the torque classes

"n-limits" Array of numbers Load matrix: upper limits of the speed classes
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Key Value Description

"n-limit-unit" String Load matrix: unit of the upper limits of the speed classes

"t-average" Array of numbers Load matrix: mean value of the class limits of the torque
classes

"t-average-unit" String Load matrix: unit of the mean value of the class limits of the
speed classes

"n-average" Array of numbers Load matrix: mean value of the class limits of the speed
classes

"n-average-unit" String Load matrix: unit of the mean value of the class limits of the
torque classes

"t-bucket-count" Number Load matrix: number of torque classes

"n-bucket-count" Number Load matrix: number of speed classes

"time-resolution" String Load matrix: resolution

"m2>m2not-counter" Number Number of times 90% of the maximum emergency off
torque was exceeded M2NOT

"gearmotor-run-time" Number Operating time of the geared motor

"gearmotor-run-time-unit" Number Unit for the operating time of the geared motor

"life-work-indicator" Number Value of the life performance indicator

"load-matrix" Array of numbers Two-dimensional array containing the load matrix; torque is
applied to the rows and speed to the columns

Tab. 188: Information on the load matrix

The following characters or control characters are not allowed in the values of the load matrix:

Symbol Description

" Quotation marks

\ Backslash

\b Backspace

\f Form feed

\n Line feed

\r Carriage return

\t Horizontal tab character

Tab. 189: Load matrix: Impermissible characters or control characters
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18.10.1.2 Example of a load matrix in JSON format

The following example shows a load matrix in JSON format.

{
"version": "1.1",
"id": "LoadMatrix",
"ds6-username": "unknown-username",
"ds6-email": "unknown-email",
"ds6-company": "unknown-company",
"ds6-comment": "unknown-comment",
"ds6-date": "unknown-date",
"database-id": 3156,
"paramodul-sn": "123456789123",
"encoder-type": 3,
"gearmotor-type": "PH932_0400",
"drive-controller-type": "SD6A36",
"reference": "T1",
"motor-type": "EZ805U",
"axis-number": 0,
"gear-ratio": 40.0,
"operating-time-h": 129,
"operating-time-m": 13,
"operating-time-s": 24,
"motor-serial-number": 123456789,
"gearbox-serial-number": 123456789,
"encoder-serial-number": 123456789,
"drive-production-number": 1234567,
"t-reference": 2644.0,
"t-reference-unit": "Nm",
"t-limits": [-2.417, -2.250, -2.083, -1.917, -1.750, -1.583, -1.417, -1.250,
-1.083, -0.917, -0.750, -0.583, -0.417, -0.250, -0.083, 0.083, 0.250, 0.417, 0.583,
0.750, 0.917, 1.083, 1.250, 1.417, 1.583, 1.750, 1.917, 2.083, 2.250, 2.417,
2.583],
"t-limit-unit": "%",
"n-limits": [-71.250, -63.750, -56.250, -48.750, -41.250, -33.750, -26.250,
-18.750, -11.250, -3.750, 3.750, 11.250, 18.750, 26.250, 33.750, 41.250, 48.750,
56.250, 63.750, 71.250, 78.750],
"n-limit-unit": "rpm",
"t-average": [-2.500, -2.333, -2.167, -2.000, -1.833, -1.667, -1.500, -1.333,
-1.167, -1.000, -0.833, -0.667, -0.500, -0.333, -0.167, 0.000, 0.167, 0.333, 0.500,
0.667, 0.833, 1.000, 1.167, 1.333, 1.500, 1.667, 1.833, 2.000, 2.167, 2.333,
2.500],
"t-average-unit": "%",
"n-average": [-75.000, -67.500, -60.000, -52.500, -45.000, -37.500, -30.000,
-22.500, -15.000, -7.500, 0.000, 7.500, 15.000, 22.500, 30.000, 37.500, 45.000,
52.500, 60.000, 67.500, 75.000],
"n-average-unit": "rpm",
"t-bucket-count": 31,
"n-bucket-count": 21,
"time-resolution": "1us",
"m2>m2not-counter": 0,
"gearmotor-run-time": 0,
"gearmotor-run-time-unit": "s",
"life-work-indicator": 0.000280,
"load-matrix": [
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 1000, 3000, 4000, 4000, 3000, 4000, 1000, 0, 0, 0, 0, 0, 0, 0, 0, 0,
0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2000, 4000, 4000, 3000, 4000, 3000, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
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[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 20000, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 41000, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 20000, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 3000, 4000, 4000, 3000, 4000, 2000, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1000, 4000, 4000, 3000, 4000, 3000, 1000, 0, 0, 0,
0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0]
] 
}

18.10.1.3 Memory requirement of the load matrix

The maximum required memory space is 16 KiB (Kibibyte) per load matrix in JSON format.

The load matrix is saved separately for each axis and in duplicate to prevent data loss. Consequently, the maximum
required memory space is 32 KiB on the SD card of a single-axis controller and 64 KiB on the SD card of a double-axis
controller.

When a geared motor is replaced by a new geared motor, new JSON files are generated for it. Accordingly, the required
memory space for each new geared motor increases by a maximum of 32 KiB.

The required memory space per day depends on the application, but is within the maximum required memory space.

18.10.1.4 Export of the load matrix

You can export the load matrix as a JSON or CSV file.

The load matrix in JSON format is particularly suitable for simple evaluation, comparison and display of the load matrix
using programming languages such as Python, C#, C++ or Java and for use in IIoT applications.

The load matrix in CSV format can be displayed and evaluated as a diagram using spreadsheet programs such as Microsoft
Excel.

18.10.1.4.1 Load matrix in JSON format

The data of the load matrix in JSON format corresponds to the data of parameter R118.

For information on the individual elements, see Information on the load matrix [} 232].

Evaluation

The data in the JSON file can be analyzed as a diagram using Python and Matplotlib.

Prerequisites:

§ Python programming language in V 3.0 or later

§ Matplotlib program library in V 1.0.0 or later

§ NumPy program library in V 1.0.0 or later
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Example

# Import required libraries
import json
import matplotlib.pyplot as plt
import numpy as np

# File path for the JSON file
file_path = r"C:\Temp\LoadMatrix_20230912_095707.json"

# Open and read data from the JSON file
with open(file_path, 'r') as file:

data = json.load(file)

# Create a 3D plot
fig, ax = plt.subplots(subplot_kw={"projection": "3d"})

# Extract and prepare data from the JSON file
speeds = np.array(data["n-average"])
torques = np.array(np.multiply(data["t-average"], data["t-reference"]))

# Set axis labels
ax.set(ylabel="torque in Nm", xlabel="speed in rpm", zlabel="amount in min")

# Define the number of ticks on the axes
plt.locator_params(axis='x', nbins=data["n-bucket-count"])
plt.locator_params(axis='y', nbins=data["t-bucket-count"])

# Prepare data for the 3D surface
speeds, torques = np.meshgrid(speeds, torques)
loads_us = np.array(data["load-matrix"])
loads_minutes = np.divide(loads_us, 1000 * 1000 * 60)

# Draw the 3D surface
ax.plot_surface(speeds, torques, loads_minutes, cmap=plt.cm.coolwarm, linewidth=0,
antialiased=True)

# Display the plot
plt.show()

Information

If copying and pasting the example, correct the syntax indentation after pasting if necessary.
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18.10.1.4.2 Load matrix in CSV format

The CSV file contains the Metadata and Load-Matrix sections.

For information on the individual elements, see Information on the load matrix [} 232].

Metadata

The metadata includes all the information required to identify the axis within the machine. It also contains information on
the operating time of the axis, the serial numbers of motor, gear unit and encoder components, and the production
number of the drive controller. The axis labels of the load matrix, the units in which the load matrix is recorded, and the life
performance indicator can also be found in the metadata.

Load-Matrix

The Load-Matrix section contains the data and axis labels of the load matrix. The speed axis label is in the first row after
Start Load-Matrix; the torque axis label follows in the first column. The speeds can be found in the line n-average
and the corresponding unit in the line n-average-unit. The torques are the result of multiplying t-average and 
t-reference. The corresponding unit can be found in the line t-reference-unit.

Evaluation

Proceed as follows to create a 3D column chart in Microsoft Excel from the load matrix data:

1. Open the CSV file in Excel.

2. Select all cells with content between the rows Start Load-Matrix and End Load-Matrix.

3. On the Insert tab, select Charts > Insert column or bar chart > 3D column.

ð The 3D column diagram is inserted.
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18.10.2 Life performance indicator
The life performance indicator is the value for the calculated life performance of the geared motor. No additional external
sensor is required to determine it. In DriveControlSuite, the life performance indicator is displayed in the Predictive
Maintenance wizard (R101). Values below 100% mean that the geared motor is being operated within its life performance.
For values above 100%, the probability of failure increases. From a value of 90%, it is recommended to replace the geared
motor and a corresponding message is output in parameter R100.

Information

Increasing values do not mean that there is damage to the geared motor. Operation of the geared motor is also possible at
values > 100%.

Information

The life performance indicator is calculated and updated only if the axis is enabled (A900 = 1).

The life performance indicator increases monotonically: faster with greater load, slower with lesser load.
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Fig. 62: Signaling area

The algorithm for the life performance indicator is continuously being further developed.
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18.10.3 Update and storage cycles
The action A00 Save values has no influence on the saving of Predictive Maintenance data.

Load matrix

The load matrix is stored in non-volatile memory on the SD card along with the life performance indicator every 30 minutes.

The data for the load matrix (speeds and torques) is sampled with the cycle time set in A150.

In the drive controller, the load matrix is updated with the cycle time set in A150.

If the drive controller is switched off before the load matrix data is automatically saved every 30 minutes, the data will be
lost.

Life performance indicator

The life performance indicator is stored in non-volatile memory in the drive controller every 10 minutes, and on the SD card
together with the load matrix every 30 minutes.

The value of the life performance indicator is updated in the drive controller twice per minute.

Unlike for the load matrix, an SD card is not absolutely necessary for the life performance indicator because of the non-
volatile storage in the drive controller.

18.10.4 Recommendation for geared motor replacement
The recommendation to replace the geared motor is displayed in DriveControlSuite in the Predictive Maintenance wizard
(R100). The recommendation is triggered when Predictive Maintenance is active and the life performance indicator reaches
a value ≥ 90% (R101).
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18.10.5 Reading out and transmitting the load matrix
Would you like to know more about the real-world load situation of your machine and its optimization potential? Would
you like to support the further development of our algorithm? If you send us your load matrix, we will help you in analyzing
or visualizing your data. We will also be able to take your specific machine behavior into consideration for further
development.

Information

It is not possible to infer specific machine cycles based on the load matrix. The load matrix contains only highly condensed,
statistical features.

Reading out data

The following graphic describes the 3 options for reading out the data.

Shortcut icon for .exe Shortcut icon for .exe

DS6
DS6

DS6
DS6

AS6
AS6

AS6
AS6

DS6 AS6

Icon for document Icon for document

AS6
AS6

AS6
AS6

AS6

DS6
DS6

DS6
DS6

DS6

{;}
JSON

{;}
JSON

{;}
JSON

CSV

1

2

3

R118

SD card

R118

PLC

PC

PC

Fig. 63: Predictive Maintenance: Options for readout

1. Via the controller (in preparation)

Function blocks for controllers are in preparation that will enable the controller to read the parameter R118 and write the
data to a JSON file.

2. From the SD card

You can read out the data on your PC directly from the SD card.

The JSON files are stored in the following form:

§ If a serial number is available for the motor, it is used for the file name.

§ If no serial number is available for the motor, the file name consists of 8 characters (hexadecimal) which are generated
from the CRC checksum of B00.
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File name Example

PRM\[Serial number].PXX 03774434.P00

PRM\[8 characters].PXX 0BB5A846.P00

Tab. 190: Predictive Maintenance files on SD card

To avoid data loss, the files are each stored twice on the SD card.

The file extensions have the following meaning:

File extension Meaning

P00 JSON

P01 JSON (backup file)

Tab. 191: Meaning of file extensions on SD card

3. Via DriveControlSuite

Use the associated wizard in DriveControlSuite to export the load matrix. For the export, parameter R118 is read out from
the drive controller directly if an online connection exists or from your project in offline mode.

Transmitting the data

You can provide the data to STOBER via upload through DriveControlSuite or by email to prm_data@stober.de.

mailto:
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19 Diagnostics
LEDs on the top and front give you initial information about the device state as well as the states of the physical connection
and the communication. In the event of an error or fault, you will receive detailed information through the
DriveControlSuite commissioning software.

19.1 Drive controller
The drive controllers have diagnostic LEDs that visually indicate the state of the drive controller as well as the states of the
physical connection and communication.

1

2

3

4

5

Err/BF

Run

FSoE/Psafe

Fig. 64: Positions of the diagnostic LEDs on the front and top of the drive controller

1 Fieldbus state

2 FSoE or PROFIsafe state

3 Drive controller state

4 Service network connection

5 Fieldbus network connection
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19.1.1 Drive controller state: LEDs
3 LEDs on the front of the device provide information about the state of the drive controller.SB6

1
2

Fig. 65: LEDs for the state of the drive controller

1 Green: Run

2 Red: Error

Green LED Conduct Description

Off No supply voltage, drive controller has a fault or STO active

Single flash Not ready to switch on (E48 = 0: Self test)

Flashing Drive controller ready to switch on (E48 = 2: Ready for switch-on)

On Operation enabled (E48 = 4: Enabled)

Rapid flashing Data is written to internal memory and the SD card

Tab. 192: Meaning of the green LED (Run)

Red LED Conduct Description

Off No error or event

Single flash STO active

Flashing Warning

On Fault

Single flash, inverse Fault; STO active

Rapid flashing No configuration active

Tab. 193: Meaning of the red LED (error)

Pattern when starting the drive controller

When the drive controller is started, all 3 LEDs flash as follows:

LEDs:
Green/Red/Red

Conduct Description

On Short phase while the firmware starts up

On

On

Tab. 194: States of the LEDS when starting the drive controller



19 | Diagnostics STOBER

244

11
/2

02
4 

| 
ID

 4
43

34
0.

01

Pattern for identifying the drive controller (DS6 online function)

You can access the Online functions window in DriveControlSuite after you have established a connection between

DriveControlSuite and the drive controller in the Add connection dialog box. The  button lets the LEDs on the front panel
of the drive controller flash to make identification in the network easier:

LEDs:
Green/Red/Red

Conduct Description

Rapid flashing Identifying the drive controller in the network

Rapid flashing

Off

Tab. 195: States of the LEDs when identifying the drive controller in the network

Pattern when transferring a firmware file using an SD card

When a firmware file is being transferred using an SD card, all 3 LEDs flash in various combinations and frequencies:

LEDs:
Green/Red/Red

Conduct Description

Off Deleting the 2nd firmware memory on the drive controller

Rapid flashing

Off

Rapid flashing Copying the firmware from the SD card to the 2nd firmware memory of
the drive controller

Rapid flashing

Rapid flashing

Single blink Copying process completed successfully; drive controller has to be
restarted

Off

Off

Off Error during copying process; remove card and restart drive controller

Single blink

Off

Tab. 196: States of the LEDs when using an SD card to transfer a firmware file
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Pattern after transferring a firmware file and restarting the drive controller

During a firmware update after restarting the drive controller, all three LEDs flash in various combinations and frequencies:

LEDs:
Green/Red/Red

Conduct Description

Off Deleting the 1st firmware memory

Rapid flashing

Off

Rapid flashing Copying the 2nd firmware memory into the 1st

Off or On (depending
on FW size)

Off

Chaser light Error during firmware update; service required

Tab. 197: States of the LEDs after transferring a firmware file and restarting the drive controller
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19.1.2 Drive controller state: Display
Event displays on the display give you additional information about the state of the drive controller.

For a listing of all events with descriptions, see Events [} 257].

Display of the reaction

If the event is parameterized as Message, it appears flashing in the lower display. An application is not affected by a
message; that is, the operation continues. A message is not acknowledged, but remains pending until the cause disappears.

A Warning is displayed by the corresponding, flashing words. In addition, the display shows the event and time remaining
until the cause is remedied. If the cause disappears within this time, the warning is reset. An application is not affected by a
warning. If the cause is not remedied, the warning becomes a fault after the defined time expires.

If an event occurs with the Fault level, this is indicated by the corresponding, flashing words. The drive controller
immediately changes to the fault reaction device state. The event is shown on the display. A fault must be acknowledged.
For many events, the drive controller provides information about the cause. This is additionally output on the display and is
indicated by a number:

Fault
46:Undervoltage
Event cause
1:UndervoltUZK

Fig. 66: Appearance of a fault on the display

Causes that are not documented in the event descriptions with a number are not shown on the display. In this case, the
documentation only provides information about potential errors.

Events during active configuration

Once the device start-up is completed and the configuration is active, the events identified by a number monitor the
operation. For some of these events, acknowledgment is possible on the operating unit or can be programmed via digital
input. Communication and operation of the drive controller are not affected. For further diagnostics, the occurrence of an
event is noted by a counter. You can find the Fault counter in parameter group Z. Some of these events can be
parameterized, e.g. Event 39: Overtemperature drive controller i2t.

Error when the drive controller is started

When the drive controller is started, the configuration from the SD card/Paramodul is loaded. Then the configuration is
started. During both steps, detailed error messages can be generated that can be output on the display and indicated by an
*. You can find more information about the cause and the required measures in the corresponding event descriptions.
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19.1.2.1 *NoConfiguration

Error when the drive controller is started:

§ The power unit remains switched off

§ The brakes remain engaged

§ The brake chopper remains switched off

ParaModul Error

Cause Check and action

1:Read Error Control unit was switched off while saving
(A00)

Transfer the drive controller configuration to
the drive controller from a project file using
DS6 and save the configuration on the SD card/
in the Paramodul (A00); fault cannot be
acknowledged

SD card(s)/Paramodul empty or not inserted

SD card(s)/Paramodul defective or unformatted Replace the Paramodul; fault cannot be
acknowledged

3:Update Firmware! The configuration on the SD card/in the
Paramodul cannot be executed with the
current firmware because it uses unknown
configuration memory areas

Update the firmware; fault cannot be
acknowledged

Tab. 198: *NoConfiguration, Cause: ParaModul Error – Causes and actions
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ConfigStartError

Cause Check and action

1:Parameters lost Control unit was switched off while saving (A00) Transfer the drive controller
configuration to the drive controller
from a project file using DS6 and save
the configuration on the SD card/in the
Paramodul (A00); fault cannot be
acknowledged

4:Non-volatile lost Save (A00) was not carried out Transfer the drive controller
configuration to the drive controller
from a project file using DS6 and save
the configuration on the SD card/in the
Paramodul (A00); fault cannot be
acknowledged

5:Unknown Block The configuration saved on the SD card/in the
Paramodul comes from a newer firmware that knows
more system blocks

Update the firmware; fault cannot be
acknowledged

6:Unknown String The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more texts (e.g. names of the system default block
parameters)

7:Unknown Scale The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more scaling functions

8: Unknown Limit The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more limit value functions

9:Unknown Post-Wr The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more post-write functions

10:Unknown Pre-Read The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more pre-read functions (mapping of firmware
parameters to configuration parameters)

11:Unknown Hiding The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more hiding functions (hiding of parameters that
should be visible depending on other parameters)

12:Unknown Post-Read The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more post-read functions

13:Unknown Pre-Write The configuration saved on the SD card/in the
Paramodul comes from newer firmware that knows
more pre-write functions (mapping of firmware
parameters to configuration parameters)

Tab. 199: *NoConfiguration, Cause: ConfigStartError – Causes and actions
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Configuration Stopped

Cause Check and action

Transfer of the configuration
through DS6 was interrupted

Switch the drive controller off and back on to load the previous configuration from
the SD card/Paramodul; fault cannot be acknowledged

Transfer the drive controller configuration to the drive controller from a project file
using DS6 and save the configuration on the SD card/in the Paramodul (A00); fault
cannot be acknowledged

Tab. 200: *NoConfiguration, Cause: Configuration Stopped – Causes and actions
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19.1.3 State of the fieldbus and safety technology
The LEDs for diagnosing the fieldbus state and the safety technology vary depending on the fieldbus system and safety
module used.

19.1.3.1 EtherCAT state

The 2 LEDs on the front of the drive controller provide information about the connection between the EtherCAT
MainDevice and SubDevice and the state of the data exchange. This information can also be read out in parameter A255.

If the drive controller includes the SY6 safety module, the safety functions are controlled using EtherCAT FSoE. In this case,
an additional LED on the front of the device provides information about the FSoE state.

1
2

Err
Run
FSoE

Fig. 67: LEDs for the EtherCAT state

1 Red: Error

2 Green: Run

Red LED Conduct Error Description

Off No Error No error

Flashing Invalid Configuration Invalid configuration

Single flash Unsolicited State Change The EtherCAT SubDevice changed operating
states by itself

Double flash Application Watchdog
Timeout

The EtherCAT SubDevice did not receive new
PDO data during the configured watchdog
timeout

On Application controller
failure

Internal device communication error; switch
device off and on again

Tab. 201: Meaning of the red LED (error)

Green LED Conduct Operating state Description

Off Init No communication between the EtherCAT
MainDevice and SubDevice; the
configuration starts, saved values are loaded

Flashing Pre-operational No PDO communication; the EtherCAT
MainDevice and SubDevice exchange
application-specific parameters via SDOs

Single flash Safe-operational The EtherCAT SubDevice sends the current
actual values to the EtherCAT MainDevice,
ignores its set values and refers to internal
default values

On Operational Normal operation: The EtherCAT MainDevice
and SubDevice exchange set and actual
values

Tab. 202: Meaning of the green LED (Run)
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19.1.3.2 FSoE state (option SY6)

If the drive controller includes the SY6 safety module, the STO and SS1 safety functions are controlled using EtherCAT FSoE.
In this case, an LED on the front of the device provides information about the state of FSoE communication. This
information can also be read out in parameter S20 FSoE status indicator.

1

Err
Run
FSoE

Fig. 68: LED for the FSoE state

1 Green: FSoE

Green LED Conduct Description

Off Initialization

Flashing Ready for parameterization

On Normal operation

Single flash Failsafe command from FSoE MainInstance received

Rapid flashing Undefined connection error

Rapid flashing with
1x flash

Error in the safety-related communication settings

Rapid flashing with
2x flash

Error in the safety-related application settings

Rapid flashing with
3x flash

Incorrect FSoE address

Rapid flashing with
4x flash

Prohibited command received

Rapid flashing with
5x flash

Watchdog error

Rapid flashing with
6x flash

CRC error

Tab. 203: Meaning of the green LED (FSoE status indicator in accordance with IEC 61784-3)
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19.1.3.3 PROFINET state

There are 2 LEDs on the front of the drive controller that provide information about the connection between controller 
and drive controller and about the state of the data exchange. This information can also be read out in parameter 
A271 PN state.

1
2

BF
Run
PROFIsafe

Fig. 69: LEDs for the PROFINET state

1 Red: BF (bus error)

2 Green: Run

Red LED Conduct Description

Off No error

Rapid flashing Data exchange with controller not
active

On No network connection

Tab. 204: Meaning of the red LED (BF)

Green LED Conduct Description

Off No connection

Single blink Connection is set up to controller

Single blink, inverse Controller activates DHCP signal service

Flashing Existing connection to controller; data
exchange expected

On Existing connection to controller

Tab. 205: Meaning of the green LED (Run)
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19.1.3.4 PROFIsafe status

If the drive controller includes the SU6 safety module, the STO and SS1 safety functions are activated via PROFIsafe. In this
case, an LED on the front of the device provides information about the status of PROFIsafe communication. This
information can also be read out in parameter S40 PROFIsafe state.

1

BF
Run
PROFIsafe

Fig. 70: LED for the PROFIsafe state

1 Green: PROFIsafe

Green LED Conduct Description

Off Initialization

Flashing Ready for parameterization by
controller (F-CPU)

On Normal operation

Rapid flashing with 1x flash Error in the safety-related
communication settings

Rapid flashing with 2x flash Error in the safety-related application
settings

Rapid flashing with 3x flash Incorrect PROFIsafe destination
address

Rapid flashing with 5x flash Interruption of the PROFIsafe
connection (watchdog error)

Rapid flashing with 6x flash Error in the transmission of the
PROFIsafe data (CRC error)

Tab. 206: Meaning of the green LED (PROFIsafe status indicator in accordance with IEC 61784-3)

Information

Parameter S40 PROFIsafe state contains detailed information about the PROFIsafe communication status. The value of S40
can be read off in PROFINET wizard > Monitoring: PROFIsafe in DriveControlSuite.



19 | Diagnostics STOBER

254

11
/2

02
4 

| 
ID

 4
43

34
0.

01

19.1.4 Service network connection
The LEDs at X9 on the front of the device display the state of the service network connection.

1

2

Fig. 71: LEDs for the state of the service network connection

1 Green: Link

2 Yellow: Activity

Green LED Behavior Description

Off No network connection

On Network connection present

Tab. 207: Meaning of the green LED (link)

Yellow LED Behavior Description

Off No network connection

Flashing Individual data packets are sent or received

On Active data exchange

Tab. 208: Meaning of the yellow LED (act.)
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19.1.5 Fieldbus network connection
The LEDs for communication diagnostics vary depending on implemented fieldbus system or communication module.

19.1.5.1 EtherCAT network connection

The LEDs LA ECIN and LA ECOUT at X200 and X201 on the top of the device indicate the state of the EtherCAT network
connection.

LA
LA

IN
EC

X2
00

:
O

U
T

EC
X2

01
:

1

2

3

4

Fig. 72: LEDs for the state of the EtherCAT network connection

1 Green: LA ECOUT at X201

2 Yellow: No function

3 Green: LA ECIN at X200

4 Yellow: No function

Green LED Behavior Description

Off No network connection

Flashing Active data exchange with other EtherCAT nodes

On Network connection exists

Tab. 209: Meaning of the green LEDs (LA)
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19.1.5.2 PROFINET network connection

The Act. and Link LEDs at X200 and X201 on the top of the device indicate the state of the PROFINET network connection.

1

2

3

4

Li
nk

Li
nk

X2
00

X2
01

Ac
t

Ac
t

Fig. 73: LEDs for the state of the PROFINET network connection

1 Green: Link at X201

2 Yellow: Activity at X201

3 Green: Link at X200

4 Yellow: Activity at X200

Green LED Conduct Description

Off No network connection

On Network connection exists

Tab. 210: Meaning of the green LEDs (Link)

Yellow LED Conduct Description

Off No data exchange

Flashing Active data exchange with controller

Tab. 211: Meaning of the yellow LEDs (Act.)
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19.1.6 Events
The drive controller has a self-monitoring system that uses test rules to protect the drive system from damage. Violating
the test rules triggers a corresponding event. There is no possible way for you as the user to intervene in some events, such
as the Short/ground event. In others, you can influence the effects and responses.

Possible effects include:

§ Message: Information that can be evaluated by the controller

§ Warning: Information that can be evaluated by the controller and becomes a fault after a defined time span has
elapsed without the cause being resolved

§ Fault: Immediate drive controller response; the power unit is disabled and axis movement is no longer controlled by
the drive controller or the axis is brought to a standstill by a quick stop or emergency braking

Depending on the event, there are various measures you can take to rectify the cause. As soon as the cause has been
successfully rectified, you can usually acknowledge the event immediately. If the drive controller has to be restarted, a
corresponding note can be found in the measures.

ATTENTION!

Damage to property due to interruption of a quick stop or emergency braking!

If, when executing a quick stop or emergency braking, a fault occurs or STO is active, the quick stop or emergency braking is
interrupted. In this case, the machine can be damaged by the uncontrolled axis movement.

19.1.6.1 Overview

The following table shows the possible events at a glance.

Event

Event 31: Short/ground [} 259]

Event 32: Short/ground internal [} 260]

Event 33: Overcurrent [} 261]

Event 34: Hardware fault [} 262]

Event 35: Watchdog [} 263]

Event 36: High voltage [} 263]

Event 37: Motor encoder [} 264]

Event 38: Temperature drive controller sensor [} 267]

Event 39: Overtemperature drive controller i2t [} 268]

Event 40: Invalid data [} 269]

Event 41: Temp.MotorTMP [} 270]

Event 42: TempBrakeRes [} 271]

Event 43: AI1 wire break [} 272]

Event 44: External fault 1 [} 273]

Event 45: Overtemp.motor i2t [} 274]

Event 46: Low voltage [} 275]

Event 47: Torque/force-max. limit [} 276]

Event 48: Brake release monitoring [} 277]

Event 49: Brake [} 278]
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Event

Event 50: Safety module [} 279]

Event 51: Virtual master software limit switch [} 280]

Event 52: Communication [} 281]

Event 53: Limit switch [} 282]

Event 54: Following error [} 283]

Event 55: Option module [} 284]

Event 56: Overspeed [} 285]

Event 57: Runtime requirement [} 287]

Event 59: Overtemperature drive controller i2t [} 289]

Event 60: Application event 0 – Event 67: 
Application event 7 [} 290]

Event 68: External fault 2 [} 291]

Event 69: Motor connection [} 292]

Event 70: Parameter consistency [} 293]

Event 71: Firmware [} 295]

Event 76: Position encoder [} 296]

Event 77: Master encoder [} 299]

Event 78: Position limit cyclic [} 301]

Event 79: Motor/position encoder plausibility [} 302]

Event 80: Illegal action [} 303]

Event 81: Motor allocation [} 303]

Event 82: Hall sensor [} 305]

Event 83: Failure of one/ all phases (mains) [} 306]

Event 84: Drop in network voltage when power section active [} 307]

Event 85: Excessive jump in reference value [} 309]

Event 86: Unknown LeanMotor record [} 310]

Event 87: Reference lostReference loss [} 310]

Event 88: Control panel [} 311]

Event 89: Maximum current LM [} 312]

Event 90: Motion block [} 313]

Tab. 212: Events
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19.1.6.2 Event 31: Short/ground

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The brake chopper is switched off.

ATTENTION!

Material damage due to repeated activation and deactivation or new enable signal!

Repeated activation and deactivation or a new enable signal with an existing short-circuit can lead to a device fault.

▪ Before the new activation or enable signal, the cause must be found and corrected.

Cause Check and action

Connection error at the motor Check the connection and correct it if necessary

Defective power cable Check the cable and replace it if necessary

Short-circuit in the motor winding Check the motor and replace it if necessary

Short-circuit in the braking resistor Check the braking resistor and replace it if necessary

Short-circuit/ground fault inside
the device

Check whether the fault occurs when switching on the power unit and replace the
drive controller if necessary; the fault can only be acknowledged after 30 s

Tab. 213: Event 31 – Causes and actions
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19.1.6.3 Event 32: Short/ground internal

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The brake chopper is switched off.

ATTENTION!

Material damage due to repeated activation and deactivation!

Repeated activation and deactivation with an existing short-circuit can lead to a device fault.

▪ Before the new activation or enable signal, the cause must be found and corrected.

Cause Check and action

Short-circuit/ground fault inside
the device

Replace the drive controller; the fault cannot be acknowledged

Tab. 214: Event 32 – Causes and actions
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19.1.6.4 Event 33: Overcurrent

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Switch-off condition fulfilled (E00 >
R04 × R26); switch-off:

§ 1: Normal
(in software)

§ 2: Fast
(in hardware)

Short acceleration times Check the actual current using the scope image
and reduce the acceleration values if necessary
(E00); the fault can only be acknowledged 3 s
after the cause has been corrected

Large torque/force limits Check the actual current using the scope image
(E00) and reduce the torque/force limits if
necessary (C03, C05); the fault can only be
acknowledged 3 s after the cause has been
corrected

Wrong drive controller design Check the design and change the drive
controller type if necessary; the fault can only
be acknowledged 3 s after the cause has been
corrected

Short-circuit/ground fault If cause 2 occurs repeatedly, check whether
there is a short-circuit/ground fault

Tab. 215: Event 33 – Causes and actions
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19.1.6.5 Event 34: Hardware fault

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: FPGA,
2: NOV control unit,
3: NOV-Power Unit,
6: NOV safety module,
7: Current measurement,
8: power supply,
9: power supply,
10: power supply,
11: power supply,
12: Timer control board

Defective drive controller Exchange drive controller; fault cannot be
acknowledged

18: Terminal module adress-/
databus,
19: Terminal module signal lines,
20: Terminal module clock error,
21: Terminal module voltage is
missing,
22: Terminal module databus

Defective or incorrectly installed
terminal module or defective drive
controller

Exchange terminal module or drive controller;
fault cannot be acknowledged

23: FPGA,
24: FPGA,
25: FPGA,
26: CPU,
27: CPU,
28: CPU,
29: Communication

Defective drive controller Exchange drive controller; fault cannot be
acknowledged

30: power supply Defective drive controller Check encoder power consumption; replace
defective or incorrectly selected component;
fault cannot be acknowledged

Defective encoder

Power output of encoder interface
outside specification

31: Operating unit Defective operating unit Exchange drive controller; fault cannot be
acknowledged

Tab. 216: Event 34 – Causes and actions
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19.1.6.6 Event 35: Watchdog

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The brake chopper and brake release override are non-functional while the runtime system restarts.

Cause Check and action

1: Core 0,
2: Core 1

Microprocessor at full load Check the runtime utilization using the scope
image (E191) and reduce it using a longer cycle
time if necessary (A150)

Microprocessor faulty Check the connection and shielding and correct
them if necessary; replace the drive controller
if necessary

Tab. 217: Event 35 – Causes and actions

19.1.6.7 Event 36: High voltage

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Short delay times Check the DC link voltage during the braking operation using the scope image (E03) and, if
necessary, reduce the delay values, use a (larger) braking resistor or connect a DC link

Brake chopper deactivated Check the values of the parameterized braking resistor and correct it if necessary (A21,
A22, A23)

Braking resistor connection
error

Check the connection to the braking resistor and drive controller and correct them if
necessary

Pulse power of the braking
resistor is too low

Check that the braking resistor pulse power is suitable for the application; replace the
braking resistor if necessary

Brake chopper is defective Check the DC link voltage during the braking operation using the scope image (E03); the
brake chopper is defective if the DC link voltage exceeds the on limit of the brake chopper
(R31) without the DC link voltage dropping; replace the drive controller if necessary

Supply voltage exceeded Check the supply voltage for an overrun of the permitted input voltage and adjust it if
necessary

Tab. 218: Event 36 – Causes and actions
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19.1.6.8 Event 37: Motor encoder

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.
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Cause Check and action

1: Parameter <-> encoder Inconsistent
parameterization

Compare the specification of the connected encoder to the
corresponding values of the H parameters and correct them
if necessary

2: Maximum speed Exceeded encoder maximum
velocity

Check the actual velocity during a movement using the
scope image (I88) and adjust the permitted encoder
maximum velocity if necessary (I297)

Connection error Check the connection and shielding and correct them if
necessary

Mass inertia ratio of load to
Lean motor

Check the setting of the mass inertia ratio (C30) and reduce
it if necessary

Dynamic control of the Lean
motor

Check the control settings; if necessary, reduce the gain
(C31, I20) and increase the reset times (C32)

Dynamic set values for the
Lean motor

Check the dynamics of the application set values and
reduce them if necessary

Dynamic acceleration of the
Lean motor

Use a scope image to check the actual velocity and shifting
speed during a movement (E15, E959) and reduce the
shifting filter time constant if necessary (B137)

6: X4 EnDat encoder found Inconsistent
parameterization

Compare the connected encoder to the parameterized
encoder and correct it if necessary (H00)

7: X4 A track/Incremental Connection error Check the connection and correct it if necessary

8: X4 no encoder found Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty supply voltage Check the supply voltage of the encoder and correct if
necessary

Inconsistent
parameterization

Compare the connected encoder to the parameterized
encoder and correct it if necessary (H00)

10: X4 A track/Clk,
11: X4 B track/Dat

Defective encoder cable Check the cable and replace it if necessary

13: X4-EnDat alarm Defective EnDat encoder Replace the motor; EnDat 2.1 digital, EnDat 2.2 digital,
EnDat 3: Fault cannot be acknowledged

14: X4 EnDat CRC,
15: X4 double transmission

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (B298)

16: X4 busy Synchronization error Update firmware

17: EBI encoder low battery Battery in battery module
weak

Replace the battery; reference remains intact

18: EBI encoder battery
empty

Battery in battery module
empty

Replace the battery

Initial connection –

Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty battery module Check the battery module and replace it if necessary

19: Alarm bit Encoder fault Check the specification of the encoder regarding the alarm
bit
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Cause Check and action

20: Resolver carrier,
21: Resolver sin/cos
undervoltage,
22: Resolver sin/cos
overvoltage

Defective encoder cable Check the cable and replace it if necessary

Incompatible encoder Compare the specification of the encoder with the
corresponding specifications from STOBER and replace the
encoder or motor if necessary; fault cannot be
acknowledged

21: Resolver sin/cos
undervoltage

Incompatible encoder;
phase search or calibration
of the optimal resolver
excitation failed

Compare the specification of the encoder with the
corresponding specifications from STOBER;
if necessary, calibrate the starting point for calibrating the
optimal resolver excitation and the phase search (B40);
fault cannot be acknowledged

24: Resolver failure Defective encoder cable Check the cable and replace it if necessary

48: X4 zero pulse missing Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Late zero track Check number of encoder increments per rotation and
correct it if necessary (H02)

49: X4 zero pulse distance
too small

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Early zero track Check number of encoder increments per rotation and
correct it if necessary (H02)

60: Hiperface
synchronisation,
61: Hiperface timeout,
62: Hiperface signal quality,
63: Hiperface link

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (B298)

64: EnDat3 Timeout,
65: EnDat3 invalid Request,
66: EnDat3 Position Check

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (B298)

Tab. 219: Event 37 – Causes and actions
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19.1.6.9 Event 38: Temperature drive controller sensor

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Surrounding temperatures
too high or too low

Check the surrounding temperature of the drive controller and adjust it to the operating
conditions of the drive controller if necessary; the fault can only be acknowledged 30 s
after the cause has been corrected

Too little air circulation in
the control cabinet

Check the minimum clearances and adjust them if necessary; the fault can only be
acknowledged 30 s after the cause has been corrected

Defective or blocked fan Switch on control unit supply; check that the fan starts and replace the drive controller if
necessary; the fault can only be acknowledged 30 s after the cause has been corrected

Assembly protection film Remove the assembly protection film

Wrong drive controller
design

Check the design and change the drive controller type if necessary; the fault can only be
acknowledged 30 s after the cause has been corrected

Increased or reduced
mechanical friction

Check the service status of the mechanical system of all axes and service them if necessary;
the fault can only be acknowledged 30 s after the cause has been corrected

Mechanical block Check the output of all axes and remove the block if necessary

Short deceleration/
acceleration times

Check the actual current during the braking process using the scope image (E00); reduce
the deceleration and acceleration values if necessary; the fault can only be acknowledged
30 s after the cause has been corrected

Clock frequency too high Check the utilization of the drive, taking into account derating and the configured clock
frequency (E20, B24); reduce the configured clock frequency or replace the drive controller
if necessary; the fault can only be acknowledged 30 s after the cause has been corrected

Tab. 220: Event 38 – Causes and actions
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19.1.6.10 Event 39: Overtemperature drive controller i2t

The i²t value of the drive controller (E22) has reached 100%. The maximum output current I2max is limited to 100% of the
nominal output current I2N,PU (R04). If the i²t value increases to 105%, event 59: Overtemperature drive controller i2t is
triggered.

The possible effects depend on the configured level (U02):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Wrong drive controller design Check the design and change the drive controller type if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system of all axes and service them if
necessary

Mechanical block Check the output of all axes and remove the block if necessary

Short deceleration/acceleration
times

Check the actual current during the braking process using the scope image (E00);
reduce the deceleration and acceleration values if necessary

Clock frequency too high Check the utilization of the drive, taking into account derating and the configured
clock frequency (E20, B24); reduce the configured clock frequency or replace the
drive controller if necessary

Tab. 221: Event 39 – Causes and actions
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19.1.6.11 Event 40: Invalid data

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Fault,
2: Block missing,
3: Data security,
4: Checksum,
5: Read only,
6: Read error,
7: Block missing,
8: Wrong/illegal serial number

Invalid data in the internal memory
of the drive controller or option
module

Determine the affected memory (Z730) and,
based on that, replace the drive controller,
option module or motor; fault cannot be
acknowledged

32: Electronic nameplate No data available in the electronic
nameplate

Deactivate the evaluation of the nameplate or
replace the motor (B04); fault cannot be
acknowledged

33: Electronic nameplate limit Invalid data in the electronic
nameplate

Deactivate the evaluation of the nameplate or
replace the motor (B04); fault cannot be
acknowledged

48: Reverse documentation Defective memory in the SD card
or internal memory of the drive
controller

Replace the SD card or drive controller; fault
cannot be acknowledged

Tab. 222: Event 40 – Causes and actions
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19.1.6.12 Event 41: Temp.MotorTMP

The possible effects depend on the configured level (U15):

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Motor temperature sensor
connection error

Check the connection and correct it if necessary

Wrong sensor source for X2 –
 HIPERFACE DSL

Check the sensor settings and correct them if necessary (B35)

Wrong motor design Check the design and change the motor type if necessary

Surrounding temperatures at the
motor too high

Check the surrounding temperature and adjust it if necessary

Mechanical block of the motor Check the output and remove the block if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system and service them if necessary

Tab. 223: Event 41 – Causes and actions
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19.1.6.13 Event 42: TempBrakeRes

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Short deceleration/acceleration
times

Check the DC link voltage during the braking process using the scope image (E03);
reduce the deceleration and acceleration values if necessary

Braking resistor too low Check that the maximum permitted braking resistor power loss is suitable for the
application and replace the braking resistor if necessary

Tab. 224: Event 42 – Causes and actions
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19.1.6.14 Event 43: AI1 wire break

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Connection error Check the connection and correct it if necessary

Inconsistent parameterization Check wire break monitoring, taking into account the configured operating mode,
and correct it if necessary (F15, F16)

Tab. 225: Event 43 – Causes and actions
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19.1.6.15 Event 44: External fault 1

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Application-specific Application-specific

Tab. 226: Event 44 – Causes and actions
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19.1.6.16 Event 45: Overtemp.motor i2t

The possible effects depend on the parameterized level (U10):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Wrong motor design Check the design and change the motor type if necessary

Mechanical block of the motor Check the output and remove the block if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system and service them if necessary

Tab. 227: Event 45 – Causes and actions
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19.1.6.17 Event 46: Low voltage

The possible effects depend on the configured level (U00):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Supply voltage does not
correspond to the configured
supply voltage

Check the supply voltage, parameterized supply voltage and undervoltage limit and
correct them if necessary (A36, A35)

Supply voltage below undervoltage
limit

Check undervoltage limit and correct it if necessary (A35)

Tab. 228: Event 46 – Causes and actions
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19.1.6.18 Event 47: Torque/force-max. limit

The possible effects depend on the configured level (U20):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Incorrectly selected torque/force
limits

Check the general machine limit and adjust it if necessary (C03, C05); check the
application limits and the parameters dependent on the operating mode and adjust
them if necessary (Drive Based C132, C133 or CiA 402 A559)

Wrong motor design Check the design and change the motor type if necessary

Mechanical block Check the output and remove the block if necessary

Brake closed Check the connection, supply voltage and parameterization and correct them if
necessary (F00)

Connection error at the motor Check the connection and correct it if necessary

Connection error at the encoder Check the connection and correct it if necessary

Wrong encoder measurement
direction

Compare the attachment and measurement direction of the encoder with the
corresponding values of the H parameters and correct them if necessary

Tab. 229: Event 47 – Causes and actions
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19.1.6.19 Event 48: Brake release monitoring

The possible effects depend on the configured level (U26).

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Connection error Check the connection and correct it if necessary

Release monitoring not adjusted Adjust release monitoring

Tab. 230: Event 48 – Causes and actions
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19.1.6.20 Event 49: Brake

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

10: Brake monitoring with engaged
brake,
11: Brake monitoring with released
brake,
12: Brake monitoring during
engaging time,
13: Brake monitoring during
release time

Connection error Check the connection and correct it if necessary

Defective power cable Check the cable and replace it if necessary

Indirect brake connection Check the connection and configured brake
connection and correct them if necessary
(F105)

Tab. 231: Event 49 – Causes and actions
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19.1.6.21 Event 50: Safety module

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Inconsistent request (single
channel)

Connection error Check the connection and correct it if
necessary; error cannot be acknowledged until
both STO channels have been requested for at
least 100 ms

2: Wrong safety module The projected E53 safety module
does not match the E54[0]
detected by the system

Check the project configuration and drive
controller and correct the project configuration
or exchange the drive controller if necessary;
fault cannot be acknowledged

3: Internal error Defective safety module Exchange drive controller; fault cannot be
acknowledged

Tab. 232: Event 50 – Causes and actions
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19.1.6.22 Event 51: Virtual master software limit switch

The possible effects depend on the configured level (U24).

§ 0: Inactive

§ 1: Message

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Event 51: Virtual master software limit switch only affects the device control of the axis. A quick stop of the virtual master
can also be triggered with G57.

Cause Check and action

1: SW-limit switch positive,
2: SW-limit switch negative

End of the travel range reached Move in the travel range in the direction
opposite the limit switch

Travel range too small Check the positions of the software limit switch
and correct them if necessary (G146, G147)

3: +/- 31 bit computing limit
reached

Computing limit of the data type
reached

Check the command sequences for multiple
successive 3: MC_MoveAdditive commands
without a breakpoint and the number of
decimal places of the axis model and reduce
them if necessary (G46)

Tab. 233: Event 51 – Causes and actions
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19.1.6.23 Event 52: Communication

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

4: PZD-Timeout Missing process data Check the cycle time in the controller and tolerated failure
time for monitoring the PZD communication in the drive
controller and correct if necessary (A109)

6: EtherCAT PDO-Timeout Missing process data Check the task cycle time in the EtherCAT MainDevice and
the timeout time in the drive controller and correct them if
necessary (A258)

7: Reserved Synchronization error Check the synchronization settings in the EtherCAT
MainDevice and correct them if necessary

Connection error Check the connection and shielding and correct them if
necessary

14: PZD parameter figure
faulty

Missing mapping Check the mapping for unmappable parameters and correct
them if necessary

15: Wrong firmware for
applicataion

Projected fieldbus
identification and that of the
drive controller do not
match

Check the projected fieldbus identification and the fieldbus
identification of the drive controller and change the fieldbus
if necessary (E59[2], E52[3])

16: PROFINET Sign-of-Life
synchronisation failed

Synchronization error Obey the information in the TIA Portal and update the GSD
file if necessary; check the controller or technology object
for clock synchronicity and correct if necessary

Tab. 234: Event 52 – Causes and actions
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19.1.6.24 Event 53: Limit switch

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Hardware-Limit-Switch
positive,
2: Hardware-Limit-Switch
negative

End of the travel range
reached

Move in the travel range in the direction opposite the limit
switch

Connection error Check the connection and source parameters and correct
them if necessary (I101, I102)

Defective cable Check the cable and replace it if necessary

3: SW-limit switch positive,
4: SW-limit switch negative

End of the travel range
reached

Move in the travel range in the direction opposite the limit
switch

Travel range too small Check the positions of the software limit switches and
correct them if necessary (Drive Based I50, I51 or CiA
A570[0], A570[1])

5: +/- 31 bit computing limit
reached

Computing limit of the data
type reached

Check the command sequences for multiple successive 
3: MC_MoveAdditive commands without a breakpoint and
the number of decimal places of the axis model and reduce
them if necessary (I06)

6: Linear motor moving
range

Axis is 200 m away from the
commutation reference
point

Check the axis model and correct it if necessary

7: Both limit switches not
connected

Connection error Check the connection and source parameters and correct
them if necessary (I101, I102)

Defective cable Check the cable and replace it if necessary

Tab. 235: Event 53 – Causes and actions
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19.1.6.25 Event 54: Following error

The possible effects depend on the configured level (U22).

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Incorrectly selected torque/force
limits

Check the general machine limit and adjust it if necessary (C03, C05); check the
application limits and adjust them if necessary (Drive Based/PROFIdrive: C132, C133
and the parameters dependent on the operating mode; CiA 402: A559)

Maximum permitted lag is too
small

Check the maximum permitted following error and correct it if necessary (Drive
Based/PROFIdrive: I21; CiA 402: A546)

Mechanical block Check the output and remove the block if necessary

Brake closed Check the connection, supply voltage and parameterization and correct them if
necessary (F00)

Tab. 236: Event 54 – Causes and actions
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19.1.6.26 Event 55: Option module

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

7: Terminal module wrong/ missing No terminal module or wrong type
installed

Correct project configuration or replace
terminal module; fault cannot be
acknowledged

10: XB6 failure Defective or incorrectly installed
terminal module

Replace the terminal module; fault cannot be
acknowledged

12: XB6 24V supply Connection error Check the connection and correct it if necessary

Defective cable Check the cable and replace it if necessary

Supply voltage too low Check the voltage source and increase the
voltage if necessary

Tab. 237: Event 55 – Causes and actions
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19.1.6.27 Event 56: Overspeed

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Information

The event is only triggered if the checking rules for Enable-on are violated.
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Cause Check and action

1: Motor encoder,
2: Position encoder,
3: Motor & position encoder

Maximum permitted velocity
too small

Check the maximum permitted velocity and increase it if
necessary (I10); event is triggered if actual velocity > I10 ×
1.111

Overshooting control system Check the actual velocity using the scope image (Sensing
time: 250 µs, actual motor velocity: E15, E91; actual
position velocity I88) and, if necessary, reduce the gain of
the control system (I20, C31)

1: Motor encoder,
3: Motor & position encoder

Wrong commutation offset Check the commutation offset using the Test phase action
(B40)

Faulty motor encoder Check the velocity display of the encoder at a standstill
(E15, E91) and replace the encoder if necessary

2: Position encoder,
3: Motor & position encoder

Faulty position encoder Check the velocity display of the encoder at a standstill (I88)
and replace the encoder if necessary

Tab. 238: Event 56 – Causes and actions
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19.1.6.28 Event 57: Runtime requirement

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

3: RT3,
4: RT4,
5: RT5

Exceeding the cycle time Check the utilization (E191) and increase the
cycle time if necessary (A150)

Tab. 239: Event 57 – Causes and actions
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19.1.6.29 Event 58: Encoder simulation

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Maximum speed Input velocity too high Check the source of the velocity being
simulated and adjust it if necessary (H80)

3: X120 channel A/Clk Defective encoder cable Check the cable and replace it if necessary

Tab. 240: Event 58 – Causes and actions
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19.1.6.30 Event 59: Overtemperature drive controller i2t

The i²t value of the drive controller (E22) has reached 105%.

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Wrong drive controller design Check the design and change the drive controller type if necessary; the fault can only
be acknowledged 30 s after the cause has been corrected

Increased or reduced mechanical
friction

Check the service status of the mechanical system and service them if necessary; the
fault can only be acknowledged 30 s after the cause has been corrected

Short deceleration/acceleration
times

Check the actual current during the braking process using the scope image (E00);
reduce the deceleration and acceleration values if necessary; the fault can only be
acknowledged 30 s after the cause has been corrected

Clock frequency too high Check the utilization of the drive, taking into account derating and the configured
clock frequency (E20, B24); reduce the configured clock frequency or replace the
drive controller if necessary; the fault can only be acknowledged 30 s after the cause
has been corrected

Tab. 241: Event 59 – Causes and actions
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19.1.6.31 Event 60: Application event 0 – Event 67: 
Application event 7

The possible effects depend on the configured level (U100, U110, U120, U130, U140, U150, U160, U170):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Application-specific Application-specific

Tab. 242: Events 60 – 67 – Causes and actions
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19.1.6.32 Event 68: External fault 2

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Application-specific Application-specific

Tab. 243: Event 68 – Causes and actions
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19.1.6.33 Event 69: Motor connection

The possible effects depend on the configured level (U12).

§ 0: Inactive

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

2: No motor connected Connection error Check the connection and correct it if necessary

Defective power cable Check the cable and replace it if necessary

Nominal speed too high
(asynchronous motor)

Check the speed of the motor and reduce the
value if necessary (B13)

3: Wake and Shake failed
(Commutation finding with Wake
and Shake failed)

Increased or reduced mechanical
friction

Check the service status of the mechanical
system and service them if necessary

Mechanical block Check the output and remove the block if
necessary

Axis with large mass inertia Increase minimum wait time between Wake
and Shakes (B33)

4: Brake
(Commutation finding with Wake
and Shake failed)

Brake engaged Check control of the brakes and carry out
action B50 if necessary,
see Commutation finding [} 360]

Tab. 244: Event 69 – Causes and actions
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19.1.6.34 Event 70: Parameter consistency

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Information

The event is only triggered if the checking rules for Enable-on are violated.

Cause Check and action

1: Wrong encoder model Encoder model unsuitable for
control type

Check the control mode, motor encoder and
encoder and correct them if necessary (B20,
B26, H parameters)

2: X120 data direction Use of the X120 interface for
evaluation and simulation at the
same time

Check the evaluation against the simulation
and correct it if necessary (motor: B26;
position: I02; H120)

3: B12<->B20 Nominal current of the motor
exceeds the drive controller
nominal current (4 kHz)

Check the motor nominal current against 150%
of the drive controller nominal current at a
clock frequency of 4 kHz and, if necessary,
reduce the motor nominal current or change
the drive controller type (B12, R04[0])

4: B10<->H31 Unsupported combination of
resolver/motor number of poles

Check number of poles of the resolver and
number of poles of the motor and correct them
if necessary (H08, H148, B10)

5: Negative slip frequency Negative slip Check the nominal velocity, nominal frequency
and number of poles of the motor and, if
necessary, correct them (B13, B15, B10)

8: v-max (I10) exeeds maximum
(B83)

Maximum permitted velocity
exceeds the maximum motor
velocity

Check the maximum permitted velocity and the
maximum motor velocity and correct them if
necessary (I10, B83)

B83 parameterized too large For Lean motors, reduce B83 to max. 6000 rpm

11: Reference retaining Conditions for reference without
tracking not met

Check that the reference is retained and that
the measurement range covers the travel range
and make corrections if necessary (I46, limited
travel range I00: Software limit switch must be
parameterized; infinite travel range I00:
Measurement range must correspond to the
revolution length Drive Based/PROFIdrive I01
or CiA 402 A568[1] or an entire multiple)

12: Type of axis Rotational axis model not suitable
for synchronous linear motor

Correct the axis type of the axis model (I00)

13: Motor temperature sensor Unsupported temperature sensors Check the motor temperature sensor type in
the motor and the drive controller series and, if
necessary, change the motor or drive controller
series
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Cause Check and action

14: Max. acceleration I11>B143 Maximum permitted velocity is
above maximum motor
acceleration

Check the maximum permissible velocity and
maximum motor acceleration and correct them
if necessary (Drive Based/PROFIdrive: I11; CiA
402: minimum values of A604 and A605, B143)

SY6 option:
15: Safety watchdog time

Monitoring of PDO timeout
deactivated

Check the EtherCAT PDO timeout in the drive
controller and activate it if necessary (A258 = 0
or 65535)

SyncManager watchdog = 0 Check the EtherCAT SyncManager watchdog in
the EtherCAT MainDevice and increase it if
necessary (A258 = 65534, A259[0])

Ratio of FSoE watchdog time to
EtherCAT PDO timeout too small

Check the FSoE watchdog time in the FSoE
MainInstance and EtherCAT PDO timeout in the
drive controller; if necessary, increase the
watchdog time or reduce the timeout
(condition: FSoE watchdog time > EtherCAT
PDO timeout + FSoE cycle time + 26 ms; S27,
A258, S26)

Ratio of FSoE watchdog time to
EtherCAT SyncManager watchdog
too small

Check the FSoE watchdog time in the FSoE
MainInstance and EtherCAT SyncManager
watchdog in the EtherCAT MainDevice; if
necessary, increase the watchdog time or
reduce the SyncManager watchdog (condition:
FSoE watchdog time > EtherCAT SyncManager
watchdog + FSoE cycle time + 26 ms; S27, A258
= 65534, A259[0], S26)

SU6 option:
15: Safety watchdog time

Monitoring of PZD timeout
deactivated

Check the PZD timeout in the drive controller
and activate it if necessary (A109 = 0 or 65535)

Ratio of PROFIsafe watchdog time
to PZD timeout too small

Check the PROFIsafe watchdog time in
TIA Portal and PZD timeout in the drive
controller; if necessary, increase the watchdog
time or reduce the PZD timeout (condition:
PROFIsafe watchdog time > PZD timeout +
PROFIsafe data bus runtime + 26 ms; S46 >
A109 + S44 + 26 ms)

16: I10 > C11 Maximum permitted velocity is
above maximum gear unit input
speed

Check the maximum permitted velocity and the
maximum gear unit input speed and correct
them if necessary (I10, C11)

Tab. 245: Event 70 – Causes and actions
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19.1.6.35 Event 71: Firmware

Cause 1:

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause 3:

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Firmware defective Defective firmware Update the firmware; fault cannot be acknowledged

Defective drive controller Exchange drive controller; fault cannot be acknowledged

3: CRC-error Defective firmware Update the firmware; fault cannot be acknowledged

Defective drive controller Check for repeated triggering of the event after a restart; if
necessary, replace the drive controller

Tab. 246: Event 71 – Causes and actions



19 | Diagnostics STOBER

296

11
/2

02
4 

| 
ID

 4
43

34
0.

01

19.1.6.36 Event 76: Position encoder

The drive controller has a fault if:

§ U30 = 0: Inactive and

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The reference is deleted (I86).
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Cause Check and action

1: Parameter <-> encoder Inconsistent
parameterization

Compare the specification of the connected encoder to the
corresponding values of the H parameters and correct them
if necessary

2: Maximum speed Exceeded encoder maximum
velocity

Check the actual velocity during a movement using the
scope image (I88) and adjust the permitted encoder
maximum velocity if necessary (I297)

Connection error Check the connection and shielding and correct them if
necessary

Mass inertia ratio of load to
Lean motor

Check the setting of the mass inertia ratio (C30) and reduce
it if necessary

Dynamic control of the Lean
motor

Check the control settings; if necessary, reduce the gain
(C31, I20) and increase the reset times (C32)

Dynamic set values for the
Lean motor

Check the dynamics of the application set values and
reduce them if necessary

Dynamic acceleration of the
Lean motor

Use a scope image to check the actual velocity and shifting
speed during a movement (E15, E959) and reduce the
shifting filter time constant if necessary (B137)

6: X4 EnDat encoder found Inconsistent
parameterization

Compare the connected encoder to the parameterized
encoder and correct it if necessary (H00)

7: X4 A track/Incremental Connection error Check the connection and correct it if necessary

8: X4 no encoder found Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty supply voltage Check the supply voltage of the encoder and correct if
necessary

Inconsistent
parameterization

Compare the connected encoder to the parameterized
encoder and correct it if necessary (H00)

9: Referencing failed Reference set for inactive
Lean motor position
determination

Check device status (E48) and, if necessary, activate the
enable signal

10: X4 A track/Clk,
11: X4 B track/Dat

Defective encoder cable Check the cable and replace it if necessary

13: X4-EnDat alarm Defective EnDat encoder Replace the motor; EnDat 2.1 digital, EnDat 2.2 digital,
EnDat 3: Fault cannot be acknowledged

14: X4 EnDat CRC,
15: X4 double transmission

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (I298)

16: X4 busy Synchronization error Update firmware

17: EBI encoder low battery Battery in battery module
weak

Replace the battery; reference is not deleted by the event

18: EBI encoder battery
empty

Battery in battery module
empty

Replace the battery

Initial connection –

Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty battery module Check the battery module and replace it if necessary

19: Alarm bit Encoder fault Check the specification of the encoder regarding the alarm
bit
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Cause Check and action

20: Resolver carrier,
21: Resolver sin/cos
undervoltage,
22: Resolver sin/cos
overvoltage

Defective encoder cable Check the cable and replace it if necessary

Incompatible encoder Compare the specification of the encoder with the
corresponding specifications from STOBER and replace the
encoder or motor if necessary; fault cannot be
acknowledged

21: Resolver sin/cos
undervoltage

Incompatible encoder;
phase search or calibration
of the optimal resolver
excitation failed

Compare the specification of the encoder with the
corresponding specifications from STOBER;
if necessary, calibrate the starting point for calibrating the
optimal resolver excitation and the phase search (B40); fault
cannot be acknowledged

24: Resolver failure Defective encoder cable Check the cable and replace it if necessary

48: X4 zero pulse missing Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Late zero track Check number of encoder increments per rotation and
correct it if necessary (H02)

49: X4 zero pulse distance
too small

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Early zero track Check number of encoder increments per rotation and
correct it if necessary (H02)

60: Hiperface
synchronisation,
61: Hiperface timeout,
62: Hiperface signal quality,
63: Hiperface link

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (I298)

64: EnDat3 Timeout,
65: EnDat3 invalid Request,
66: EnDat3 Position Check

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (I298)

Tab. 247: Event 76 – Causes and actions
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19.1.6.37 Event 77: Master encoder

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The reference is deleted (G89).

Cause Check and action

1: Parameter <-> encoder Inconsistent
parameterization

Compare the specification of the connected encoder to the
corresponding values of the H parameters and correct them
if necessary

2: Maximum speed Exceeded encoder maximum
velocity

Check the actual velocity during a movement using the
scope image (G105) and adjust the permitted encoder
maximum velocity if necessary (G297)

Connection error Check the connection and shielding and correct them if
necessary

6: X4 EnDat encoder found Inconsistent
parameterization

Compare the connected encoder to the parameterized
encoder and correct it if necessary (H00)

7: X4 A track/Incremental Connection error Check the connection and correct it if necessary

8: X4 no encoder found Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty supply voltage Check the supply voltage of the encoder and correct if
necessary

Inconsistent
parameterization

Compare the connected encoder to the parameterized
encoder and correct it if necessary (H00)
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Cause Check and action

10: X4 A track/Clk,
11: X4 B track/Dat

Defective encoder cable Check the cable and replace it if necessary

13: X4-EnDat alarm Defective EnDat encoder Replace the motor; EnDat 2.1 digital, EnDat 2.2 digital,
EnDat 3: Fault cannot be acknowledged

14: X4 EnDat CRC,
15: X4 double transmission

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (G298)

16: X4 busy Synchronization error Update firmware

17: EBI encoder low battery Battery in battery module
weak

Replace the battery; reference is not deleted by the event

18: EBI encoder battery
empty

Battery in battery module
empty

Replace the battery

Initial connection –

Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty battery module Check the battery module and replace it if necessary

19: Alarm bit Encoder fault Check the specification of the encoder regarding the alarm
bit

20: Resolver carrier,
21: Resolver sin/cos
undervoltage,
22: Resolver sin/cos
overvoltage

Defective encoder cable Check the cable and replace it if necessary

Incompatible encoder Compare the specification of the encoder with the
corresponding specifications from STOBER and replace the
encoder or motor if necessary; fault cannot be
acknowledged

21: Resolver sin/cos
undervoltage

Incompatible encoder;
phase search or calibration
of the optimal resolver
excitation failed

Compare the specification of the encoder with the
corresponding specifications from STOBER;
if necessary, calibrate the starting point for calibrating the
optimal resolver excitation and the phase search (B40);
fault cannot be acknowledged

24: Resolver failure Defective encoder cable Check the cable and replace it if necessary

48: X4 zero pulse missing Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Late zero track Check number of encoder increments per rotation and
correct it if necessary (H02)

49: X4 zero pulse distance
too small

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Early zero track Check number of encoder increments per rotation and
correct it if necessary (H02)

60: Hiperface
synchronisation,
61: Hiperface timeout,
62: Hiperface signal quality,
63: Hiperface link

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (G298)

64: EnDat3 Timeout,
65: EnDat3 invalid Request,
66: EnDat3 Position Check

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 96] and, if
necessary, increase the fault tolerance (G298)

Tab. 248: Event 77 – Causes and actions
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19.1.6.38 Event 78: Position limit cyclic

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Illegal direction Cyclical set position outside of the
software limit switch

Check the set position in the controller and
software limit switch in the drive controller and
correct it if necessary (PROFIdrive: I50, I51;
CiA 402: A570)

2: Reference value invalid Cyclical set position outside of the
travel range

Check the set position in the controller and
travel range in the drive controller and correct
it if necessary (PROFIdrive: I01; CiA 402: A568)

3: Extrapolation time I423
exceeded

Missing update of the cyclical set
position or cyclical set velocity

Check the task cycle time in the fieldbus
MainDevice of the controller and maximum
permitted extrapolation in the drive controller
and correct it if necessary (I423)

Tab. 249: Event 78 – Causes and actions
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19.1.6.39 Event 79: Motor/position encoder plausibility

The possible effects depend on the configured level (U28).

§ 0: Inactive

§ 1: Message

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Connection error Check the connection and shielding and correct them if necessary

Slip Check the mechanics between the motor and position encoder and maximum
permitted slip and correct them if necessary (I291, I292)

Mechanical damage Check the mechanics between the motor and position encoder and correct any
damage if necessary

Tab. 250: Event 79 – Causes and actions
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19.1.6.40 Event 80: Illegal action

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Illegal Not supported by the control type Check the control type and correct it if
necessary (B20)

2: Brake Loaded axis Remove the axis load and start the action again

Tab. 251: Event 80 – Causes and actions

19.1.6.41 Event 81: Motor allocation

The possible effects depend on the configured level (U04):

§ 0: Inactive

§ 1: Message

§ 3: Fault

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Depending on the cause, data for the motor (in the case of a change to the motor or motor type), current controller (in the
case of a change to the motor type), brake (in the case of a change to the brake or motor type), temperature sensor (in the
case of a change to the temperature sensor or motor type) or motor adapter, gear unit and geared motor (in the case of a
change to the gear unit type) are read out of the electronic nameplate and entered in the respective parameters. In the
event of a change to the motor, motor type or even just the commutation, the commutation offset (B05) is reset.
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Cause Check and action

1: Different motor type Modified motor assignment Check the change to the motor
assignment and save the new
motor assignment if necessary
(A00)

Modified gear unit assignment Check the change to the gear unit
assignment and save the new
assignment if necessary (A00)

32: Different motor,
33: Different motor & brake,
34: Different motor & temperature sensor,
35: Different motor & brake & temperature
sensor,
38: Different motor, temperature sensor & gear
unit,
64: Different commutation,
65: Different commutation & brake,
66: Different commutation & temperature
sensor,
67: Different commutation & brake &
temperature sensor,
129: Different brake,
130: Different temperature sensor,
131: Different brake & temperature sensor

Modified motor assignment Check the change to the motor
assignment and save the new
assignment if necessary (A00)

36: Different motor & gear unit
37: Different motor, brake & gear unit,
39: Different motor, brake, temperature sensor
& gear unit

Modified motor and gear unit
assignment

Check the change to the motor and
gear unit assignment and save the
new assignment if necessary (A00)

150: Temperature sensor unknown Motor with unknown temperature
sensor type

Update the firmware or change the
motor

Tab. 252: Event 81 – Causes and actions
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19.1.6.42 Event 82: Hall sensor

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Invalid sample Connection error Check the connection and correct it if necessary

Signal levels do not correspond to
any sector

Check the Hall distance and correct it if
necessary (B08)

2: Invalid sequence Connection error Check the connection and correct it if necessary

Direct change between two non-
adjacent sectors

Check the Hall distance and correct it if
necessary (B08)

3: Signal edge missing Missing signal change within pole
pitch

Check the pole pitch and correct it if necessary
(B16)

Defective Hall sensor Replace the Hall sensor

4: X120 wire break Defective encoder cable Check the cable and replace it if necessary

Tab. 253: Event 82 – Causes and actions
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19.1.6.43 Event 83: Failure of one/ all phases (mains)

Upon the occurrence of an event, a warning is output initially, becoming a fault after a 10 s warning period.

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Failure of one or all line phases Check the line fuse and connection and correct them if necessary

Tab. 254: Event 83 – Causes and actions
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19.1.6.44 Event 84: Drop in network voltage when power section active

The event is triggered if the drive controller cannot recharge itself quickly enough via the charging resistors after a line drop
when the power supply returns.

If the voltage falls below the undervoltage limit before the power supply returns, event 46: Low voltage is triggered; if the
tolerance time of 10 s expires before the power supply returns, the drive controller goes into fault mode with event 83:
Failure of one/ all phases (mains).

The drive controller has a fault if:

§ U30 = 0: Inactive and

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.
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Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

A quick stop is not possible when the power supply returns.

Cause Check and action

Decrease in supply voltage under
load

Check the supply voltage for load stability and stabilize the network if necessary

Sporadic power failures Check the supply voltage for stability and stabilize the network if necessary

Tab. 255: Event 84 – Causes and actions
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19.1.6.45 Event 85: Excessive jump in reference value

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Position Fast set position change leads to
acceleration that cannot be
performed

Check the current set acceleration against the
maximum permitted acceleration in the drive
controller (E64, E69) and reduce the set value
change in the controller or change the motor
type if necessary

2: Velocity Fast set velocity change leads to
acceleration that cannot be
performed

Check the current set acceleration against the
maximum permitted acceleration in the drive
controller (E64, E69) and reduce the set value
change in the controller or change the motor
type if necessary

Tab. 256: Event 85 – Causes and actions
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19.1.6.46 Event 86: Unknown LeanMotor record

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Motor Motor type not supported by
firmware

Update the firmware or change the motor
(B100)

2: Cable length Cable length not supported by
firmware

Update the firmware or change the cable
(B101)

Tab. 257: Event 85 – Causes and actions

19.1.6.47 Event 87: Reference lostReference loss

A reference loss is issued as a message only.

Cause Check and action

Power unit switched off on moving
axis

Reference the drive again and, if necessary, only shut off the power unit at standstill
(I199)

Actual position (motor) changes
when power unit is shut off

Do not change the actual position (motor) when the power unit is shut off and, if
applicable, switch to a motor with a brake (F00)

Tab. 258: Event 87 – Causes and actions
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19.1.6.48 Event 88: Control panel

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Commissioning and
parameterization computer heavily
loaded

Check and, if necessary, reduce the number of open windows (DS6) and the number
of active programs

Connection error Check the connection and correct it if necessary

Defective network cable Check the cable and replace it if necessary

Faulty network connection Check the network settings and, if applicable, the switch, router or wireless
connections and correct them or contact your network service provider if necessary

Tab. 259: Event 88 – Causes and actions
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19.1.6.49 Event 89: Maximum current LM

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Id,
2: Iq

Excessive controller gain at low
speeds

Check the controller coefficients and speed
controller factors and reduce them if necessary
(I19, C31, B146, B147)

Tab. 260: Event 89 – Causes and actions
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19.1.6.50 Event 90: Motion block

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Next motion block missing Subsequent motion block for
motion block with final velocity is
missing

Define buffered subsequent motion block

2: Target Position in reverse
direction

Set position is in the opposite
direction

A change of travel direction by the subsequent
motion block is not permitted for motion
blocks with final velocity; adjust the set
position

Set position cannot be reached
without reversing

Check limiting values for velocity, deceleration
and jerk and adjust if necessary

Tab. 261: Event 90 – Causes and actions
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19.2 Acknowledging faults
There are several options for acknowledging faults. As a rule, an acknowledgement is also transmitted to the safety module.

Application-independent

Independent of the application, you can acknowledge faults directly on the drive controller using the [Esc] button or
alternatively in DriveControlSuite using the control panels.

Drive Based application

In the Drive Based application, the following options for acknowledging are available in DriveControlSuite:

§ By defining the source of the signal in A61 (source: digital input or control byte A180, bit 1)

§ By additional enable signal via A60 (source: digital input or control byte A180, bit 0)

The drive controller has a configurable restart (A34) in the Drive Based application.

WARNING!

Injury to persons and material damage due to unexpected motor startup!

Only activate autostart if the standards and regulations applicable to the system or machine in question permit a direct
switch to the Ready to switch on device state.

▪ In accordance with EN 61800-5-1, clearly mark an activated autostart on the system and in the associated system
documentation.

CiA 402 application

In the CiA 402 application, you can acknowledge faults in DriveControlSuite using control word A515, bit 3 (Enable
operation) or bit 7 (Fault reset).

PROFIdrive application

In the PROFIdrive application, you can acknowledge faults in DriveControlSuite using control word M515, bit 3 (Enable
operation) or bit 7 (Fault acknowledge).
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20 Analysis
Scope and multi-axis scope in DriveControlSuite are two analysis tools that help you commission single axes or entire
machines and troubleshoot.

You can select and record up to 12 parameters from the entire pool of drive controller parameters. The sampling time can
be set from 250 µs to several seconds to be able to observe both highly dynamic as well as very slow processes. Like for an
actual oscilloscope, there are a variety of trigger options and many statistical evaluation functions for the recorded data
(minimum value, maximum value, average, RMS value, standard deviation, etc.).

Tool Objectives Application cases

Scope Create multiple scope images of a single drive controller at
different times.

Optimize or diagnose a drive
controller

Create multiple scope images with the same settings
(channels, trigger, pre-trigger, sampling time), but differing
values for individual parameters.

Combine multiple scope images for the analysis.

Create a temporary direct image.

Multi-axis scope Create individual scope images of multiple drive controllers
or axes at the same time.

Check the machine
utilization or diagnosis in
synchronous operationCreate an individual scope image with the same settings or

individual settings (for each axis or for individual axes).

Tab. 262: Application cases for scope and multi-axis scope
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20.1 Scope and multi-axis scope
With the Scope and Multi-axis scope windows, you can create scope images for diagnostic purposes for one or more drive
controllers if an online connection is established.

Information

The Scope window can be reached using the button in the project menu if you have selected a drive controller in the
project tree.

The Multi-axis scope window can be reached using the button in the project menu if you have selected the project in the
project tree.

1

2

Fig. 74: Scope and multi-axis scope: Program interface

No. Area Description

1 Action area In the Action area, you can define settings for the scope image, start and stop the scope
image, and read information on the status, scope image progress and remaining recording
time.

2 Scope images In the Images area, you can open, delete, rename, comment on or export scope images
that have already been read out. In the scope, the Combinations and Direct image tabs are
also available in this area.
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Action area: Buttons

Button Availability Description

Start Scope, 
multi-axis scope

Starts the scope image (prerequisite: online connection).

Stop Scope, 
multi-axis scope

Stops the scope image (prerequisite: online connection).

Settings Scope,
multi-axis scope

Opens the Settings window where you can define the
trigger condition, channel assignment, sampling time and, in
the case of the multi-axis scope, the nodes for the scope
image.

Scope images: Buttons

Icon Description

Opens the dialog box for storing a comment for the scope image.

Shows/hides the bottom margin area.

Information

If you want to learn more about a particular scope image, click on it. Any comments and the properties of the scope image
are then displayed at the bottom of the window. You can show the lower margin area using the button in the Scope images
or Combinations tab.

Button Description

Close all windows Closes all open scope images and combinations.

Delete all scope images Deletes all individual scope images; combined scope images are retained (tab: Scope
images).

Delete all combinations Deletes all combined scope images; individual scope images are retained (tab:
Combinations).
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Scope images: Context menus

Tab Availability Description Context menu

Scope images Scope On the Images tab,
completed scope images are
listed after being read out
from the drive controller.
Double-click to open the
scope image. If you have
created multiple scope
images and select this, you
can combine and open them
via the context menu.

§ Open

§ Delete

§ Rename

§ Comment

§ Export

§ Combine and open

Multi-axis scope On the Images tab,
completed scope images are
listed after being read out
from the drive controller.
Double-click to open the
scope image.

§ Open

§ Delete

§ Rename

§ Comment

§ Export

Combinations Scope On the Combinations tab,
combined scope images are
listed that you can open by
double-clicking.

§ Open

§ Delete

§ Rename

§ Comment

§ Export

Direct image Scope In the Direct image tab, you
can create a temporary
scope image that is
discarded with the start of
the next scope image and
use the set value generation
to optimize the control
cascade.

—
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20.1.1 Scope settings
In the Settings window, you define the settings for the scope image and the trigger before you start the scope image. The
scope image settings are shown in the Channel assignment tab, the trigger settings in the Trigger condition tab (scope) or
Node and trigger condition tab (multi-axis scope).

Information

The Settings window for scope images can be reached via the Settings button in the Scope or Multi-axis scope window.

Tab Availability Description

Channel assignment Scope,
multi-axis scope

With the scope image settings in the Channel assignment
tab, you define which data of the respective axis you want
to record in the scope image, in which time intervals the
data is sampled and which time period is recorded before
triggering the trigger.

Trigger condition Scope With the trigger settings in the Trigger condition tab, you
define which event triggers the recording of a scope image.

Node and trigger condition Multi-axis scope With the trigger settings in the Node and trigger condition
tab, you define which event triggers the recording of a
scope image and for which axes a scope image is recorded.

Example: Trigger and scope image settings

Settings Example Results

Trigger settings § Simple trigger

§ Source: E15 v-motor-
encoder

§ Condition: greater

§ Comparison value:
50 rpm

The trigger condition is met if the value of parameter 
E15 v-motor-encoder is greater than 50 rpm.

Scope image settings § Recorded channels: 1

§ Sampling time: 1 ms

§ Pre‐trigger: 33%

The recording time calculated from the number of channels
and the sampling time is 6.6 s. 2.2 s (33%) are recorded
before the trigger is triggered and 4.4 s afterwards.

Information

Additional settings for your scope images can be made using parameters T25 Automatic start and T26 Retrigger scope.
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20.1.1.1 Trigger settings

With the trigger settings in the Trigger condition tab (scope) or Node and trigger condition tab (multi-axis scope), you define
which event triggers the recording of a scope image. To do this, define the trigger for each axis and, if applicable, the trigger
condition. The selection of the trigger influences which of the settings described below are available to you.

Information

The Settings window for the scope image can be reached via the Settings button in the Scope or Multi-axis scope window.
For the scope, you can find the trigger settings directly in the Trigger condition tab. For the multi-axis scope, you can reach
the trigger settings for the respective axis via the Settings button in the Node and trigger condition tab.

Trigger Description

Manually at stop The trigger is triggered by the Stop button, without taking the pre-trigger time into
account.

Immediately at start The trigger is triggered by the Start button as soon as the pre-trigger time has elapsed.

Simple trigger The trigger is triggered automatically when the trigger condition is met and the pre-trigger
time has elapsed.

Trigger logic The trigger is triggered automatically when the trigger logic is satisfied and the pre-trigger
time has elapsed.

Trigger conditions

A simple trigger consists of a single trigger condition, while trigger logic is composed of 2 trigger conditions logically linked
by an operator. A trigger condition consists of the source, the condition and the comparison value.

Source Description

Inactive Default value if Manually at stop was selected as the trigger.

Immediately at start Default value if Immediately at stop was selected as the trigger.

Parameter Defines a parameter as the source for the trigger. You can enter the parameter either via
the [...] button and Add parameter dialog box or directly into the text field with auto-
completion by specifying the coordinate, name and, if applicable, axis number (example:
1.I80 Current position).

Signal name Defines a signal as the source for the trigger. You have assigned a signal name for this
signal in the graphical programming at the input or output of a block. If you have not yet
assigned a signal name in the graphical programming, the list is empty.

Physical address Defines a physical address in the drive controller memory as the source for the trigger.
Physical addresses can be assigned as part of an extended diagnosis by the development
team. They must be specified with the associated data type.

Information

If you record the value of a parameter or use a parameter as a trigger source, you can display the associated parameter

description as a tooltip in both the scope image settings and the trigger settings (button: ).
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Setting Description

Condition Condition for the trigger condition with which the source and the comparison value are
compared.

§ less than

§ less than or equal to

§ greater than

§ greater than or equal to

§ equal to

§ not equal to

Comparison value Comparison value for the trigger condition that is compared to the source.

Minimum time Time, in µs, in which the condition must at least be met for the trigger condition to be
considered met.

Option Description

Absolute value The Absolute value option enables you to ignore the sign when comparing the source and
comparison value.

Mask The Mask option allows you to evaluate only a single bit of the source.

Edge The Edge option activates/deactivates edge detection.

Information

You can switch the display of the Mask option between hexadecimal and binary display if required. The mask is displayed
with leading zeros according to the data type or data width of the selected parameter.

Operator Description

AND The trigger logic is satisfied if both trigger conditions are met.

OR The trigger logic is satisfied if one or both trigger conditions are met.

XOR The trigger logic is satisfied if one of the two trigger conditions is met, not both.

NAND The trigger logic is satisfied if neither or one of the two trigger conditions is met, not both.

NOR The trigger logic is satisfied if neither of the two trigger conditions is satisfied.

XNOR The trigger logic is satisfied if neither or both of the two trigger conditions are met.

Trigger 1 The trigger logic is satisfied if the first trigger condition is met.

Trigger 2 The trigger logic is satisfied if the second trigger condition is met.

Button Description

Export Exports all settings (trigger and scope image settings) to a text file (*.txt).

Import Imports all settings from a text file (*.txt).

Close Closes the window. All settings are accepted.

Information

Export your settings if you want to reuse the same or similar settings in other projects or import existing settings and adjust
them as necessary.
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20.1.1.2 Scope image settings

With the scope image settings in the Channel assignment tab, you define which data of the respective axis you want to
record in the scope image, in which time intervals the data is sampled and which time period is recorded before triggering
the trigger. To do this, define the channel assignment, the sampling time and the pre-trigger for each axis.

Information

The Settings window for the scope image can be reached via the Settings button in the Scope or Multi-axis scope window.
For the scope and multi-axis scope, the scope image settings are shown in the Channel assignment tab.

Information

For a multi-axis scope, you must first select at least 2 nodes before you can specify the settings in the Channel assignment
tab. You can specify identical channel assignments for all axes or use the Individual option to store differing settings for
each axis. The calculation of the recording time and pre-trigger time relate to the axis with the shortest recording time.

Setting Selection Description

Channel assignment Inactive When Inactive is selected, no value is recorded in the scope
image for the channel.

Parameters When Parameter is selected, the value of a parameter is
recorded in the scope image for the channel.

Signal names When Signal name is selected, the value of a signal is
recorded in the scope image for the channel. You defined a
signal name for this signal in the graphic programming at
the input or output of a block.

Physical address When Physical address is selected, the value of a physical
address in the memory of the drive controller is recorded in
the scope image for the channel.

Sampling time 250 µs - 100 ms With the Sampling time setting, you define the time interval
in which the signals are sampled for the scope image.

Pre-trigger 0 % – 100 % With the Pre-Trigger setting, you define the percentage of
the scope memory that must be occupied for the axis to be
trigger-ready and thus the percentage of the recording time
before the trigger.

Information

If you record the value of a parameter or use a parameter as a trigger source, you can display the associated parameter

description as a tooltip in both the scope image settings and the trigger settings (button: ).

Information

The scope memory has approximately 32 KB available for the scope image. The recording time is calculated from the
sampling time, the number of recorded channels and the available disk space. The larger the number of recorded channels
and the more frequently the channels are sampled, the faster the available disk space is occupied and the shorter the scope
image becomes.

The pre-trigger time is calculated from the set pre-trigger and the recording time.
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Information

If a large pre-trigger value is entered with a long recording time, the scope image may remain in the Started state for a
period after the start until the pre-trigger is fulfilled and recording readiness is signaled by the Trigger-ready state. Status
and progress of the scope image are displayed in DriveControlSuite. The scope image is then read out from the drive
controller and transmitted to DriveControlSuite.

Button Description

Export Exports all settings (trigger and scope image settings) to a
text file (*.txt).

Import Imports all settings from a text file (*.txt).

Close Closes the window. All settings are accepted.

Information

Export your settings if you want to reuse the same or similar settings in other projects or import existing settings and adjust
them as necessary.
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20.1.2 Image editor
The image editor contains all the functions you need to edit your scope images.

Information

The image editor can be reached by double-clicking a scope image or via the context menu of the respective scope image.

1 2

3

4

5

Fig. 75: Scope and multi-axis scope: Image editor

No. Area Description

1 Assignment of channel
to band

For combinations or multi-axis scope images, you can change the assignment to a section
within the scope image (= band) for each channel in the Channels and bands area.

2 Scope image In the Scope image area, you see the graphical representation of the recorded and visible
channels.

3 Channel selection In the Channel selection area, you manage the bands and channels of a scope image.

4 Channel settings In the Channel settings area, you can adjust the graphical representation of the channels.

5 Measured values In the Measured values area, values for different measured variables are output with
measuring points A and B for the selected channel. For scope images, there is also the
option to carry out a frequency analysis.

Assignment of channel to band

This area is only available in case of combinations or multi-axis scope images. By default, each scope image is assigned a
band with the recorded channels. You can hide each channel (parameter, signal name or physical address) or change the
assignment to a band via the corresponding picklist. However, new bands must be created beforehand in the Channel
selection area.
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Scope image

A scope image shows a graphical representation of the recorded and visible channels.

Icon/Button Description Context menu

 Left-clicking on measuring line A or B allows the line to be
shifted to the left or right as desired.

—

[Right mouse button] Right-clicking on any point of the scope image opens the
context menu.

§ Set marking A here

§ Set marking B here

§ Jump to marking A

§ Jump to marking B

[Left mouse button] Left-clicking on any point of the scope image activates the
quick measurement. The values are output in the Channel
selection area in the Measured value column.

—

Marking the zero line of a channel. —

Marking the trigger line. —

Icon Description

Opens the image editor settings for the coloring of the drawing area and channels.

Opens the dialog box for storing a comment for the scope image.

Opens the list of scope images in order to take over the channel scaling from a scope image
that has already been adjusted. Button only available for scope images, not for
combinations or multi-axis scope images.

Channel selection

In the Channel selection area, you manage the bands and the channels assigned to them. You can delete existing bands or
create new bands. You can activate or deactivate the display of a channel. For each channel, a channel number and the
name of the scope image is output. If you click any point within the scope image, the associated measured value is also
displayed.

Element Description Context menu

Band Section of a scope image § Delete band

§ Create new band

Channel Recorded parameter, signal name or physical address § Hide channel

§ Only show this channel

§ Show all channels

§ Invert display of channels

§ Create new band
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Channel settings

The channel settings are used to adjust the graphical representation of the channels and scope image. In the display above
the buttons, you see the color, complete designation and scaling of the selected channel. You can use the buttons to
change the display of the channel or time axis. In the display next to the button for the time axis, the current scaling of the
x-axis is displayed.

Button Section Description

Channel display Opens the color palette for changing the channel color.

Channel settings Moves the curve of the activated channel up or down by a
grid interval:

§ [Shift] + [button]: Moves curve up or down by a pixel

§ [Ctrl] + [button]: Moves curve up or down to the next grid
line

§ [Shift] + [Ctrl] + [button]: Centers curve vertically

Enlarges or reduces the channel scaling (fixed point =
horizontal image center):

§ [Shift] + [button]: Autoscaling

Displays or hides the channel.

Inverts the channel display.

Indicates the zero line of the channel.

Opens the list of parameter signals for selecting an
individual bit. Button can only be used for whole-number
parameters without decimal places (BYTE, WORD or
DWORD data types), but not for selection parameters.

Time axis settings Enlarges or reduces the scaling of the x-axis:

§ [Ctrl] + [button]: Autoscaling

Moves the scope image left or right by a grid interval:

§ [Shift] + [button]: Moves scope image left or right by a
pixel

§ [Ctrl] + [button]: Moves scope image left or right to the
next grid line

§ [Shift] + [Ctrl] + [button]: Centers scope image horizontally

Information

You can use the buttons in the channel settings to scale both the channel (y-axis) and time axis (x-axis) in steps.
Alternatively, you can freely scale both axes by entering the desired scaling factor directly in the respective field. Also define
the desired unit for the time axis (ns, µs/us, ms, s).

Free channel scaling makes it easier to compare channels or parameters with different scaling, e.g. for comparing set and
actual values. To convert between motor and user sizes, you can either view the scaling factor in parameter I240 or use the
scaling calculator (wizard: Axis: Scaling).
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Measured values

In the Measured values area, values for different measured variables are output with measuring points A and B for the
selected channel. For scope images, there is also the option to carry out temporary frequency analyses in the form of a
discrete Fourier transform (DFT). When the image editor is closed, DFT calculations are discarded again.

Tab Availability Description

Scope Scope, multi-axis scope The Scope tab has a list of the values for various variables
referring to measuring points A and B for the selected
channel.

Frequency analysis Scope The Frequency analysis tab can be used for performing
Fourier transforms on scope images.

20.1.3 Frequency analysis
Between measuring points A and B in the Frequency analysis tab of the image editor, a blue transparent window appears
for which a discrete Fourier transform can be carried out. Interval and measured values (= number of sensing points
between A and B) are displayed for you.

Information

You can reach the tab where you can carry out a frequency analysis in the image editor of a scope image through the
Measured values area > Frequency analysis tab.

Setting Selection Description

Window function Hamming Minimizes the leakage effect for the Fourier transform.

Without weighting Calculation without correction.

Button Description

Calculate DFT The DFT is calculated and opened in a separate window.

DFT window

The calculated DFT opens in a separate window. When the window is closed, the calculation is discarded again. You can
adjust the display:

§ [Ctrl] + [Left mouse button]: Zoom in on section

§ [Ctrl] + [Right mouse button]: Reset display to initial value (100%)

Button Description

OFF Displays or hides the selected channel.

Log Logarithmically scales the y- or x-axis.

Lin Linearly scales the y- or x-axis.
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20.2 Scope image
Scope image recording is divided into 3 steps:

§ Preparation of the scope image in DriveControlSuite

• Establish online connection

• Configure channels of the participating axis

• Define trigger settings

• Start the scope image

§ Loading the data in the drive controller

• Process of trigger communication (independent of DriveControlSuite)

• Monitor the scope image with DriveControlSuite

§ Reading out and displaying the scope image

• Read the scope image out of the drive controller

• Display the scope image in DriveControlSuite

20.2.1 Creating a scope image
Create a scope image by specifying the scope image and trigger settings. Then start the scope image with an existing online
connection.

Information

To create a scope image with the scope or multi-axis scope, you need an online connection between DriveControlSuite and
the drive controller. You can establish the online connection either before or after defining the scope image and trigger
settings.

Define the settings for scope images and triggers

Define the scope image settings and the trigger settings before you start the scope image.

1. Select the relevant drive controller in the project tree and click Scope in the project menu.

ð The Scope window opens.

2. Action area:
To define the settings for the scope image, click Settings.

ð The Settings window opens.

3. Trigger condition tab:
Define which event triggers the scope image.

3.1. Select Manual at stop to activate the trigger via the Stop button (without pre-trigger).

3.2. Select Immediately at start to activate the trigger via the Start button (with pre-trigger).

3.3. Select Simple trigger to activate the trigger automatically when a trigger condition occurs.

3.4. Select Trigger logic to activate the trigger automatically when two logically linked trigger conditions occur.

4. Trigger condition tab:
If you have selected Simple trigger or Trigger logic, define the Source, Condition and Comparison value for the trigger
condition.

4.1. If you have selected Single trigger, define the individual trigger condition.

4.2. If you have selected Trigger logic, define both trigger conditions and the operator for the logical operation.



STOBER 20 | Analysis
11

/2
02

4 
| 

ID
 4

43
34

0.
01

329

5. Channel assignment tab:
Select which data is to be recorded with the scope image.

5.1. Parameter:
To record the value of a parameter, enter the coordinate, name and, if applicable, axis number of the
parameter with the Add parameter dialog box via ... or by writing directly into the text field and using auto-
completion (example: 1.I80 Current position).

5.2. Signal name:
To record the value of a signal, select a signal for which you have assigned a signal name in the graphic
programming.

5.3. Physical address:
To record the value of a physical address in the drive controller memory, select the data type and specify the
address.

6. Channel assignment tab, Sampling time selection:
Select the time interval at which the channel is to be sampled.

7. Channel assignment tab, Pre-trigger selection:
Define the percentage of the recording time before the trigger.

ð The calculated recording time and pre-trigger time are displayed.

8. Confirm your settings with Close.

Creating a scope image

Start the scope image of the data in the drive controller and read out the scope image to DriveControlSuite according to the
scope image and trigger settings.

ü You are in the Scope window, Scope images tab.

ü You have configured the settings for the scope image.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Action area:
To start the scope image of the data in the drive controller, click Start.

ð The drive controller records the data in the scope memory in accordance with the scope image settings.

ð The Action area of DriveControlSuite displays information about the status of the scope image.

2. If you are using the Manually at stop trigger setting or if you want to stop the scope image early before the recording
time expires, click Stop.

ð When the trigger is triggered, DriveControlSuite reads the data from the scope memory according to the scope
image settings.

ð The finished scope image is listed in the Scope images tab and can be opened via double-click.
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20.2.2 Combining scope images
Combine scope images with each other to easily compare the recorded data.

ü You are in the Scope window, Scope images tab.

ü You have created multiple scope images for a drive controller.

1. Scope images tab:
Select the scope images you want to combine and choose Combine and open from the context menu.

ð Combinations tab:
The combined scope image is listed in the Combinations tab and opens in the image editor.

20.2.3 Creating a direct image
Create a scope image by specifying the scope image and trigger settings. Then start the scope image with an existing online
connection.

Information

To create a scope image with the scope or multi-axis scope, you need an online connection between DriveControlSuite and
the drive controller. You can establish the online connection either before or after defining the scope image and trigger
settings.

Define the settings for scope images and triggers

Define the scope image settings and the trigger settings before you start the scope image.

1. Select the relevant drive controller in the project tree and click Scope in the project menu.

ð The Scope window opens.

2. Action area:
To define the settings for the scope image, click Settings.

ð The Settings window opens.

3. Trigger condition tab:
Define which event triggers the scope image.

3.1. Select Manual at stop to activate the trigger via the Stop button (without pre-trigger).

3.2. Select Immediately at start to activate the trigger via the Start button (with pre-trigger).

3.3. Select Simple trigger to activate the trigger automatically when a trigger condition occurs.

3.4. Select Trigger logic to activate the trigger automatically when two logically linked trigger conditions occur.

4. Trigger condition tab:
If you have selected Simple trigger or Trigger logic, define the Source, Condition and Comparison value for the trigger
condition.

4.1. If you have selected Single trigger, define the individual trigger condition.

4.2. If you have selected Trigger logic, define both trigger conditions and the operator for the logical operation.
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5. Channel assignment tab:
Select which data is to be recorded with the scope image.

5.1. Parameter:
To record the value of a parameter, enter the coordinate, name and, if applicable, axis number of the
parameter with the Add parameter dialog box via ... or by writing directly into the text field and using auto-
completion (example: 1.I80 Current position).

5.2. Signal name:
To record the value of a signal, select a signal for which you have assigned a signal name in the graphic
programming.

5.3. Physical address:
To record the value of a physical address in the drive controller memory, select the data type and specify the
address.

6. Channel assignment tab, Sampling time selection:
Select the time interval at which the channel is to be sampled.

7. Channel assignment tab, Pre-trigger selection:
Define the percentage of the recording time before the trigger.

ð The calculated recording time and pre-trigger time are displayed.

8. Confirm your settings with Close.

Creating a direct image

Start the scope image of the data in the drive controller and read out the scope image to DriveControlSuite according to the
scope image and trigger settings.

ü You are in the Scope window, Direct image tab.

ü You have configured the settings for the scope image.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Action area:
To start the scope image of the data in the drive controller, click Start.

ð The drive controller records the data in the scope memory in accordance with the scope image settings.

ð The Action area of DriveControlSuite displays information about the status of the scope image.

2. If you are using the Manually at stop trigger setting or if you want to stop the scope image early before the recording
time expires, click Stop.

ð When the trigger is triggered, DriveControlSuite reads the data from the scope memory according to the scope
image settings.

ð The finished scope image is displayed in the Direct image tab.
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20.3 Multi-axis scope images
Recording via multi-axis scope is divided into 3 steps:

§ Preparation of the scope images in DriveControlSuite

• Establish online connections

• Select participating axes and define settings for triggering axes

• Configure channels of the participating axes

• Start recording

§ Loading of the data in the drive controllers

• Process of trigger communication (independent of DriveControlSuite)

• Monitoring of individual recordings by DriveControlSuite

§ Reading out and displaying the scope images

• Read out scope images from the drive controllers

• Display scope images in DriveControlSuite

20.3.1 Requirements
To find the participating drive controllers in the network and their communication with each other via broadcast, you must
observe the following requirements:

§ Network supports IPv4 limited broadcast

§ All drive controllers are in the same subnet (broadcast domain)

§ All drive controllers are connected with a switch via the X9 service interface

§ Your PC with installed DriveControlSuite commissioning software is also connected with the switch

§ Optional: EtherCAT‐based controller takes over synchronization of the scope images via distributed clocks

The following graphic shows the basic network structure for multi-axis scope images.

EtherCAT

Subnet
Switch

Fig. 76: Multi-axis scope: Network structure
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20.3.2 Creating a multi-axis scope image
Create a scope image by specifying the scope image and trigger settings. Then start the scope image with an existing online
connection.

Information

To create a scope image with the scope or multi-axis scope, you need an online connection between DriveControlSuite and
the drive controller. You can establish the online connection either before or after defining the scope image and trigger
settings.

Defining nodes and triggering axes

Define which axes are recorded for the multi-axis scope image and which of the axes can trigger the scope image.

1. Select the project in the project tree and click Multi-axis scope in the project menu.

ð The Multi-axis scope window opens.

2. Action area:
To define the settings for the scope image, click Settings.

ð The Settings window opens.

3. Node and trigger condition tab, Node column:
Activate all axes that you want to record with the multi-axis scope image.

4. Node and trigger condition tab, Distribute trigger column:
Activate all axes for which you want to define a trigger that triggers the scope image for all participating axes.

ð The Settings button is displayed for each triggering axis.

Information

If you define more than one trigger for a multi-axis scope image, the scope image is triggered for all participating axes as
soon as one of the trigger conditions occurs (logical OR operation).
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Define the settings for scope images and triggers

Define the scope image settings and the trigger settings before you start the scope image.

ü You are in the Multi-axis scope window > Settings window.

1. Node and trigger condition tab:
To define the trigger condition, click Settings next to the respective triggering axis.

ð The Settings window opens.

2. Node and trigger condition > Settings tab:
For each triggering axis, define which event triggers the scope image.

2.1. Select Manual at stop to activate the trigger via the Stop button (without pre-trigger).

2.2. Select Immediately at start to activate the trigger via the Start button (with pre-trigger).

2.3. Select Simple trigger to activate the trigger automatically when a trigger condition occurs.

2.4. Select Trigger logic to activate the trigger automatically when two logically linked trigger conditions occur.

3. Node and trigger condition > Settings tab:
If you have selected Simple trigger or Trigger logic, define the Source, Condition and Comparison value for the trigger
condition.

3.1. If you have selected Single trigger, define the individual trigger condition.

3.2. If you have selected Trigger logic, define both trigger conditions and the operator for the logical operation.

4. Confirm your settings with Close.

ð The Settings window closes.

5. Node and trigger condition tab:
If you have defined more than one triggering axis, repeat the procedure for the remaining triggering axes.

6. Channel assignment tab:
Select which data is to be recorded with the scope image.

6.1. Parameter:
To record the value of a parameter, enter the coordinate, name and, if applicable, axis number of the
parameter with the Add parameter dialog box via ... or by writing directly into the text field and using auto-
completion (example: 1.I80 Current position).

6.2. Signal name:
To record the value of a signal, select a signal for which you have assigned a signal name in the graphic
programming.

6.3. Physical address:
To record the value of a physical address in the drive controller memory, select the data type and specify the
address.

7. Channel assignment tab, Sampling time selection:
Select the time interval at which the channel is to be sampled.

8. Channel assignment tab, Pre-trigger selection:
Define the percentage of the recording time before the trigger.

ð The calculated recording time and pre-trigger time are displayed.

9. Confirm your settings with Close.
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Information

In a multi-axis scope image, you can define per channel whether the same data is recorded for all participating axes or
individual data per axis. To do this, activate the Individual option in the Channel assignment tab, click Open settings and
define the data to be recorded per participating axis for the respective channel.

Creating a multi-axis scope image

Start the scope image of the data in the drive controller and read out the scope image to DriveControlSuite according to the
scope image and trigger settings.

ü You are in the Multi-axis scope window.

ü You have configured the settings for the scope image.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Action area:
To start the scope image of the data in the drive controller, click Start.

ð The drive controller records the data in the scope memory in accordance with the scope image settings.

ð The Action area of DriveControlSuite displays information about the status of the scope image.

2. If you are using the Manually at stop trigger setting or if you want to stop the scope image early before the recording
time expires, click Stop.

ð When the trigger is triggered, DriveControlSuite reads the data from the scope memory according to the scope
image settings.

ð The finished scope image is listed in the Scope images tab and can be opened via double-click.

20.4 Parameters
You can use the following parameters to configure additional settings for the scope images:

§ T25 Automatic start

§ T26 Retrigger scope
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21 Replacement
The following chapters describe the replacement of a drive controller and the available accessories.

21.1 Replacing the drive controller

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

Hazardous voltages may be present on the connection terminals and the cores connected to them.

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

ATTENTION!

Loss of absolute position!

The absolute position in the encoder is lost if the encoder cable is disconnected from the AES battery module.

▪ Do not disconnect the encoder cable from the AES during service work! Disconnect the AES from the drive controller.

Information

Note that the SD card from the drive controller being replaced can be re-used only for drive controllers of the same series.

Tools and material

You will need:

§ Tool for loosening and tightening the fastening screws

Requirements and replacement

ü Drive controllers of the same series and same power can be replaced interchangeably.

ü The fieldbus variants of the firmware for the drive controller to be installed and to be replaced match.

ü The hardware and firmware of the drive controller to be installed is of the same or a newer version as that of the drive
controller to be replaced.

ü The SD card is present in the drive controller being replaced; the original project is stored on the SD card. Or: The
control unit of the drive controller being replaced still works; copy the original project to the SD card before removing
the drive controller.

1. Optional: If an AES battery module is present, disconnect the AES from the drive controller.

2. Disconnect all terminals from the drive controller being replaced.

3. Release the grounding conductor from the ground bolt.

4. Loosen the fastening screws and remove the drive controller from the control cabinet.

5. Insert the SD card with the original project into the drive controller being installed.
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6. Optional: If you are using the SY6 or SU6 safety module, you must transfer its address in the FSoE or PROFIsafe
network from the replaced drive controller to the new one (DIP switch S12) to be able to uniquely identify it in the
network. For further information, refer to the manual for the corresponding safety module.

7. Install the new drive controller in the control cabinet.

8. Reconnect the previously removed grounding conductor.

9. Reattach the terminals.

10. Optional: If an AES battery module was present, attach it to the new drive controller with the associated encoder
cable. Tighten the knurled screws so that AES is securely connected to the drive controller.

ð The replacement is completed. Now commission the new drive controller.

21.2 Commissioning the new drive controller after replacing
the device

If the SD card with the original project is present and inserted, the data is loaded from the inserted SD card when the
replacement drive controller is switched on. Now save the data in non-volatile memory on the drive controller.

Information

If available, the reference is also transferred to the replacement drive controller via the SD card. The information is also
saved on the SD card if the action A00 Save values is executed for the referenced axis.

ü The SD card with the original project is inserted.

1. Switch on the 24 VDC supply of the drive controller.

ð The self-test of the drive controller starts.

ð The green LED flashes with a single flash.

ð The transfer of configuration data from the SD card starts.

ð The green LED flashes steadily.

2. Press the S1 operating button for 3 s or carry out action A00, e.g., via DriveControlSuite.

ð The green LED flashes quickly.

ð All data is stored in non-volatile memory in the drive controller and on the SD card.

ð The LEDs now switch back to the normal operating display.

3. Restart the drive controller to have the configuration on the drive controller take effect.

ð The commissioning of the new drive controller is complete.
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21.3 Replacing the SD card
STOBER recommends the use of cards with a storage capacity of 2 to 4 GB. The cards require FAT32 formatting (also refer
to X700: SD slot [} 117]).

Preparation

To prepare the new, formatted card for operation in the drive controller, proceed as follows:

1. Switch on the 24 VDC supply of the control unit.

2. Insert the formatted SD card.

3. Execute the action A00 and wait until saving is finished.

ð The preparation of the SD card is complete.

If an SD card is inserted when the drive controller is started, it is started from this card. Any existing configuration in the
internal memory of the drive controller is ignored. If there is no configuration on the SD card or if it is invalid, the drive
controller starts in emergency operation. For drive controllers with firmware V 6.5-A or higher, the fixed IP address
192.168.3.2 and fixed subnet mask 255.255.255.0 are used for service interface X9 in emergency operation.

In emergency operation, the internal configuration cannot be read out. If you require a data backup from the internal
memory of the drive controller, you must save the information of the desired IP address, subnet mask and address
assignment on the SD card (see Starting a drive controller in emergency operation [} 181]).
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21.4 Updating firmware
The drive controllers are normally delivered with the latest firmware version. You can use the DriveControlSuite
commissioning software to update the firmware version of one or more drive controllers simultaneously and then monitor
the successful update. On the other hand, if a PC with a network connection is not available at the drive controller location,
you also have the option of using an SD card to transfer a more current firmware version.

21.4.1 Updating firmware using DS6
If you require a different firmware version or want to update the firmware of a drive controller, you can change the
firmware using the DriveControlSuite commissioning software. You can prepare a live firmware update while the drive
controller and machine are operating. The update does not take effect until after a restart. This dual firmware behavior
prevents a firmware loss or need for a case of service, since it ensures, for example, that the existing firmware can be
accessed if the connection is interrupted.

Updating the firmware

Update the firmware of your drive controllers to the current version to use the full range of DriveControlSuite functions.

ü You are in the Online functions window, Live firmware update tab.

ü You have added a direct connection between DriveControlSuite and drive controllers.

1. Live firmware update tab:
Click Assign default version to all drive controllers.

ð The current firmware version is assigned to the drive controllers.

2. Click Start live firmware update.

3. Confirm the safety note with OK.

ð The firmware version is downloaded and installed during the next restart of the drive controller.

4. For the live firmware update to take effect, click Restart all drive controllers.

5. Confirm the restart with Yes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð All connected drive controllers restart.

Information

The firmware version that is available for the update in the standard depends on the DriveControlSuite version used. Install
the latest version of DriveControlSuite to update the firmware of your drive controllers to the latest version and to be able
to use the full range of functions.
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Updating firmware (alternative version)

To update the firmware of your drive controllers to a version other than that of the DriveControlSuite version used,
proceed as described below.

ü You are in the Online functions window, Live firmware update tab.

ü You have added a direct connection between DriveControlSuite and the drive controller.

1. Live firmware update tab:
Click Add new firmware version.

ð The Live firmware update dialog box opens.

2. Navigate to the firmware file (*.fli) that you want to use to perform the live firmware update.

3. Confirm with Open.

ð The firmware version becomes available in the DriveControlSuite.

4. Assignment tab, Firmware update selection:
Select Alternative version.

5. Assignment area, Firmware version selection:
Select the firmware version you want to use to perform the live firmware update.

6. Click Start live firmware update.

7. Confirm the safety note with OK.

ð The firmware version is downloaded and installed during the next restart of the drive controller.

8. For the live firmware update to take effect, click Restart all drive controllers.

9. Confirm the restart with Yes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð All connected drive controllers restart.



STOBER 21 | Replacement
11

/2
02

4 
| 

ID
 4

43
34

0.
01

341

21.4.2 Updating firmware using an SD card
If you would like to update the firmware of a drive controller but do not have access to a PC with a network connection,
transfer the firmware version to the drive controller using an SD card.

Information

The fieldbus variant of the firmware (EC or PN) cannot be changed. The fieldbus variant of the firmware on the SD card
must match the fieldbus variant of the drive controller firmware.

Preparation

Prepare an SD card with the latest firmware version. For information on the SD cards that can be used, see X700: SD slot
[} 117].

ü The firmware of the drive controller is at least version 6.4-A.

ü A more current version of DriveControlSuite is installed on your PC.

1. Create the firmware directory on the SD card.

2. Use Windows Explorer to copy the firmware.slf file from the installation directory of DriveControlSuite 
(C:\Program Files (x86)\STOBER\DriveControlSuite\Suite) into the directory on the SD card.

Information

You can also transfer an older firmware version to drive controllers with firmware version 6.5-H or later.

Updating the firmware

Information

When a firmware file is being transferred by an SD card, the three LEDs flash in various combinations and frequencies. For
information on this, see Drive controller state: LEDs.

To update the firmware of the drive controller via SD card, proceed as described below.

ü The prepared SD card is present.

1. Insert the prepared SD card into the drive controller.

2. Start the drive controller.

ð The transfer of the firmware file begins.

ð The copying process is successfully completed as soon as the green LED of the drive controller flashes with a single
flash.

3. Remove the SD card when the transfer is complete.

4. Since the firmware update only takes effect after the drive controller is restarted, restart the drive controller after
completing the transfer.
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21.5 Changing a fieldbus variant
Fieldbus communication is determined by the firmware. The SB6 drive controller is delivered with the firmware version in
the required fieldbus variant. You can subsequently change the fieldbus using the DriveControlSuite commissioning
software, provided that you are not using a fieldbus-specific safety module.

Information

You can only subsequently change the fieldbus for drive controllers with the SZ6 option (without safety technology) or SR6
option (STO using terminals).

For warranty reasons, when changing the fieldbus, you are prompted to notify our service department of the change with
an email to replace@stoeber.de. The information relevant for this can be transferred directly from DriveControlSuite to
your email program.

Information

Changing the fieldbus variant of the drive controller without contacting our Service department voids any warranty claims.

Changing a fieldbus variant

ü You are in the Online functions window, Live firmware update tab.

ü You have added a direct connection between DriveControlSuite and the drive controller.

1. Assignment area, Live firmware update selection:
Select Change fieldbus for the relevant drive controller.

ð The Select and start fieldbus variant button is displayed below the picklist.

2. Click Select fieldbus variant and start.

3. Confirm the safety note with OK.

ð The Select and start fieldbus window opens.

4. Select the desired fieldbus variant according to your firmware version.

5. To secure your warranty claim, inform STOBER Service about the change of fieldbus variant.

6. Activate the Email was sent option.

7. Click Start live firmware update.

ð The firmware version is downloaded and installed during the next restart of the drive controller.

8. For the live firmware update to take effect, click Restart all drive controllers.

9. Confirm the restart with Yes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð All connected drive controllers restart.

mailto:replace@stoeber.de
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21.6 Motor replacement
When replacing a synchronous servo motor with EnDat encoder and electronic nameplate, the drive controller detects that
a motor replacement has been performed upon switching on the drive controller (prerequisite: B04 = 64: Active).

As a response, the drive controller reads out the changed data from the electronic nameplate, transmits this data to the
corresponding parameters and reports the process using a fault of type 81: Motor allocation. Based on the cause of the
fault, you can recognize what has changed.

Otherwise, the next time the drive controller is switched on, the electronic nameplate is read out again and the changed
data is reported using a fault of type 81: Motor allocation.
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22 Service
You can find important information all about our range of services in this chapter.

22.1 Information about the product
You can find information about your product online at the following address: https://id.stober.com.

In the search field there, enter the serial number, delivery note number or invoice number of the product.

Alternatively, you can use a suitable mobile device to scan in the QR code on the front of the device in order to directly
access product information that is available online.

22.2 STOBER electronics service
If you need support, please contact our service department (see Consultation, service and address [} 405]).

Please have the following descriptive information on hand so that we can provide you with quick, professional assistance.

Ordering a replacement device

If you would like to order a replacement device, our System Support requires the following information:

§ MV and serial number of the drive controller being replaced (see Material variant [} 29])

§ Information on subsequent changes (e.g. change in option modules, application or firmware)

The MV number indicates the ordered and delivered material variant, i.e. the device-specific combination of all hardware
and software components. The serial number is used to determine your customer information. Both numbers are stored in
the STOBER enterprise resource planning system and make reordering a drive controller easier in case of service.

Service request

If you need assistance or have any questions regarding commissioning, create reverse documentation for your project as
your first step. This makes it easier for our System Support to process your request.

https://id.stober.com
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22.3 Reverse documentation
If you have questions concerning commissioning and would like to contact our service department, start by first creating
reverse documentation and send this to our System Support email address (see Consultation, service and address [} 405]).

When creating reverse documentation, DriveControlSuite captures a snapshot of the parameter values in the drive
controller before the online connection is disconnected. With reverse documentation, the parameter values in
DriveControlSuite, which you can otherwise only view with an existing online connection to the drive controller, are also
available offline.

22.3.1 Creating reverse documentation
If you have any questions about commissioning your drive project and would like to contact our service department, create
reverse documentation in advance so that we can help you more specifically.

Information

If you create reverse documentation of the values in the drive controller when disconnecting the online connection, the
assigned configuration is write-protected in the project tree of DriveControlSuite until you delete the reverse

documentation. The  icon in the project tree shows you whether a drive controller contains reverse documentation.

Creating reverse documentation (single)

ü You are in the Online functions window, Online tab.

ü There is an online connection between DriveControlSuite and drive controllers.

1. Assignment area, drive controller:
Click Set offline for the relevant drive controller.

ð The Reverse documentation dialog box opens.

2. Confirm the dialog box with Yes.

ð The reverse documentation is created and the drive controller is marked as write-protected in the project tree.

ð The online connection between DriveControlSuite and the drive controller is disconnected.

Information

If you have networked multiple SD6 drive controllers via IGB motion bus, when you disconnect the connection, you can
create reverse documentation for the entire module or selected drive controllers of the module by disconnecting the
connection for the network adapter in the Assignment area.

Creating reverse documentation (all)

ü You are in the Online functions window, Online tab.

ü There is an online connection between DriveControlSuite and drive controllers.

1. Online tab:
Click Set all drive controllers to offline (with reverse documentation).

ð The reverse documentation is created, the drive controllers are marked in the project tree as write-protected.

ð The online connections between DriveControlSuite and drive controllers are disconnected.



22 | Service STOBER

346

11
/2

02
4 

| 
ID

 4
43

34
0.

01

22.3.2 Deleting reverse documentation
Delete reverse documentation that you no longer need in order to remove the write protection of the drive controller in
the project tree and be able to edit it again.

Information

If you create reverse documentation of the values in the drive controller when disconnecting the online connection, the
assigned configuration is write-protected in the project tree of DriveControlSuite until you delete the reverse

documentation. The  icon in the project tree shows you whether a drive controller contains reverse documentation.

Deleting reverse documentation

Clean reverse documentation that is no longer needed from your project.

ü You have created one or more instances of reverse documentation.

1. Delete reverse documentation (drive controller):
Select the relevant drive controller in the project tree and choose Delete reverse documentation from its context
menu.

2. Delete all reverse documentation (module):
Select the relevant module in the project tree and choose Delete all reverse documentation from its context menu.

3. Delete all reverse documentation (project):
Select the project in the project tree and choose Delete all reverse documentation from its context menu.

ð The reverse documentation of the selected drive controllers is deleted.

ð The write protection of the selected drive controllers is removed.

ATTENTION!

Data loss due to deletion

If you delete reverse documentation from the project, DriveControlSuite cannot restore the reverse documentation after
the fact.

▪ Delete reverse documentation from the project only if you definitely no longer need it.
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23 Appendix

23.1 Weights

Description Type ID No. Weight without
packaging [g]

Weight with
packaging [g]

Drive controller sz. 0 SB6A06 5050162 2500 3500

Drive controller sz. 1 SB6A16 5050164 3700 5400

Drive controller sz. 2 SB6A26 5050166 5000 6500

Operating unit for drive controller OP6 5050180 100 100

Terminal set for drive controller All Diverse 100 100

Option module without safety
technology

SZ6 56660 50 50

Safety module ─ STO using terminals SR6 56661 50 50

Safety module – STO and SS1 using
PROFIsafe

SU6 56696 50 50

Safety module ─ STO and SS1 using FSoE SY6 56662 50 50

Terminal module XB6 5050181 120 120

X120 TTL connecting cable — 49482 60 60

EtherCAT cable approx. 0.25 m — 49313 15 15

EtherCAT cable approx. 0.5 m — 49314 20 20

PC connecting cable — 49857 190 190

USB 2.0 Ethernet adapter — 49940 50 50

Braking resistor FZMU 400×65 49010 2200 2200

FZZMU 400×65 53895 4170 4170

GVADU 210×20 55441 300 300

GBADU 265×30 55442 930 930

GBADU 335×30 55443 1200 1200

Rear section braking resistor RB 5022 45618 640 640

RB 5047 44966 460 460

RB 5100 44965 440 440

Output choke TEP3720-0ES41 53188 2900 2900

TEP3820-0CS41 53189 5900 5900

TEP4020-0RS41 53190 8800 8800

Battery module AES 55452 60 60

Interface adapters AP6A00 56498 30 30

AP6A01 56522 30 30

AP6A02 56523 30 30

Tab. 263: Weights of SB6 and accessories
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23.2 Terminal specifications
Relevant information for project configuration of the connecting wiring can be taken from the following chapters.

EN 60204-1 contains basic recommendations that should be taken into account when selecting conductors. The chapter
"Conductors and cables" provides specifications for the maximum current carrying capacity of conductors based on the way
they are laid as well as tips for derating, for example in the case of increased surrounding temperatures or lines with
multiple loaded individual conductors.

WARNING!

Personal injury and material damage due to electric shock and thermal overload!

▪ Prepare the conductor ends according to the terminal specifications.

▪ In the case of pre-made cables and conductors, check the conductor ends and adjust them if necessary.

23.2.1 Overview
The following tables clarify which specifications must be observed for which connections depending on the type of drive
controller or accessory.

Drive controller

Type X1 X2, X5, X7, X8 X10, X20 X11 X21, X22

SB6A06 FMC 1,5 -ST-3,5
[} 351]

BLF 5.08HC 180
SN [} 349]

GFKC 2,5 -ST-7,62
[} 352]

BLDF 5.08 180 SN
[} 350]

GFKIC 2.5 -ST-7.62
[} 352]

SB6A16 SPC 5 -ST-7,62
[} 354]

ISPC 5
-STGCL-7,62

[} 353]

SB6A26 SPC 16 -ST-10,16
[} 354]

ISPC 16 -ST-10,16
[} 353]

Tab. 264: Terminal specifications for the base device

Safety technology

Type X12

SR6 BCF 3,81 180 SN [} 349]

Tab. 265: Terminal specifications of the safety technology

Terminal module

Type X100, X101

XB6 DFMC 1.5 -ST-3.5 [} 350]

Tab. 266: Terminal specifications of the terminal module

Braking resistors

Type Braking resistor

FZMU, FZZMU G 10/2 [} 351]

Tab. 267: Terminal specifications for the braking resistors
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23.2.2 BCF 3,81 180 SN

Feature Conductor type Value

Contact spacing — 3.81 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 16 A/10 A/
11 A

Max. conductor cross-section Flexible without end sleeve 1.5 mm²

Flexible with end sleeve without plastic collar 1.0 mm²

Flexible with end sleeve with plastic collar 1.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 16

Min. conductor cross-section Flexible without end sleeve 0.14 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 268: BCF 3,81 180 SN BK specification

23.2.3 BLF 5.08HC 180 SN

Feature Conductor type Value

Contact spacing — 5.08 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 16 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.2 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 269: BFL 5.08HC 180 SN specification
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23.2.4 BLDF 5.08 180 SN

Feature Conductor type Value

Contact spacing — 5.08 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 14 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.2 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 270: BLDF 5.08 180 SN specification

23.2.5 DFMC 1.5 -ST-3.5

Feature Conductor type Value

Contact spacing — 3.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 8 A

Max. conductor cross-section Flexible without end sleeve 1.5 mm²

Flexible with end sleeve without plastic collar 1.5 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 16

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 24

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 271: Specification for DFMC 1.5 -ST-3.5
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23.2.6 FMC 1,5 -ST-3,5

Feature Conductor type Value

Contact spacing — 3.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 8 A

Max. conductor cross-section Flexible without end sleeve 1.5 mm²

Flexible with end sleeve without plastic collar 1.5 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 16

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 24

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 272: FMC 1,5 -ST-3,5 specification

23.2.7 G 10/2

Feature Conductor type Value

Contact spacing — 17.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 57 A/65 A/
65 A

Max. conductor cross-section Flexible without end sleeve 10.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 16.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

6.0 mm²

AWG according to UL/CSA 6

Min. conductor cross-section Flexible without end sleeve 0.5 mm²

Flexible with end sleeve without plastic collar 0.5 mm²

Flexible with end sleeve with plastic collar 0.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 24

Insulation stripping length — 12 mm

Tightening torque — 1.5 – 1.8 Nm

Tab. 273: G 10/2 specification



23 | Appendix STOBER

352

11
/2

02
4 

| 
ID

 4
43

34
0.

01

23.2.8 GFKC 2,5 -ST-7,62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 12 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 24

Insulation stripping length — 10 mm

Tightening torque (for terminals with
screw)

— 0.3 – 0.7 Nm

Tab. 274: GFKC 2,5 -ST-7,62 specification

23.2.9 GFKIC 2.5 -ST-7.62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 12 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.0 mm²

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque (for terminals with
screw)

— 0.3 – 0.7 Nm

Tab. 275: Specification for GFKIC 2.5 -ST-7.62
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23.2.10 ISPC 5 -STGCL-7,62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 32 A/35 A/
35 A

Max. conductor cross-section Flexible without end sleeve 6.0 mm²

Flexible with end sleeve without plastic collar 6.0 mm²

Flexible with end sleeve with plastic collar 4.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 8

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.25 mm²

AWG according to UL/CSA 24

Insulation stripping length — 15 mm

Tightening torque — —

Tab. 276: ISPC 5 -STGCL-7,62 specification

23.2.11 ISPC 16 -ST-10,16

Feature Conductor type Value

Contact spacing — 10.16 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 55 A/66 A/
66 A

Max. conductor cross-section Flexible without end sleeve 16.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 10.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

4.0 mm²

AWG according to UL/CSA 4

Min. conductor cross-section Flexible without end sleeve 0.75 mm²

Flexible with end sleeve without plastic collar 0.75 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.75 mm²

AWG according to UL/CSA 20

Insulation stripping length — 18 mm

Tightening torque — —

Tab. 277: SPC 16 -ST-10,16 specification
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23.2.12 SPC 5 -ST-7,62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 32 A/35 A/
35 A

Max. conductor cross-section Flexible without end sleeve 6.0 mm²

Flexible with end sleeve without plastic collar 6.0 mm²

Flexible with end sleeve with plastic collar 4.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 8

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.25 mm²

AWG according to UL/CSA 24

Insulation stripping length — 12 – 15 mm

Tightening torque (for terminals with
screw)

— 0.3 – 0.7 Nm

Tab. 278: SPC 5 -ST-7,62 specification

23.2.13 SPC 16 -ST-10,16

Feature Conductor type Value

Contact spacing — 10.16 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 55 A/66 A/
66 A

Max. conductor cross-section Flexible without end sleeve 16.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 10.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

4.0 mm²

AWG according to UL/CSA 4

Min. conductor cross-section Flexible without end sleeve 0.75 mm²

Flexible with end sleeve without plastic collar 0.75 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.75 mm²

AWG according to UL/CSA 20

Insulation stripping length — 18 mm

Tightening torque (for terminals with
screw)

— 0.3 – 0.7 Nm

Tab. 279: SPC 16 -ST-10,16 specification
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23.3 Wiring examples
The following chapters show the basic connection using examples.

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.

23.3.1 Stand-alone operation with direct brake control
The following graphic shows a wiring example for the stand-alone operation of SB6 with direct brake control.

Note the information on EMC-compliant installation (see EMC recommendations [} 96]).

RB
1 2

RB

1 42 3
L1 L2 L3 PE

1 3
+ -

1 42 3 5 6 7 8
GND GND Vc

1 3
+ -

5
1BD1

6
1BD2

1 3 42
U PEV W

7
1TP1 1TP2

8

X10 X11 X7

X5X4X20X2X21

nR1 M1
M

K1

F3

F2

F1

F4

T1

L1 L2 L3 PE

M

24 VDC

11

STO
b

STO
a

STO
status

X12 option

Direct
brake

control

D-sub
15p

SB6

SR6

Fig. 77: Wiring example with direct brake control

F1 – F4 Fuse

K1 Safety relay

L1 – L3 Three-phase power supply

M Reference potential

M1 Motor

R1 Braking resistor

T1 Drive controller

1 Optional connection
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For UL-compliant operation:

The protective grounding of motors connected to the drive controller must not be connected using terminal X20. The
grounding conductor connection of the motor must be ensured for the respective application in accordance with the valid
electrical standards.

23.4 Order overview of the hardware components
Note that the drive controller is delivered without terminals. Suitable terminal sets are available separately for each size.

Information

The drive controller is delivered in the standard design without safety technology (option SZ6). If you want a drive
controller with integrated safety technology, you must order it together with the drive controller. The safety modules are
an integrated part of the drive controllers and must not be modified.

Drive controller Safety technology Terminal set

Type ID No. ID No. ID No.

SB6A06 5050162 56660a) 138711

56696b)

56662c)

56661d) 138717

SB6A16 505016456691 56660a) 138712

56696b)

56662c)

56661d) 138718

SB6A26 5050166 56660a) 138713

56696b)

56662c)

56661d) 138719

Tab. 280: Overview of hardware components with ID No.

a) SZ6 option: Without safety technology

b) SU6 safety module: STO and SS1 using PROFIsafe

c) SY6 safety module: STO and SS1 using FSoE

d) SR6 safety module: STO using terminals

Specify the desired fieldbus system (EtherCAT or PROFINET) when placing your order for the basic device in combination
with option SZ6 or SR6, since fieldbus communication is defined by the firmware.

All delivered components (drive controllers and accessories) are marked to make it easy to assign connected components
(e.g., assignment of a terminal set to the drive controller).

For further accessories, see Accessories [} 31].
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23.5 SSI encoders
The following chapters provide you with more detailed information on setting SSI encoders with the help of the
DriveControlSuite commissioning software.

23.5.1 SSI: Evaluation at X4 with free setting (H00 = 78)
Obey the instructions described below if you use X4 as the connection for SSI encoders and want to use the free setting
option for the encoder function.

Evaluation of an encoder

To evaluate an encoder connected to X4, configure the following settings in DriveControlSuite.

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

H00 Function 78: SSI free setting 78: SSI free setting 78: SSI free setting

H14 Data bit Sum of single-turn bits +
alarm bits

Sum of single-turn bits +
multi-turn bits + alarm bits

Sum of position bits + alarm
bits

H01 Mechanical
value

1 rotation 1 rotation Measuring range, e.g.
200 mm

H02 Raw encoder
value

2Number of single-turn bits 2Number of single-turn bits Number of increments of the
measuring range

Tab. 281: Evaluation of an SSI encoder at X4 with free setting

Interpretation

The interpretation of the data bits as the position is carried out using the H01 and H02 parameters.

Relationship between resolution, clock frequency and double transmission in SSI encoders

Ideally, a new, valid position value in high resolution is available in every cycle of the control.

With a higher resolution of the position value, the amount of data to be transmitted (H14) increases and thus so does the
transmission time. The same applies if the position is read out twice to enable better detection of transmission errors (H11)
for increasing data security.

The transmission time of the position value should not exceed the cycle time of the control. To compensate for the
increased transmission time, you can transmit the bits at a higher clock frequency (H15) if the SSI encoder supports this
function. From approx. 600 kHz, cable lengths of 100 m are no longer possible.
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23.5.2 SSI: Evaluation, simulation and motion bus at X120 with free setting
(H120 = 76 or 83)

Obey the instructions described below if you are using X120A and X120B on a XB6 terminal module as connections for SSI
encoders and want to use the free setting option for the encoder function. SSI encoder signals can be made available to
several drive controllers via the dual interface without extra wiring needed (SSI motion bus). Alternatively, you can evaluate
or simulate a single SSI encoder at X120A or X120B.

Evaluation of an encoder

To evaluate an encoder connected to X120, configure the following settings in DriveControlSuite.

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

H120 Role 76: SSI free setting 76: SSI free setting 76: SSI free setting

H134 Data bit Sum of single-turn bits +
alarm bits

Sum of single-turn bits +
multi-turn bits + alarm bits

Sum of position bits + alarm
bits

H121 Mechanical
value

1 rotation 1 rotation Measuring range, e.g.
200 mm

H122 Raw encoder
value

2Number of single-turn bits 2Number of single-turn bits Number of increments of the
measuring range

Tab. 282: Evaluation of an SSI encoder at X120 with free setting

Simulation of an encoder

To simulate an encoder at X120, configure the following settings in DriveControlSuite.

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

H120 Role 83: SSI simulation free
setting

83: SSI simulation free
setting

83: SSI simulation free
setting

H80 Source of the
simulated
position

E.g.: 5: Motor position
(E09)

E.g.: 5: Motor position (E09) E.g.: 5: Motor position (E09)

H134 Data bit Sum of single-turn bits +
alarm bits

Sum of single-turn bits +
multi-turn bits + alarm bits

Sum of position bits + alarm
bits

H121 Mechanical
value

1 rotation 1 rotation Measuring range, e.g.
200 mm

H122 Raw encoder
value

2Number of single-turn bits 2Number of single-turn bits Number of increments of the
measuring range

Tab. 283: Simulation of an SSI encoder at X120 with free setting

SSI motion bus

In addition to encoder evaluation and simulation, an SSI motion bus with a maximum of 8 nodes can be set up using the
X120A and X120B connections. The SSI motion bus is used to make the position signal of a real or simulated SSI encoder
available to several drive controllers. If synchronization via EtherCAT or PROFINET IRT is not configured, all SSI motion bus
nodes can synchronize their runtime systems to the SSI motion bus.

Depending on the required function of the drive controller within the SSI motion bus, different settings are required in
DriveControlSuite.
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SSI motion bus with real encoder

Drive
controller

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

1 H120 Role 76: SSI free setting 76: SSI free setting 76: SSI free setting

2 – 8 77: SSI passive 77: SSI passive 77: SSI passive

1 – 8 H134 Data bit Sum of single-turn bits +
alarm bits

Sum of single-turn bits +
multi-turn bits + alarm bits

Sum of position bits +
alarm bits

1 – 8 H121 Mechanical
value

1 rotation 1 rotation Measuring range, e.g.
200 mm

1 – 8 H122 Raw encoder
value

2Number of single-turn bits 2Number of single-turn bits Number of increments
of the measuring range

Tab. 284: SSI motion bus with real encoder on X120 with free setting

SSI motion bus with simulated encoder

Drive
controller

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

1 H120 Role 83: SSI simulation free
setting

83: SSI simulation free
setting

83: SSI simulation free
setting

2 H80 Source of the
simulated
position

E.g.: 5: Motor position
(E09)

E.g. 5: Motor position (E09) E.g. 5: Motor position
(E09)

3 H120 Role 76: SSI free setting 76: SSI free setting 76: SSI free setting

4 – 8 77: SSI passive 77: SSI passive 77: SSI passive

1 – 8 H134 Data bit Sum of single-turn bits +
alarm bits

Sum of single-turn bits +
multi-turn bits + alarm bits

Sum of position bits +
alarm bits

1 – 8 H121 Mechanical
value

1 rotation 1 rotation Measuring range, e.g.
200 mm

1 – 8 H122 Raw encoder
value

2Number of single-turn bits 2Number of single-turn bits Number of increments
of the measuring range

Tab. 285: SSI motion bus with simulated encoder on X120 with free setting

Interpretation

The interpretation of the data bits as the position is carried out using the H121 and H122 parameters.

Relationship between resolution, clock frequency and double transmission in SSI encoders

Ideally, a new, valid position value in high resolution is available in every cycle of the control.

With a higher resolution of the position value, the amount of data to be transmitted (H134) increases and thus so does the
transmission time. The same applies if the position is read out twice to enable better detection of transmission errors
(H128) for increasing data security.

The transmission time of the position value should not exceed the cycle time of the control. To compensate for the
increased transmission time, you can transmit the bits at a higher clock frequency (H135) if the SSI encoder supports this
function. From approx. 600 kHz, cable lengths of 100 m are no longer possible.
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23.6 Commutation finding
Obey the instructions on commutation finding described below when using the control types 48: SSM-vector control
incremental encoder or 70: SLM - vector control for synchronous servo motors or synchronous linear motors.

The following table provides an overview:

Control mode Encoder Commutation finding

48: SSM-vector control incremental
encoder

Incremental encoders Wake and Shake

70: SLM - vector control Linear encoders (incremental
encoders)

Wake and Shake

70: SLM - vector control Linear encoders (absolute encoders) Action B40

Tab. 286: Commutation finding with control mode B20 = 48 or 70

Commutation finding via Wake and Shake

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

Gravity-loaded axes can sink during a commutation finding process using Wake and Shake because the brake for the
commutation finding process has to be released.

▪ Use the 48: SSM-vector control incremental encoder and 70: SLM - vector control control modes in combination with
a commutation finding process using Wake and Shake only for axes without a gravity load.

▪ For gravity-loaded axes, use motors with an absolute encoder.

Incremental encoders

With incremental encoders, commutation finding via Wake and Shake takes place automatically after the control unit is
switched on and the power unit is enabled for the first time. Select the velocity control control type for this first enable
(G90 = 2: Velocity control; alternatively: select a command with velocity control as the first motion command if G90 = 
0: Inactive).

Incremental encoder in combination with a brake

With incremental encoders in combination with a brake, automatic commutation finding via Wake and Shake after Enable-
on is not possible, as the brake is not released in this case (event 69: Motor connection, cause: 4: Brake).

Carry out the action B50 every time you switch on the control unit. The axis moves by up to one pole pitch during the
action.

Commutation finding via action B40

Absolute encoder

With absolute encoders, start commutation finding via the action B40 Test phase with a referenced axis. Then execute the
action A00 Save values.
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23.7 Device addressing

MAC address

A MAC address consists of a fixed and a variable portion. The fixed portion designates the manufacturer and the variable
portion distinguishes the individual network nodes and must be universally unique.

The MAC addresses of the interfaces are issued by STOBER and cannot be changed.

Information

The MAC address range of the STOBER hardware is: 00:11:39:00:00:00 – 00:11:39:FF:FF:FF

IP address – Value range

An IPv4 address always consists of 4 decimal numbers, each in a range from 0 to 255, and separated by periods. It must be
unique within a (sub)network.

Subnet and subnet mask – Value range

Subnets are created in order to provide standalone networks with their own address range. Each IP address is divided into a
network and host address. The subnet mask determines where this division takes place.

Like the IP address, the subnet mask consists of 4 decimal numbers, each in a range from 0 to 255, separated by periods.

Assignment for direct connection

In the default factory settings, both the IP address and the subnet mask are automatically assigned by DriveControlSuite or
using DHCP for a direct connection. Alternatively, you can switch to manual parameterization using parameter A166.

The active address is displayed in parameter A157 and the active subnet mask in parameter A158.

Assignment for fieldbus connection

Note that the IP address and subnet mask are assigned by the controller for a fieldbus connection.
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23.8 DriveControlSuite
The DriveControlSuite commissioning software uses wizards to guide you step by step through the installation process. You
can find more detailed information on the system requirements and installation in the following chapters.

23.8.1 System requirements
The following minimum requirements for the PC system apply to the installation and operation of the DriveControlSuite 
commissioning software:

§ Operating system: Windows 10 (32-bit, 64-bit *) or Windows 11 (32-bit, 64-bit *)

§ Processor: Intel Pentium 4 (2 GHz, Dual Core) or equivalent

§ Memory: 2 GB

§ Free disk space on the hard disk: 1 GB

§ Graphics: 1024 × 768 pixel resolution, 65536 colors

§ Font size: 100% (default)

§ Interfaces: 100 Mbps Ethernet (Fast Ethernet, copper)

*) Only DriveControlSuite

23.8.2 Installation types
To install the DriveControlSuite commissioning software, select one of two installation types.

Default installation

Select this installation type if you want to install the latest version of DriveControlSuite. DriveControlSuite is installed in the
version-independent .../Programs/STOBER/DriveControlSuite/ directory. During the installation process, you do not need to
specify any additional installation instructions.

Provided that you are connected to the Internet, a check is performed prior to installation to determine if a newer software
version is available. If a newer version is already available, it is downloaded and installed in place of the started version.

If an older software version is already installed on your PC, it is deleted prior to installation. However, if the latest version is
already installed on your PC, a new installation is not performed.

User-defined installation

Select this installation type if you want to install a specific version of DriveControlSuite or if you still need an older version
that is already installed on your PC. You can use this installation type to change the default installation directory and
manage the version-dependent destination folders.

Checking whether the software version is up-to-date before installation is optional.
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23.8.3 Installing DriveControlSuite
Current versions of the DriveControlSuite commissioning software can be found in our download center at:
http://www.stoeber.de/en/downloads/.

ü You have administrator rights.

ü The DriveControlSuite software is currently not running.

ü You have downloaded the setup file from the STOBER Download Center and saved it locally.

1. Start the installation via the setup file.

2. Select the language for the installation and confirm with OK.

3. Select Default as the installation type.

ð If an Internet connection is available, the recency of the setup file is checked and, if necessary, the latest version 
is downloaded.

ð The latest DriveControlSuite version is installed.

ð After successful installation, DriveControlSuite checks the access to the network.

ð If a firewall is active, a safety note opens according to the firewall settings.

4. If applicable, allow DriveControlSuite to communicate on public and private networks.

ð After successful installation, DriveControlSuite opens automatically.

http://www.stoeber.de/en/downloads/
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23.8.4 Communication requirements
Note the following requirements for the direct connection.

23.8.4.1 Personal firewall

For communication, both DriveControlSuite and the SATMICL communication service must be enabled in the PC's firewall.

Test communication is initiated during the installation of DriveControlSuite that opens a dialog box for enabling
communication in case of an activated firewall. Note that operation on public networks must also be enabled for
communication using mobile network adapters.

The required setup file for installing DriveControlSuite can be found in our download center at:
http://www.stoeber.de/en/downloads/.

Program/service Path

DS6A.exe
(DriveControlSuite)

Standard installation:

C:\Program Files (x86)\STOBER\DriveControlSuite\bin

Parallel installation of different versions (version 6.X-X):

C:\Program Files (x86)\STOBER\DriveControlSuite (V 6.X-X)\bin

SATMICLSVC.exe 
(SATMICL service)

32-bit Windows 7, 32-bit Windows 10, or 32-bit Windows 11:

C:\Windows\System32

64-bit Windows 7, 64-bit Windows 10, or 64-bit Windows 11:

C:\Windows\SysWOW64

Tab. 287: Programs and services

23.8.4.2 Protocols and ports for communication using routers

For communication using routers, the protocols and ports used by DriveControlSuite and the SATMICL communication
service must be enabled in the routers, if applicable.

Protocol Port Use Program/service

UDP/IP 37915 Connection test (inquiry) SATMICL service

UDP/IP 37916 Node search SATMICL service

UDP/IP 30001 Primary port for connection
response (response)

SATMICL service

30002 – 39999 Alternative ports for
connection response
(response)

UDP/IP 40000 Primary port for IP address
specification

DriveControlSuite

40001 – 50000 Alternative ports for IP
address specification

TCP/IP 37915 Data transmission DriveControlSuite

Tab. 288: Protocols and ports for a direct connection

http://www.stoeber.de/en/downloads/
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23.8.5 Establishing a connection
Establishing an online connection between DriveControlSuite and the drive controller is divided into 3 steps. In each step,
you can influence the settings for establishing the connection.

Establishing an online connectionMaking an assignmentAdd connection

Fig. 78: DriveControlSuite: Establishing a connection

Add connection

To establish an online connection, first set up a direct connection between the drive controller and DS6 via the local
network.

Making an assignment

After you have added the connection between DriveControlSuite and the drive controller and before you establish an
online connection, make the assignment between the real drive controller and its virtual copy in the DS6. Select whether
DriveControlSuite should have read or write access to the drive controller and assign a configuration from your project to
each drive controller (manually or automatically).

§ Read access
With read access, the configuration is read out from the drive controller to DriveControlSuite.

§ Send access
With send access, the configuration is sent from DriveControlSuite to the drive controller.

Information

DriveControlSuite stores the reference and the production number of the real drive controller with which an online
connection was last established in the project tree for each drive controller.

The information with which reference or with which production number an online connection most recently existed is
saved as part of the project configuration. It is also retained when the drive controller is duplicated or imported into
another project.

Establishing an online connection

After you have specified the settings for the assignment, the last step is to establish the online connection between
DriveControlSuite and the drive controller. With an online connection, you can read out information from the drive
controller to DriveControlSuite and vice versa. For example, the two-way data exchange allows you to create scope images
for diagnostic purposes or to move axes using control panels. With an online connection, you can change the configuration
with regard to the parameters. However, changes to the project configuration or graphical programming are only possible
offline.

Information

Whether you have read or send access to the drive controller controls if the configuration is initially transferred from
DriveControlSuite to the drive controller when the online connection is established or vice versa. As soon as there is an
online connection, the information flows bidirectionally: The values of the drive controller are displayed in
DriveControlSuite and changes in DriveControlSuite affect the drive controller.
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23.8.5.1 Adding a connection (direct connection)

Add a direct connection to a drive controller in the local network to DriveControlSuite to enable an online connection to be
established or to perform a firmware update. If the network topology does not allow an automatic direct connection, you
can add a direct connection manually via the IP address of the drive controller.

Information

The Add connection dialog box can be reached via the start screen, the toolbar, the button in the project menu if you have
selected the project or a module in the project tree, or via the button with the same name in the Online functions window.

Adding a direct connection

Establish a direct connection to a drive controller in the local network to enable an online connection to be established or
to update the firmware.

ü You are in the Add connection dialog box.

ü The drive controller is switched on and can be found in the network.

1. Direct connection tab, IP address column:
Select the drive controller by activating the relevant IP address.

2. Confirm with OK.

ð The connection is added, the Online functions window opens.

Information

In the Direct connection tab, select Select all from the context menu to establish a direct connection to all drive controllers
found in the local network.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)
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Adding a direct connection (manual)

Establish a direct connection via the IP address of the drive controller if DriveControlSuite does not automatically find the
drive controller in the local network due to the network topology.

ü You are in the Add connection dialog box.

ü The drive controller is switched on and can be found in the network.

ü You know the IP address of the drive controller to which you want to establish a direct connection.

1. Direct connection (manual) tab, IP address field:
Enter the IP address of the drive controller (A157).

2. Confirm with OK.

ð The search for the specified IP address in the local network starts.

ð The connection is added, the Online functions window opens.

Information

DriveControlSuite cannot automatically find the drive controllers in the local network if they are connected to a controller,
DS6 is running on a separate PC and the controller does not forward the broadcast telegrams of DS6 to the drive
controllers. With the manual direct connection, DriveControlSuite deliberately sends unicast telegrams to the IP address of
the respective drive controller. The telegrams are usually forwarded by the controller.

You can read out the IP address from the drive controller if an online connection exists, for example (parameter A157). For
SD6 drive controllers, the IP address is shown on the display of the operating unit.

Adding a direct connection (additional IP addresses)

You can add additional IP addresses to the search in the local network if DriveControlSuite does not automatically find the
drive controllers due to the network topology. The drive controllers found are displayed in the Direct connection tab and
are available for establishing the connection.

ü You are in the Add connection dialog box.

ü The drive controllers are switched on and can be found in the network.

ü You know the IP addresses of the drive controllers to which you want to establish a direct connection.

1. Direct connection tab:
Use the context menu to select Additional IP addresses.

ð The Additional IP addresses window opens.

2. To include additional IP addresses in the local network search, select one of the options below.

3. Address range:
To add additional IP addresses via an address range, activate the Address range option.

3.1. First IP address, Last IP address:
Define the range of addresses you want to include in the local network search.

4. Address list:
To add additional IP addresses via an address list, activate the Address list option.

4.1. Define the list of IP addresses you want to include in the local network search, separated by commas.
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5. Addresses from project:
To add additional IP addresses in line with the project's presets, activate the Addresses from project option.

ð The IP addresses from the project's presets are included in the search in the local network.

6. Import settings:
To import the settings for the search for additional IP addresses from an INI file (*.ini), click Import.

ð The Import additional IP addresses dialog box opens.

6.1. Select the directory from which you want to import the settings.

6.2. Confirm with Open.

ð The settings for searching for additional IP addresses are imported.

7. To start the search for additional IP addresses in the local network according to the selected option, confirm with OK.

ð The search for the specified IP addresses in the local network starts.

ð The drive controllers found are displayed in the Direct connection tab and are available for establishing the
connection.

Information

The list of additional IP addresses is not limited and there is no limit to the number of telegrams. An extensive address list
can lead to increased telegram traffic and, accordingly, to increased network utilization.
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23.8.5.2 Establishing an online connection

Establish an online connection between DriveControlSuite and the drive controller to read out or transfer a configuration,
create scope images or use control panels to move the axis.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Adding a direct connection

Establish a direct connection to a drive controller in the local network to enable an online connection to be established or
to update the firmware.

ü You are in the Add connection dialog box.

ü The drive controller is switched on and can be found in the network.

1. Direct connection tab, IP address column:
Select the drive controller by activating the relevant IP address.

2. Confirm with OK.

ð The connection is added, the Online functions window opens.

Information

In the Direct connection tab, select Select all from the context menu to establish a direct connection to all drive controllers
found in the local network.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)
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Establishing an online connection

Establish an online connection to enable the exchange of information between the drive controller and DriveControlSuite.

ü You are in the Online functions window, Online tab.

ü The drive controller is switched on and can be found in the network.

ü You have added a direct connection between DriveControlSuite and the drive controller.

1. Assignment area, Access selection:
Select how DriveControlSuite should access the relevant drive controller.

1.1. If DriveControlSuite is to read a configuration from the drive controller, select Read.

1.2. If DriveControlSuite is to send a configuration to the drive controller, select Send.

1.3. If DriveControlSuite is not to establish an online connection, select Do not connect.

2. Assignment area, Configuration selection:
Select which configuration from the project tree is to be assigned to the real drive controller.

2.1. Read access:
Select a configuration from the project tree or select Create new drive controller.

2.2. Send access:
Select the configuration from the project tree that you want to send to the drive controller.

3. Online tab:
Click Establish online connection.

ð The online connection between DriveControlSuite and the drive controller is established.

ð With read access, the configuration is read from the drive controller to DriveControlSuite.

ð With send access, the configuration is sent from DriveControlSuite to the drive controller.

Information

Whether you have read or send access to the drive controller controls if the configuration is initially transferred from
DriveControlSuite to the drive controller when the online connection is established or vice versa. As soon as there is an
online connection, the information flows bidirectionally: The values of the drive controller are displayed in
DriveControlSuite and changes in DriveControlSuite affect the drive controller.

Information

If you want to establish an online connection to multiple drive controllers, you can use the buttons in the Online tab to
make the assignment easier by setting the access for all drive controllers to Read or Send.

If you have previously established an online connection between DriveControlSuite and the drive controller with the
current project, you can make the assignment automatically according to the reference or according to the production
number of the drive controller.
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23.8.6 Configuring virtual machines
If you would like to connect the drive controllers to the DriveControlSuite commissioning software from a virtual machine,
you have to configure the communication between the virtual machine and host so that, from the perspective of the
network, the virtual machine is no different from a physical PC.

VMware, Inc. VMware

If you use the VMware software from the company of the same name as a virtual machine, configure it in the VMware
Workstation. For the direct connection, the virtual network card is operated as a network bridge.

Microsoft Windows Virtual PC

If you use the Windows Virtual PC software from Microsoft as a virtual machine, configure it in the Virtual PC software and
in the Virtual Server. In both components, the name of the virtual network card has to match the physical network card. 
For Virtual PC network connections, Microsoft distinguishes between the Public and Private types. For the direct
connection, the virtual network card is operated on the Virtual Server with the Public connection type.

Microsoft Hyper-V

If you use the Hyper-V software from Microsoft as a virtual machine, configure a Virtual Switch Manager in the Hyper-V
Manager. 
For network connections through Virtual Switch, Microsoft distinguishes between the External, Internal and Private types.
For the direct connection, the virtual network card is operated with the External connection type.

Oracle VirtualBox

If you use the VirtualBox software from Oracle as a virtual machine, configure the network directly in VirtualBox. For the
direct connection, a virtual network adapter is operated in bridge mode.

23.8.7 Updates
In the Help menu of the DriveControlSuite commissioning software, you can search for a newer version and, if available,
download and install it.

Information

If the DriveControlSuite version is outdated, but the latest version is already installed on the computer, the check will yield
the result that no newer version is available.
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23.8.8 Script mode
Script mode is an automation function of the DriveControlSuite commissioning software. In Script mode, commands can be
processed automatically. For example, this includes opening and closing project files or changing parameters. Processing
commands can be used for executing various actions, such as transmitting a firmware update to multiple drive controllers.

When Script mode is called up from DriveControlSuite, a window with the same name opens. Here, you can transfer
commands to DriveControlSuite in the form of a command script.

When you switch from Script mode to DriveControlSuite, the instance of DriveControlSuite being run in the background
becomes visible.

23.8.8.1 Script mode window

In the DriveControlSuite – Script mode window, you can execute a command script and view information about the status
of the script.

Information

The DriveControlSuite – Script mode window can be reached using the key combination [Ctrl] + [F9] when DriveControlSuite
is open and by executing a command script by double-clicking the batch file when DriveControlSuite is closed.

1

2

3

Fig. 79: Script mode: Program interface
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No. Area Description

1 Overview The Overview area informs you about the progress of the individual script sections.

2 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

3 Log file The Log file area shows the entries that are written to the log file while the command
script is running. Each entry is output with a time stamp and source and can be filtered by
its level through use of the options above the entries (Error, Warning, Info, Verbose). You
can use Save as to save the log file locally.

Button Description

Load file Loads a command script in Script mode.

Run Runs a loaded command script.

Switch to DriveControlSuite Exits Script mode and switches to DriveControlSuite.

Exit Exits Script mode and, where applicable, DriveControlSuite.

23.8.8.2 Command script structure

The command script is structured in the JSON data format (*.json) with UTF-8 encoding with BOM. You can find an
introduction to JSON at:
https://www.json.org/json-en.html

Information

To create a script for DriveControlSuite, use a JSON editor such as JSON Editor Online, JSONViewer or Visual Studio Code.

Three data types are used in the script based on the standard JSON RFC-7159:

§ Boolean

§ String

§ Integer

The command script is divided into three sections: settings, sequence and commands.

Script section Description

settings In the settings section, you define basic settings for executing the command script.

sequence In the sequence section, you define the sequence of the individual commands.

commands In the commands section, you define the individual commands of the command script.

https://www.json.org/json-en.html
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23.8.8.2.1 "settings" script section

In the settings section, you define basic settings for executing the command script. You specify whether a log file is created
when the script is executed and whether DriveControlSuite is closed after the script ends. The settings section is optional.

Attributes

§ "logFilePath": Path of the log file, <optional> <string>

§ "quitWhenDone": Behavior of DriveControlSuite after script end, <optional> <string>

Example

"settings": {
"logFilePath": "%COMMANDFILE%/LoadNewConfig.log",
"quitWhenDone": "never"

},

Creating a log file (logFilePath)

The log file logs the progress of a command script in chronological order. You create a log file by using the logFilePath
attribute to specify the file path under which the log file is to be created. If you specify a file path for the log file, the
command script will be executed only if the log file could be created successfully.

You can specify the file path for the log file either absolutely or relative to the command script directory
(%COMMANDFILE%), \\ or / serve as separators of the path. By specifying %TIMESTAMP%, you can add the current time
stamp (format: YYYYMMDD-hhmmss) to the file name and thus create a new log file each time the command script is
executed. Without a time stamp in the file name, the log file will be overwritten each time the command script is executed.

Quit when done (quitWhenDone)

quitWhenDone can have three values assigned to it, which determine the behavior after the script is done.

"never" DriveControlSuite remains open after the script has ended
(default value).

"noErrors" DriveControlSuite is closed after the script has ended,
insofar as no errors have occurred.

"always" DriveControlSuite is closed after the script has ended in
every case.
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23.8.8.2.2 "sequence" script section

In the sequence section, you define the sequence of the individual commands. The commands are specified as an array of
strings with the key "sequence" and the name you specify in the commands section. A command can occur any number of
times in the array.

The order in the array corresponds to the order in which the commands are executed in the command script. Set a
reasonable order for the commands so that the command script does not abort with an error if a command cannot be
executed. For example, you must first open a project (openProject) before you can change a parameter in it (setParameter).

Example

"sequence": [
"commandName 1",
"commandName 2",
"commandName 1",
"commandName 3"

],

23.8.8.2.3 "commands" script section

In the commands section, you define the individual commands of the command script. A command consists at least of a
name and the "command" attribute, which determines the command and the further attributes of the command.

Example

"commandName1": {
"command": "commandName",
"attributeKey": "attributeValue"

},
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23.8.8.3 Script mode commands

In the following, all available commands are described with the corresponding attributes.

The following table shows an overview of the available commands.

Command Description

openProject [} 376] Open project file

closeProject [} 377] Close project file

connect [} 378] Establish connection

disconnect [} 379] Disconnect connection

setOnline [} 379] Send/read out configuration

setOnlineByPreset [} 381] Send/read out configuration according to the presets

setOffline [} 381] Set offline

updateFirmware [} 382] Multiple live firmware updates

setParameter [} 383] Modify parameters

performAction [} 383] Executing an action

openMessageBox [} 384] Open message window

wait [} 384] Wait

exportParameter [} 385] Export parameters

importParameter [} 386] Import parameters

updateTemplates [} 387] Update project configuration

takeSnapShot [} 387] Create reverse documentation

discardReverseDocumentation [} 388] Delete reverse documentation

Tab. 289: Script mode commands

23.8.8.3.1 openProject

With the command openProject, you can open a project in Script mode, which is required for many commands. When you
open a project with openProject, closeProject is automatically called for the current project.

Attributes

§ "filePath": directory of the project file (*.ds6), <binding> <string>

Description

In the filePath attribute, you specify the name of the project file to be opened. The specification can be made either as an
absolute value or relative to the command script directory (%COMMANDFILE%).

Example

"openProjectfile": {
"command": "openProject",
"filePath": "<your path>"

},
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23.8.8.3.2 closeProject

With the closeProject command, you can close an open project in Script mode. When you open a project with openProject,
closeProject is automatically called for the current project.

Attributes

§ "saveAs": Storage directory of the project file (*.ds6), <optional> <string>

§ "saveBeforeClose": <optional> <Boolean>

Description

saveAs specifies the storage location of the project. Alternatively, the project can be saved at the path specified in the
filePath attribute before it is closed with saveBeforeClose: true. By default, a dialog box opens if the project has
been modified.

Example

"closeProjectfile": {
"command": "closeProject",
"saveBeforeClose": true

},
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23.8.8.3.3 connect

With the connect command, you can establish a direct connection to the drive controllers of a module in Script mode.

Requirements for communication with the drive controllers include a direct connection to the drive controller or gateway
drive controller and assignment to the module within the project under which this drive controller is recorded.

Attribute

§ "module": Reference of the module in the project, <binding> <string>

One of the attributes listed below must be specified for the assignment. The IP address can always be used. The production
number can be used only if the drive controller can be found by searching in a network. The reference can be used only if
the drive controller can be found by searching in a network and a unique reference is defined for each drive controller that
is found:

§ "ipAddress": IPv4 address of the direct connection, <optional> <string>

§ "serialNumber": Production number of the drive controller or gateway drive controller, <optional> <integer>

§ "reference": Reference of the drive controller or gateway drive controller, <optional> <string>

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Description

The connect command establishes a direct connection to drive controller or the gateway drive controller with the
corresponding IP address, production number or reference. Establishing a connection using Internet remote maintenance
or LAN-based remote maintenance is not supported.

Example

"ipConnect": {
"command": "connect",
"module": "M1",
"ipAddress": "192.168.3.2"

},
"serialnumberConnect": {

"command": "connect",
"module": "M1",
"serialNumber": 70012345

},
"referenceConnect": {

"command": "connect",
"module": "M1",
"reference": "T123"

},
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23.8.8.3.4 disconnect

With the disconnect command, you can disconnect all existing direct connections in Script mode (without reverse
documentation).

Example

"DisconnectAll": {
"command": "disconnect"

},

23.8.8.3.5 setOnline

With the setOnline command, you can establish an online connection in Script mode to send a configuration from the
project to the drive controller or to read it from the drive controller into the project.

Attributes

§ "direction": Read or send access; read or write, <optional> <string>

§ "reference": Reference of the drive controller in the project, <optional> <string>

§ "targetId": Reference, production number or IGB position of the physical drive controller, <optional> <string> or
<integer>

§ "targetType": igbPosition, serialNumber or reference, <optional> <string>

§ "connectAndAssignMethod": serialNumber or reference, <optional> <string>

Description of single connection

The configuration of the active project file specified with "reference" is loaded into the specified drive controller or vice
versa. The specification must be unique. Based on the content of targetType, a decision is made about how to interpret the
content of targetId. The online connection is established in the reading or sending direction according to the attribute.

Value set of targetType:

1. "igbPosition": If you network multiple SD6 drive controllers via IGB, the position of the drive controller in the IGB
network is determined based on the plug sequence; assignment takes places based on this position; the left outer
drive controller in the IGB has the position 0 (zero)

2. "serialNumber": The assignment is made using the production number of the drive controller

3. "reference": The assignment is made based on the reference already existing in the drive controller (E120); this was
assigned during the most recently executed project configuration

It is always a prerequisite that a drive controller with this igbPosition, production number or reference must be in the
established connection.

Description of multi-connection

When using the connectAndAssignMethod attribute with the values serialNumber or reference (see example 4), the
configurations of the active project file are loaded to the corresponding drive controllers most recently connected or vice
versa. The online connection is established in the reading or sending direction according to the attribute.
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Examples

Example 1
The configuration of the projected drive controller T1 is loaded into the device with the production number 7000026.

"sendConfigFromT1to7000026": {
"command": "setOnline",
"direction": "write",
"reference": "T1",
"targetId": 7000026,
"targetType": "serialNumber"

},

Example 2

"readConfigOutOfIgb5intoT2": {
"command": "setOnline",
"direction": "read",
"reference": "T2",
"targetId": 5,
"targetType": "igbPosition"

},

Example 3

"writeFromT3ToArAlt": {
"command": "setOnline",
"direction": "write",
"reference": "T3",
"targetId": "ArAlt",
"targetType": "reference"

},

Example 4

"setOnline": {
"command": "setOnline",
"direction": "write",
"connectAndAssignMethod": "reference"

},
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23.8.8.3.6 Sending/reading out a configuration according to the presets (setOnlinebyPreset)

With the setOnlineByPreset command, you can establish an online connection in Script mode to send a configuration from
the project to the drive controller or to read it from the drive controller into the project. The command uses the presets
stored in the project to establish the connection. If you do not specify any specific drive controllers via the attributes, an
online connection is established for all drive controllers in the project.

If you store presets for the connection setup in the project, you can easily store a command script or reuse it for multiple
projects. For more information on the presets, see Presetting connections [} 390].

Attributes

§ "module": Reference of the module, <optional> <string>

§ "reference": Reference of the drive controller, <optional> <string>

§ "direction": Read of send access; read or write; overwrites the preset transmission direction, <optional> <string>

Description

The transmission applies to one individual drive controller based on the specification of module and reference (see example
1), but it can also be defined for all drive controllers pre-defined in the project (see example 2).

Examples

Example 1

"singleConnectByPresets": {
"command": "setOnlineByPreset", "module": "m1", "reference": "T1"

},

Example 2

"multiConnectByPresets": {
"command": "setOnlineByPreset"

},

23.8.8.3.7 setOffline

With the setOffline command, you can disconnect the online connection to all connected drive controllers in Script mode
(with or without reverse documentation). You can save changes to the parameter values of the drive controller before
disconnecting.

Attribute

§ "reverseDocumentation": For true or false, reverse documentation is either created or not, <optional> <Boolean>
<default = false>

§ "saveValues": For true, the parameter A00 is set to active before setOffline is carried out, <optional> <Boolean>
<default = false>

Example

"setOfflineAndSaveValues":
{

"command": "setOffline",
"reverseDocumentation": false,
"saveValues": true

},
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23.8.8.3.8 Updating firmware (updateFirmware)

With the updateFirmware command, you can perform a live firmware update in Script mode for a defined list of drive
controllers in the network.

Attributes

§ "ipAddresses": List of IP addresses of the drive controllers at the gateways

§ "serialNumbers": List of production numbers of the drive controllers at the gateways, <integer>

§ "references": List of references of the drive controllers at the gateways

§ "connectByMethod": serialNumber, reference or presets, <optional> <string>

• "serialNumber": In the open project, all drive controllers are provided with a firmware update whose production
number matches the production number defined in the project

• "reference": In the open project, all drive controllers are provided with a firmware update whose references
matches the reference defined in the project

• "presets": In the open project, all drive controllers are provided with a firmware update that corresponds to the
drive controllers defined in the presets

§ "firmwarePath": Directory in which the firmware files are stored, <optional>

§ "firmware": Firmware version

• "default": In this value, the version of the target firmware corresponds to the DriveControlSuite version (highest
firmware version that was loaded)

§ "restart": Restart after the update is finished, <optional> <Boolean> <default = false>

§ "waitForRenewedAvailability": Wait until the update has been completed and the drive controllers are available again
in the network, <optional> <Boolean> <default = false>

Example

"updateFirmwareToV_6_4_D": {
"command": "updateFirmware",
"firmware": "V 6.4-D",
"firmwarePath": "<your path>",
"ipAddresses": ["192.168.3.101",

"192.168.3.102",
"192.168.3.103"

],
"restart": true,
"waitForRenewedAvailability": true

},



STOBER 23 | Appendix
11

/2
02

4 
| 

ID
 4

43
34

0.
01

383

23.8.8.3.9 Changing the parameter value (setParameter)

With the setParameter command, you can change the value of a parameter in Script mode. You can execute the command
both offline and with an existing online connection.

Attributes

§ "module": Reference of the module, <binding> <string>

§ "reference": Reference of the drive controller, <binding> <string>

§ "coordinate": Coordinate of the parameter, <binding> <string>

§ "value": Value of the parameter, <binding> <string>

Example

"setA10[3]:" {
"command": "setParameter",
"module": "M1",
"reference": "T2",
"coordinate": "A10[3]",
"value": "2"

},

23.8.8.3.10 performAction

With the performAction command, you can perform an action in Script mode. You can only execute the command if there is
an existing online connection.

Attributes

§ "reference": Reference of the drive controller, <optional> <string>

• If the specification is missing, the action is executed on all connected drive controllers

§ "module": Reference of the module, <optional> <string>

• If the specification is missing, the action is executed on all connected drive controllers

§ "coordinate": Coordinate of the action parameter, <binding> <string>

§ "waitForDone": Wait until the action has been completed, <optional> <Boolean> <default=true>

§ "timeout", <optional> <integer><default = 60> (timeout in seconds):

• If waitForDone is true: If the timeout is reached before the action has been fully completed, the command was
unsuccessful and the sequence has been interrupted

• If waitForDone is false: After the action is started, there is a wait until the timeout has expired; then the sequence
is continued; the command is considered successfully processed

§ "livingSpace": Axis (in the case of multiple axes, those to which a parameter is assigned), <optional>
<string><default=Global>
Possible values:

"livingSpace": "Global",
"livingSpace": "Axis1",
"livingSpace": "Axis2",
"livingSpace": "Axis3",
"livingSpace": "Axis4",
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Example

"restartSIAx1": {
"command": "performAction",
"module": "M1",
"reference": "SIAx1",
"coordinate": "A09",
"livingSpace": "Global",
"waitForDone": false,
"timeout": 10

},

23.8.8.3.11 Opening a message (openMessageBox)

With the openMessageBox command, you can open a message in Script mode that displays the specified text. The
command script is stopped until the message is confirmed with OK.

Attributes

§ "text": text of the message, <binding> <string>

Example

"ShowMsgBox": {
"command": "openMessageBox",
"text": "Please press OK!"

},

23.8.8.3.12 wait

With the wait command, you can pause the command script in Script mode for the specified time.

Attribute

§ "seconds": Wait time in seconds, <binding> <integer>

Example

"Wait15Secs": {
"command": "wait",
"seconds": 15

},
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23.8.8.3.13 Exporting parameter values (exportParameter)

With the exportParameter command, you can export the parameter values of a drive controller, a module or the entire
project in Script mode. If you do not define any specific drive controller or module via the attributes, the parameter values
of the entire project are exported. You can work with the variables listed below to have unique file names when exporting
the entire project. These are replaced by the actual values during export.

Attributes

§ "exportPath": Directory to which the parameter values are exported as a text file, <binding> <string>

§ "module": Reference of the module, <optional> <string>

§ "reference": Reference of the drive controller, <optional> <string>

Variables

Variable Description

%m% Module reference

%M% Designation of the module

%r% Reference of the drive controller

%d% Designation of the drive controller

%i% Iteration over the number of drive controllers

Tab. 290: Script mode: Variables for importing and exporting parameters

Example

"ExportSingle": {
"command": "exportParameter",
"module": "M1",
"reference": "T2",
"exportPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt"

},
,

"ExportMulti": {
"command": "exportParameter",
"exportPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt"

},
,
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23.8.8.3.14 Importing parameter values (importParameter)

With the importParameter command, you can import previously exported parameter values for a drive controller, a module
or the entire project in Script mode. If you do not define a specific drive controller or module via the attributes, the
parameter values of the entire project are imported. You can work with the variables listed below to have unique file
names when exporting the entire project. These are replaced by the actual values during export.

Attributes

§ "importPath": Path to the text file from which the parameter values are imported, <binding> <string>

§ "module": Reference of the module, <optional> <string>

§ "reference": Reference of the drive controller, <optional> <string>

§ "deleteAfter": If true, the text file with the parameter values will be deleted after import <optional> <Boolean><default
= true>

§ "reportPath": Path under which the change overview (*.html) is saved, <binding> <string>

Variables

Variable Description

%m% Module reference

%M% Designation of the module

%r% Reference of the drive controller

%d% Designation of the drive controller

%i% Iteration over the number of drive controllers

Tab. 291: Script mode: Variables for importing and exporting parameters

Example

"ImportSingle": {
"command": "importParameter",
"module": "M1",
"reference": "T2",
"importPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt",
"reportPath": "%COMMANDFILE%/parameterImportReport_ ProjectName.html",
"deleteAfter": false

},
,

"ImportMulti": {
"command": "importParameter",
"importPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt",
"reportPath": "%COMMANDFILE%/parameterImportReport_ ProjectName.html",
"deleteAfter": false

},
,
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23.8.8.3.15 updateTemplates

With the updateTemplates command, you can update the project configuration of the drive controllers to the latest version
in Script mode (templates and system parameter version).

Attributes

§ "reportPath": Generates an overview (*.html) of the changes in the project configuration, <optional> <string>

Example

"updateTemplates": {
"command": "updateTemplates",
"reportPath": "%COMMANDFILE%/updateReport.hmtl"

},

23.8.8.3.16 Creating reverse documentation (takeSnapShot)

With the takeSnapShot command, you can establish an online connection in Script mode to read out the configurations of
the connected drive controllers into the project and to create reverse documentation when disconnecting. The
configurations are read out into a new module in the project tree. If you do not use the attributes to specify any specific
drive controllers, the configuration is read out for all drive controllers in the network and reverse documentation is created.

If you have networked multiple SD6 drive controllers via IGB, the entire IGB network is always read out as reverse
documentation via the IP address of the gateway drive controller. If no project is open, the command creates a new empty
project.

Attributes

§ "ipAddresses": List of IP addresses of the drive controllers at the gateways, <optional> <string array>

§ "serialNumbers": List of production numbers of the drive controllers at the gateways, <optional> <integer array>

§ "references": List of references of the drive controllers at the gateways, <optional> <string array>

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Description

The command establishes a direct connection to the gateway drive controllers with the corresponding IP addresses,
production numbers or references.

Example 1

"takeSnapShot": {
"command": "takeSnapShot"

},

Example 2

"takeSnapShotIpAddresses": {
"command": "takeSnapShot",
"ipAddresses": ["192.168.3.4","192.168.3.139"]

},
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Example 3

"takeSnapShotReferences": {
"command": "takeSnapShot",
"references": ["T3","T4"]

},

Example 4

"takeSnapShotSerialNumbers": {
"command": "takeSnapShot",
"serialNumbers": [9011564,9012296]

},

23.8.8.3.17 Deleting reverse documentation (discardReverseDocumentation)

With the discardReverseDocumentation command, you can delete one or all instances of reverse documentation in Script
mode. If you do not define any specific drive controller via the attributes, the reverse documentation of all drive controllers
in the project is deleted.

Attributes

§ "reference": Reference of the drive controller, <optional> <string>

§ "module": Reference of the module, <optional> <string>

Example

"discardReverseDocu": {
"command": "discardReverseDocumentation",
"reference": "T1"
"module": "M1"

},

23.8.8.4 Executing a command script

To execute a command script, in addition to the actual script, you need a batch file with which you pass the command script
to DriveControlSuite. You can execute the command script either when DriveControlSuite is opened from the
DriveControlSuite – Script mode window or when DriveControlSuite is closed by double-clicking on the corresponding batch
file.

Information

Place all the files you need to execute a command script in the same directory. To execute a command script, you need at
least 2 files (command script and batch file). If you want to log the script execution, you also need a log file. Depending on
the application, you may also need a project file if you want to create or import a backup, for example.

Information

For application examples for the Script mode, go to our download center at http://www.stoeber.de/en/downloads/ and
search for Script mode. The application examples contain sample files for the 3 following use cases: update firmware
(firmware update), save configuration (backup) and import configuration (restore). You can adapt the sample files to your
application by changing the number and addressing of the drive controllers and also the file names and path specifications.

http://www.stoeber.de/en/downloads/
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Creating a command script

Create a command script (*.json) that contains the appropriate commands and attribute values for your application.

ü You are in the directory for the command script files.

1. Create a new text file via the Windows Explorer context menu.

2. Assign a suitable file name and change the file extension from *.txt to *.json.

2.1. Example: FirmwareUpdate.json.

3. Open the file.

4. Write the command script for your application by defining the settings, sequence and commands script sections.

4.1. Example:
{ 

"settings": { 

"logFilePath": "%COMMANDFILE%/FirmwareUpdate.log", 

"quitWhenDone": "never" 

}, 

"sequence": [ 

"UpdateFirmware" 

], 

"UpdateFirmware": { 

"command": "updateFirmware", 

"firmware": "V 6.4-D", 

"ipAddresses": 

[ "200.0.0.1", 

"200.0.0.2", 

"200.0.0.3"

], 

"restart": true 

} 

}

5. Save the command script.

Creating a batch file

Create a batch file (*.bat) with which you pass the command script to DriveControlSuite.

ü You are in the directory for the command script files.

1. Create a new text file via the Windows Explorer context menu.

2. Assign a suitable file name and change the file extension from *.txt to *.bat.

2.1. Example: FirmwareUpdate.bat.

3. Open the file.

4. Specify the path to the EXE file of DriveControlSuite and assign the command script.

4.1. Example:
"C:\Program Files (x86)\STOBER\DriveControlSuite\bin\DS6A.exe"

FirmwareUpdate.json

5. Save the batch file.
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Executing a command script

Execute a command script with DriveControlSuite closed or open.

ü You are in DriveControlSuite.

1. Use the key combination [Ctrl] + [F9].

ð The DriveControlSuite – Script mode window opens.

2. Click Load file.

ð The Open file dialog box opens.

3. Navigate to the desired command script and click Open.

4. To run the command script, click Run.

ð The command script will be executed.

ð The DriveControlSuite – Script mode window displays information about the status of the command script in the
Overview, Messages and Log file areas.

Information

You can execute a command script even when DriveControlSuite is closed by double-clicking the associated batch file.
Double-clicking the batch file executes the command script and the DriveControlSuite – Script Mode window will open to
display information about the status of the command script.

23.8.8.5 Presetting connections

You need the presets for the connection setup for the setOnlineByPreset command in Script mode. If you store presets for
establishing the connection in the project, you can easily keep a command script or reuse it for multiple projects.

The IP addresses stored in the presets can be taken into account for establishing the connection when searching for drive
controllers in the local network.

ü You are in DriveControlSuite.

ü Your project is open.

1. Select the project in the project tree and choose Preset connections from the context menu.

ð The Preset connections window opens.

2. Direction selection:
Select whether read or send access to the drive controllers is to be made when the connection is established.

3. Target selection:
Select how the configuration and drive controller are to be assigned to each other when the connection is established
(IP address, reference, production number, PLC device name).

4. Confirm the presets with OK.

ð The presets are taken into account in the next execution of the setOnlineByPreset command.

ð The stored IP addresses can be taken into account when searching for drive controllers in the local network.
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23.8.8.6 Application examples for EtherCAT

Examples are provided to illustrate how Script mode functions and how you can use it.

The files required for running the application examples can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter Script mode in the search field.

The package contains the example files for the following actions:

§ Carry out a firmware update (FirmwareUpdate)

§ Load the prepared configuration (Restore)

§ Saving the current configuration (Backup)

The requirements for executing the actions are almost identical for all example files (see Running a script).

If you would like to use the example files, you must adapt them (file names and paths, addressing of the drive controllers).

Test setup

1001
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SI6A162
9004002
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200.0.0.5
SI6A162
9004016

T5

1015
200.0.0.6
SI6A161
9008011

T6

1016
200.0.0.7
SI6A161
9001135

T7

1017
200.0.0.8
SI6A161
9001151

T8

Drive
Controller

1

Drive
Controller

2

Drive
Controller

3

Drive
Controller

4

Drive
Controller

5

Drive
Controller

6

Drive
Controller

7

Drive
Controller

8
ECAT addr.:
IP address:

Type:
S/N:

Reference:

Test project
200.0.0.200

EK
D

10
05

10
06

10
07

10
08

10
09

10
10

10
11

10
12

10
13

20
0.

0.
0.

10
0

BK
E
O
E

Fig. 80: Test setup of the application examples

Eight drive controllers of the SI6 series with fixed IP addresses 200.0.0.1 - 200.0.0.8 assigned by the EtherCAT MainDevice.

Variant 1

DriveControlSuite runs on the same IPC as the EtherCAT MainDevice.

Variant 2

The DriveControlSuite runs on a PC or laptop. The PC or laptop are on the same network as the IPC, but not on the same
network as the EoE device group. A route must also be set here. For more information, see Network route [} 393].

http://www.stoeber.de/en/downloads/
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23.8.8.6.1 Carrying out a firmware update

Requirements

§ DriveControlSuite version 6.4-D or later is the default installation

§ All drive controllers are operated with firmware version 6.4-A or later

§ All drive controllers can be reached through a direct connection using IP addresses 200.0.0.1 to 200.0.0.8

Behavior of the script

The script for the drive controllers with the IP addresses 200.0.0.1 - 200.0.0.8 transfers a firmware update to firmware
version 6.4-D. The drive controllers are then restarted.

Information

Be aware that values that have been changed or only stored in volatile memory are lost and that fieldbus communication
and the connection to DriveControlSuite are interrupted in the event of a drive controller restart.

23.8.8.6.2 Load the prepared configuration (Restore)

Requirements

§ DriveControlSuite version 6.4-D or later is the default installation

§ All drive controllers are operated with firmware version 6.4-A or later

§ All drive controllers can be reached through a direct connection using IP addresses 200.0.0.1 to 200.0.0.8

§ A project file Restore.ds6 with the drive controllers

Behavior of the script

The configurations of the drive controllers projected in the Restore.ds6 project are transferred to the drive controllers with
the parameterized IP addresses by a script.

Information

Be aware that values that have been changed or only stored in volatile memory are lost and that fieldbus communication
and the connection to DriveControlSuite are interrupted in the event of a drive controller restart.

ATTENTION!

Machine damage from uncontrolled stopping!

Note that sending a configuration includes a brief stop of the device configuration. Communication with the EtherCAT
MainDevice is interrupted. For this reason, the script may be run only in the pre-operational state.
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23.8.8.6.3 Saving the current configuration (Backup)

Requirements

§ DriveControlSuite version 6.4-D or later is the default installation

§ All drive controllers are operated with firmware version 6.4-A or later

§ All drive controllers can be reached through a direct connection using IP addresses 200.0.0.1 to 200.0.0.8

§ A project file Backup.ds6 with the drive controllers.

Behavior of the script:

The configurations of the drive controllers with the parameterized IP addresses are saved in the Backup.ds6 file by a script.

23.8.8.6.4 Network route

The Internet Protocol (IP) ensures that data packets are communicated across network boundaries. Routing is the
determination of a suitable path for transferring the data packets.

Particularly when EoE is used, it is often necessary to create a route manually.

Information

Note that manually routing to the controller will function only if the IP address of the controller and the IP address of the PC
in question are in the same network. Otherwise, the network administration has to add a static route to the router's routing
table.

Creating a network route

In Windows, the route is created as follows:

route ADD 200.0.0.0 MASK 255.0.0.0 192.168.12.36

Explanation:

200.0.0.0 is the EoE network with a network mask of 255.0.0.0.
192.168.12.36 is the address of the controller that connects to the EoE network.

Deleting a network route

In Windows, the route is deleted as follows:

route delete 200.0.0.0
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23.8.8.7 Exit statuses

Calling a command script returns the exit statuses described below, which can be output on a Windows PC using the
command prompt, for example. The exit status for the successful execution of a command script is 0. An exit status not
equal to 0 signals an error.

Exit status Name Description or cause Check and action

0 SUCCESS Command script was executed
without errors

—

100 JSON-ERROR Error parsing the command script Check syntax of JSON file and correct
if necessary

101 JSON-FILE-NOT-EXISTING Command script was not found Check assignment of the command
script in the batch file and correct if
necessary

201 PROJECT-FILE-NOT-EXISTING Project file was not found Check attributes in the command
script and correct if necessary

202 PROJECT-FILE-NOT-OPENING Project file could not be opened Check whether the DS6 project is
already open and close it if necessary

203 PROJECT-FILE-NOT-
READABLE

Project file was not readable Check read access rights to the DS6
project and extend them if necessary

204 PROJECT-FILE-WRONG-FW Project file could not be loaded
due to wrong firmware; firmware
version of the project file does not
match the DriveControlSuite

Check firmware version in DS6
project and correct if necessary

210 CANNOT-SAVE-PROJECT-FILE Project file could not be saved Check write access rights to the DS6
project and extend them if necessary

300 CONNECTION-ERROR Error when establishing a
connection

Check network connection; check
attributes in the command script and
correct if necessary

400 SETONLINE-ERROR Error during online connection if
the error cannot be narrowed
down more precisely

Check attributes in the command
script and correct if necessary

401 SETONLINE-ERROR-READING Error with read online connection Check attributes in the command
script and correct if necessary

402 SETONLINE-ERROR-WRITING Error with write online connection Check attributes in the command
script and correct if necessary

500 FWUPDATE-ERROR Error during firmware update if the
error cannot be narrowed down
more precisely

Check attributes in the command
script and correct if necessary

501 FWUPDATE-FILE-NOT-
FOUND

Error during firmware update if the
firmware file was not found

Check attributes in the command
script and correct if necessary

502 FWUPDATE-CONTROLLER-
NOT-FOUND

Error during firmware update if the
drive controller was not found

Check attributes in the command
script and correct if necessary

601 PARAIMPORT-FILE-NOT-
FOUND

Error during parameter import if
the import file was not found

Check attributes in the command
script and correct if necessary

602 PARAEXPORT-FILE-NOT-
WRITABLE

Error during parameter export if
the file could not be written

Check access rights to the directory
and file and extend them if necessary

700 ACTION-ERROR Error when performing an action if
the error cannot be narrowed
down more precisely

Check attributes in the command
script and correct if necessary
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Exit status Name Description or cause Check and action

701 ACTION-WRONG-
PARAMETER

Error while executing an action if
the parameter coordinate was
wrong

Check attributes in the command
script and correct if necessary

800 SET-PARAMETER-ERROR Error when writing a parameter
value if the error cannot be
narrowed down more precisely

Check attributes in the command
script and correct if necessary

801 SET-PARAMETER-NOT-
WRITABLE

Error when writing a parameter
value if the parameter is write-
protected

Parameter value cannot be changed;
check attributes in the command
script and change parameter
coordinate if necessary

802 SET-PARAMETER-NOT-
EXISTING

Error writing a parameter value if
the parameter does not exist

Check attributes in the command
script and correct if necessary

900 UPDATE-TEMPLATES-ERROR Error when updating a template Check project configuration of the
drive controllers for compatibility
with the latest version of the
templates

1100 SNAPSHOT-ERROR Error when creating reverse
documentation

Check attributes in the command
script and correct if necessary

1150 DISCARD-SNAPSHOT-ERROR Error when deleting reverse
documentation

Check attributes in the command
script and correct if necessary

1200 ONLINE-BY-PRESET-ERROR Error during online connection
according to the default settings

Check network connection; check
attributes in the command script and
correct if necessary

Tab. 292: Script mode: Exit statuses

Extending a batch file

The exit status can be queried with the following command:

echo %ERRORLEVEL%

The following example shows the content of a batch file (*.bat), extended by the output of the exit status in the
penultimate line:

echo off
"C:\Program Files (x86)\STOBER\DriveControlSuite\bin\DS6A.exe" FirmwareUpdate.json
IF %ERRORLEVEL% NEQ 0 Echo An error was found:
IF %ERRORLEVEL% EQU 0 Echo No error found:
echo %ERRORLEVEL%
pause
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23.8.9 Simple Network Time Protocol (SNTP)
An SNTP client is implemented in the drive controller in accordance with RFC4330. This client sets the internal clock of the
drive controller to the current time, which it obtains from an external time server. The internal clock runs with an
(inaccurate) controllable internal clock in the drive controller. As a result, the time is queried from the server in intervals. It
is compared with the internal time and the clock for the internal clock is readjusted accordingly. You define the settings in
parameter A199.

Two NTP servers can be defined as time sources, both of which are used as possible time servers. In the case of data traffic
via the service interface, the computer through which the drive controller is connected via DriveControlSuite automatically
counts as one of the possible time servers. The time servers must be accessible either via EoE, service interface X9 or
terminals X200 and X201. Make sure that the time server is accessible from the drive controller. It may be necessary to set
the gateway parameter A175 accordingly.

The time is always requested from the same NTP server and then cyclically repeated by the server to track the synchronicity
control loop. If the current server fails, the next one in the list is used. A server that was once active is discarded only in case
of connection failure to this server or server unavailability.

After the drive controller is switched on, it takes a random time of 1 to 5 minutes (in accordance with RFC4330) until the
SNTP client sends its first request to one of the time servers.

The cyclic repetition of a request occurs approximately every 5 to 6 hours.

23.8.9.1 Setting up time service on the computer

On a Windows PC with DriveControlSuite, you can use the registry editor to set up the time service. You must stop the time
server in advance and restart it after changing the registry. Proceed as follows:

1. Open the command prompt, e.g. as follows:

1.1. Use the [Windows]+[r] key combination to open the Run dialog box.

1.2. Enter the command cmd and confirm with OK.

ð The command prompt opens.

2. Stop the time server by using the command net stop w32time.

3. Open the registry editor, e.g. as follows:

3.1. Use the [Windows]+[r] key combination to open the Run dialog box.

3.2. Enter the command regedit and confirm with OK.

ð The registry editor opens.

4. Select HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > W32Time > TimeProvider > NtpServer.

5. Set Enable to the value 1 and confirm with OK.

6. Close the registry editor.

7. Open the command prompt again.

8. Start the time server in the command prompt by using the command net start w32time.

ð The time service is set up on the PC.

Automation using a command script

If you want to change the registry on the PC via a command script, create a *.reg file by creating an empty text file and
renaming the file extension. Then open the file and enter the following content:

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimeProviders\NtpServ

er] "Enabled"=dword:00000001

Run the file in the command line of the command prompt.
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More commands

If you want to query the status on the current PC, use the following command in the command prompt:

w32tm /query /status

To query the IP address by PC name, use the following command at the command prompt:

nslookup <name>

Example:

nslookup ptbtime1.ptb.de
Name: ptbtime1.ptb.de
Addresses: 2001:638:610:be01::108 192.53.103.108

The IP address is: 192.53.103.108.

23.8.10 Security log
The Security log window shows a complete, antichronological overview of all changes to the firmware and configuration of
the drive controller.

Information

In firmware V 6.5-K and later, the Security log window can be reached using either the context menu of the drive controller
in the project tree or the button in the Online functions window.

In the Online functions window, the current security log is read out from the drive controller to DriveControlSuite if a direct
connection or online connection exists. It can also be saved with the project file. In the project tree, the security log is only
read out if there is an existing online connection. If there is no online connection between DS6 and the drive controller, the
last security log read out is displayed.

Field Description

Production number Production number of the drive controller

Time stamp Time stamp of the readout (local date and time)

Column Description

Index Entry index

Event type Type of event

Date + time (UTC) Date and time of the event in UTC (source: DS6)

Operating time Operating time of the drive controller (source: E30)

Interface Interface through which the event occurred (DriveControlSuite, SD card)

Event information Information about the event

Information

The source for the Date + time (UTC) column of the event is the time that the drive controller has at the moment of the
event (e.g. via DriveControlSuite or fieldbus). If the configuration of the drive controller is changed via the SD card, the date
and time of the event are not recorded.

Button Description

Export Exports the security log to a CSV file (*.csv).

Close Closes the Security log window.
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23.8.10.1 Reading out the security log

With an existing online connection, you can read out the current version of the security log from the drive controller to
DriveControlSuite in order to track changes to the firmware and configuration of the drive controller and export them if
necessary.

Reading out the security log

Read out the security log from the drive controller into DriveControlSuite as described below.

ü You are in the Online functions window.

ü You have added a direct connection between DriveControlSuite and the drive controller.

1. Click next to the relevant drive controller on .

ð The security log is read out from the drive controller.

ð The Security log window opens.

Exporting the security log

Export the security log to be able to view it later.

ü You have read out the security log from the drive controller to DriveControlSuite.

ü You are in the Security log window.

1. Click Export.

ð The Export security log dialog box opens.

2. Select the directory where you want to save the security log.

3. Confirm with Save.

ð The security log is saved as a CSV file (*.csv).
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23.9 Further information
The documentation listed below provides you with further relevant information on the 6th STOBER drive controller
generation. The current status of the documentation can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter the ID of the documentation in the search field.

The grouping of the documentation is intended to provide you with assistance, but is only relevant if you control the drive
controller using a fieldbus.

PROFINET

Title Documentation Contents ID

PROFINET communication – SC6,
SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

443039

PROFIdrive application – SC6, SI6 Manual Project configuration, configuration,
parameterization, function test, detailed
information

443270

Drive Based application (DB) – SC6,
SI6

Manual Project configuration, configuration,
parameterization, function test, detailed
information

443437

Drive Based Synchronous
application (DBS) – SC6, SI6

Manual Project configuration, configuration,
parameterization, function test, detailed
information

443059

Drive Based Center Winder
application (DBCW) – SC6, SI6

Manual Project configuration, configuration,
parameterization, function test, detailed
information

443440

SU6 safety technology – STO and
SS1 via PROFIsafe

Manual Technical data, installation, commissioning,
diagnostics, detailed information

443258

SR6 safety technology – STO via
terminals

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442741

Connection method Manual Selection of encoder, power and hybrid cables,
accessories, technical data, connection

443102

http://www.stoeber.de/en/downloads/
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EtherCAT

Title Documentation Contents ID

EtherCAT communication – SC6,
SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

443025

CiA 402 application – SC6, SI6 Manual Project planning, configuration,
parameterization, function test, detailed
information

443080

Drive Based application (DB) – SC6,
SI6

Manual Project configuration, configuration,
parameterization, function test, detailed
information

443437

Drive Based Synchronous
application (DBS) – SC6, SI6

Manual Project configuration, configuration,
parameterization, function test, detailed
information

443059

Drive Based Center Winder
application (DBCW) – SC6, SI6

Manual Project configuration, configuration,
parameterization, function test, detailed
information

443440

SY6 safety technology – STO and
SS1 via FSoE

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442744

SR6 safety technology – STO via
terminals

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442741

Connection method Manual Selection of encoder, power and hybrid cables,
accessories, technical data, connection

443102

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

EtherCAT Technology Group (ETG), 2015. ETG.1300: EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Specification.
2015-07-03.
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23.10 Formula symbols

Symbol Unit Explanation

C1max F Maximum input capacitance

Cmax F Maximum capacitance

CN,PU F Nominal charging capacity of the power unit

CPU F Self-capacitance of the power unit

DIA % Reduction in the nominal current depending on the installation altitude

DT % Reduction in the nominal current depending on the surrounding temperature

E2max J Maximum switch-off energy at the output

ηN % Nominal efficiency

f1max Hz Maximum input frequency

f2max Hz Maximum output frequency

f2PU Hz Output frequency of the power unit

fN Hz Rotating magnetic field frequency at nominal speed

fPWM,PU Hz Frequency of the pulse width modulation of the power unit

I0 A Stall current

I1max A Maximum input current

I1maxCU A Maximum input current of the control unit

I1N,PU A Nominal input current of the power unit

I2max A Maximum output current

I2maxPU % Maximum output current of the power unit (in relation to the nominal output current)

I2N,PU A Nominal output current of the power unit

I2PU(A) A Output current of the power unit for axis A

I2PU(B) A Output current of the power unit for axis B

i²t % Limit load integral

Id,ref A Magnetization-generating reference current in the d/q coordinate system

ILINE A Supply current

Imax A Maximum current

ImaxLINE A Maximum supply current

IminLINE A Required supply current

IN A Nominal current

IN,MF A Nominal current of the choke or motor filter

Iq,ref A Torque/force-generating reference current in the d/q coordinate system

KI — Integral coefficient

KP — Proportional coefficient

λLINE – Power factor of the supply grid

M/Fset Nm/N Set torque or set force

M0 Nm Stall torque

M1Bstat Nm Static braking torque of the brake in the motor adapter (tolerance +40%, −20%)

M2N Nm Nominal torque on the gear unit output (relative to n1N)

M2NOT Nm Gear unit emergency off torque on the gear unit output for max. 1000 load changes

MB Nm Braking torque
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Symbol Unit Explanation

MBstat Nm Static braking torque of the motor brake at 100 °C

Mk Nm Permitted tilting torque on the output

MN Nm Nominal torque

MN,B Nm Nominal braking torque

n1N rpm Nominal speed at the gear unit input

n2N min-1 Nominal speed at the gear unit output

nfed – Number of drive controllers connected to the grid

nN rpm Nominal speed: The speed for which the nominal torque MN is specified

p – Number of pole pairs

PeffRB W Effective power at the external braking resistor

PLINE W Power output

PmaxRB W Maximum power at the external braking resistor

PMOT W Motor rating

PtotalMOT W Total rating of all motors

PV W Power loss

PV,CU W Power loss of the control unit

R2minRB Ω Minimum resistance of the external braking resistor

ϑamb °C Surrounding temperature

ϑamb,max °C Maximum surrounding temperature

t1B ms Engaging time (also: linking time) of the brake; time span from when the current is switched
off until the nominal holding torque is reached

t2B ms Release time (also: disengagement time) of the brake; time span from when the current is
switched off until the brake is completely released

TM Year, a Mission time

Ti ms Reset time

tmin ms Minimum cycle time of the application

τth °C Thermal time constant

U0/U V Nominal voltage of electrical conductors, expressed by the ratio of 2 values:

§ U0: RMS value of the voltage between the line conductor and ground

§ U: RMS value of the voltage between 2 line conductors

U1 V Input voltage

U1CU V Input voltage of the control unit

U1max V Maximum input voltage

U1PU V Input voltage of the power unit

U2 V Output voltage

U2PU V Output voltage of the power unit

U2PU,ZK V Output voltage of the power unit for the DC link connection (typical values: 400 VAC

corresponds to 560 VDC, 480 VAC corresponds to 680 VDC)

Umax V Maximum voltage

UmaxMOT V Maximum motor voltage

UMOT V Motor voltage

U V Nominal voltage
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Symbol Unit Explanation

UoffCH V Switch-off threshold of the brake chopper

UonCH V On limit of the brake chopper

vact m/min Actual velocity

vset m/min Set velocity

xact m Actual position

xset m Set position

23.11 Abbreviations

Abbreviation Meaning

AC Alternating Current

AEH Aderendhülse (end sleeve)

AWG American Wire Gauge

BAT Battery

BG Baugröße (size)

CiA CAN in Automation

CNC Computerized Numerical Control

CSA Canadian Standards Association

csp Cyclic synchronous position mode

cst Cyclic synchronous torque mode

csv Cyclic synchronous velocity mode

DC Direct Current

DHCP Dynamic Host Configuration Protocol

DI Digital Input

DMZ Demilitarized zone

EMC Electromagnetic Compatibility

ETG EtherCAT Technology Group

EtherCAT Ethernet for Control Automation Technology

FAT File Allocation Table

FSoE Fail Safe over EtherCAT

HTL High Threshold Logic

IE International Efficiency

IE class Energy efficiency class

IIoT Industrial Internet of Things

ip Interpolated position mode

IP International Protection

IP Internet Protocol

MDevice MainDevice

NAT Nennansprechtemperatur (nominal response temperature)

NTP Network Time Protocol

P controller Proportional controller
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Abbreviation Meaning

PE Protective Earth (grounding conductor)

PELV Protective Extra Low Voltage

PI controller Proportional-Integral controller

PID controller Proportional-Integral-Differential controller

PL Performance Level

pp Profile position mode

PRM Predictive Maintenance

pt Profile torque mode

PTC Positive Temperature Coefficient

pv Profile velocity mode

RCD Residual Current protective Device

RCM Residual Current Monitoring device

RFC Request For Comments

RoHS Restriction of Hazardous Substances

SCCR Short-circuit current rating

SD Secure Digital (memory card)

SDHC Secure Digital High Capacity (memory card)

S/FTP Screened/Foiled Twisted Pair

SF/FTP Screened Foiled/Foiled Twisted Pair

SF/UTP Screened Foiled/Unshielded Twisted Pair

SIL Safety Integrity Level

SNTP Simple Network Time Protocol

PLC Programmable Logic Controller

SS1 Safe Stop 1

SSI Serial Synchronous Interface

STO Safe Torque Off

SubDevice SubordinateDevice

TCP Transmission Control Protocol

TTL Transistor-Transistor Logic

UL Underwriters Laboratories

W&S Wake and Shake
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24 Contact

24.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

If you need our system support:
Phone +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Tel. +49 7231 582-3000

Our address:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12
75177 Pforzheim, Germany

24.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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24.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
+43 7613 7600-0
sales@stoeber.at

STOBER CHINA 
www.stoeber.cn 
+86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE 
www.stober.fr 
+33 478 98 91 80 
sales@stober.fr

STOBER Germany 
www.stoeber.de 
+49 7231 582-0
sales@stoeber.de

STOBER ITALY 
www.stober.it 
+39 02 93909570 
sales@stober.it

STOBER JAPAN 
www.stober.co.jp 
+81-3-5875-7583
sales@stober.co.jp

STOBER KOREA 
www.stober.kr 
+82 10 5681 6298 
sales@stober.kr

STOBER SWEDEN 
www.stober.com 
+46 702 394 675
neil.arstad@stoeber.de

STOBER SWITZERLAND 
www.stoeber.ch 
+41 56 496 96 50 
sales@stoeber.ch

STOBER TAIWAN 
www.stober.tw 
+886 4 2358 6089 
sales@stober.tw

STOBER TURKEY 
www.stober.com 
+90 216 510 2290 
sales-turkey@stober.com

STOBER UK 
www.stober.co.uk 
+44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
+1 606 759 5090 
sales@stober.com
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Glossary

100Base-TX

Ethernet network standard based on symmetrical copper cables in which the nodes are connected to a switch via
copper cables twisted in pairs (shielded twisted pair, CAT 5e quality level). 100Base-TX is the subsequent progression
from 10Base-T and includes those properties with the option of a transfer speed of 100 Mbps (Fast Ethernet).

Band

In the context of a scope, a section in the display of a scope image. The recorded channels can be individually assigned,
each to one such section.

Braking resistor

Electrical resistor that is switched on by a brake chopper in order to avoid a hazard to electrical components in the
event of significant brake energy by limiting the DC link voltage. Braking energy, which is usually only present for brief
periods, is converted into heat in the resistor.

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Channel (scope, multi-axis scope)

The reserved disk space for recording a signal in DriveControlSuite. As part of a scope image, up to 12 channels can be
recorded simultaneously.

Channel assignment

Source of the data that is recorded with/by/in a channel. For example, this may involve parameters that are
transmitted in a cyclical fieldbus communication channel or a parameter that is recorded in a measurement channel.

Circuit breakers

Current-limiting switches for motor or starter protection. They guarantee safe shut-off in the event of a short-circuit
and protect loads and systems from overload.

Control cascade

Complete model of the control structure with the position controller, velocity controller and current controller
components.

Current controller

Controller that is part of the control cascade and makes sure the deviation between the set and actual torque/force is
small. In addition, it uses the deviation to calculate a value for the set current and transfers this to the power unit. The
controller has a part that controls torque/force and a part that controls the magnetic flux.

DC link discharge time

Time until the DC link capacitors are discharged enough that the device can be worked on safely.
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Defense in depth

In accordance with DIN EN IEC 62443-4-1, an approach to defend the system against any kind of attack using multiple
independent methods.

Demilitarized zone (DMZ)

Specially controlled network located between the external network (Internet) and internal network. It represents a
kind of buffer zone that separates the networks from each other through strict communication rules and firewalls.

Differential (HTL/TTL)

In the context of signal transmission, a process for being able to transmit signals with the highest possible fault
tolerance even with longer transmission paths. In this approach, transmission takes place using a pair of signal
conductors instead of just one signal conductor. The actual signal is transmitted on one line and the inverse signal on
the other.

Discrete Fourier transform (DFT)

Maps a time-discrete signal onto a periodic, discrete frequency spectrum. A Fourier transform can be carried out on a
scope image in DriveControlSuite. The spectrum display of the scope image shows all occurring frequencies. The
amplitude of a frequency stands for its frequency of occurrence.

Electronic nameplate

The synchronous servo motors are generally equipped with absolute encoders that provide special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and
electronic values of a motor. When you operate a drive controller with a synchronous servo motor and an absolute
encoder, the electronic nameplate is read and all motor data transferred if the drive controller is connected online. The
drive controller automatically determines the associated limit values and control parameters from this data.

Fail Safe over EtherCAT (FSoE)

Protocol for transferring safety-related data via EtherCAT using a FSoE MainInstance and an indefinite number of FSoE
SubInstances (i.e. devices that have a Safety over EtherCAT interface). The protocol enables the realization of
functional safety via EtherCAT. FSoE and its implementation are TÜV-certified and comply with the SIL 3 requirements
in accordance with IEC 61508.

Firewall

Network security device that monitors incoming and outgoing network traffic and decides whether to allow or block
specific traffic based on a set of defined security rules. It is based either on hardware, software or a combination of
both.

Frequency analysis

Method for investigating how frequently certain events occur in a certain time span, or how strongly which frequency
components are represented in a signal.

i²t model

Computational model for thermal monitoring.
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i²t value

Criterion for short-term overload capacity.

Industrial Internet of Things (IIoT)

Subgroup of the Internet of Things (IoT) that focuses specifically on the application of IoT technologies in industrial
environments, including manufacturing, logistics and other sectors. The focus is on improving industrial processes,
efficiency, automation and real-time data collection. It is about optimizing operations, reducing downtime and
maximizing productivity.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

I-share

Integral share of the controller that acts on the manipulated variable through the temporal integration of the control
deviation with the weighting caused by the reset time: the longer the control difference is present, the stronger the
response is.

Life performance indicator

Value for the calculated life performance of the geared motor.

Load matrix

Recording of the frequency distribution of speeds and torques that occurred at the output of the geared motor.

Miniature circuit breakers

Special switch that protects electrical systems from overload and short-circuits.  It is specifically used for the fuse
protection of individual cores or cables. The switch has different triggering characteristics (A, B, C, D) and, thus, serves
all application areas in industrial, functional and residential construction.

Multi-axis scope

Analysis tool of DriveControlSuite with graphical output. It can be used to create synchronized scope images of
multiple drive controllers or axes in order to measure and depict the progress of parameter values, signal names or
physical addresses over time.

MV number

The number of the material variant ordered and delivered as stored in the enterprise resource planning system, i.e. the
device-specific combination of all hardware and software components.

Network Time Protocol (NTP)

Standard for synchronizing clocks in computer systems via packet-based communication networks. The protocol uses
the connectionless transport protocol UDP or the connection-based TCP. It is specifically designed to provide reliable
timing over networks with variable packet runtime.
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Output choke

Choke type that delays the current increase at the input of the drive controller or supply module in order to reduce the
harmonics in the supply grid and reduces the load of the power feed-in of the devices.

P controller

Controller type in which the manipulated variable is always proportional to the recorded control difference. As a result
of this, the controller responds to the control deviation without a delay and only creates a manipulated variable if a
deviation is present. It is a fast and stable controller with a permanent control deviation that can be used for non-
critical controls where permanent control deviation can be accepted when faults occur, e.g. pressure, flow, fill level
and temperature control.

Performance Level (PL)

In accordance with DIN EN ISO 13849-1: Measure for the reliability of a safety function or a component. The
Performance Level is measured on a scale of a – e (lowest – highest PL). The higher the PL, the safer and more reliable
the function in question is. The PL can be assigned to a specific SIL. A reversed inference from a SIL to a PL is not
possible.

PI controller

Controller type that results from a parallel connection of a P and an I-controller. With the right layout, it combines the
advantages of both types (stable and fast, no permanent control deviation) and compensates for the disadvantages
simultaneously.

PID controller

Universal controller type with a P-, I- and D-share. These three adjustment parameters make the controller flexible and
ensure exact and highly dynamic control. However, by implication, it also necessitates a wide variety of variants. It is
that much more important to ensure careful construction that is well-coordinated to the system. The application areas
for this controller type are control circuits with systems of the second order and higher, which must be stabilized
quickly and do not allow for any permanent control deviation.

Plug connectors

Component for disconnecting and connecting cables. The connecting parts are appropriately aligned by the positive
locking of the plug pieces, feature detachable, positive attachment by spring force (pin) and are often also secured
against unintended disconnection by a screw connection.

Position controller

Controller that is part of the control cascade and makes sure the deviation between the set and actual position is small.
To do so, it calculates a set velocity from the deviation and passes it to the velocity controller.

Predictive Maintenance (PRM)

Proactive maintenance process based on permanent monitoring and evaluation of machine and process data. The aim
here is to predict future maintenance requirements, thereby avoiding faults and making maintenance processes more
efficient.
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Pre-trigger

Percentage portion of the recording time that takes place before the trigger and that defines the starting time of the
scope image.

Pre-trigger time

Portion of the recording time that takes place before the trigger and that defines the starting time of the scope image.

PROFIdrive

Standardized drive interface for PROFIBUS and PROFINET open standard buses. It defines the device behavior and
procedure for accessing internal device data for electrical drives on PROFINET and PROFIBUS. The interface is specified
by PROFIBUS and PROFINET International (PI) user organizations, and is specified as the future-proof standard by
standard IEC 61800-7-303.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

PROFINET IRT

Transmission method for high-precision as well as synchronized processes in a PROFINET IO system.

PROFINET RT

Transmission method for time-critical process data in a PROFINET IO system.

PROFIsafe

Communication standard for safety standard IEC 61508 that includes both standard as well as fail-safe communication.
The standard enables reliable communication for PROFIBUS and PROFINET open standard buses based on standard
network components, and is defined as the international standard in standard IEC 61784-3-3.

P-share

Proportional share of the controller gain: the greater this share is, the stronger the influence on the manipulated
variable.

PTC thermistor

Thermistor whose resistance significantly changes with the temperature. When a PTC reaches its defined nominal
response temperature, the resistance increases dramatically, by two or more times the original resistance, to several
kOhms. Since PTC triplets are used, each thermistor monitors one phase of the motor winding. For 3 thermistors, this
means all 3 phases are monitored, achieving effective motor protection.

Quantization

Conversion of analog signals into numbers and measurable variables. For this purpose, the analog signals are scanned
in regular intervals at the sampling rate and their voltage rating is converted at each of these scanning points to a
digital value. The analog signal can only be expressed in a finite number of digital values.
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Recording time

Recording of an image, occurrence, acoustic event or other event on a corresponding medium. In the context of a
scope, the display of the calculated duration of scope image recording. The memory size, sampling time and channels
used form the basis of the calculation.

Reforming

Protective measure for drive controllers. In case of a longer storage time, the oxide layer of the capacitors reacts with
the electrolytes. This influences the electrical strength and capacitance. The process to be performed before
commissioning re-establishes the dielectric in the capacitors.

Reverse documentation

Refers to a read-only file read out by a drive controller that includes the fault memory in addition to the configuration
of a drive controller. This file is a snapshot of the time that the connection between the PC and drive controller was
interrupted. The information it contains is used for diagnostics as well as for processing service requests.

RFC

Proposed and published Internet standards, reviewed by the Internet Engineering Task Force (IETF), as consensus-
building body that facilitates discussion, and eventually a new standard is established.

Safe Stop 1 (SS1)

In accordance with DIN EN 61800-5-2: Procedure for stopping a PDS(SR). With the SS1 safety function, the PDS(SR)
performs one of the following functions: a) Triggering and controlling the motor delay variable within defined limits
and triggering the STO function if the motor speed falls below a specified limit value (SS1-d), or b) triggering and
monitoring the motor delay variable within defined limits and triggering the STO function if the motor speed falls
below a specified limit value (SS1-r), or c) triggering the motor delay and triggering the STO function after an
application-specific delay (SS1-t). In this case, SS1(-t) corresponds to the time-controlled stop in accordance with IEC
60204-1, stop category 1(-t).

Safe Torque Off (STO)

In accordance with DIN EN 61800-5-2: Procedure for stopping a PDS(SR). The STO safety function prevents the motor
from being supplied with any energy that could cause rotation (or motion in a linear motor). The PDS(SR) does not
supply the motor with any energy that could generate torque (or force in a linear motor). STO is the most fundamental
drive-integrated safety function. It corresponds to an uncontrolled stop in accordance with DIN EN 60204-1, stop
category 0.

Safety Integrity Level (SIL)

In accordance with DIN EN 61800-5-2: Probability of a safety function failure. SIL is divided into levels 1 – 4 (lowest –
highest level). SIL precisely assesses systems or subsystems based on the reliability of their safety functions. The higher
the SIL, the safer and more reliable the function in question is.

Sampling time

In signal processing, the time after which an analog signal (also called a continuous-time signal) is scanned again, i.e.
measured and converted into a discrete-time signal.
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Scope

Analysis tool of DriveControlSuite with graphical output. It can be used to create scope images of a drive controller in
order to measure and depict the progress of parameter values, signal names or physical addresses over time. The term
stems from traditional scope-type measuring instruments.

Scope memory

Disk space in the drive controller that records the data of a scope image.

Security

Term for the protection and safety of components and systems with regard to confidentiality, integrity and availability.

Self-discharge

Passive running process that causes the capacitors to discharge even when no electrical load is connected.

Serial number

Consecutive number stored for a product in the enterprise resource planning system and used for individual
identification of the product and for determining the associated customer information.

Short-circuit current rating (SCCR)

Characteristic of electrotechnical components or modules. It is defined as the maximum short-circuit current that a
component or system must safely withstand.

Simple Network Time Protocol (SNTP)

Simplified version of the Network Time Protocol (NTP). The structure of the protocol is identical to that of NTP. SNTP
clients can thus also obtain the time from NTP servers. The main difference lies in the algorithms used for time
synchronization. While NTP usually uses multiple time servers for time synchronization, SNTP uses only one time
server.

Single-ended (HTL/TTL)

In the context of signal transmission, electrical signal transmission takes place using a voltage that changes in relation
to a constant reference potential.

System parameter

Parameter that is defined by the firmware. Examples include parameters for motor control, for encoders or
parameters of the control cascade.

Template

In the context of the DriveControlSuite commissioning software, a template for graphical programming. This template
can be selected in the configuration dialog for device control, communication (fieldbus) or application in a certain
version.
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Trigger

Switch or software function that generates a pulse or a switching operation during a triggering event.

Trigger condition

Triggering event that generates a pulse or switching operation.

Velocity controller

Controller that is part of the control cascade and makes sure the deviation between the set and actual velocity is small.
In addition, it uses the deviation to calculate a value for the set torque/force and transfers this to the current
controller.

Window function

Auxiliary function for minimizing the leakage effect for the Fourier transform.
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